Get to know your Mac right out of the box

Master all the cool apps that come standard

Learn practical troubleshooting tips

The book you need to succeed!
Mac® Bible
Mac® Bible

Dwight Spivey

Wiley Publishing, Inc.
About the Author

Dwight Spivey is the author of How to Do Everything: Mac and Mac OS X Leopard Portable Genius. He is also a software and support engineer for Konica Minolta, where he specializes in working with Mac operating systems, applications, and hardware, as well as color and monochrome laser printers. He teaches classes on Mac usage, writes training and support materials for Konica Minolta, and is a Mac OS X beta tester for Apple. Dwight lives on the Gulf Coast of Alabama with his wife, Cindy, and their three beautiful children, Victoria, Devyn, and Emi. He studies theology, reads as much J. R. R. Tolkien and C. S. Lewis as possible, and roots for the Auburn Tigers in his ever-decreasing spare time.
This is for the children in my life who have been such blessings from God for our entire family:
My own dear little ones: Victoria, Devyn, and Emi
My precious nieces and nephews: Kelsey, Keaton, Kelen, and Kooper
I love you so much, each and every one.

Credits

Acquisitions Editor
Courtney Allen

Project Editor
Lynn Northrup

Technical Editor
Brian Joseph

Editorial Manager
Robyn Siesky

Business Manager
Amy Knies

Senior Marketing Manager
Sandy Smith

Vice President and Executive Group Publisher
Richard Swadley

Vice President and Executive Publisher
Barry Pruett

Project Coordinator
Lynsey Stanford

Graphics and Production Specialists
Samantha Allen
Ana Carrillo
Shawn Frazier
Melanee Habig
Andrea Hornberger
Jennifer Mayberry
Sarah Philippart

Proofreading
Laura Bowman

Indexing
BIM Indexing & Proofreading Services
First things first: Thanks to my wife, Cindy, for her love and help in getting this project finished (finally!). Thank you for your patience and for keeping the household from falling apart while I was working on this tome.

Thanks to my family and friends (especially you, John Michael) who were patient with my many absences during this work. Knowing you were always there for me made this a much easier task to accomplish.

Thanks to my wonderful agent, Carole McClendon, for landing me another great assignment.

Much thanks is owed to my editors, Courtney Allen and Lynn Northrup, for their understanding, help, and patience throughout this project. I would also like to thank Brian Joseph, who carefully reviewed the text for technical accuracy.

I also want to offer many thanks to all those who had a hand in this book whom I didn’t mention by name here. You all make my work look much better than I probably deserve.

I’d like to extend a special word of thanks to my friend Gene Everette, for his help, expertise, advice, and just plain old good friendship over the years. Gene was the person who first introduced me to the Mac.
The Mac Bible is written for you, oh Mac user. It doesn't matter if you just bought your first Mac or if you are like me, a dyed-in-the-wool you-can-have-my-Mac-when-you-pry-it-from-my-cold-dead-fingers Mac geek. I'm not ashamed of my Mac geekness, and neither should you be. I suspect if you were really worried about such labels you might not have picked up this heavy volume in the first place. One unabashed goal of this book is to increase readers' Mac geek quotient, making them a force to be reckoned with when required to defend their operating system of choice to those poor folks upon whom Microsoft Windows has been foisted.

In the Mac Bible you will learn many of the basics, but also many of the not-so-basics, that make living and working with a Mac such a great experience. I'll tackle everything from the latest Apple hardware, to discovering the Finder, printing and scanning, learning about word processing and spreadsheets, creating your own home movies and DVDs, maintaining your music library, finding the best games, diving into Mac OS X Leopard's UNIX underpinnings, and much more!

Even if you don't think a particular chapter or section interests you, I implore you to read through it anyway, whether sooner or later. It may sound funny to some, but when you use a computer enough, you develop a relationship with it, much as you do with your car. When things are going great you're glad to have it, when things are confusing you get frustrated with it, and when things break you could experience any of a wide range of emotions. Get to know your computer and you will experience a much happier and more satisfying relationship with it.

When I was first asked to write the Mac Bible I was so grateful to have an opportunity to participate in one of the most widely recognized technical book series around, the Bible series. I was almost overwhelmed when it dawned on me that I could contribute something like this to the ever-expanding Mac community. Mac users are an intelligent lot, and this book's aim from the very beginning was to make sure that it didn't talk down to or speak over and above its readers, while still supplying, with just the right amounts of candor, levity, and detail, the kind of information that makes it relevant to their daily Mac activities. I hope, dear reader, you find that to be the case. My utmost gratitude goes to you for giving me a chance to lend you a helping hand when needed.

How This Book Is Organized

If you're new to the Mac, I suggest reading this book from cover to cover to learn everything you need to know. Or use it as a desk reference and check the Table of Contents or the Index to go right to the specific topics that interest you.

The Mac Bible is organized into seven main parts:
Part I: The Basic Mac
This part of the book is aimed at helping you become proficient with the standard bells and whistles of Mac OS X and your Mac's hardware. You discover how to easily and efficiently navigate your work and play environments and master the skills necessary to make you feel comfortable with your Mac.

Part II: The Networked Mac
Most computers aren't loners, meaning that you will most likely want it to communicate with other computers in its vicinity. This part of the book shows you how to set up your Mac on a network and teach it how to converse with computers of all stripes.

Part III: The Working Mac
Get the lowdown on using your Mac to actually get some work done. Here, you learn about the Mac's ability to handle just about any task you can throw at it, including word processing, spreadsheets, and presentations.

Part IV: The Multimedia Mac
We live in a digital age (as if you didn't know that already), and your Mac is ready to tackle your multimedia needs with elegance and simplicity. From listening to music to creating your movies and DVDs, these chapters help you manage your digital life.

Part V: The Surfing Mac
Where would we be without the Internet? Today, most of our communications take place over the Internet in some form or another, and your Mac is ready to jump into all things related to the World Wide Web, right out of the box. This part of the book covers everything from browsing the Internet with your favorite Web application to getting and receiving e-mail.

Part VI: The Advanced Mac
You learn how to handle tasks that require a bit more advanced knowledge of the Mac in this part. I show you how to use the Terminal, give you tips for maintaining your Mac, and help you learn some of the basic — and not-so-basic — troubleshooting tricks.

Part VII: Appendixes
Check this part of the book to discover some of the most popular third-party applications and utilities for making your Mac life even better, as well as learn a bit about gaming on the Mac. Continue your Mac education with a list of helpful books and Web sites, and get information on Mac professional certification and training. Finally, check the glossary for concise definitions of often-used Mac terms.
Icons Used in This Book

To make this book as usable as possible, icons in the margins alert you to special or important information. Look for the following:

- **CAUTION** The Caution icon offers important information about a procedure to which you should pay particular attention.

- **CROSS-REF** The Cross-Reference icon refers you to a related topic elsewhere in the book. Because you may not read this book straight through from cover to cover, you can use cross-references to quickly find the information you need.

- **NOTE** The Note icon alerts you to a special point or supplementary information about a feature or task that may be helpful.

- **TIP** The Tip icon marks a tip that saves you time and helps you work more efficiently.

To further assist you in reading and learning the material in this book, the following conventions are used throughout:

New words or phrases that may require definition and explanation appear in italics. Text that carries emphasis and single characters that may be easy to lose in the text also appear in italics.

Menu commands are indicated in chronological order by using command arrows: File→Open.
# Contents

Acknowledgments .......................................................... vii
Introduction ........................................................................ ix

## Part I: The Basic Mac .................................................. 1

Chapter 1: Know Your Mac ............................................. 3
Chapter 2: The Finder Is Your Friend ................................ 21
Chapter 3: Finder Fun ..................................................... 49
Chapter 4: Customize Your Mac ....................................... 67
Chapter 5: The Nuts and Bolts of System Preferences ....... 83
Chapter 6: Manage User Accounts ................................. 109

## Part II: The Networked Mac ........................................ 127

Chapter 7: Add Your Mac to a Network ......................... 129
Chapter 8: Sharing Files from Your Mac ......................... 153

## Part III: The Working Mac ......................................... 183

Chapter 9: Word Processing with Your Mac ................... 185
Chapter 10: The Mac Does Spreadsheets and Presentations, Too 213
Chapter 11: Organize Life Using Your Mac ..................... 247
Chapter 12: Printing and Scanning with Your Mac .......... 267

## Part IV: The Multimedia Mac .................................... 291

Chapter 13: Mastering Digital Images ............................ 293
Chapter 14: iMovie Magic .............................................. 325
Chapter 15: Musical Mac ............................................. 341

## Part V: The Surfing Mac ............................................. 371

Chapter 16: Staying Connected Through E-Mail ............. 373
Chapter 17: Cruising the Internet with Web Browsers ...... 407
Chapter 18: Chatting Across the Miles .......................... 429

## Part VI: The Advanced Mac ...................................... 441

Chapter 19: UNIX ....................................................... 443
Chapter 20: Alternative Operating Systems ................. 457
Chapter 21: Doctor Your Ailing Mac ............................. 473
Chapter 22: Backing Up Your Mac ................................. 489
Part VII: Appendixes

Appendix A: Popular Third-Party Applications and Utilities..........................................................505
Appendix B: Gaming on the Mac ........................................................................................................515
Appendix C: Resources ....................................................................................................................521
Appendix D: Apple Certification and Training ..................................................................................529
Appendix E: Glossary ..........................................................................................................................533

Index ..................................................................................................................................................541
# Contents

Acknowledgments .......................................................... vii
Introduction ...................................................................... ix

## Part I: The Basic Mac .................................................. 1

### Chapter 1: Know Your Mac ........................................ 3

- Laptops ......................................................................... 4
- MacBook ........................................................................ 4
- MacBook Pro ............................................................. 6
- MacBook Air ............................................................... 7
- Desktops ........................................................................ 8
- iMac ............................................................................ 8
- Mac mini ....................................................................... 10
- Mac Pro ........................................................................ 11
- Input Devices .............................................................. 12
- Mac keyboards ........................................................... 12
- Using a mouse ............................................................ 13
- Get familiar with the trackpad ..................................... 14
- Alternative input devices .............................................. 15
  - Trackballs ............................................................... 15
  - Graphics tablets ...................................................... 15
- External Devices ........................................................ 15
- FireWire devices ......................................................... 16
- USB devices ............................................................. 17
- Mac OS X ..................................................................... 17
- Prevalent Technologies in Mac OS X ............................ 18
  - Darwin ..................................................................... 19
  - Quartz ..................................................................... 19
  - Aqua ........................................................................ 19
  - PDF .......................................................................... 19
  - Java ......................................................................... 19
  - ColorSync ............................................................... 20
  - OpenGL ..................................................................... 20
  - QuickTime .............................................................. 20
- Summary ...................................................................... 20
## Contents

### Chapter 2: The Finder Is Your Friend .................................................. 21
- Finder Functions .................................................................................................... 21
- Utilizing the Finder .................................................................................................. 22
  - Menus and icons .................................................................................................. 23
  - Working with windows .......................................................................................... 25
    - Choosing a view .................................................................................................. 26
    - Moving and resizing windows .......................................................................... 26
    - Customizing the Finder toolbar ........................................................................ 28
  - Working with folders ............................................................................................ 29
    - What are the folders on your Mac used for? .................................................. 29
    - Create new folders ............................................................................................ 30
    - Smart Folders and Burn Folders ...................................................................... 30
  - Working with files .................................................................................................. 32
    - Creating new files ............................................................................................. 32
    - Open files in applications .................................................................................. 33
    - Preview files with Quick Look ......................................................................... 34
  - Get information on files and folders ..................................................................... 35
  - A few more file and folder tricks .......................................................................... 36
  - Create aliases of files and folders ........................................................................ 36
  - Rename files and folders .................................................................................... 38
  - Delete items from your Mac ................................................................................. 38
- Set the Finder Preferences ..................................................................................... 39
  - General .................................................................................................................. 39
  - Labels ..................................................................................................................... 40
  - Sidebar .................................................................................................................. 41
  - Advanced .............................................................................................................. 41
- Find Items on Your Mac .......................................................................................... 42
  - Use the Spotlight menu ......................................................................................... 43
  - Search from within a Finder window .................................................................... 44
  - Set Spotlight’s preferences .................................................................................. 45
- Summary .................................................................................................................. 47

### Chapter 3: Finder Fun ................................................................. 49
- Mastering the Dock .................................................................................................. 49
  - Rearrange items in the Dock ................................................................................ 50
  - Remove items from the Dock .............................................................................. 50
  - Add items to the Dock ......................................................................................... 51
  - Organize the Dock’s icons .................................................................................. 53
  - Taking out the Trash ............................................................................................ 53
- Change the way your Dock behaves ....................................................................... 53
- Become a Dashboard Aficionado ........................................................................... 55
  - Viewing your widgets .......................................................................................... 55
  - Activate a widget .................................................................................................. 55
  - Deactivate a widget .............................................................................................. 56
Contents

Managing widgets ..................................................................................................... 56
  Enable and disable widgets .............................................................................. 57
  Install new widgets .......................................................................................... 57
  Uninstall a widget ........................................................................................... 58
Exposé Basics ........................................................................................................ 60
  Use the function keys to enable Exposé ......................................................... 60
  Set preferences for Exposé ............................................................................ 62
Gain More Desktop Ground with Spaces .......................................................... 63
  Enable your Mac for Spaces .......................................................................... 64
  Move between Spaces .................................................................................... 64
  Link applications to Spaces .......................................................................... 65
Summary ................................................................................................................ 66

Chapter 4: Customize Your Mac ............................................................................ 67
Installing Applications ............................................................................................ 67
  CD or DVD installation .................................................................................... 68
  Installing downloaded items ............................................................................ 69
Adding and Managing Fonts .................................................................................... 70
  Where are fonts stored? .................................................................................. 70
  How to use Font Book .................................................................................... 70
    Manage fonts .................................................................................................. 71
    Add or delete fonts ......................................................................................... 72
    Font Book Preferences .................................................................................. 73
  Third-party font-management utilities ............................................................. 74
Jazz Up Your Workspace with Desktop Pictures and Screen Savers ................. 76
  Change your Desktop picture .......................................................................... 76
  Selecting screen savers ................................................................................... 78
Assign Custom Icons to Your Folders ................................................................. 79
Utilities to Help You Change the Look of Your Mac ........................................... 81
Summary ................................................................................................................ 82

Chapter 5: The Nuts and Bolts of System Preferences ............................................ 83
What Are System Preferences? ........................................................................... 83
System Preferences In-Depth ................................................................................ 84
Personal: Configuring Appearance, Security, and Searches ......................... 85
  Appearance ........................................................................................................ 85
  Desktop & Screen Saver .................................................................................. 87
  Dock ................................................................................................................. 87
  Exposé & Spaces ............................................................................................. 87
  International ..................................................................................................... 87
    Language ........................................................................................................ 87
    Formats .......................................................................................................... 87
    Input Menu .................................................................................................... 89
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security</td>
<td>89</td>
</tr>
<tr>
<td>General</td>
<td>90</td>
</tr>
<tr>
<td>FileVault</td>
<td>91</td>
</tr>
<tr>
<td>Firewall</td>
<td>92</td>
</tr>
<tr>
<td><strong>Spotlight</strong></td>
<td>93</td>
</tr>
<tr>
<td><strong>Hardware: Interacting with Other Devices</strong></td>
<td>93</td>
</tr>
<tr>
<td>Bluetooth</td>
<td>93</td>
</tr>
<tr>
<td>CDs &amp; DVDs</td>
<td>94</td>
</tr>
<tr>
<td>Displays</td>
<td>94</td>
</tr>
<tr>
<td><strong>Energy Saver</strong></td>
<td>95</td>
</tr>
<tr>
<td><strong>Keyboard &amp; Mouse</strong></td>
<td>96</td>
</tr>
<tr>
<td>Keyboard</td>
<td>96</td>
</tr>
<tr>
<td>Trackpad</td>
<td>97</td>
</tr>
<tr>
<td>Mouse</td>
<td>97</td>
</tr>
<tr>
<td>Bluetooth</td>
<td>97</td>
</tr>
<tr>
<td>Keyboard Shortcuts</td>
<td></td>
</tr>
<tr>
<td><strong>Print &amp; Fax</strong></td>
<td>98</td>
</tr>
<tr>
<td><strong>Sound</strong></td>
<td>98</td>
</tr>
<tr>
<td>Sound Effects</td>
<td>98</td>
</tr>
<tr>
<td>Output</td>
<td>99</td>
</tr>
<tr>
<td>Input</td>
<td>99</td>
</tr>
<tr>
<td><strong>Internet &amp; Network</strong></td>
<td>99</td>
</tr>
<tr>
<td>MobileMe</td>
<td>100</td>
</tr>
<tr>
<td>Network</td>
<td>100</td>
</tr>
<tr>
<td><strong>QuickTime</strong></td>
<td>100</td>
</tr>
<tr>
<td>Register</td>
<td>100</td>
</tr>
<tr>
<td>Browser</td>
<td>100</td>
</tr>
<tr>
<td>Update</td>
<td>101</td>
</tr>
<tr>
<td>Streaming</td>
<td>101</td>
</tr>
<tr>
<td>Advanced</td>
<td>101</td>
</tr>
<tr>
<td><strong>Sharing</strong></td>
<td>102</td>
</tr>
<tr>
<td>System: Modifying Leopard</td>
<td>102</td>
</tr>
<tr>
<td><strong>Accounts</strong></td>
<td>102</td>
</tr>
<tr>
<td><strong>Date &amp; Time</strong></td>
<td>102</td>
</tr>
<tr>
<td>Date &amp; Time</td>
<td>103</td>
</tr>
<tr>
<td>Time Zone</td>
<td>103</td>
</tr>
<tr>
<td>Clock</td>
<td>103</td>
</tr>
<tr>
<td>Parental Controls</td>
<td>104</td>
</tr>
<tr>
<td><strong>Software Update</strong></td>
<td>104</td>
</tr>
<tr>
<td>Scheduled Check</td>
<td>104</td>
</tr>
<tr>
<td>Installed Updates</td>
<td>105</td>
</tr>
<tr>
<td><strong>Speech</strong></td>
<td>105</td>
</tr>
<tr>
<td>Speech Recognition</td>
<td>105</td>
</tr>
<tr>
<td>Text to Speech</td>
<td>106</td>
</tr>
<tr>
<td><strong>Startup Disk</strong></td>
<td>106</td>
</tr>
<tr>
<td>Time Machine</td>
<td>107</td>
</tr>
</tbody>
</table>
Chapter 10: The Mac Does Spreadsheets and Presentations, Too .......................... 213

Using Numbers to Create Spreadsheets ............................................................... 213
Create a new spreadsheet ...................................................................................... 214
Use templates ....................................................................................................... 215
Getting around in Numbers .................................................................................. 216
Format cells and rows ......................................................................................... 217
Spicing up your table with a chart .................................................................... 221
Import and export spreadsheets .......................................................................... 222
Importing spreadsheets ...................................................................................... 223
Exporting spreadsheets ...................................................................................... 223
Working with Excel ................................................................................................ 224
Spreadsheet creation ........................................................................................... 225
Use the Toolbox to format your spreadsheet ....................................................... 226
Add items to your spreadsheet with the Elements Gallery .............................. 228
Share your spreadsheets ..................................................................................... 231
Creating Presentations Using Keynote ................................................................. 234
Learn your way around in Keynote ..................................................................... 234
Use Themes to create a new presentation ............................................................ 236
Spicing up your slide show .................................................................................. 237
A few more Keynote tidbits ................................................................................ 239
Sharing your slide show ..................................................................................... 240

Alternative Word Processors ................................................................................ 211
OpenOffice.org Writer .......................................................................................... 211
NeoOffice .............................................................................................................. 211

Summary ................................................................................................................ 221

Contents

Setting margins and tab stops ............................................................................. 190
Working with fonts ............................................................................................... 190
Using Pages ............................................................................................................ 192
Create new documents ......................................................................................... 192
Choose a template ............................................................................................... 193
Getting around in the Pages interface ............................................................... 193
Placing images and shapes .................................................................................. 195
Images .................................................................................................................. 195
Shapes .................................................................................................................. 197
Add tables and charts ......................................................................................... 197
Import and export files ....................................................................................... 200
Get to Know Word on Your Mac ........................................................................ 201
Utilize the Project Gallery .................................................................................. 201
New text and graphics features .......................................................................... 202
Document Elements ............................................................................................ 203
Quick Tables ......................................................................................................... 204
Charts ................................................................................................................... 204
SmartArt Graphics ............................................................................................... 204
WordArt ................................................................................................................ 206
Import and export files ....................................................................................... 206

Chapter 10: The Mac Does Spreadsheets and Presentations, Too ................. 213

Using Numbers to Create Spreadsheets ............................................................... 213
Create a new spreadsheet ...................................................................................... 214
Use templates ....................................................................................................... 215
Getting around in Numbers .................................................................................. 216
Format cells and rows ......................................................................................... 217
Spicing up your table with a chart .................................................................... 221
Import and export spreadsheets .......................................................................... 222
Importing spreadsheets ...................................................................................... 223
Exporting spreadsheets ...................................................................................... 223
Working with Excel ................................................................................................ 224
Spreadsheet creation ........................................................................................... 225
Use the Toolbox to format your spreadsheet ....................................................... 226
Add items to your spreadsheet with the Elements Gallery .............................. 228
Share your spreadsheets ..................................................................................... 231
Creating Presentations Using Keynote ................................................................. 234
Learn your way around in Keynote ..................................................................... 234
Use Themes to create a new presentation ............................................................ 236
Spicing up your slide show .................................................................................. 237
A few more Keynote tidbits ................................................................................ 239
Sharing your slide show ..................................................................................... 240

Contents

Setting margins and tab stops ............................................................................. 190
Working with fonts ............................................................................................... 190
Using Pages ............................................................................................................ 192
Create new documents ......................................................................................... 192
Choose a template ............................................................................................... 193
Getting around in the Pages interface ............................................................... 193
Placing images and shapes .................................................................................. 195
Images .................................................................................................................. 195
Shapes .................................................................................................................. 197
Add tables and charts ......................................................................................... 197
Import and export files ....................................................................................... 200
Get to Know Word on Your Mac ........................................................................ 201
Utilize the Project Gallery .................................................................................. 201
New text and graphics features .......................................................................... 202
Document Elements ............................................................................................ 203
Quick Tables ......................................................................................................... 204
Charts ................................................................................................................... 204
SmartArt Graphics ............................................................................................... 204
WordArt ................................................................................................................ 206
Import and export files ....................................................................................... 206
Alternative Word Processors ................................................................................ 211
OpenOffice.org Writer .......................................................................................... 211
NeoOffice .............................................................................................................. 211
Summary ................................................................................................................ 221
Contents

PowerPoint for Mac OS X ........................................................................................................... 240
  Getting around in PowerPoint ............................................................................................... 241
  Using themes and layouts ...................................................................................................... 242
  Import and export presentations ........................................................................................... 244
  Summary ................................................................................................................................ 245

Chapter 11: Organize Life Using Your Mac ............................................................................ 247
  Getting to Know iCal .............................................................................................................. 247
  Working with calendars .......................................................................................................... 249
    Create new calendars .......................................................................................................... 249
    Exporting and importing calendars .................................................................................... 251
    Subscribe to calendars ........................................................................................................ 252
  Add events to your calendar .................................................................................................. 252
    Create an event .................................................................................................................... 252
    Set reminders for your events ............................................................................................. 253
  Using the Address Book ......................................................................................................... 254
    Add contacts and groups ....................................................................................................... 254
    Edit contact information ...................................................................................................... 256
    Importing and exporting address books .............................................................................. 257
    Address Book preferences ................................................................................................... 257
  In Sync with iSync .................................................................................................................. 259
    Set up a device to sync with ............................................................................................... 259
    Synchronize information between devices .......................................................................... 260
  Third-Party Organizational Tools .......................................................................................... 262
    Bento .................................................................................................................................. 262
    Today .................................................................................................................................. 263
  Summary ................................................................................................................................ 265

Chapter 12: Printing and Scanning with Your Mac ................................................................. 267
  Using a Printer ....................................................................................................................... 267
  How to Connect Your Printer to Your Mac ........................................................................... 268
    USB .................................................................................................................................. 269
    Ethernet ............................................................................................................................... 269
  Basic Printer Installation ........................................................................................................ 269
    Install a driver ..................................................................................................................... 269
    Create a printer queue ........................................................................................................ 270
    USB .................................................................................................................................. 270
    Network ............................................................................................................................... 272
    Utilizing the printer queue ................................................................................................. 274
    Change your printer's configuration ................................................................................... 277
  Printing a Job .......................................................................................................................... 278
  Printer Sharing ......................................................................................................................... 280
    Share with other Macs ......................................................................................................... 281
    Share with Windows users ................................................................................................. 281
Contents

Part IV: The Multimedia Mac

Chapter 13: Mastering Digital Images ................................................................................................................. 293

Get to Know iPhoto ................................................................................................................................................... 294
Import Images ......................................................................................................................................................... 296
Import from a camera .............................................................................................................................................. 297
Import from files ................................................................................................................................................... 299
View and Organize Images ..................................................................................................................................... 301
Assigning keywords to images .............................................................................................................................. 303
Creating albums and Smart Albums .......................................................................................................................... 304
Making a standard album ......................................................................................................................................... 304
Making a Smart Album .......................................................................................................................................... 304
Utilizing slide shows ............................................................................................................................................... 305
Create slide shows ................................................................................................................................................. 305
Setting up and playing slide shows ......................................................................................................................... 306
Edit Images ............................................................................................................................................................. 309
Remove that pesky red-eye ................................................................................................................................... 309
Advanced image editing ........................................................................................................................................ 309
Export Images .......................................................................................................................................................... 312
Exporting as a file ................................................................................................................................................ 312
Exporting via e-mail ............................................................................................................................................ 313
Print Your Images ................................................................................................................................................... 315
Create Customized Books, Calendars, and Greeting Cards ..................................................................................... 317
Image Capture .......................................................................................................................................................... 320
Acquiring images ..................................................................................................................................................... 320
Deleting and adding images to and from your camera ............................................................................................... 322
Manually delete images from your camera .................................................................................................................. 322
Add images to your camera ....................................................................................................................................... 323
Summary ................................................................................................................................................................ 324

Chapter 14: iMovie Magic ........................................................................................................................................... 325

Get to Know iMovie ................................................................................................................................................... 326
Import Video into iMovie .......................................................................................................................................... 327
Importing from a video camera ................................................................................................................................. 328
Random Access Devices ........................................................................................................................................ 328
Tape-based digital video cameras ............................................................................................................................ 329
## Contents

Importing from a file ................................................................. 329
Viewing your imported video .................................................... 330

**Create New iMovie Projects** .................................................. 331
Select clips ......................................................................................... 332
Mark your favorite clips ................................................................. 332
Add music and sound effects ......................................................... 333
Using transitions ............................................................................. 334

**Sharing Your Projects** ............................................................. 335
Publish your iMovie to the Web ................................................... 335
Create a movie for your iPhone, iPod, or Apple TV ....................... 337
Share a movie with other applications ........................................... 338
Export your iMovie ........................................................................... 339

Summary .......................................................................................... 339

### Chapter 15: Musical Mac ......................................................... 341

**Getting Around in iTunes** ...................................................... 341
Initializing iTunes ........................................................................... 342
Navigating the iTunes Jukebox interface ....................................... 344
Getting music into iTunes ............................................................... 348
Importing audio files ....................................................................... 349
Importing from a CD ......................................................................... 349

**iTunes preferences** .................................................................... 350
General .......................................................................................... 350
Podcasts ......................................................................................... 351
Playback ......................................................................................... 352
Sharing .......................................................................................... 354
Store ............................................................................................... 354
Advanced ....................................................................................... 355
Parental .......................................................................................... 358
Apple TV and Syncing ...................................................................... 359

**Playlists and Smart Playlists** .................................................... 359
Create a standard playlist .............................................................. 360
Create a Smart Playlist .................................................................... 361

**Spend a Buck (Or Not) at the iTunes Store** .............................. 361
Getting around in the iTunes Store ............................................... 362
Creating an iTunes Store account ............................................... 363

**Using iPod and iPhone with iTunes** ......................................... 364
Viewing information about your iPhone/iPod ................................ 365
Synchronizing libraries and other information .............................. 366
Viewing other items on your iPhone/iPod ..................................... 366

**Other Music Utilities** ............................................................... 367
GarageBand .................................................................................... 367
Audacity ........................................................................................ 368
Songbird ......................................................................................... 368

Summary .......................................................................................... 369
Part V: The Surfing Mac

Chapter 16: Staying Connected Through E-Mail

You've Got Mail ................................................................. 373
Get Rolling with Your First Account ..................................... 374
Get to know Mail's interface .................................................. 378
Modify Mail's toolbar .......................................................... 380
A look at Mail's preferences .................................................. 380
General .............................................................................. 380
Accounts ............................................................................ 382
RSS ................................................................................... 385
Junk Mail ............................................................................ 385
Fonts & Colors ................................................................... 386
Viewing ................................................................................ 386
Composing ........................................................................... 387
Signatures ............................................................................. 388
Rules .................................................................................... 389
Sending E-Mail ...................................................................... 390
Format your message ............................................................ 390
Letting other files tag along .................................................. 392
Customize your messages with Stationery .............................. 392
Receiving and Replying to E-Mail .......................................... 394
Saving attachments .............................................................. 394
Add people to your Address Book ......................................... 395
Alternative E-Mail Clients ...................................................... 396
Thunderbird ......................................................................... 396
How to get and install Thunderbird ......................................... 397
Set up your account ............................................................... 397
Extensions ............................................................................ 401
Entourage ............................................................................. 402
Create an account ................................................................. 402
Utilize My Day ....................................................................... 404
Summary ............................................................................... 405

Chapter 17: Cruising the Internet with Web Browsers

Internet Technologies Built Right into Your Mac ................. 407
Java ..................................................................................... 408
QuickTime ............................................................................ 408
PDF ....................................................................................... 409
Safari .................................................................................... 409
Getting from point A to point B ............................................ 409
Set Safari's preferences ......................................................... 411
General ................................................................................ 411
Appearance .......................................................................... 411
Bookmarks ........................................................................... 412
Contents

Tabs .............................................................................................................. 413
RSS ................................................................................................................ 413
AutoFill ......................................................................................................... 414
Security ......................................................................................................... 414
Advanced ...................................................................................................... 415
Private browsing .......................................................................................... 416
Block those annoying popups ........................................................................ 416
Tabbed browsing .......................................................................................... 416
Develop menu ............................................................................................... 418
Using bookmarks .......................................................................................... 419
Organize bookmarks ..................................................................................... 419
Import/export bookmarks ............................................................................. 420
Using RSS ..................................................................................................... 420
Firefox ............................................................................................................. 422
How to get and install Firefox ......................................................................... 423
Add-ons ......................................................................................................... 424
Other Web-Browsing Alternatives ................................................................... 425
Opera ............................................................................................................. 425
Camino .......................................................................................................... 425
Working with Downloaded Files ...................................................................... 426
Where to save downloaded files ..................................................................... 426
Archived and compressed files ....................................................................... 427
Supported file compression types ................................................................... 427
Archive and compression utilities ................................................................... 427
Summary ......................................................................................................... 428

Chapter 18: Chatting Across the Miles ......................................................... 429
Discover iChat ............................................................................................... 429
Setting Up Your Account .............................................................................. 431
Start Chatting ............................................................................................... 432

Add people to your Buddy List ..................................................................... 432
Different ways to chat .................................................................................... 434

Text chats ..................................................................................................... 434
Audio chats .................................................................................................... 434
Video chats .................................................................................................... 436

Other Cool Uses for iChat ............................................................................. 437
Sending files via iChat ................................................................................... 437
Receiving files in iChat ................................................................................... 438
Make Presentations with iChat Theater ......................................................... 439

Third-Party Chat Utilities ............................................................................. 439
Yahoo Messenger ........................................................................................... 439
Microsoft Messenger ..................................................................................... 439
AIM ................................................................................................................ 440
Adium ............................................................................................................. 440
Summary ......................................................................................................... 440
# Part VI: The Advanced Mac

## Chapter 19: UNIX

- Using a Command Line Interface ........................................ 444
- Using the Terminal ................................................................. 445
  - Getting around in Terminal .................................................. 445
  - Tabbed windows ................................................................. 446
- Modify Terminal's preferences .............................................. 448
  - Startup ............................................................................... 449
  - Settings ............................................................................. 450
  - Window Groups ............................................................... 451
  - Encodings ......................................................................... 451
- Common UNIX Commands .........................................................
  - man .................................................................................. 452
  - ls ..................................................................................... 452
  - ls -a .............................................................................. 453
  - cd ..................................................................................... 454
  - su ..................................................................................... 454
  - sudo .................................................................................. 454
  - mv .................................................................................... 454
  - cp ..................................................................................... 455
  - mkdir .............................................................................. 455
  - pwd ................................................................................... 455
  - rm .................................................................................... 455
  - rm -r ............................................................................. 455
- Summary ................................................................................. 456

## Chapter 20: Alternative Operating Systems

- Why Install Other Operating Systems on Your Mac? ................. 457
- Boot Camp ............................................................................. 459
  - Installing Windows ........................................................... 459
  - Selecting a startup volume ....................................................
    - Choosing a startup volume within Windows ...................... 464
    - Choosing a startup volume within Mac OS X ................... 465
  - Restoring your Mac’s hard disk ........................................ 466
- Virtual Machines ......................................................................
  - What is a virtual machine? .................................................. 467
  - Virtualization software for Mac OS X ................................. 467
    - Which virtualization software should you use? ............... 467
  - Parallels Desktop for Mac ............................................... 469
  - VMware Fusion .......................................................... 470
  - VirtualBox ....................................................................... 471
- Summary ............................................................................... 472
# Contents

## Chapter 21: Doctor Your Ailing Mac ................................................. 473

- Restart: It's Just That Simple! .......................................................... 474
- Utilize a Troubleshooting Account .................................................. 475
- Keep Software Up to Date .............................................................. 475
  - Using Software Update ................................................................... 475
  - Update your third-party software .................................................. 476
- Your Mac Won't Start Up or Shut Down Properly ............................ 477
  - The Mac simply won't power on ................................................... 477
  - Hanging at startup ....................................................................... 478
  - Your Mac can't shut down .......................................................... 479
- Problematic External Devices ......................................................... 479
- Thaw Your Frozen Mac ................................................................... 480
- Straighten Out That Misbehaving Application ............................... 481
- Fixing Permissions .......................................................................... 482
- Maintenance and Troubleshooting Utilities .................................... 483
  - Disk utilities .................................................................................. 484
  - Virus-proof your Mac .................................................................... 484
  - Maintain your Mac ........................................................................ 484
- Starting from Scratch ...................................................................... 486
- Helpful Resources ........................................................................... 487
- Summary ......................................................................................... 488

## Chapter 22: Backing Up Your Mac ................................................ 489

- Why and What to Back Up ............................................................. 489
  - Why back up? ............................................................................... 489
  - What files should you back up? .................................................... 490
- Discover Time Machine ................................................................. 491
  - Using a disk to store backups ....................................................... 491
    - Hardware requirements ............................................................ 491
    - Set up a backup disk .................................................................. 491
    - Tell Time Machine about the backup disk .................................. 492
- Tell Time Machine what to back up .............................................. 494
- Working with your backups .......................................................... 495
  - Manually back up your stuff ......................................................... 496
  - Pausing and resuming backups .................................................... 496
- Retrieving backed up information .................................................. 497
  - Restoring single files ................................................................... 497
  - Restoring entire disks ................................................................... 498
  - Delete files from Time Machine backups ..................................... 499
- Third-Party Backup Utilities .......................................................... 500
  - Carbon Copy Cloner .................................................................... 500
  - SuperDuper! ............................................................................... 500
  - Personal Backup .......................................................................... 501
  - Retrospect .................................................................................... 502
- Summary ......................................................................................... 502
## Part VII: Appendixes

<table>
<thead>
<tr>
<th>Appendix</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Popular Third-Party Applications and Utilities</td>
<td>505</td>
</tr>
<tr>
<td>B</td>
<td>Gaming on the Mac</td>
<td>515</td>
</tr>
<tr>
<td>C</td>
<td>Resources</td>
<td>521</td>
</tr>
<tr>
<td>D</td>
<td>Apple Certification and Training</td>
<td>529</td>
</tr>
<tr>
<td>E</td>
<td>Glossary</td>
<td>533</td>
</tr>
</tbody>
</table>

| Index    |                                           | 541  |
Part I

The Basic Mac

IN THIS PART

Chapter 1
Know Your Mac

Chapter 2
The Finder Is Your Friend

Chapter 3
Finder Fun

Chapter 4
Customize Your Mac

Chapter 5
The Nuts and Bolts of System Preferences

Chapter 6
Manage User Accounts
Getting to know your new Mac is a really fun time. For all of you who have previously owned a Mac, you know how cool it is when you hear the first start-up chime of your new Mac and begin comparing it to your older model. For those who are new to the Mac, the experience can swing from one of pure excitement all the way over to near dread. The pure excitement feeling usually happens to someone who is very computer savvy but has been stuck in a Windows world (usually against their will). Those experiencing dread are also typically coming from a Windows world, but don't consider themselves to be the most computer-knowledgeable folks around. To those who can't wait to dive in, I say, "Enjoy!" To those who are apprehensive, please don't be. You bought your Mac for a reason, didn't you? Someone you know and trust may have had some fantastic things to say about his or her Mac, you may have tinkered with one in an Apple Store, or one or more of Apple's great commercials may have persuaded you to give them a go.

All those wonderful things you hear about Macs aren't fantasy, but reality. I'll help you get to know your Mac a little better in this chapter so that you can familiarize yourself with the ins and outs of your particular model and get a bird's-eye view of Mac OS X.

Your Mac comes with some great documentation that can help you get started and can point out all its bells and whistles. This chapter is intended as an overview of your computer, and Macs in general, not as a replacement to those vitals pieces of information. I suggest you consult them either before or along with this text.
A Bit About Apple

Apple has been the innovative giant of the computing industry since the mid-1970s and is the driving force behind such phenomena as the iMac, Mac OS X, iPod, and more recently, the iPhone. Started by the two Steves, Steve Jobs and Steve Wozniak, Apple saw its share of ups and downs in the 1990s, but has since remained a prominent player in the industry and is one of the most recognizable brands in the world. Because you're an Apple owner, you would do well to familiarize yourself with their Web site, which is where you can find a wealth of information and support for your product. Go to www.apple.com to see all the great products Apple has to offer, and visit www.apple.com/support for help you may need with all things Apple.

Laptops

Laptops are awesome! They allow you to have your Mac wherever you want it, and with no power cords attached if you so desire. I prefer a laptop to a desktop, but that's because they tend to suit my basic needs better; this may not be the case for you, however. Here are a few pros and cons to consider before deciding on a laptop, if you're not sitting in front of one already:

- Laptop pros:
  - Portability
  - Portability
  - Portability

- Laptop cons:
  - Batteries don't stay charged forever
  - Expandability is limited compared to some desktop models
  - Portability

I'm sure you noticed that I emphasized the portability of a laptop as its essential benefit, and then also listed the same attribute as a con. The ability to move your Mac from room to room, or even outside if you want to, is too awesome not to be touted. However, that same great ability can make it much easier for someone to abscond with your precious Mac. You'll want to keep a tight rein on your laptop if you frequently work in public places, to be sure.

As of this writing, Apple offers three models of Mac laptops, or notebooks: MacBook, MacBook Pro, and MacBook Air. Let's find out a bit about each one.

MacBook

The MacBook is an incredibly popular offering from Apple that is more oriented to consumers than to the professional market. The latest incarnation of the MacBook, shown in Figure 1.1, is both compact and powerful, while also lightweight yet sturdy. With its shiny aluminum body, this little beauty is perfect for the student, small or home office user, or any casual computer guy or gal.
MacBooks are some of Apple's most popular computers.

MacBooks are loaded and ready to tackle your computing needs. Here are a few features to whet your appetite:

- Fast Intel Core 2 Duo processor and lots of RAM (memory)
- Built-in iSight camera and microphone
- Slot-loading SuperDrive—perfect for using and burning CDs and DVDs
- Two USB 2.0 ports
- Gigabit Ethernet for superfast wired networking
- Mini DisplayPort for connecting an external display
- Audio in/optical digital audio in
- Headphone out/optical digital audio out
- Internal Bluetooth adapter for wireless connectivity with other wireless Bluetooth-enabled devices
- Built-in AirPort Extreme Wi-Fi wireless networking
- Nvidia GeForce graphics processor
- MagSafe power port, which keeps you from throwing your MacBook to the floor should someone pull the power cable (the cable is held in by a magnet, and simply pulls away from the computer if the cord is pulled with any appreciable force)

Visit www.apple.com/macbook for all the details you need to know.
MacBook Pro

The MacBook Pro, seen in Figure 1.2, is essentially the MacBook on steroids, and is aimed at the professional laptop user. To be a little more specific (because saying that this is for professionals almost sounds like a put-down of other serious computer users), this laptop is meant for users who require a lot of computing power, sporting a larger display than the MacBook and greater graphics and processing capability.

**FIGURE 1.2**

MacBook Pros are for the power user who needs mobility.

![Image](image_url)

*Courtesy of Apple*

Here are some of the features that make this a truly professional laptop:

- 15.4-inch backlit display
- Built-in iSight camera and microphone
- Slot-loading SuperDrive—perfect for using and burning CDs and DVDs
- Two USB 2.0 ports
- FireWire 800 port for connecting devices such as digital cameras
Gigabit Ethernet for wired networking
- Mini DisplayPort for connecting an external display
- Audio in/optical digital audio in
- Headphone out/optical digital audio out
- Internal Bluetooth adapter for wireless connectivity with other wireless Bluetooth-enabled devices
- Built-in AirPort Extreme Wi-Fi wireless networking
- Nvidia GeForce graphics processor
- MagSafe power port
- Built-in stereo speakers
- Tons of storage, upwards of 250GB or more
- Full-size backlit keyboard

www.apple.com/macbookpro can provide you with more features and specification info.

**MacBook Air**

The primary descriptor for the MacBook Air is *thin*. As a matter of fact, the MacBook Air is the thinnest laptop on the planet, with the possible exception of the Windows laptop I saw someone run over with a steamroller on YouTube. In spite of its thinness, the MacBook Air (Figure 1.3) is a full-size laptop, yet weighs in at just 3 pounds!

**FIGURE 1.3**

MacBook Air is the ultimate in thin!

*Courtesy of Apple*
Some features of note for the MacBook Air include the following:

- 13.3-inch backlit LED display
- Built-in AirPort Extreme Wi-Fi wireless networking
- Mini DisplayPort
- One USB 2.0 port
- Built-in iSight camera and microphone
- Audio out
- Full-size keyboard
- Built-in Bluetooth adapter

Check out www.apple.com/macbookair for more.

I'm not going to make someone at Apple happy when I say this, but I must give you a caveat when it comes to the MacBook Air. The MacBook Air does not come with a built-in CD or DVD drive, so if that's important to you, please consider either a MacBook or MacBook Pro. Apple has a really cool way for you to utilize the CD or DVD drive from other computers wirelessly with your MacBook Air, but if you don't have another computer, you will be out of luck and very unhappy if you're unable to install applications or games using their installation disks. There is another option, though: Apple sells an external SuperDrive that connects to the USB port of your MacBook Air, but you'll have to pony up an extra $99 for it.

**Desktops**

Desktops are where it's at when it comes to most computers. While laptops are becoming more popular than ever, it seems most computer users currently prefer to keep their Macs in one place (you never know where it might get off to if left untethered).

Apple does offer quite an impressive lineup of desktop computers, to be sure: the iMac, the diminutive Mac mini, and the ludicrously powerful Mac Pro.

**iMac**

The iMac is the stuff of computer legend. When Steve Jobs first introduced the translucent iMac to the world in 1998, Apple began a firestorm in the industry that only seems to be gathering steam after all these years. The iMac, seen in its latest form in Figure 1.4, has gone through many transformations over the years, but has remained an amazingly popular all-in-one device.
Everybody has heard of the iMac, even those new to computers.

Here's a peek at the specs that make this computer so special:

- A total of five USB 2.0 ports (three on the back and two on the keyboard)
- One port each of FireWire 400 and FireWire 800
- Built-in 20- or 24-inch widescreen display
- Gigabit Ethernet for fast wired networking
- Audio in/optical digital audio in port
- Headphone out/optical digital audio out port
- Mini-DVI port for connecting additional displays
- Massive storage options, ranging from 250GB to 1TB
- AirPort Extreme Wi-Fi wireless networking
- Built-in Bluetooth adapter
- Built-in iSight camera and microphone
- Apple Keyboard and Mighty Mouse
- Slot-loading SuperDrive for using or burning CDs and DVDs
Mac mini

The Mac mini is the most affordable Mac going, and is a tiny computer at 6.5 inches square and 2 inches wide. Don’t let the smaller size fool you, though; the Mac mini (Figure 1.5) is quite capable of doing some mighty fine computing and is a great choice for someone who has used a computer before and just needs the most basic configuration.

The Mac mini with its included Apple Remote

![The Mac mini with its included Apple Remote](image)

Courtesy of Apple

NOTE The Mac mini doesn’t ship with a keyboard, mouse, or display. If you don’t already have these devices (any VGA-capable monitor and USB mouse and keyboard will do), acquiring them may jack up the price of your Mac mini, making what was possibly a great bargain a little less bargain-like.

The Mac mini has a surprising list of features:

- Fast Intel Core 2 Duo processor
- Four USB 2.0 ports
- One FireWire 400 port (the new MacBooks don’t even have FireWire!)
- Gigabit Ethernet for fast wired networking
- DVI and VGA video output
- Audio in/optical digital audio in
- Built-in AirPort Extreme wireless networking and Bluetooth, for maximum wireless capability
- Headphone out/optical digital audio out
- Choice of a slot-loading Combo drive (plays and burns CD, but only plays DVDs) or a SuperDrive (plays and burns both CDs and DVDs)
See much more on the Mac mini at www.apple.com/macmini.

**Mac Pro**

It's time to bring out the big dog: the Mac Pro. The Mac Pro is the power user's dream come true. Stuffed to the gills with all a professional could ask for, the Mac Pro (Figure 1.6) has been a stalwart in the graphics, science, and entertainment industries for years, and is finding purchase among the world's IT departments as well. If you need your Mac to ooze power, this is the computer for you (be careful; that stuff runs everywhere).

**FIGURE 1.6**

The Mac Pro tower is one mighty powerful computer.

![Mac Pro](image)

_Courtesy of Apple_

The Mac Pro is packed full of the features it needs to truly be a professional-grade machine:

- A total of seven USB 2.0 ports (five on the tower and two on the keyboard)
- Two ports each of FireWire 400 and FireWire 800
- Quad-Core Intel Xeon processors
- Two independent Gigabit Ethernet ports for exceptionally fast wired networking
- Support for multiple ATI Radeon or Nvidia GeForce graphics cards
- DVI and VGA video output capability
- Gigantic storage options, reaching all the way up to 4TB
- Built-in Bluetooth 2.0 adapter
- Incredible expandability through PCI Express
The Basic Mac

- Apple Keyboard and Mighty Mouse
- Support for up to 32GB or memory
- SuperDrive for using or burning CDs and DVDs

There's much more to the Mac Pro than I can sufficiently cover here, so I suggest you stop by www.apple.com/macpro to scope out all the details concerning this beast.

Input Devices

An input device is any tool you use to provide information to your Mac. Keyboards and mice would be the best examples of input devices, but there are other types. We'll take a look at using input devices with your Mac in this section of the chapter.

By the way, if you haven't already done so, go ahead and turn your Mac on. Consult the documentation that came with your particular model to find out where the power button is located.

Mac keyboards

A keyboard is a keyboard, right? Well, yes and no. I don't mean to be so wishy-washy, but that's the answer to the question. When I say yes, I mean that all keyboards are indeed input devices that perform the same basic functionality, and when I say no, I mean that not all keyboards are created identically or equally.

While it is true that you can use just about any USB keyboard with your Mac, using a keyboard meant for use on a Windows-based PC may prove interesting because the keys aren't exactly the same as those on a Mac. Keyboards specifically designed for use on a Mac have some minor differences in key labeling but major differences in some key functions. If you're new to computers altogether, you don't need to worry about a thing; you'll learn specific key functions as you go along in the book. However, if you are used to working with a Windows PC, you may experience a little keyboard anxiety. The keys I'm really concerned with telling you about are the Command, Control, and Option keys. These keys are of particular interest to Windows users because they correspond to keys they use quite frequently on their PCs.

The Command key (⌘) is in the same position on a Mac keyboard as the Windows key is on a PC keyboard, but their functionality is worlds apart. The Command key is the main modifier key on a Mac, meaning that it is used very often as a shortcut key. The Control key handles this function on Windows keyboards, so this may get a little confusing. The Control key on Mac keyboards is used as a modifier key also, but usually for performing right-clicks (we'll get to that in the upcoming mouse section of this chapter). The Option key is in the same place as the Alt key on Windows keyboards, and is also used as a modifier key, usually in conjunction with another modifier such as ⌘ or Shift.
Apple’s official keyboard isn’t your father’s Mac keyboard. The new Apple keyboard, shown in Figure 1.7, is made of aluminum and is insanely thin. It comes in two types: wired, which contains a full-size keyboard (including a numeric keypad), and wireless. Find out more at www.apple.com/keyboard.

**FIGURE 1.7**
The Apple keyboard is the most unique around.

Some Apple keyboards, including those built-in to the MacBooks, also sport a Function (fn) key. This key is used to launch the functions that correspond to the tiny labels seen in the lower right corner of some keys.

**NOTE**

Using a mouse

The Apple mouse has seen its share of transformations over the years as well. The famous (or infamous, depending on who you ask) single-button mouse that has been a staple of Apple’s since the mid-1980s has thankfully gone the way of the dinosaurs. This single-button conundrum has driven more than its fair share of Windows users to the loony bin. You see, the one thing Windows users have had in their favor the last couple of decades is the two-button mouse. When you sat these poor souls in front of a Mac with a single button, the fireworks started almost immediately.

Apple solved the problem in a rather awkward way: by using the Control key as a stand-in for a second mouse button. To get the same functionality as our two-button-mouse-using compadres, we Apple folks had to hold down the Control key on the keyboard while clicking our little single-button mouse on the object of choice. This little scenario was the butt of many a joke in the halls of the geek elite, until Apple took a step forward in mouse technology by coming out with the Mighty Mouse (Figure 1.8).
Mighty Mouse to the rescue of Mac users everywhere!

Being true to their style, though, Apple couldn't just make a simple two-button mouse with an Apple logo on it; it had to be the best mouse in the land, and by golly, they did just what they set out to do. The Mighty Mouse is a fantastic little input device, regardless of whether you prefer the wired or wireless variety. The tiny trackwheel on the top is one of the best tools of its type anywhere, and it will surprise you, I promise.

By the way, any old USB mouse will do if you haven't sprung for a Mighty Mouse, or if one didn't come with your Mac, as in the case of a MacBook or the Mac mini.

Get familiar with the trackpad

All three of the MacBooks come with an input device built right into them called a trackpad. Trackpads work pretty much the same as a mouse, except you use your finger on the trackpad as opposed to pushing the mouse around with your hand.

If you're not familiar with a trackpad, it works by simply placing a finger on the pad and moving it around on the surface. As you move your finger, the pointer on your screen moves along in sync with it. Here are a few tricks to use with your trackpad:

- To simulate a mouse button right-click with your trackpad, hold down the Control key on the keyboard while clicking the trackpad button. If you have an aluminum MacBook, you could also click anywhere on the trackpad with two fingers.

- To select an object on the screen, click the trackpad button once when the pointer is positioned over the object.

- To open an item on your screen, double-click the trackpad button with the pointer positioned over the item.

You can use any USB mouse with your laptop if you feel more comfortable with that than the trackpad. That's what I prefer to do myself, but it's a good idea to at least become comfortable with using a trackpad should the need ever arise.
Alternative input devices
There are other means by which you can get data into your trusty Mac, you know. You don’t have to limit yourself to mice, keyboards, and trackpads when there are other cool toys like trackballs and graphics tablets around!

**Trackballs**
Trackballs have been the alternative to mice for quite some time. As a matter of fact, the trackball was invented more than a decade sooner than the mouse. Trackballs have a ball on the top of them that you rotate with your thumb or fingers to move the pointer on your screen, accompanied by buttons that perform much the same way as a mouse’s. Many people prefer trackballs because they tend to be ergonomically easier for some to use than a mouse. Trackballs, like the one shown in Figure 1.9, are especially useful when precision is essential, such as when using CAD applications.

![Logitech Cordless Optical Trackman](image)

**FIGURE 1.9**
This Logitech Cordless Optical Trackman is a great example of a modern trackball.

**Graphics tablets**
Graphics tablets are essentially electronic drawing desks or paint canvases. The tablet is a relatively small space on the device itself, which resembles a trackpad, but instead of using your fingers to manipulate items on-screen, you use a touch pen that comes with the tablet. You can use the tablet with any application that supports the use of a mouse, which is pretty much anything.

**External Devices**
There are several ports on your Mac and they aren’t there just to look pretty or to be tempting chewing gum storage compartments for your three-year-old. Those ports are there to be used by external devices, which you almost assuredly will want to use at some point in your Mac’s life. “Okay, like what?” you may ask. Well, your mouse and keyboard, for starters. They both connect
The Basic Mac

to USB ports on your Mac (assuming they aren’t the wireless variety, of course). But those two items are only the tip of the iceberg. You’ll probably want to use one or more of these devices at some point:

- A printer is one of the most obvious devices you will need. Everyone needs to print something sometime for some reason.
- iPods and iPhones are quickly becoming indispensable parts of a computer user's arsenal. They use your Mac’s USB port to communicate with the computer for moving music and applications, and for synchronizing data such as contacts and calendars.
- An external hard drive can be an invaluable tool when you run out of space on your Mac’s built-in hard drive, or if you need portable storage that you can take from place to place with you. They’re also great for backing up your files (see Chapter 22 for much more on the subject of backups).
- Scanners are essential to getting physical documents into your Mac. You can digitize your family photo album, keep digital copies of old records and financial papers, and so on.
- Digital cameras are a must-have in today’s digital world, and no other computer is better suited for using them than your Mac. Whether they be digital still or digital video cameras, Mac OS X Leopard has got you covered, and your Mac has all the right connections necessary for those devices.
- Adding external speakers to your Mac can enhance the quality of the computer’s audio exponentially. Crank up iTunes with a couple of good computer speakers and you will have to put tape on the windows to keep them from shattering.

Most external devices use either USB or FireWire connections to hook up with your Mac. USB and FireWire both use very fast topologies, or communication techniques, but there are a few important differences between them that I’ll discuss in the next section of the chapter.

When you first attach a device to your Mac, the computer will recognize the device and perform an action depending on the type of device it is. For instance, if it’s a printer, the Mac will find the driver for the printer (if it is installed already) and it will create a queue for the printer. If the device is a digital still camera, either iPhoto or Image Capture will automatically open for you to begin downloading your pictures to your Mac.

FireWire devices

Most Macs today have FireWire ports, with the notable exception of the latest iteration of MacBook (this infuriated some would-be buyers who wanted to upgrade from their older MacBooks, which did include FireWire ports). This is a touchy subject with some longtime Mac fans, so we should probably move on.
As I was saying, FireWire ports have been on the Mac for quite some time, and they are used to transfer very large amounts of data very quickly. FireWire is ideal for high-bandwidth information, such as live video feeds or transferring video from your digital video camera to your Mac. FireWire devices can also connect directly to one another because they use a peer-to-peer topology (no computer or hub required, although perfectly permissible). FireWire also comes in two different speeds, 400 megabits per second (FireWire 400) and 800 megabits per second (FireWire 800).

USB devices

Most devices today have USB (Universal Serial Bus) connectors of some variety on them, from printers to scanners to digital cameras. USB has come a very long way since its introduction in the first iMac back in 1998.

Unlike FireWire, USB uses host-client topology, meaning that a USB-enabled device must be connected to a computer in order for other USB devices to communicate with it. Like FireWire, there are two speeds at which USB communicates. USB 1.0 is the first version of USB that was introduced, and it transfers information at a creepy-crawly 12 megabits per second, whereas USB 2.0 scoots along at a very nice clip of 480 megabits per second. Can you say “improvement”? But there’s no need to fear for those of us who purchased a ton of USB 1.1 devices and now own new Macs, which run USB 2.0; USB is backward compatible, which means your old devices will run on the newer technology, albeit at their slower rates.

Mac OS X

Mac OS X is what makes that beautiful machine you call a Mac work like a Mac. Mac OS X (pronounced Mac Oh-Ess Ten, not Mac Oh-Ess Ex) is the operating system (OS) of your Mac, which means it’s the software that allows you to tell it what to do and how to do it. Every computer has an operating system, but it just so happens that yours runs the best operating system on the planet! How convenient, huh? Actually, the chances are pretty good that you know about Mac OS X already and that it’s a big part of why you chose a Mac to begin with, but I wanted to be sure.

Mac OS X has been the operating system on Apple computers since 2001, and it has gone through many transformations since that time. While there are some other good operating systems out there, none of them combine the ease of use, stability, and high level of security that Mac OS X provides the user from the word “go.” Not only is the Mac experience the greatest you’ll find of any OS, Mac OS X is the most often imitated OS around in terms of its look and feel.

This book focuses on the latest version of Mac OS X, which is 10.5, or Leopard. Apple has been using the names of big cats for its different versions of Mac OS X since the beginning. Table 1.1 gives you a look at the history of Mac OS X and its names.
The Basic Mac

### TABLE 1.1

<table>
<thead>
<tr>
<th>Version</th>
<th>Name</th>
<th>Year Released</th>
</tr>
</thead>
<tbody>
<tr>
<td>10.0</td>
<td>Cheetah</td>
<td>Early 2001</td>
</tr>
<tr>
<td>10.1</td>
<td>Puma</td>
<td>Late 2001</td>
</tr>
<tr>
<td>10.2</td>
<td>Jaguar</td>
<td>2002</td>
</tr>
<tr>
<td>10.3</td>
<td>Panther</td>
<td>2003</td>
</tr>
<tr>
<td>10.4</td>
<td>Tiger</td>
<td>2005</td>
</tr>
<tr>
<td>10.5</td>
<td>Leopard</td>
<td>2007</td>
</tr>
</tbody>
</table>

So what version of Mac OS X are you running on your Mac? To check, click the Apple menu in the upper left corner of your screen and choose About This Mac. You will find the currently installed version of Mac OS X in the window that opens, as illustrated in Figure 1.10.

### FIGURE 1.10

I'm running the latest and greatest version of Mac OS X that is available as of this writing.

---

**Prevalent Technologies in Mac OS X**

I'd like to take just a moment to mention some of the great technologies that are included in Mac OS X. These are the components that you may hear about from time to time that really make the Mac OS run like a top and make your Mac computing experience the best that man has to offer.
Darwin
Darwin is the open source operating system from Apple that contains all the UNIX goodies of Mac OS X. To be more specific, it is the core components that comprise the base for Mac OS X and give it its stability and functionality. It’s also a free download for anyone who wants to install it separately from Mac OS X, but it doesn’t provide much in the way of a user interface; its commands can only be accessed through a command line by someone who knows UNIX commands. Learn much more about Darwin and other Apple open source projects at http://developer.apple.com/opensource/index.html.

Quartz
Quartz generally refers to the components that make up the Mac OS X graphics model. These technologies determine how graphics are displayed on your Mac. Everything you see on your screen is rendered by Quartz using one method or another. You can learn more about Quartz by visiting http://developer.apple.com/graphicsimaging/quartz/.

Aqua
Aqua is the term used for the themed look and feel of Mac OS X. Aqua is specific to Mac OS X, and it has evolved with each new version of the operating system into what you see on your computer screen. Aqua keeps the look of Mac OS X’s windows, menus, icons, visual effects, animations, and more consistent for users and developers alike.

PDF
PDF stands for Portable Document Format, and it is an integral part of the Mac OS X imaging model. PDF is universally known as a great way to disseminate documents to anyone at any time, because PDF files can be viewed on any operating system around. Most folks who have used computers at home or at work are familiar with PDF files, because most documentation comes in this electronic form nowadays. PDF is more than just a document format in Mac OS X, however; as I said, it is a crucial part of graphics rendering. Much of what you see on-screen has been rendered using PDF. Since PDF is such a deeply embedded part of Mac OS X, you can easily create PDF files from any application on your computer.

Java
Java is a programming language that is cross-platform, meaning that an application created by Java can be run on any major operating system in the world. The cool thing about Mac OS X is that it is the only major OS to incorporate a full Java runtime and development environment. There’s no need to download and install Java as some sort of fifth-wheel application environment because it’s part of Mac OS X right out of the box. For more info on Java and Mac OS X, go to http://developer.apple.com/java/.
ColorSync

ColorSync is the part of Mac OS X that handles color matching between your Mac and other devices, such as your monitor, printer, scanner, camera, and the like. The ColorSync utility that comes with Mac OS X is a direct way for you to collaborate with Mac OS X's color-matching system so that you can assign color profiles to particular devices, repair damaged color profiles, and so on. Review the technical note on Apple's developer Web site for more about ColorSync: http://developer.apple.com/technotes/tn/tn2035.html.

OpenGL

OpenGL, or Open Graphics Library, is a standard graphics specification utilized by Mac OS X to render both 2-D and 3-D graphics on your computer screen. OpenGL gives some games and screen savers the beautiful graphics you've come to expect from today's advanced processors. Apple goes into more detail about their implementation of OpenGL at http://developer.apple.com/graphicsimaging/opengl/.

QuickTime

QuickTime is the best multimedia software architecture around, and because it's cross-platform, it's available for other major operating systems. QuickTime is used by Mac OS X to play audio and video. To download the latest version and get the basics about QuickTime, check out www.apple.com/quicktime/. If you want the technical ins and outs, you need to see http://developer.apple.com/QuickTime/.

Summary

With this chapter you've been given the basics of what makes a Mac tick. You learned the latest hardware Apple has to offer, and glanced under the hood of Mac OS X. Now I get into the meat and potatoes (or potatoes and more potatoes for our vegetarian friends) of using your Mac for fun and for profit.
By now I'm sure you've noticed that curiously happy face in the lower left portion of your screen that's been smiling at you since the first time you started up your Mac. He's not just some overly zealous icon; he's the Finder.

The Finder is where the action always starts and always ends with your Mac. It's actually an application that runs all the time, sometimes in the foreground, and sometimes biding its time in the background. But rest assured, the Finder is always there, waiting for you to give it a command or two. This chapter will get you up and running with the features that make the Finder such a joy to work with.

**Finder Functions**

There's no starting up the graphical user interface of your Mac without the Finder being present. When you first turn on your Mac, the Finder is automatically launched, as evidenced by its name next to the Apple icon in the upper left portion of your screen. The Finder icon is shown in Figure 2.1.
At this point, the Finder must seem like some mysterious fellow who resides in the bottom portion of your screen, smiling slyly while you attempt to use this contraption called a "Mac." Fear not, computer user, for the Finder is your friend, and what a friend indeed. So as to satiate your curiosity, let's take a look at a few of the wonderful things the Finder helps you to accomplish while using your Mac:

- Navigate the folders (directories) on your Mac's hard drive, removable media (CDs, DVDs, USB thumb drives, external hard disks, and so on) and connected network shares.
- Create new folders.
- Delete folders and files.
- Get information on files and folders.
- Browse your network for shared files, folders, and computers.
- Organize files and folders easily.
- Burn data to CDs, DVDs, and other types of media.
- Eject optical discs, hard drives, and other removable media.
- Quickly access your favorite applications.
- Search for items on your Mac and other connected media.

There are even more tasks that the Finder is capable of handling, but this is more than enough to get you going.

**Utilizing the Finder**

The basics of the Finder consist of working with windows, folders, and files, and I also want to introduce you to the Finder preferences a little bit later. Figure 2.2 points out some of the major landmarks in the Finder, to help you get your bearings.
The Finder helps maximize your interactive experience by making items easy and intuitive to access.

Menus and icons

You need to be familiar with menus and icons before delving too deeply into the other aspects of the Finder. They are key concepts when it comes to getting around in your Mac's OS. Here's a quick recap.

Menus are lists of options that are available to you within the currently running application. For example, Figure 2.3 shows the Go menu of the Finder. This menu provides several possibilities for quickly zipping to a location on your Mac or network.
Context menus are also lists of options, but these pertain to actions that can be taken on a particular object, such as a document (Figure 2.4).

Icons are the little pictures you see everywhere: in the Dock at the bottom of your screen (more on the Dock in Chapter 3), the folders that populate your hard drive, and those next to the names of your applications.
Icons are typically very descriptive of the items they represent. For example, document icons look like pieces of paper, folders look like folders (duh!), the icon for Automator looks like a robot, and the icon for iTunes looks like a CD and a musical note.

**Working with windows**

Finder windows are aptly named, as their main function is to act as a window, or port hole, for looking into the contents of your Mac's hard drive. Of course, the functionality of a window far exceeds that of simply letting you look at things. To open a new Finder window, press ⌘+N or choose File ➪ New Finder Window from the menu.

Figure 2.5 gives you a good overview of the basic items in a typical Finder window, and Table 2.1 explains the functions of these items.
Part I The Basic Mac

### TABLE 2.1

**Finder Window Items**

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide Toolbar button</td>
<td>Click this button to hide or show the toolbar.</td>
</tr>
<tr>
<td>Search</td>
<td>Type any text in the search field to have your Mac look for it in the files and folders you currently have displayed.</td>
</tr>
<tr>
<td>Results window</td>
<td>Displays the items contained in the folder or disk you currently have open.</td>
</tr>
<tr>
<td>Toolbar</td>
<td>Provides buttons and tools that help you quickly navigate or perform functions on the files and folders currently displayed.</td>
</tr>
<tr>
<td>Sidebar</td>
<td>Gives you instant access to your favorite or most frequently accessed drives, folders, and network shares.</td>
</tr>
<tr>
<td>Statistics bar</td>
<td>Shows you an overview of the contents of the folder you are currently viewing, such as the number of files it holds and their collective size.</td>
</tr>
<tr>
<td>Path bar</td>
<td>Provides an easy way for you to see where you are on your hard drive, displaying the path of folders that lead to the one you are currently in. This is one of my favorite features, but it isn't enabled by default. To enable the path bar, open a new Finder window and choose View→Show Path Bar from the Finder menu.</td>
</tr>
</tbody>
</table>

### Choosing a view

You'll notice in Figure 2.5 that my folders may be laid out differently than in the new windows you create. That's because the default view for the Finder is to show items as icons, but I changed mine to columns. You can change the view of a Finder window by using the View buttons in the toolbar, or by selecting a different view by choosing one from the View menu. Your options are to view items as icons, in a list, in columns, or in Cover Flow, which is shown in all its coolness in Figure 2.6.

### TIP

I like to use columns because I feel they are easier to navigate. When you click on a folder in one column, its contents are shown in a new column to the right, and so on until you've reached the last folder in the path. I can then use the back buttons in the upper left corner of the Finder window, or the path bar at the bottom, to go back to previous folders I've visited.

### Moving and resizing windows

I'm sure you've noticed what appears to be a traffic light in the upper left corner of every Finder window. Those red, yellow, and green buttons are there for more than just decoration:

- Click the red, or close, button to close the window.
- Click the green, or zoom, button to automatically resize the window.
- Click the yellow, or minimize, button to minimize the window. The window actually appears to flow into the Dock. You can see the whole process in slow motion, as I'm doing in Figure 2.7, by holding down the Shift key while clicking the yellow button. Now that's the definition of cool!
Cover Flow is the “happening” way to view items in the Finder. Scroll through items by dragging the slider button beneath the icons.

Bet you never thought minimizing a window could be so exciting!

You can also manually resize a window by clicking-and-dragging the lower right corner of the window.
Move windows around in the Finder by clicking anywhere in the toolbar or status bar and dragging the window to your preferred position.

**Customizing the Finder toolbar**

The toolbar already gives you several practical tools to help you with your Finder exploration, but there are lots of others you can add, and you can even remove some you don’t need. Here’s how to customize your toolbar:

1. Open a Finder window.
2. Choose View -> Customize Toolbar from the menu.
3. The customize sheet, shown in Figure 2.8, gives you lots of options for changing up the items in your toolbar.

![FIGURE 2.8](image)

Customize the toolbar to your heart’s content!

4. Drag items you want to add into the toolbar and drop them into place.
5. Drag items you want to remove out of the toolbar and they will disappear in a puff of smoke!
6. Decide whether to show just the toolbar icons, the icons with text, or just the text, using the Show popup menu. Check the Use Small Size box to make the icons and text take up a little less real estate in the toolbar.
7. Click Done when you’ve finished customizing.

**TIP**

Click the oval button in the upper right corner of the window to hide the toolbar.
Working with folders

Folders are the main organizational tools in any operating system. You keep your documents, movies, music, pictures, applications, and everything else under the sun in a folder. Think of your Mac as a desk with a big file cabinet built right in.

What are the folders on your Mac used for?

Your Mac's hard drive wasn't a barren wasteland when you first turned it on. Mac OS X already comes with lots of its own folders, and a few are even made just for you. Table 2.2 gives you an overview of the major folders in Mac OS X and what they hold.

<table>
<thead>
<tr>
<th>Folder</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applications/Utilities</td>
<td>The Applications folder is the default location for applications that everyone on the computer can access. The Utilities folder is inside of the Applications folder, and contains tools that help with the administration of your Mac.</td>
</tr>
<tr>
<td>Library</td>
<td>System-wide preferences for applications and utilities reside here.</td>
</tr>
<tr>
<td>System</td>
<td>The basic files necessary for Mac OS X operation are in this folder. This folder should be considered totally off limits by all but the most experienced users!</td>
</tr>
<tr>
<td>Users</td>
<td>All user accounts and their files are kept in this folder.</td>
</tr>
</tbody>
</table>

Each individual account has its own set of folders, which Table 2.3 explains.

<table>
<thead>
<tr>
<th>Folder</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Desktop</td>
<td>All items that you have on your Desktop can also be accessed from this folder.</td>
</tr>
<tr>
<td>Documents</td>
<td>This is a common repository for any documents you may work with.</td>
</tr>
<tr>
<td>Downloads</td>
<td>This is the default location for all files you download from the Internet.</td>
</tr>
<tr>
<td>Library</td>
<td>Preferences specific to the particular user account are in this folder.</td>
</tr>
<tr>
<td>Movies</td>
<td>Store your movies you may download from iTunes or create using iMovie in this folder.</td>
</tr>
<tr>
<td>Music</td>
<td>This is where all of your iTunes music is automatically kept when you import or download songs (and other media).</td>
</tr>
<tr>
<td>Pictures</td>
<td>iPhoto keeps your pictures here.</td>
</tr>
<tr>
<td>Public</td>
<td>This is for items that you want to share with other users on the Mac or your network.</td>
</tr>
<tr>
<td>Sites</td>
<td>If you choose to run a personal Web site from your Mac, you can use this folder to store files that comprise it.</td>
</tr>
</tbody>
</table>
The Basic Mac

Create new folders
While the folders that come with Mac OS X are useful, they certainly won't cover the gamut of topics and organization that you will eventually need in order to keep things neat and tidy. Once you start to create and receive documents, download pictures and music, and customize your Mac to your liking, you will want to make folders that more accurately describe the contents of your hard drive. For example, in your Documents folder you may want to create a new folder called Work to house all your work-related files, and another called Home to keep track of shopping lists, bills, and what-have-you that pertain to your life away from work. If you just start saving all documents in a willy-nilly fashion in your Documents folder, you may spend more time looking for the documents you want than actually working with them.

To create a new folder, simply press ⌘+Shift+N, or choose File » New Folder from the menu. The name of the new folder is “Untitled” and is highlighted in light blue. Change the name to your liking by typing it on the keyboard. That's all there is to it!

Smart Folders and Burn Folders
There are two other types of folders you can create: Smart Folders and Burn Folders.

Smart Folders automatically add files to their contents based on the criteria you assign them. For example, you could create a Smart Folder that automatically adds files to itself when those files contain the words “My Project” or “football.” These Smart Folders are so intelligent they can automatically add, remove, or otherwise change their contents as you make changes to your files. To create a Smart Folder:

1. Press ⌘+Option+N, or choose File » New Smart Folder from the menu.
2. Set up the search criteria for the Smart Folder using the resulting window:
   - To add files that contain a specific subject, enter the appropriate text in the search field in the upper right corner of the window.
   - To narrow the search, choose either This Mac (searches all the files on your Mac), your home folder (searches only files in your home folder), or a server on your network (searches for files contained on other computers on your network).
   - Further narrow the search by adding certain attributes, as shown in Figure 2.9. To add an attribute, click the + button beneath the search field. Use the popup menus to determine the specifics of the attribute, such as what kind of file to be searching for (images, PDFs, and so on) or what dates the files were created or modified. Use the + or - button to add or remove attributes.
3. Click Save, and then choose a name and location for your Smart Folder. If you don’t want the Smart Folder to show up in the sidebar, uncheck the Add To Sidebar option.

A third kind of folder is a Burn Folder, which you copy files to that you want to burn to a CD or DVD. To create and use a Burn Folder:

1. Open a new Finder window to the location you want to keep the Burn Folder.
2. Choose File » New Burn Folder and enter a name for the folder. You generally want to make the name descriptive of the intended contents.
3. Drag-and-drop items into the Burn Folder that you want burned to a CD or DVD. This action doesn't move the original files, but makes an alias (shortcut) of the original in the Burn Folder, as shown in Figure 2.10.

4. To burn the folder's contents to a disc, open the Burn Folder and click the Burn button in the upper right corner of the window.

5. Insert a disc into your Mac that's large enough to handle the contents of your Burn Folder, and follow the instructions for burning the files to your disc.

FIGURE 2.9
Creating a new Smart Folder is easy and can save you lots of time when looking for specific types of files.

FIGURE 2.10
A Burn Folder is great for burning the same items to multiple discs.
**Working with files**

Folders aren't much more than boring little icons unless they have something to keep in them, and that's where files come in to the equation. Files are individual items that can be opened in an application and worked with in some fashion. For example, a text document is a file, and so is a picture. A movie trailer is a file, as is a song. Each of these files can be opened in an application that specifically handles that type of file. Using these examples, you can open the text document in TextEdit, the picture in iPhoto or Image Capture, the movie trailer in QuickTime, and the song in iTunes.

**Creating new files**

You can also use applications to create new files. Let's give it a shot using TextEdit:

1. Open the TextEdit application:
   - From within the Finder, press `⌘+Shift+A` to automatically open a Finder window in the Applications folder.
   - Locate and then double-click the icon (Figure 2.11) for TextEdit to open it.

3. Type something in the new document.
4. Save your new document:
   a. Press `⌘`+S, or choose File ➤ Save.
   b. Enter a name for your document in the Save As field.
   c. Choose the location in which to save your document using the Where popup menu, as shown in Figure 2.12. If the default locations in the Where menu aren't what you're looking for, click the blue square containing the downward-pointing arrow (immediately to the right of the Save As field) to expand the dialog window. You can now browse the hard drive for the location you need.

![FIGURE 2.12](image)
Select the appropriate location to save your newly minted document.

5. Click Save to save the document, or new file, in the desired location.

These same basic steps can be used with almost any application to create, name, and save new files on your Mac.

**Open files in applications**
Opening files is typically a pretty straightforward affair. Using the file you just created in TextEdit, use one of these two methods:

- Double-click the file's icon from the Finder and it automatically opens using its parent application.
- Open the file from within the application:
  1. Press `⌘`+O, or choose File ➤ Open.
  2. In the resulting dialog window, browse your Mac for the file you want to open.
  3. Once located, select the file you want to open and click Open, as shown in Figure 2.13.
Opening a file becomes second nature pretty quickly.

**Figure 2.13**

Preview files with Quick Look

One of Leopard’s new features is called Quick Look, and it offers you the ability to check out a file’s contents without actually opening an application to view it. This can be a real time-saver, especially if you have several documents that you want to look at, but that were all created with different applications. Instead of opening every application (which can be a lengthy process for some applications), simply use Quick Look:

1. Open a Finder window and locate the file(s) you want to preview.
2. Highlight the file in question.
3. To open a Quick Look preview of the file, click the Quick Look icon in the Finder window’s toolbar (it looks like a small eye).
4. The preview opens in the window without the aid of any application, as shown in Figure 2.14.

You can view every page of the file using the scroll bar, or see a full-screen representation of the file by clicking the arrows at the bottom of the Quick Look window.

**Tip**

For efficiency, press the spacebar when highlighting a file to open the Quick Look preview. Press the spacebar again to close the preview.
Get information on files and folders

There are times when you need information about the files and folders you are using, such as the dates they were created and their file size. This info can be very beneficial when troubleshooting problems, copying files to a drive that is low in memory space, setting permissions for a file, and other tasks. To view a file's information:

1. Highlight the file you want to see information about.
2. Press `⌘`+1, or choose File⇒Get Info from the Finder menu.
3. The Info window opens (Figure 2.15), providing you with oodles of facts and figures about your file.
4. Click the arrow next to a category in the Info window to see its contents.
5. Click the circle at the far top left of the Info window to close it when you're finished viewing its wealth of data.
Assign Applications to File Types

Double-clicking is usually all you have to do to open a file in the application that created it, but what if you have several applications that can open the same type of file? What if you prefer to open files in a different application than the one it was originally created in? For example, let's say you installed Adobe Acrobat on your Mac, which is a great application for creating and viewing PDF files, but Mac OS X prefers opening PDF files using Leopard's built-in Preview application. You now have two applications that can open the same type of files. When you double-click PDFs to open them, they may not open in the application you prefer. To remedy this situation:

1. Perform a Get Info on any PDF file on your Mac.
2. Click the arrow next to the Open With category to expand it.
3. In the popup menu, select the application you want to use as the default for opening this type of file (in the case of our example, PDFs). Click the Change All button to make sure all documents of this type on your Mac are set to open with this application.

Choosing a default application from the Get Info window.
A few more file and folder tricks

There are a few more matters to discuss when it comes to dealing with files and folders on a Mac that I'd like to cover. What if you have a folder that is buried underneath several other layers of folders, but you use that folder often and need to get to it quickly? What if you need to change the name of an item? How do you remove files and folders from your Mac when you no longer need them? Let's find out!

Create aliases of files and folders

I mentioned earlier in the chapter that aliases are really just shortcuts to original items on your hard drive. You can make aliases for anything on your Mac: files, folders, disks, and even applications. After you've made an alias, you will want to place it somewhere that provides you with fast access to it, such as your Desktop or the Dock. To make an alias:

1. Highlight the item you want to make an alias for.
2. Press ⌘+L, or choose File ➤ Make Alias from the Finder menu.
3. The alias for the item is displayed with a small arrow in the lower left corner of its icon, as shown in Figure 2.16.

![Figure 2.16](image)

I made an alias to my MacBible folder, which will give me fast access to it after I place it on my Desktop.

Drag folders into the sidebar of a Finder window to make them instantly available from within any Finder windows you may open in the future. Simply drag the folder out of the sidebar to remove it if you no longer need it. This only gets rid of the alias, of course, and not the original.

Rename files and folders

Say it's tax season and you create a folder called Taxes in your Documents folder. Your Mac balks at you and says a folder by that name already exists! What to do? Because the new folder you want to make will hold files pertaining to this year's taxes, let's call it Taxes 2009 and simply rename the other folder as Taxes 2008. While that's easily said, renaming folders and files is also easily done:
1. Click once on the file or folder to be renamed to select it.
2. After a brief pause (a second or two), click the name of the file or folder one time. The name becomes highlighted and is surrounded by a text field.
3. Simply type the new name of the file or folder and click its icon once again to accept the new name. Voilà!

Delete items from your Mac

Your Mac's hard drive is a finite thing, so there's only so much information that it can store before it cries "no more!" Every now and then you need to do a little spring cleaning on your Mac and discard the items you no longer need or that take up too much space.

CAUTION If you're not absolutely certain beyond any shadow of any doubt that you no longer need the file you just moved to the Trash, don't empty the trash. Leave the items in the Trash until you're sure you no longer need them, or until your Mac begs you to make room on its hard disk.

To remove an item from your Mac:

1. Drag the item to the Trash icon in the Dock, as I'm doing in Figure 2.17, and drop it right in.

   **FIGURE 2.17**

   The Trash icon changes from empty to full when you place something in it.

2. Click and hold the mouse button on the Trash icon until a menu appears.
4. When the Mac prompts you if you are sure you want to empty the Trash, click OK and the file will be gone, freeing up that much space on your hard drive.
I must come clean and tell you that just because you emptied the Trash doesn't really mean your file isn't still on the hard drive; it is. When you empty the Trash you are simply telling Leopard that the area of the hard drive that was taken up by the file is able to be erased, or written over, by something else now. The actual data is still there until it's written over. If you have files that you must be absolutely certain are deleted (permanently, that is), you want to securely empty the Trash. To do so, simply choose Finder ➤ Secure Empty Trash from the menu bar and then click OK. This time the files really are gone!

Set the Finder Preferences

The Finder preferences allow you to customize certain functions of the Finder, making it work for you instead of you working for it. The Finder preferences are easy to get to: Choose Finder ➤ Preferences from the menu bar, or press ⌘+, (comma). The Finder preferences are divided into four sections: General, Labels, Sidebar, and Advanced. Let's tackle them one at a time.

General

The General tab of the Finder Preferences window is shown in Figure 2.18. Table 2.4 gives an overview of what each function performs.

![FIGURE 2.18](image)

The General tab of Finder preferences
Part I

The Basic Mac

TABLE 2.4

Functions of the General Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show these items on the Desktop</td>
<td>Check the boxes next to the types of media and servers you want to appear on the Desktop when they are inserted or connected via the network.</td>
</tr>
<tr>
<td>New Finder windows open</td>
<td>Use the popup menu to choose a default folder on your hard drive for new Finder windows to automatically open to.</td>
</tr>
<tr>
<td>Always open folders in a new window</td>
<td>Selecting this check box causes a new Finder window to open every time you open a folder.</td>
</tr>
<tr>
<td>Spring-loaded folders and windows</td>
<td>When using spring-loaded folders, you can drag an item (such as a file or another folder) over the folder you want to move it to, hold it there briefly, and the destination folder will automatically &quot;spring&quot; open. This allows you to selectively drop items into other folders contained in the destination folder. Use the Delay slider to choose how long the wait time should be for the folder to spring open. Alternatively, you can press the spacebar when you drag an item onto a folder to make the folder open instantly.</td>
</tr>
</tbody>
</table>

Labels

The Labels tab allows you to assign labels, or colors, to folders. These labels are a great way to organize folders, giving you an instant clue to what is contained in the folders based on their color. Use the Labels tab to assign names to specific colors. Assign labels to folders by right-clicking, or Ctrl-clicking, the folder, and then choose the label you want to use from the Label list (Figure 2.19).

The name of my folder now appears with a red background behind it.

FIGURE 2.19

Choose a label that reflects the contents of the folder. Oh, and please don’t tell anyone about my top-secret folder!
Sidebar
The Sidebar tab (Figure 2.20) controls what items appear in the sidebar of Finder windows. Simply choose which items should be shown under each category of the sidebar.

![Finder Preferences](image)

**FIGURE 2.20**
Check the boxes next to items you want to be visible in the sidebar of Finder windows.

Advanced
The Advanced tab helps you with, well, a few advanced options for the Finder. As Figure 2.21 shows, there are four options you can enable or disable:

- **Show all file extensions.** All files have extensions, which tell Mac OS X what type of files they are. However, Mac OS X hides those extensions by default, to prevent any confusion that may occur and to keep from taking up any unnecessary Desktop real estate.

- **Show warning before changing an extension.** Leopard warns you before allowing you to change a file's extension.
Part I  The Basic Mac

- **Show warning before emptying the Trash.** Mac OS X warns you every time you empty the Trash, which can get annoying after awhile if you are someone who empties the Trash frequently (like me).

- **Empty Trash securely.** Select this option to securely empty the Trash every time without having to use the Finder menu, as described earlier in the chapter.

![FIGURE 2.21](image)

Select which advanced options you want to implement.

---

**Find Items on Your Mac**

We've all lost our car or house keys, right? The search seems to go on and on until you finally turn over that last couch cushion, which ironically is the first place you thought about looking, but then said, "No, why would they be there?" Wouldn't it be nice to just press a button on the wall and say out loud, "car keys," and then have the house tell you exactly where they are? While that technology hasn't quite made it into modern homes, it has made it into your Mac. Yep, your trusty Mac can tell you precisely where that elusive file or folder is hiding, whether on its built-in hard drive, external drives, removable media, or even network shares. This technology, built right into Leopard, is called Spotlight, and it can help you find even the sneakiest of items on your Mac.

When you turn on your Mac for the first time, or install a new copy of Mac OS X, Spotlight creates an index of every single file that is stored on your hard drive. This index allows Spotlight to instantly know where every file that contains the items you wish to search for is located, and it displays those files and their whereabouts almost immediately. Spotlight uses metadata, which is simply data about data (such as creation dates, modification dates, the owner of the file, the application it was created in, and so on), to learn the complete ins and outs of every single file on your system. It keeps track of everything you do to a file: Whether you move a file, rename a file, change the content of a file, or even delete a file, Spotlight knows all and instantly updates its index with the relative information about said file. Spotlight can find items as old-hat as files and folders, but it also searches every other crack and crevice of Mac OS X, such as your e-mails and Web pages you have visited, to find any mention of the topic you are searching for.
Use the Spotlight menu

The Spotlight menu is easy to find; just look for the magnifying glass in the upper right corner of your screen. When you click the magnifying glass you are presented with a Spotlight search field, as shown in Figure 2.22.

To find an item using the Spotlight menu, simply type some text into the search field, such as the name of the item or keywords it contains. For example, I typed the word Mac into my Spotlight search field so that I could find anything and everything on my computer that contained the word “Mac,” and you can see the results in Figure 2.23.
Spotlight categorizes the results it finds, also called hits, which helps you find what you need faster. The categories range from documents to folders to images, and even dictionary definitions! If you don't find what you're looking for in the list of hits, click the Show All option at the top of the list to see a window like the one in Figure 2.24.

**FIGURE 2.24**
Notice the bottom of the window—there are over 4,000 hits for “Mac” on my computer!

---

**Search from within a Finder window**

If there is a "problem" with using the Spotlight menu for searches, it is that you get every single file that has any mention whatsoever of your search terms, hence the 4,000+ hits I received when searching for “Mac.” To perform a more specific search in Mac OS X, you need to use a Finder window:

1. While in the Finder, press ⌘+F or choose File→Find.
2. In the upper right corner of the resulting Finder window, enter keywords for your search into the search field.
3. To further narrow your search, you must enter criteria that helps Spotlight filter through the results it finds.
   - The Search bar allows you to further refine your search. You can click on This Mac or the name of the folder you are currently in to limit the search. There is also an option to look for the keywords in the contents of files (click the Content button) or just in the name of the files (click the File Name button).
   - There is a criteria selector below the Search bar. Click the first button, which is labeled Kind by default, to select from a list of pre-defined criteria. You may be presented with other options as well, depending on the criteria you select. Choose Other from the popup menu to find other types of criteria that aren't listed by default. Click
the + or – button to the right of the criteria to add or remove other criteria, which can help narrow or broaden the scope of your search, as I’ve done in Figure 2.25.

FIGURE 2.25
I’ve narrowed my search for “Mac” quite a bit, haven’t I?

If you find yourself frequently performing the same search, click Save after you’ve entered all of your criteria and select a folder to save the search folder. Check the Add to Sidebar box to make it even more convenient to perform the search; simply click the folder under the Search For category in the sidebar.

Set Spotlight’s preferences
You can specify exactly how Spotlight searches your Mac by setting its preferences. To open the Spotlight preferences:

1. Click the Apple menu in the upper left corner of your screen.
2. Select System Preferences.
3. Choose the Spotlight icon from the Personal category of the System Preferences window.

There are two tabs in the Spotlight preferences pane: Search Results and Privacy.

Click the Search Results tab, shown in Figure 2.26. Check the boxes next to the categories you want to appear in the Spotlight menu when you perform searches there. You can rearrange the order in which the categories appear by simply clicking, dragging, and then dropping the category of your choice into the order you want it to appear in.

Choose the Privacy tab, shown in Figure 2.27, to determine which folders or drives you want to exclude from your searches.
Select the categories you want to search in using the Spotlight menu.

I've decided not to perform searches in the user folders of the other accounts on my Mac.
You can also modify the keyboard shortcuts used to quickly open the Spotlight menu and the Spotlight search windows by choosing a new shortcut from the popup menus at the bottom of the Spotlight preferences pane.

**Summary**

At this point you can get around in the Finder with the best of them! You know how to work with windows, search for information, and customize your Finder experience. As with almost anything on your Mac, there are alternative ways to do most of the things I discussed in this chapter, but I believe that I'm showing you the most practical and efficient ways to utilize this most important of all tools in Leopard. Happy Mac-ing!
ow that you and the Finder are a bit more acquainted, I want to show you some fun, neat ways to make the Finder even more useful.

Mac OS X has always included beautiful graphics, but Apple has been mindful that the gorgeous interface of Mac OS X wasn't just eye candy, but functional as well. This chapter explores some of these great-looking yet functional and easy to use tools: the Dock, Dashboard, Exposé, and Spaces.

Mastering the Dock

The Dock, shown in Figure 3.1, is the row of icons that sits at the bottom of your Mac's screen by default. The Dock has been a part of Mac OS X since its first version, Cheetah (10.0), and has seen many revisions leading up to its current state in Mac OS X 10.5, or Leopard. The Dock is the perfect place to store icons for your favorite applications, making it easy to open the application with just one click without having to navigate your hard drive to find it. Apple has preloaded the Dock with application icons, but you can rearrange and even remove the icons you don't need, and you can add icons you do need.

The Dock isn't limited to just application icons; it can also contain shortcuts to folders that reside on your hard drive—for instance, the Documents folder in your home directory.
Part I  The Basic Mac

FIGURE 3.1
The Dock is one of the most widely used elements of the Mac OS X interface.

The Dock is divided into two sections, designated by the dashed line that sits between the last application icon and the first folder icon. The left side of the Dock is where your application icons reside, and the right side houses your Trash and shortcuts to folders you access most often.

To open an application from the Dock, simply click its icon one time and the application launches. A glowing dot under an icon in the Dock, shown in Figure 3.2, indicates that the application is already running. In this case, clicking the icon brings the application to the forefront.

FIGURE 3.2
The glowing dot tells you the application is already running.

Rearrange items in the Dock
Keeping the Dock streamlined and organized can go a long way in determining how enjoyable your Mac experience is. If your Dock is chock-full of icons for every application on your Mac, you will have to send out a search party just to find the application you're looking to open. On the flip side, if you don't have any icons in your Dock, you will find yourself wasting a lot of time navigating your hard drive for the same application several times a day.

As I mentioned, Apple has included several application icons in the Dock by default. It's important to understand that these icons—and those of any applications you add to the Dock—are simply shortcuts to the application and not the actual application itself, so removing an item from the Dock doesn't remove it from your Mac entirely.

Remove items from the Dock
Your Dock's real estate is precious, so you only want to keep items in it that you use on a regular basis. Remove any icons you no longer want to appear in the Dock by simply dragging the icon out of the Dock and dropping it. The icon disappears in a puff of smoke!

NOTE  The Finder icon, which looks like a smiley-face, and the Trash icon are permanent residents of the Dock. They cannot be removed from or rearranged in the Dock.
Add items to the Dock

Adding items to the Dock is one of my favorite things to do in Mac OS X. I know it sounds silly, especially to the more seasoned Mac users who may be reading this, but I get a kick out of dropping an icon in the Dock and watching the other icons scoot over to make room for it. Now that we’ve established how easy I am to entertain, here’s how to add application icons to your Dock:

1. Click the Finder icon on the far left side of the Dock to activate the Finder.
2. Press ⌘+Shift+A to open a Finder window, which automatically displays the items in your Applications folder.
3. Find the icon for the application you want to add to the Dock, and then drag-and-drop the icon into the left side of the Dock. Notice how the icons already in the Dock move over to accommodate the new icon you are adding.

You can just as easily add a folder shortcut, called a stack, to your Dock by dragging-and-dropping the original folder into the right side of the Dock. For example, if you have a folder that contains work-related documents that you need to access several times a day, drag the folder into your Dock to get to those documents quickly and easily. To view the contents of these stacks, simply click the folder icon. The items display with a fan pattern (Figure 3.3), a grid (Figure 3.4), or a list (Figure 3.5), depending on the number of items in the stack.

**FIGURE 3.3**

Viewing the contents of a stack from the Dock, using a fan pattern.
Part I  The Basic Mac

**FIGURE 3.4**
A grid pattern shows more items in a stack than the fan pattern is capable of showing.

**FIGURE 3.5**
The list pattern skips the fancy graphics for a more straightforward approach.
You can choose the default pattern for displaying items in a stack, instead of relying on Mac OS X to figure it out for you. Right-click, or Ctrl+click, the Stacks icon in the Dock, and then select Fan, Grid, or List in the View content as section.

**Organize the Dock’s icons**

The icons in the Dock can be arranged in any order you choose, with the already noted exceptions of the Finder and Trash icons. Simply drag the icon you want to move to its new position, illustrated in Figure 3.6, and drop it in. Voilà!

![Figure 3.6](image)

Drag-and-drop the icons to the location in the Dock you prefer.

**Taking out the Trash**

The Trash icon on the far right side of the Dock is where you drag items you want to remove from your Mac. These items remain in the Trash until you empty it. Right-click, or Ctrl+click, the Trash icon and select Empty Trash to discard its contents.

**Change the way your Dock behaves**

The Dock can be modified to behave exactly as you specify by changing its preferences. You can open the Dock’s preferences in one of three ways:
Part I  The Basic Mac

- Click the Apple menu in the upper left of your screen, choose System Preferences, and choose Dock from the Personal section.
- Click the System Preferences icon in the Dock (it looks like three gears meshing) and then choose Dock from the Personal section.
- Right-click, or Ctrl+click, the Dock separator line and select Dock Preferences from the list.

Figure 3.7 shows the Dock preferences window, while Table 3.1 describes the options available to you.

FIGURE 3.7
Adjust the Dock’s preferences to suit your tastes.

![Dock Preferences Window]

TABLE 3.1
Dock Preferences

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
<td>Adjust the slider to increase or decrease the size of the Dock and its icons.</td>
</tr>
<tr>
<td>Magnification</td>
<td>Causes the icons in the Dock to enlarge as you pass your mouse pointer over them, making them easier to distinguish. Very useful if you have set the size of your Dock’s icons to very small sizes.</td>
</tr>
<tr>
<td>Position on screen</td>
<td>Allows you to anchor your Dock to the left or right side, or the bottom (default), of your screen.</td>
</tr>
<tr>
<td>Minimize using</td>
<td>When you minimize an item it flows down into the Dock. This option lets you choose the flow effect (Genie Effect is the default). This doesn’t provide any functionality; it simply flaunts your Mac’s cool quotient.</td>
</tr>
<tr>
<td>Animate opening applications</td>
<td>With this option selected, which is the default, icons of applications bounce in the Dock while the application launches.</td>
</tr>
<tr>
<td>Automatically hide and show the Dock</td>
<td>Some users simply don’t like the Dock taking up their valuable screen real estate, but they don’t want to do without its functionality. Checking this option causes the Dock to hide from sight until you move and hold your mouse pointer at the bottom of your screen. The place where you hold your mouse pointer will vary to the right or left side if you choose one of those in the Position on screen setting.</td>
</tr>
</tbody>
</table>
Become a Dashboard Aficionado

Apple introduced Dashboard in Mac OS X 10.4 (Tiger) to much fanfare, and it has become a staple of Mac users everywhere. Dashboard is an application that allows you to run other mini applications, called widgets, when Dashboard is activated. Widgets usually focus on one specialty, such as displaying the time, finding driving directions, showing movies theaters and times, giving weather information, and other similar tasks. Mac OS X comes loaded with many useful widgets, which you can easily manage. You can also install other third-party widgets, and even create your own. Widgets are typically HTML files that use Cascading Style Sheets and JavaScript to perform their intended functions.

Viewing your widgets

To activate Dashboard and view installed widgets, simply press the F12 key. As soon as you press the F12 key, your Desktop is dimmed and the currently enabled widgets show up, as shown in Figure 3.8. How cool is that? Very.

**FIGURE 3.8**

This is the default set of widgets.

Activate a widget

Click the + symbol in the lower left corner of your screen to open the widget bar and see the other widgets that are installed on your Mac.
Part I  The Basic Mac

Customize the Dock

As with anything else in this world, the Dock does have its detractors. Some don’t like the 3-D appearance that Leopard ushered in, or they may not like the glowing dots that represent open applications, or greatly dislike the reflective surface of the Dock. The desire to change the appearance of the Dock has led to a Web site solely dedicated to helping Mac users customize their Dock from top to bottom: www.leoparddocks.com. There you can find tips on changing the look of your Dock, view Dock changes that other Mac users have made, and even download a utility called LeopardDocks App that helps you easily make changes to your Dock.

To activate, or open, a widget, simply click its icon in the widget bar. When you click the icon, you see a really neat splash effect in the center of your screen, as if you dropped a pebble in a pond, and the widget opens. To see this in action, open the Movies widget that comes with Leopard.

You can reposition a widget by clicking-and-dragging it to any location on your screen.

TIP

Some widgets need input from you in order to display information for your part of the world. For example, the Movies widget needs to know your zip code so that it can display movies that are playing in your local theaters. Click the Movies widget to see a list of theaters and show times. Notice the “i” in the lower left corner of your widget window; click it and the window flips over so that you can enter your zip code. Click the Done button after you’ve entered your zip code and you’ll see a listing of movies playing in your area.

Deactivate a widget

Follow these steps to deactivate a widget you may no longer need to use:

1. Press F12 to activate Dashboard.
2. Hold down the Option key on your keyboard.
3. Click the X button that appears in the upper left corner of the widget you want to deactivate. The widget seems to get sucked away into some invisible black hole, which is just another notch in Apple’s coolness belt.

Managing widgets

As mentioned, you can view all the widgets included with Mac OS X Leopard in the widget bar, shown in Figure 3.9. Because the widget bar can only display a certain number of widget icons, it is divided into multiple pages or sections, providing access to all your installed widgets. Press F12, click the + symbol in the lower left of your screen to open the widget bar, and hold your mouse pointer over one of the arrows on the right and left sides of the widget bar. The arrows indicate which page of the widget bar you are viewing. To see the next page in the widget bar and view the icons it contains, simply click one of the arrows.
Enable and disable widgets
You can trim down or expand the number of icons, and consequently the number of pages, that are displayed in your widget bar by enabling or disabling widgets. Click the Manage Widgets button above the widget bar to activate the Widget Manager, shown in Figure 3.10.

To enable or disable widgets, check or uncheck the box next to the icon of the widget you want to affect. When you check the box, the widget's icon is shown in the widget bar, and conversely, deselecting the check box removes the widget's icon. Use the scroll bar on the right side of the widget list to see all the widgets currently installed on your Mac.

Install new widgets
None of the widgets that come with Leopard excite you? Do you need a widget for a particular task, such as tracking packages or playing solitaire? If so, you're in luck! The Mac community has flooded the Internet with tons of widgets that cater to almost any need. Apple has made it very easy to find new widgets and install them with minimal effort. To install new widgets:

1. Open the Widget Manager.
2. Click the More Widgets button at the bottom of the Widget Manager window.

3. Safari opens and you are automatically taken to Apple's Dashboard Widgets site. Peruse this site for fun and useful widgets that interest you.

4. When you find a widget you want to install, click its Download link. Safari downloads the file, unzips (or extracts) it, and asks if you want to install the widget, as illustrated in Figure 3.11.

5. The new widget opens in Dashboard and allows you to test it out. If you like the widget, click the Keep button; if not, click Delete.

![Figure 3.11](image)

Click the Install button to install the new widget on your Mac.

---

**Uninstall a widget**

If you decide that a widget's usefulness has run its course, you can easily uninstall it from your Mac:

1. Open the Widget Manager.

2. Find the widget you want to uninstall. Widgets that have a red circle with a white dash to the right of their name, as shown in Figure 3.12, can be uninstalled from the Widget Manager.

![Figure 3.12](image)

A red circle with a white dash indicates the widget can be uninstalled.
3. Simply click the red circle to remove the widget from your Mac. Widgets that are installed as part of Leopard cannot be removed from the Widget Manager; see the sidebar entitled "Manually Uninstall Widgets" for help in removing those.

4. When asked if you want to move this widget to the Trash (Figure 3.13), click OK. Click Cancel if you decide you want to keep it after all.

**FIGURE 3.13**

Leopard confirms that you would indeed like to remove this widget.

---

**Manually Uninstall Widgets**

The Widget Manager won't let you uninstall widgets that shipped as part of Mac OS X, but take heart—you can remove them, but you'll have to get your hands a little dirty:

1. From within the Finder, press ⌘+N to open a new Finder window.
2. Select the hard drive that contains your Mac's installation of Mac OS X from the sidebar on the left side of the window.
3. Open the Library folder.
4. Open the Widgets folder, find the widget you want to remove, and drag-and-drop it in the Trash.
5. Enter your administrator account user name and password to delete the widget. The deed is done!
Exposé Basics

We've all been there: You have 100 windows open from 50 different applications (that may be a slight exaggeration, but you get the point), and you have to hunt and peck for the window you may need at any given moment. This little aggravation can quite rapidly escalate to a hair-pulling free-for-all. Well, with the little wonder known as Exposé, there's no need to suffer through "lost window hell" ever again! Exposé first saw the light of day in Mac OS X 10.4 (Tiger) and quickly became a fan favorite. Exposé allows you to quickly find any window you need with just the press of a function key and your mouse (or trackpad, as the case may be). When you push one of the soon-to-be-discussed function keys, Exposé arranges all the open windows on your Mac in such a way that you can see them all at once. One click of the mouse on the window you need instantly brings it to the forefront.

Use the function keys to enable Exposé

The function keys, specifically F9, F10, and F11, activate Exposé and determine what it reveals for you. Let's delve a little more deeply into this great time-saver.

Pressing F9 arranges every open window for each currently active application (not hidden ones, mind you) on your Desktop, as shown in Figure 3.14. As you move your mouse over each window, it becomes highlighted and displays its name so you can quickly identify it. To bring the window to the forefront, simply click it once; all other windows recede to the background. Press F9 again instead of making a selection with the mouse to have all windows return to their original positions.

Pressing F10 highlights and arranges all the open windows in the application you are currently working in. For example, if you are in Microsoft Word, pressing F10 arranges all the open Word documents in such a fashion that you can see document's contents and select which to work on, as shown in Figure 3.15. Click the window you need and it comes to the front. Press F10 a second time to cause the windows to fall back to their original places.

The F11 key is the giant broom of Exposé; it totally sweeps all the open windows from view, exposing (no pun intended) the Desktop. Press F11 to quickly see any files or folders that may reside on your Desktop, as well as steal a glance at your beautiful Desktop background, as I'm doing in Figure 3.16. Pressing F11 again makes the windows reappear at their starting points.
All open windows are ready and at attention, waiting for you to select one of them.

**FIGURE 3.14**

All the windows for my current application, in this case Word, are arranged for my perusal.

**FIGURE 3.15**
Part I  The Basic Mac

The kids are a rather welcome break from the humdrum.

Set preferences for Exposé

Exposé will prove very valuable to you, for sure, but you can increase its value by customizing it to work the way you want it to. Some of you may feel that you should leave well enough alone, and that’s fine, but for the more adventurous types, let’s open Exposé’s preferences and see what we can tinker with. To see Exposé’s preferences:

1. Click the Apple menu and choose System Preferences.
2. Choose Exposé & Spaces from the Personal section.
3. Click the Exposé tab, as shown in Figure 3.17.

The Exposé preferences allow you to do a bit more than one might expect. Here’s a look at what each section of the preferences pane allows you to change according to your taste:

- **Active Screen Corners.** Your Mac’s monitor, or screen, has four corners, each of which just sits unused unless you decide to enable Active Screen Corners. With Active Screen Corners, you can have your Mac perform a task that you specify here in the preferences pane whenever you hold your mouse pointer in the corresponding corner. You are given the options to set corners to perform one of the following tasks:
  - All windows (shows all open windows)
  - Application windows (shows all open windows in the currently active application)
Finder Fun

- Desktop (shows the Desktop)
- Dashboard (opens Dashboard and reveals all active widgets)
- Start Screen Saver
- Disable Screen Saver
- Sleep Display (causes your display to go into Sleep mode)

**Keyboard and Mouse Shortcuts.** Changing these settings modifies which keystrokes engage Expose and Dashboard. Hold down the Shift, Control, Option, and Command keys to see more options.

**FIGURE 3.17**
The Exposé preferences await your input.

---

**Gain More Desktop Ground with Spaces**

For the busiest, and most cluttered, of Mac users, the Desktop simply doesn't have enough room to hold all your "stuff." With this productive group in mind, Mac OS X Leopard introduced an awesome new feature that lets you use more than just one Desktop: that feature is called Spaces. Spaces are simply multiple Desktops that you can use for various tasks. For example, you may have one space that you use to perform all your project research, another space for surfing the Web, a third space for your e-mail, and yet a fourth space for keeping track of your stocks.
Enable your Mac for Spaces
Spaces is turned off by default and must be enabled before it can be used. To enable Spaces:

1. Click the Apple menu and choose System Preferences.
2. Click Exposé & Spaces in the Personal section.
3. Click the Spaces tab.
4. Check the box next to Enable Spaces, as shown in Figure 3.18.

**Figure 3.18**
Fit Spaces to your needs by adjusting its preferences.

![Spaces Preferences](image)

**TIP**
Check the box next to Show Spaces in menu bar to place a Spaces icon in the menu bar where it can be easily reached. Click the Spaces icon, which looks like a black box with a number inside of it, to select the Space you want to change to or to open the Spaces preferences window.

Move between Spaces
Once Spaces is enabled, you can switch between four distinct Desktops by pressing the F8 key. When you press F8, your Mac's screen changes to show you all four Desktops at once, letting you see the contents of each one (Figure 3.19). To zip instantly to a new space, simply click the one you want.
If four spaces are not enough for your workload, you can add up to 12 more by clicking the + buttons next to the Rows and Columns options in the Spaces preferences pane. However, the more spaces you have, the more you will have to manage.

**TIP** Each space is assigned a number, from 1 up to 16. An even faster way to navigate your spaces is by holding down the Ctrl key and pressing the corresponding number key for the space you want to go to. You can also move from space to space in a flash by holding Ctrl and pressing the arrow keys on your keyboard.

A window can be moved from space to space by pressing F8, and then dragging-and-dropping it from its original space to the space you want it to now reside.

**Link applications to Spaces**

Spaces allows you to assign applications to open in their own respective space when launched. For instance, you can assign your e-mail application to open in Space 2 when you start it up, avoiding the need to move it to that space after the fact. To assign an application to its own space:

1. Open the Spaces preferences pane.
2. Click the + button under the Application Assignments window and select Other from the list.
Part I  The Basic Mac

3. Browse your Mac's hard drive for the application you want to assign, select the application, and click the Add button. Select multiple applications by holding down the ⌘ key while clicking the applications' names.

4. Click the name of the application you want to assign to a space to highlight it.

5. Select the Space assignment to the right of the application's name, as shown in Figure 3.20, to change the space the application opens in.

**FIGURE 3.20**
Choose which space this application hangs out in once it's up and running.

---

Summary

Chapter 3 has shown you how to successfully use the Dock for quickly accessing applications and documents you use more often than others. You also learned how to use Dashboard and widgets, organize your jumbled windows using Exposé, and assign windows and applications to their own Desktops using Spaces.
Customization, customization, customization. We all like to have things personalized to our tastes, to fit our lifestyles. When you first buy a car you make sure to add your own personal touches to it, whether it be a personalized license plate or some fuzzy dice hanging from the rearview mirror. After you buy a home you typically like to paint the rooms in colors that appeal to you, or plant a garden, and maybe even install a pool. For that matter, the clothing that you choose to wear speaks volumes about you and the kind of person you are. So, when you own a Mac, why not jazz it up a little to make it fit your personality?

Mac OS X allows you to make changes to your user account (learn more in Chapter 6) so that it tells the world this is your computer and you love using it! This chapter takes a look at the various ways to customize your Mac, from installing applications to using third-party applications and utilities, to add that personal flavor you crave.

### Installing Applications

Installing third-party applications on your Mac is certainly a way to customize it, because you are adding elements to the computer that change it in one way or the other, whether cosmetic or just simply taking up more space on your hard drive. I venture to say that 99.99 percent of all Mac users will install a piece of third-party software at some point in their computing adventures, and luckily enough for them, installing the vast majority of apps in Mac OS X is about as simple as it can get.

There are a couple of ways to go about getting software for your Mac: You can download the software from the Internet, or you can install it using an installation CD or DVD.
Always read and follow the developer's or manufacturer's instructions carefully to make sure you are correctly installing their application or utility. Read those instructions before continuing and follow them (as opposed to mine if they differ).

**CD or DVD installation**

Usually you can get installation discs for major applications you want to install, such as Microsoft Office or Adobe Creative Suite, and even some of the smaller profile applications offer this capability. The following instructions discuss the typical installation of a major software program; in this case, Microsoft Office 2008 for Mac:

1. Insert the disc into your computer.
2. Usually an installer disc automatically displays a dialog window, much like the one in Figure 4.1, when you insert it. If it does not, double-click the icon for the disc on the Desktop or in a Finder window.

3. In some cases you can simply drag-and-drop the application's icon to the folder you want to install it to, but you typically need to double-click the installer icon for the application to get the ball rolling.
4. Follow the installer's prompts and instructions from here. There is no definitive step that I can offer beyond this point due to variations in the way that developers provide their products to their customers. You most likely have to type in items such as a serial
number and your contact information at some stage of the process, and you almost always have to authenticate the installation by entering the user name and password for your account (you must have administrative rights to install software).

5. Once you’re finished with the installation, launch the application to make sure it opens properly.

6. Eject the disc by dragging its icon from the Desktop to the Trash, or by simply pushing the Eject button on your keyboard.

Installing downloaded items

Downloading things such as applications, utilities, and drivers has rapidly become the simplest way to obtain software titles and install them. Two major advantages to this are

- You don’t have to go to a store to browse for software.
- You can install the software instantly.

In today’s Internet-friendly environment, most people prefer to download software as opposed to the old-fashioned disc-in-a-box way of doing things. You can always burn the installers to a disc after you’ve downloaded them, which isn’t a bad idea insofar as backups are concerned.

One of my favorite playtime things to do on my Mac is to have a go at Frenzic, which is a really great little game you can get from The Iconfactory and ARTIS Software. We’ll use Frenzic as my test subject in this section of the chapter. Of course, if there is some other software you’ve had your eye on, by all means download it instead. Let’s get started:

1. Go to the Web site of the software you want to download and click on the download link. For Frenzic, go to http://frenzic.com.

2. Most software is compressed (see Chapter 17 for info) to save the integrity of the software while being downloaded and to decrease the size of the downloaded file. These compressed files are typically in the form of disk images or zip files. If you are using Safari, it automatically downloads and decompresses the disk image or zip file.

3. For installation, some applications, like Frenzic, simply require you to drag-and-drop their icon to the disk or folder you want it to reside in. Others may have an installer icon you must double-click to launch. Follow the instructions of the developer to finish installation beyond this point.

**TIP**

Most applications that you download allow you to try the software for a certain period of time before requesting that you pay for using it. I suggest you “try before you buy” whenever possible, even for software you think you simply can’t live without. If you still like the program after using it a few times, it’s safe to hand over the cash.

Applications that you install can be placed anywhere on the computer that you like, but Apple specifically created an Applications folder so that you can stay organized. If you are installing the application for only your use, create an Applications folder in your home folder and install it there.
Adding and Managing Fonts

The Mac has always been associated with desktop publishing because of its friendliness to those with a creative bent, and therefore its ability to use, store, and manipulate fonts has always been in high demand. Mac OS X uses fonts to display and print typefaces. These fonts are used to change the look of documents, applications, and even your operating system. You can add or remove fonts to and from the hard drive as well.

Where are fonts stored?
Fonts are typically stored in one of the following folders:

- Use /Library/Fonts to store fonts that will be accessed by everyone using the system.
- Use /Users/your home folder/Library/Fonts to house fonts that only your account will be able to access.

While you can manually move fonts into these directories, Font Book is the application typically used to install and manage fonts in Mac OS X.

How to use Font Book
The Font Book application is the easiest method for handling fonts in Leopard. Font Book is found in the Applications folder at the root of your Mac’s hard drive. Double-click its icon to see the Font Book window, which should look like the one in Figure 4.2.

**FIGURE 4.2**

Font Book’s main window

![Font Book's main window](image-url)
Manage fonts
Font Book helps you organize fonts by allowing you to place them in collections, or categories. For example, if you have a business and use only a certain set of fonts for your company's official letterhead and documents, you can create a collection called Official Business and add the fonts you need to the collection. Here's how to create a new collection:

1. Click the + button below the Collection column.
2. Give the collection a descriptive name.
3. Click the All Fonts collection and find the fonts you want to add to your new collection.
4. Drag the font you want to add from the Font column and drop it onto the new collection, as shown in Figure 4.3. To select multiple fonts, hold down the ⌘ key while clicking the desired fonts.

![FIGURE 4.3](image)

Drag fonts to the new collection to make them easy to find.

5. Highlight the collection to view the fonts it contains. The fonts you added to the collection are still available under the All Fonts collection. They have not been moved from their original location on your hard drive; the font in the collection is only a pointer, or alias, to the original font.
6. To temporarily disable (turn off) a font, highlight the font and press ⌘+Shift+D. Click the Disable button if you are asked if you’re sure you want to disable the font. Enable the font by pressing ⌘+Shift+D again.
7. To temporarily disable an entire collection, highlight the collection and press ⌘+Shift+E. Press the same key combination again to enable the collection again.
You can preview a font family by highlighting it in the Font column. A preview of the font family appears to the right of the Font column. Use the Size popup menu and the slider on the right side of the preview window to see how the font appears at different sizes.

**Add or delete fonts**

For most of us, the default set of fonts that comes with our Macs suffices quite nicely for the services we require. However, some folks need to install fonts beyond the standard ones, whether it be for business or pleasure. To install a font using Font Book:

1. Click the gear button in the upper left corner of the Font Book window and select Add Fonts, as shown in Figure 4.4.

![Figure 4.4](image)

**FIGURE 4.4**

Installing new fonts in Mac OS X using Font Book

2. Browse your Mac for the font you want to install, select it, and click Open in the lower right corner.

3. The font is automatically activated.

There may be some fonts that you simply have no use for and don’t want them taking up precious space on your hard drive. Those fonts can easily be dealt with:

1. Highlight the font in the Font column that you want to delete.

2. Either click the gear button, or right-click (Ctrl+click) the offending font in the Font column (Figure 4.5), and choose Remove “name of the font” family.

3. Click the Remove button when prompted.
If you have multiple copies of a font installed, a dot appears next to its name. To disable all but one of the fonts, select the font, and then choose Edit → Resolve Duplicates.

**FIGURE 4.5**
Expunging an extraneous font, with sincere apologies to fans of Tekton Pro

[Image of Font Book interface with a menu option to remove a family of fonts]

**Font Book Preferences**
One more item to take note of in Font Book is its preferences. Open Font Book Preferences by pressing ⌘+, (comma). Table 4.1 describes the functions available in Font Book, shown in Figure 4.6.

**FIGURE 4.6**
These preferences control how Font Book behaves with the rest of your system.
Part I  The Basic Mac

### TABLE 4.1  
**Font Book Preferences**

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Install Location</td>
<td>Select Computer if all fonts should be accessed by all user accounts, or</td>
</tr>
<tr>
<td>Validate fonts before installing</td>
<td>Font Book checks the font file to make sure it’s valid before installing it.</td>
</tr>
<tr>
<td>Automatic font activation</td>
<td>Check to automatically activate each new font that is installed. You can</td>
</tr>
<tr>
<td>Alert me if system fonts change</td>
<td>You are notified if new fonts are added to the system fonts in the System folder.</td>
</tr>
</tbody>
</table>

#### Third-party font-management utilities

Mind you, Font Book isn’t all there is in the world of font management. There are plenty of other developers out there with their own take on how fonts need to be told what’s what, the most famous of which are (in no particular order):

- FontExplorer X by Linotype (Figure 4.7)—[www.linfoyte.com/2493/fontexplorerx.html](http://www.linfoyte.com/2493/fontexplorerx.html)
- Suitcase Fusion by Extensis—[www.extensis.com](http://www.extensis.com)
- MasterJuggler by Alsoft—[www.alsoft.com/MasterJuggler/index.html](http://www.alsoft.com/MasterJuggler/index.html)

#### FIGURE 4.7  
Managing fonts in Mac OS X with FontExplorer X
Finding Additional Fonts on the Web

You've got a really great project that you want to make sure turns out perfect, but you've been unable to find that perfect font that will lift your project right off the page. What to do? You have three options: Use a font you don't want to use, buy a font from a font developer, or download an open source font from the Internet (for free!). If free sounds as good to you as it does to me, try giving these sites a few minutes of your time:

- www.1001freefonts.com/
- www.dafont.com/
- www.urbanfonts.com/

Is it worth buying a third-party font-management utility when Font Book seems to be doing the job? Well, if that's your question, the answer is no. If, however, your question is whether these utilities are worth looking into if Font Book isn't adequate for you, the answer is an emphatic yes. Each one of the four I just listed performs the task of font management in its own unique way. Most provide a trial period so you can determine if the product is right for your needs, and FontExplorer X is even free. Although FontExplorer X may not be as feature-rich as the other apps, it provides a heck of a lot of punch for a free utility, such as providing every little detail about the fonts you have installed, as illustrated in Figure 4.8 using the Academy Engraved LET Plain: 1.0 font family.

**FIGURE 4.8**

The amount of detail available in some fonts is staggering!
Jazz Up Your Workspace with Desktop Pictures and Screen Savers

Nothing says "this is my Mac" better than an original Desktop picture or a unique screen saver that stops people in their tracks when they traipse by your desk. One of the first things people like to do to their computers after they've become familiar with them is to personalize things a bit, and Desktop pictures and screen savers are the prime places to start.

Change your Desktop picture

Leopard is loaded with great Desktop pictures, including the coolest default Desktop picture ever to grace an operating system, called Aurora. However, if gazing at the stars isn't your thing, you can change things up.

Desktop pictures can be anything from a solid-color background to a picture of your family you took while on vacation. The only rule that applies is this: Use something you like! Don't downplay the significance of such a seemingly small thing. Nobody likes to work in a bleak office with no windows and drab colors, right? You add pictures and knickknacks to your desk to make the space your own. So why would you want to work on a computer that doesn't reflect your taste?

To change the look of your Desktop:

1. Click the Apple menu and choose System Preferences.
2. Select Desktop & Screen Saver from the Personal category. You can also right-click, or Ctrl+click, anywhere on the current Desktop picture and select Change Desktop Background from the menu.
3. Click the Desktop tab, shown in Figure 4.9.
4. The list on the left of the preferences pane shows folders containing the Desktop backgrounds that come with Leopard, as well as any photos you may have in iPhoto (see Chapter 13). Browse this list to find your perfect Desktop image. Select a folder to see its contents.
5. Once you've found an image you like from within the folders, click it and your Desktop background automatically changes, like mine does in Figure 4.10.
6. If the picture you choose doesn't fill the Desktop like it ought to, use the popup menu above the list of Desktop backgrounds. Choose from Fill Screen, Fit to Screen, Stretch to Fill Screen, Center, and Tile.
7. Should you desire a little variety and spontaneity in your Desktop backgrounds, check the Change picture box and select a time increment to allow Mac OS X to change the background for you. Check the Random order box to have Leopard arbitrarily grab new backgrounds.

If you don't see your favorite Desktop background pictures in the list, click the + button below the list to browse your Mac for the folder containing your preferred images to add them to the list.
A large choice of Desktop pictures beckons you.

FIGURE 4.9

Two handsome dudes hitting the beach

FIGURE 4.10
Another option at the bottom of the Desktop & Screen Saver preferences pane is the Translucent Menu Bar box. Leopard introduced the translucent menu bar, and as is usually the case with new things, some Mac fans loved it and some hated it. To placate those who didn't take too kindly to Apple messing with their solid menu bar, Apple extends this olive branch. Uncheck the box to see the traditional menu bar.

Selecting screen savers

Screen savers are still cool to me, even though their main purpose of preventing burn-in on the old CRT monitors is fading away with the advent of LCD monitors. But besides their ability to simply entertain, they can still perform a critical security function: You can assign a password to the screen saver, which prevents someone from disabling the screen saver without knowledge of the password. Leopard comes with several great screen savers, and there are multitudes more on the Internet. To select a screen saver to use:

1. Click the Apple menu and choose System Preferences.
2. Select Desktop & Screen Saver from the Personal category.
3. Click the Screen Saver tab, shown in Figure 4.11.

4. Select a screen saver from the list on the left.
5. Get a quick peek at the selected screen saver using the Preview window.
6. Move the Start screen saver slider to determine how long your computer is unused before the screen saver activates.
Finding Awesome Desktop Pictures and Screen Savers

The Web is simply crawling with great sites that offer Desktop pictures and screen savers. Search Google for "desktop pictures," "desktop backgrounds," "wallpapers," or "screen savers" to find the thousands of sites that offer them. Add topics to the search, such as "Mac desktop backgrounds" or "Auburn desktop pictures," to find backgrounds for your favorite things in life. I have a few Web sites that are my favorites, and I recommend them as often as possible:

- www.desktopography.net/
- www.desktopnexus.com/
- www.digitalblasphemy.com/
- http://wallpaper.deviantart.com/

7. If available, click the Options button to customize the way the screen saver appears and works.
8. Click the Test button to see the screen saver as it will appear when activated.
9. The Hot Corners button allows you to designate a corner of your screen as a hot corner, as shown in Figure 4.12. This means that when you move your mouse to the hot corner and hold it there for just a second, you instantly activate your screen saver.

![Active Screen Corners](image)

FIGURE 4.12
Assign a hot corner to activate your screen saver immediately.

TIP You can also set up hot corners to disable your screen saver, or activate Exposé and Dashboard.

Assign Custom Icons to Your Folders

Let's face it, folders are boring. They're just plain old folders that hold other documents and files. The default folder icon in Mac OS X, shown in Figure 4.13, is just blue; a plain folder that is colored . . . blue. Well, I guess that's fine and dandy for most folders, but sometimes I like my folder to reflect either my personality or its contents, or even both. Mac OS X allows you to customize your folder icons, which just goes even further toward making your Mac truly your own.
To change a folder’s icon, you must have an icon to change it to. One of the best places on the Internet to find new icons is The Iconfactory (www.iconfactory.com). For my demonstration I chose to use the Indiana Jones and the Raiders of the Lost Ark icon set by Anthony Piraino. While not very indicative of the folders’ contents, they sure look cool!

Let’s change a folder’s icon:

1. Click the icon you want to use for your generic folder to highlight it.
2. Press ⌘+I to open the Info window for the icon, as I’ve done in Figure 4.14.

3. Highlight the picture of the icon, in my case the hat, and press ⌘+C to copy it.
4. Close the Info window for the icon.
5. Open an Info window for the folder you want to change by highlighting the folder and pressing ⌘+I.
6. Highlight the folder icon in the upper left corner of the info window.
7. Press ⌘+V to paste the new icon for the folder. Your folder should now have changed to the new icon, like mine in Figure 4.15.

**FIGURE 4.15**
My generic folder icon now resembles the most famous hat in Hollywood.

---

## Utilities to Help You Change the Look of Your Mac

The Mac community is always looking for ways to make tasks easier, and the task of customizing your computer is no different. There are tons of utilities available to help you quickly and simply change the look and feel of your Mac’s operating environs. Here’s a list of a few favorites:

- LeopardDocks App is a free utility that allows you to change your Dock’s skin, which you can also download from their Web site, www.leoparddocks.com. I used it to change my Dock, shown in Figure 4.16.

  **FIGURE 4.16**
  My Dock using the carbonChrome theme from LeopardDocks

- MacPilot (www.koingosw.com/products/macpilot.php) allows you to make loads of system tweaks that would normally require the use of Leopard’s Terminal command line application (see Chapter 19 for much more on Terminal). Get the free trial of MacPilot to give it a test flight.

- CandyBar, seen in Figure 4.17, is a great utility for easily customizing and organizing icons in your system. You can download a free trial of CandyBar at www.panic.com/candybar/.
There are many, many more customization utilities available for Mac OS X. Search for these other apps and open up your Mac!

Summary

You've taken your first steps toward giving your Mac the makeover that tells the world it is yours and yours alone. Mac OS X looks fantastic straight out of the box, but tweaking it to make it suit you only helps to make you more productive and comfortable with your Mac. With this chapter you're now able to install applications, manage your fonts, utilize custom icons, and find new Desktop backgrounds and screen savers. Today we use our computers as much as or more than we do our automobiles, so why not enjoy the experience as much as possible?
Your Mac was designed to do a lot of things really well right out of the box. Apple’s engineers have put together a system that, for the most part, works wonderfully well with almost any device or software designed for it (and even many that aren’t), and with almost any network setup you can think of, with no tweaking of any kind necessary. However, those engineers are but flesh and blood, and cannot realistically be expected to think of and prepare for every possible scenario you, or any other user, may experience or require. On the positive side, they are very bright folks who have done a terrific job of giving you the ability to make any adjustments to your system that may be necessary for your particular circumstances. This is where System Preferences comes in.

What Are System Preferences?

System Preferences is your one-stop location for making changes to the way your Mac interacts with you, your network, the Internet, devices such as printers, and other users on the Mac and on your network. They give you the tools needed to make adjustments necessary for proper functionality and compatibility between your Mac and other entities.
Want to speak to your Mac and have it speak to you? System Preferences is the place to start. Need to set up an external hard drive for backing up your Mac? This is the place you need to be. Do you have files and folders you want to share with other computers on your network? Here you go.

To open System Preferences, do one of the following:

- Click the Apple menu and choose System Preferences.
- Click the System Preferences icon (shown in Figure 5.1) located in the Dock.

**FIGURE 5.1**
The System Preferences icon looks like gears meshing, illustrating the functionality it offers.

![System Preferences Icon](image)

**TIP**
If you are a former Windows user, System Preferences is very similar to the Control Panel used in all versions of the Windows operating system.

**System Preferences In-Depth**

When you open the System Preferences window, shown in Figure 5.2, you are presented with several rows of icons, each of which represents a different task or technology. These rows and the icons they contain are divided and organized into categories according to the type of function they provide.

**NOTE**
At the bottom of Figure 5.2 is a category called Other that contains a couple of icons. This category only appears if you have installed third-party software titles that use their own preferences panes.
This chapter describes what each of the System Preferences is used for and explains most of the options available in them. However, some of the preferences are described in great detail in other chapters of this book, so in the interest of preventing unnecessary duplication I will not cover them in total here, but will point you to the appropriate chapter. Now, let's see what each category has in store.

### Personal: Configuring Appearance, Security, and Searches

The Personal category houses preferences panes for modifying the appearance of your Mac, how it utilizes Expose and Spaces, keyboard settings, security options, and search preferences.

#### Appearance

Adjust the look and feel of your Mac with the options in this preferences pane, shown in Figure 5.3. Any changes you make affect the current user's account only. Table 5.1 lays out the options available to you.
The Appearance pane can change your whole outlook!

![Image of Appearance pane]

**TABLE 5.1**

<table>
<thead>
<tr>
<th>Option</th>
<th>Functionality</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appearance</td>
<td>Choose either blue or graphite as the main color of your menus, buttons, and windows.</td>
</tr>
<tr>
<td>Highlight Color</td>
<td>Pick a default color for text that you highlight in documents, Web pages, or anywhere else you can select text.</td>
</tr>
<tr>
<td>Place scroll arrows</td>
<td>The scroll arrows seen in almost every window can be placed next to one another at the bottom of the scroll bar or one on either end of the scroll bar.</td>
</tr>
<tr>
<td>Click in the scroll bar to</td>
<td>Clicking a location in the scroll bar once can either move you to the next page in a document or to a specific location in it, depending on what you decide to select here.</td>
</tr>
<tr>
<td>Use smooth scrolling</td>
<td>Select this box to have the contents of a window scroll by smoothly or jump by when you click the scroll arrows.</td>
</tr>
<tr>
<td>Minimize when double-clicking a window title bar</td>
<td>Normally a window just sits there and stares back at you if you double-click its title bar, but if you select this option you can double-click the title bar of a window and it automatically zips down to the Dock.</td>
</tr>
<tr>
<td>Number of Recent Items</td>
<td>Click the Apple menu and you will see an item in the list called Recent Items. This is a wonderfully handy list to have, as it shows you the most recent items that you’ve opened without you having to find them over and over again. This option lets you tell your Mac how many of your most recent applications and documents it should remember.</td>
</tr>
</tbody>
</table>
The Nuts and Bolts of System Preferences

<table>
<thead>
<tr>
<th>Option</th>
<th>Functionality</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font smoothing style</td>
<td>Anti-aliasing, or font smoothing, helps fonts appear without jagged edges. The font-smoothing methods used are meant to improve how fonts look on your display, which will vary greatly from user to user. Select the method you prefer here (Automatic is the default).</td>
</tr>
<tr>
<td>Turn off text smoothing for font sizes</td>
<td>The smaller the font size, the more difficult it can be to read. The Appearance pane lets you turn off font smoothing for fonts smaller than the size you choose in the popup menu at the bottom of the pane.</td>
</tr>
</tbody>
</table>

**Desktop & Screen Saver**

The Desktop & Screen Saver preferences pane is discussed in much detail in Chapter 4.

**Dock**

Chapter 3 sufficiently covers all things Dock.

**Exposé & Spaces**

Again, Chapter 3 gives you all the juicy tidbits of Exposé & Spaces preferences.

**International**

Your Mac is a world traveler, without ever even leaving the confines of your home or office. There are several (and I'm being very conservative) languages installed with Mac OS X that can make just about anyone from anywhere feel right at home on your Mac. The International preferences pane houses three tabs: Language, Formats, and Input Menu.

**Language**

Figure 5.4 shows you the Language tab of the International preferences pane.

Click and drag the languages in the list in the order you want them to be used when using application menus, dialog boxes, and when sorting files. Click the Edit List button to choose which languages are displayed in the list.

**Formats**

Different areas of the world have their own preferred ways of displaying important information such as monetary denominations, measures and weights, and dates. This tab, shown in Figure 5.5, allows you to modify the formats to match the preferences of your part of the world.
Part I  The Basic Mac

**FIGURE 5.4**
Leopard is an international wiz, with over 18 languages to choose from.

![Image of Language Preferences window]

**FIGURE 5.5**
Be careful when making these selections! Euros, dollars, and pesos, for example, are entirely different beasts.

![Image of Regional Settings window]
**Input Menu**
The Input Menu helps you tell Leopard how your keyboard is laid out. Different languages require their own unique layouts of keys, and this tab lets Leopard know how to map those keys.

One of the most useful features of this tab is the Characters palette, shown in Figure 5.6, which allows you to access special characters, such as decorative arrows, common symbols used in mathematical equations, unique bullet points, and the like.

**FIGURE 5.6**
Use special characters in your documents with the help of the Characters palette.

To use the Characters palette:

1. Check the box next to Characters palette in the list, as shown in Figure 5.7.
2. Select the box called Show input menu in menu bar at the bottom of the pane.
3. The input menu appears in your menu bar with an icon of a small flag.
4. Click the Input Menu icon from within any application and select Characters palette to access the special characters you need.

**Security**
Leopard is a secure operating system, meaning it has all the right tools to prevent prying eyes from seeing what you don't want them to see. Some of these tools are off by default due to just how secure they really are. Read on and you'll see what I mean.
Part I  The Basic Mac

FIGURE 5.7
The Input Menu tab of the International preferences pane is where you enable the Characters palette.

![Input Menu Tab](image)

General
This tab contains some of the more basic security options of Mac OS X. All of the options in this pane, shown in Figure 5.8, are self-explanatory and don't require much delving into. Most are very helpful, but some of the options are not much more than simply irritating to the average user, such as the check box labeled Require password to unlock each System Preferences pane.

FIGURE 5.8
Basic Leopard security features

![Security Tab](image)
The Nuts and Bolts of System Preferences

One caveat I must discuss is the Disable automatic login option. If you are even the slightest bit security-conscious, you will not leave this box unchecked. Doing so leaves your Mac wide open to anyone who happens to walk by it when you are away from your desk. The next thing you know you’re receiving unsolicited e-mails from the Jelly-of-the-Month Club that the passerby decided to sign you up for. It could be far worse than that if the person doesn’t like you or has a mean streak.

FileVault

FileVault is the ultimate answer for securing the contents of your home folder. FileVault encrypts the files and folders in the home folders for which it is enabled, preventing access to them without the login password for the account or the master password, which you create when you first turn on FileVault. FileVault stores the encrypted home folder in a disk image. The master password can be used to recover data from the FileVault disk image if you or another user forgets the account’s login password.

Do not forget the master password. If you lose the master password and the login password for your account, your data will be lost—forever! There is no way to recover data from an encrypted FileVault disk image without either the master or login password. Not even an administrator can access data without that information.

I can’t recommend that you use or don’t use FileVault: It depends on the level of security you want to attain. Another factor in your decision to use it is your ability to remember the master password. If you have a tendency to easily forget your ATM PIN or anniversary date, using FileVault is probably not a good idea.

The FileVault tab, shown in Figure 5.9, affords you the options of setting a master password and turning on FileVault for the account you are working in.

Figure 5.9

The FileVault tab is security central. Heed the warnings!
If you receive a warning that there isn't enough space on your hard drive when turning on FileVault, you'll need to make room on the drive by deleting unnecessary files and/or applications.

**Firewall**

A firewall blocks unsolicited network traffic from bugging you or your Mac. In other words, it keeps potential bad guys from getting information from your computer that you would rather they didn't. Leopard comes with a firewall built right in as part of its UNIX underpinnings. This firewall is very secure and robust, and it is also easily configurable. Click the Firewall tab to see the options available to you (Figure 5.10).

**FIGURE 5.10**

The firewall can help keep unwanted network traffic at bay.

![Firewall settings](image)

The Mac OS X firewall gives you three options:

- Allow all incoming connections, which places no restrictions at all on incoming network traffic.
- Allow only essential services, which blocks all nonessential traffic. Apple provides a list of what it considers to be nonessential services on its support Web site: `www.apple.com/support/`. Search the Knowledge Base for "firewall."
- Set access for specific services and applications, which allows you to customize which services and applications can be accepted. If you have any sharing services enabled, such as file or printer sharing, they are automatically added to the list. Add applications to the list by clicking the + button in the lower left corner.
Click the Advanced button in the lower right corner to access two more options: Enable Firewall Logging and Enable Stealth Mode. Enable Firewall Logging tells your Mac to keep an ongoing register of all network traffic, which can be helpful when diagnosing networking issues. Enable Stealth Mode tells your Mac to keep quiet when any network traffic hits it. Your Mac is invisible to all other devices on the network.

**Spotlight**

The Spotlight preferences pane tells Leopard how to interact with the files on your Mac when conducting a search. See Chapter 2 for more extensive coverage.

**Hardware: Interacting with Other Devices**

The Hardware section of System Preferences is where you tell your Mac how to interact with other devices. Settings run the gamut from how it talks to Bluetooth-enabled devices and how it handles optical discs, to how to monitor settings and sound options.

**Bluetooth**

Bluetooth is a very common wireless protocol that is used by many devices ranging from cell phones and PDAs to mice, keyboards, and even some printers. Most Macs today have Bluetooth built in, but older Macs require a Bluetooth adapter of some sort (usually a USB adapter).

The Bluetooth preferences pane, displayed in Figure 5.11, is where you go to enable or disable Bluetooth on your Mac, as well as configure other Bluetooth-enabled devices that it connects with.

**FIGURE 5.11**

Setting up Bluetooth connectivity is simple.
Part I The Basic Mac

To enable Bluetooth for your Mac, check the On box. To allow other Bluetooth devices to see your Mac, check the Discoverable box.

Click the Advanced button in the lower right corner to see several more options that control how your Mac handles certain situations with Bluetooth. The descriptions under each option are self-explanatory.

**CDs & DVDs**

The CDs & DVDs pane, shown in Figure 5.12, is the most self-explanatory of the lot. This pane simply tells your Mac what task to perform, if any, when you insert a CD or DVD into its optical drive.

![Figure 5.12](image)

Telling your Mac how to handle CDs and DVDs

**Displays**

This pane, shown in Figure 5.13, lets you adjust the display, or monitor, of your Mac.

In the Display tab, you can set the default resolution you want it to use, the number of colors it should reproduce, and the refresh rate of the monitor. Click the Detect Displays button to have Leopard automatically discover the resolutions and refresh rates supported by your display.

The Color tab allows you to select a color profile for your monitor. The neatest part of this tab is the Calibrate button, which, when clicked, opens the Display Calibrator Assistant. The Display Calibrator Assistant walks you through choosing color preferences, and builds a color profile based on those preferences. The default mode lets you select a target gamma and a target white point, but checking the Expert mode box (found on the Introduction screen of the Display Calibrator Assistant) allows you to determine your display's native luminance response curves, as shown in Figure 5.14.
The Nuts and Bolts of System Preferences

FIGURE 5.13
The Display preferences adjust your monitor's resolution and color settings.

FIGURE 5.14
Fine-tune your display's color.

Energy Saver
The Energy Saver preferences pane, displayed in Figure 5.15, is where you determine the allotted time of inactivity before your Mac goes into sleep, or power saving, mode. Adjust the sliders in the Sleep tab to the desired amount of inactive time for both the computer itself and the display.
Determine how often your Mac gets a little shut-eye.

The Settings for popup menu offers options for using a Power Adapter or Battery if you are using a Mac laptop, and the Optimization popup menu lets you choose from preconfigured settings or a custom setting of your own.

If you are running a laptop without a power adapter, it's a good idea to make the inactive time intervals shorter than you normally might. This helps preserve the battery's power if you aren't going to be near a power source for some time.

The Options tab offers just that, more energy-saving options that help you manage your Mac's power usage.

Click the Schedule button to have your Mac wake up and go to sleep at a certain time each day. This way your Mac can be gearing up for the workday ahead while you're getting that first cup of coffee in the morning.

Keyboard & Mouse
The Keyboard & Mouse preferences pane offers several tabs for configuring how your input devices work on your Mac.

Keyboard
The Keyboard tab lets you set the Key Repeat and Delay Until Repeat rates. See Chapter 1 for more information on the Use all F1, F2, etc. keys as standard function keys option and the Modifier keys button.
Trackpad
This tab, shown in Figure 5.16, is only available if you are using a Mac laptop, such as a MacBook or MacBook Pro.

![Figure 5.16](image)

Keep your laptop “on track” with this tab (that was a terrible play on words, I know, but I couldn’t resist).

Mouse
The Mouse preferences pane is also covered in Chapter 1. Use it to adjust the way your mouse interacts with your Mac.

Bluetooth
Your Mac can use a wireless mouse and keyboard, which gives you a bit more freedom in your workspace. Wireless mice and keyboards use Bluetooth to connect to your Mac, and this preferences pane shows you the power status and names of both devices. Check the box next to Allow Bluetooth devices to wake this computer. This allows a move of your wireless mouse or the press of a key on your wireless keyboard to wake up your Mac when it is in a sleep state.

Keyboard Shortcuts
Keyboard shortcuts are a fantastic way to perform common tasks quickly and easily, but most people are only aware of the most common ones, such as ⌘C to copy text, ⌘P to print a document, and so on. This tab, displayed in Figure 5.17, gives you a long list of preconfigured shortcuts you may not be aware of, and even offers you the chance to make your own custom shortcuts.
Click the + button under the list to create your own custom keyboard shortcuts.

Print & Fax
The Print & Fax preferences pane is where you set up printers and fax machines, configure installed printers, and manage print jobs. Chapter 12 covers all the bases of this pane from top to bottom.

Sound
The Sound preferences pane, shown in Figure 5.18, helps you configure all things sound related. The Output volume slider at the bottom of the pane is always present, regardless of the tab you are in. Move the slider to turn the volume of your Mac up or down. Check the Mute box to silence your Mac.

For quick, on-the-fly adjustment of volume, I always keep the volume icon in the menu bar. To do so, check the box next to Show volume in menu bar. If your keyboard is so configured, you can also use the keys on it that are designated for volume control.

Sound Effects
Your Mac alerts you with a sound when there is a problem or when a task needs attention. The Sound Effects tab is where you set the default alert sound for your Mac and adjust the volume of the alert.
The Sound preferences pane is ready to configure your Mac’s bells and whistles.

Output
Select a default device for sound output from your Mac. If you have external speakers connected to your Mac, they would be in the list along with the built-in speakers. Adjust the balance between the speakers using the Balance slider.

Input
Your Mac is just as adept at listening as it is at talking, using its built-in microphone or another external mic. This tab is where you select a default listening, or sound input, device. Move the slider to configure the Input volume level.

Internet & Network
The abilities to surf the Web and to communicate with other computer users around the globe are probably the two most important functions of computers today, and as is usually the case, your Mac is very easy to get up and going on the Internet and/or a network. The Internet & Network section of System Preferences is where you tell your Mac how to connect to the outside world.

MobileMe
MobileMe is Apple’s fantastic offering of Web services, which was formerly known as .Mac (see www.apple.com/mobileme/ for more information on the name change and transition). This preferences pane is where you can set up your MobileMe user account. Enter your MobileMe member name and password in the proper fields, and you can do things like synchronize your
contacts and Safari favorites between multiple Macs and your iPhone, retrieve e-mail from any computer in the world, upload pictures and videos to share with others, and a whole host of other options. See the aforementioned Web site for more details. Click the Learn More button to sign up for a free 60-day trial MobileMe membership.

**Network**

The Network preferences are discussed extensively in Chapter 7.

**QuickTime**

Chapters 1 and 17 cover the technology behind QuickTime and how to utilize it for a rich multimedia experience, but here I simply cover options available in the QuickTime preferences pane.

**Register**

If you purchased QuickTime Pro, enter your registration name and code in the appropriate fields of this tab to activate the professional QuickTime options. Click the Buy QuickTime Pro button to claim your QuickTime Pro registration information if you wish to purchase the upgrade.

**Browser**

This tab, shown in Figure 5.19, lets you tell your default Web browser to play QuickTime movies as they are being downloaded, and whether to save those downloaded movies in the disk cache for faster loading if you wish to view them again in the future. Use the slider to allocate the amount of space on your hard drive that is set aside for such downloads. Click the Empty Download Cache button to clear the downloaded movies from the cache and free up that hard drive space.

---

**FIGURE 5.19**

Tell your favorite Web browsers how to handle QuickTime movie downloads using options in the Browser tab.
The Nuts and Bolts of System Preferences

Update
The Update tab performs one function only: It takes you to Apple's QuickTime Web site where you can view the list of optional plug-ins and technologies that can be used to enhance QuickTime's already stellar capabilities. Click the Install button to see the QuickTime Components site.

Streaming
When you are watching movies on the Internet, QuickTime automatically discovers your Mac's Internet connection speed, which should allow your Mac to play back the movie without many, if any, glitches. If your movie is stuttering and stalling, the connection speed may be lower than QuickTime thinks. Change the Streaming Speed selection to match that of your Internet connection if this occurs. If you don't know the speed of your connection, contact your Internet Service Provider.

Check the Enable Instant-On box to have your Mac begin playing streamed media immediately. Move the slide to adjust the delay time if you are experiencing playback problems.

Advanced
Table 5.2 lists the options available in the Advanced tab.

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Synthesizer</td>
<td>Used for playing MIDI files. Automatically set to the default QuickTime Music Synthesizer, which is perfectly suited to the needs of the vast majority of users. You can change this option if you have a third-party synthesizer installed.</td>
</tr>
<tr>
<td>Transport Setup</td>
<td>Determines how your Mac handles connections to streaming media. The default is RTSP (Real-Time Streaming Protocol), but you may need to change it to HTTP if you are using a firewall.</td>
</tr>
<tr>
<td>Enable kiosk mode</td>
<td>Perfect for Macs that are used by the public, such as in a library or at a tradeshow. Check this option to prevent users from changing QuickTime settings and saving movies.</td>
</tr>
<tr>
<td>Show legacy encoders</td>
<td>Allows you to export video and audio using older codecs.</td>
</tr>
<tr>
<td>MIME Settings</td>
<td>Every audio and video file has a MIME setting, which tells QuickTime what kind of file it is. Click this button to modify MIME settings or to add new ones to the list.</td>
</tr>
<tr>
<td>Media Keys</td>
<td>Media keys are used to secure access to restricted QuickTime files. The person who created the files should provide these keys. Add the keys to QuickTime to be able to view or listen to the files.</td>
</tr>
</tbody>
</table>
Part I  The Basic Mac

Sharing
This preferences pane is discussed in detail in Chapter 8, which is dedicated to sharing.

System: Modifying Leopard
The preferences in the System section make changes that affect your Mac system-wide. Many of these panes are discussed in other chapters throughout this book.

Accounts
This preferences pane is given its due in Chapter 6.

Date & Time
Making certain that your Mac is set to the correct date and time is integral to many functions. If the wrong date is set on your Mac, iCal may not remind you in time of that important appointment you made a month ago, or the scheduled printing of documents may not occur when you meant them to. These are but two of countless other examples that illustrate the importance of the Date & Time preferences pane, shown in Figure 5.20.

FIGURE 5.20
Configure all things time-related right here.
**Date & Time**
Select the Date & Time tab to set both options either automatically or manually.

To set the date and time automatically, simply check the box, then select a time server from the popup menu. Uncheck the Set date & time automatically box to enter the info manually.

To set the date manually, do one of the following:

- Use the directional arrows in the upper left corner of the calendar window to find the appropriate month and then click the correct day.
- Type the information into the date box.

To set the time manually, just type the correct time into the time box.

**Time Zone**
As you see in Figure 5.21, setting the time zone for your Mac is as easy as clicking your geographical location on the map. Once you have the time zone correct, you can select the closest city to you from the popup menu.

**FIGURE 5.21**
The world is a big place, and has a lot of time zones to choose from.

**Clock**
The Clock tab allows you to modify how the clock appears in the upper right of the menu bar, should you choose to leave it displayed there, of course.
The one option I find indispensable on this tab for troubleshooting purposes is the Display the time with seconds box. I like to have that selected so that when my computer doesn’t seem to be responding I can tell if Leopard itself is frozen up or if it’s simply an application that’s misbehaving.

If you are so inclined, for reasons of poor eyesight or just simply to have a little fun, you can tell your Mac to speak the time aloud to you. To turn on this option, check the Announce the time box, use the popup menu to determine how often the time should be spoken, and then select a voice to use by clicking the Customize Voice button.

Parental Controls
Chapter 6 goes into all the juicy details of the Parental Controls preferences pane.

Software Update
One of Leopard’s best features is its ability to search Apple’s servers for updates to the operating system or to any of Apple’s applications. This feature is called Software Update, and its preferences pane (Figure 5.22) is where you tell it how to behave.

Keep your system up-to-date with automatic updates to its operating system and software.

Scheduled Check
This tab is where you tell Software Update how often to check for updates. Click the Check for updates box and then choose a time interval for Software Update to automatically find updates from Apple. Check the Download important updates automatically box to have updates that Apple deems as must-do’s downloaded to your Mac as soon as they are available.
The Nuts and Bolts of System Preferences

If you’re the impatient type, or simply want to see if any new updates are available on your own time, click the Check Now button.

**Installed Updates**
This tab lists exactly what you think it does: updates that you’ve installed on your Mac.

**Speech**
Your Mac can speak to you if you want it to. What’s more, it even takes spoken commands from you! All this right out of the box; no third-party software required.

**Speech Recognition**
The Speech Recognition tab (Figure 5.23) is a dangerous place to be. I say that to warn you not of impending doom, but of impending loss of time. When you start playing with the options in here, you can get so wrapped up in how fun it is that you’ll wonder where those hours went. To enable Speakable Items, click the On radio button.

![FIGURE 5.23](image)

Literally tell your Mac what tasks to perform!

Table 5.3 lists the options available in the Speech Recognition tab of the Speech preferences pane.
TABLE 5.3

Speech Recognition Options

<table>
<thead>
<tr>
<th>Section</th>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Settings</td>
<td>Microphone</td>
<td>Select the microphone used by your Mac to listen for your spoken commands. Click the Calibrate button to open the Microphone Calibration window, and follow the instructions to make sure your mic is optimized to listen for your voice. This is a very important step in the speech recognition process.</td>
</tr>
<tr>
<td>Settings</td>
<td>Listening Key</td>
<td>Your Mac listens for commands only when the listening key is pressed. Click the Change Key button to choose a different key than the default, which is ESC.</td>
</tr>
<tr>
<td>Settings</td>
<td>Listening Method</td>
<td>You can have your Mac listen only when the listening key is pressed, or when you issue a keyword.</td>
</tr>
<tr>
<td>Settings</td>
<td>Upon Recognition</td>
<td>Your Mac makes a sound, designated by the Play this sound popup menu, when it recognizes a command you give it. You can also have it speak an acknowledgement when it understands the command by checking the Speak command acknowledgement box.</td>
</tr>
<tr>
<td>Commands</td>
<td>Select a command set</td>
<td>This is a list of preconfigured commands that have been divided into categories, according to their functions. Check or uncheck their boxes to enable or disable them.</td>
</tr>
<tr>
<td>Commands</td>
<td>Configure</td>
<td>Highlight a command set, and then click the Configure button to modify how those commands are affected. This button is not active for all command sets.</td>
</tr>
<tr>
<td>Commands</td>
<td>Open Speakable Items Folder</td>
<td>Click this button to open a Finder window directly in the Speakable Items folder. You can see the list of all preconfigured commands here.</td>
</tr>
<tr>
<td>Commands</td>
<td>Helpful Tips</td>
<td>Click this button! The tips given in the window that opens are priceless and can help you avoid a lot of frustration.</td>
</tr>
</tbody>
</table>

Text to Speech

Use this tab to select a default system voice for your Mac and determine how fast it speaks to you. There are also options here for having the Mac tell you when you have alerts and when an application needs your attention, and to speak highlighted text to you when you press a certain key combination that you specify (once you check the Speak selected text when the key is pressed box).

Startup Disk

Your Mac can be booted from any hard drive or CD/DVD connected to it that contains a Mac OS X installation. Use this preferences pane to select which drive is to be the default startup disk. Click the Restart button to have the Mac restart using the disk selected.
The Nuts and Bolts of System Preferences

Time Machine
Chapter 22 has an exhaustive amount of information about this pane.

Universal Access
The Universal Access preferences pane is a huge help to those users who have a difficult time controlling their Mac due to physical hindrances, such as poor eyesight or hearing. The tabs in this pane help address these issues.

Seeing
The Seeing tab, shown in Figure 5.24, can give a big boost to those Mac experts who need a little help with seeing items on the screen.

![Figure 5.24](image)

These options help a user see exactly what’s going on.

VoiceOver tells your Mac to read aloud any text the mouse pointer passes over, Zoom makes portions of the screen larger or smaller using keyboard shortcuts, and Display can reverse the color values, making text easier to read for some users.

Hearing
The primary function of this tab is to help hearing-impaired users be aware of when the Mac issues an alert by flashing the screen several times.
Keyboard
The Keyboard tab helps users who may have difficulties holding down multiple keys at once or who have trouble with repeated keystrokes. Use the Sticky Keys option to help with the former, and the Slow Keys option for the latter.

Mouse & Trackpad
If you have problems using a mouse to point at items on the screen, you can enable Mouse Keys and then use the numeric keypad of your Mac to move the pointer. If you use a laptop, press the F6 key to enable number lock, and then use the number keys (numbers are located in the lower right corner of some of the keys on your keyboard). Another tip for laptop users: Check the box next to Ignore trackpad when Mouse Keys is on to prevent the trackpad from interfering with mouse pointer navigation if it is accidentally touched.

You can also dramatically increase the size of the mouse pointer by adjusting the Cursor Size slider.

Summary
Chapter 5 has given you a basic understanding of all the System Preferences panes, which control how your Mac works and plays. This chapter helped you to know what options are available and dropped a few helpful hints, tips, and cautions along the way. If you want to customize your Mac’s appearance, enhance security, manage your kids’ computing time, and more, this is the place for you, dear Mac user.
Does your spouse or child frequently use your Mac, and subsequently rearrange its icons and delete items you would prefer he or she didn't? Do you have co-workers who need to use your Mac, but you don't want them getting their mitts within 10 feet of your computer for fear that it might meet a terrible fate? If this experience sounds anything like you, or if you are an IT professional who needs to restrict access to a Mac, this chapter is right up your alley.

Mac OS X allows your Mac to be used by more than one person by adding multiple user accounts. User accounts have become a necessity in my home and business. You can create user accounts for each individual who accesses your Mac. These user accounts are secure and are meant to be utilized only by the person assigned to the account, or by an administrator of the computer. The best thing about user accounts is that each user can customize their account to their specs, personalizing the work environment to suit their tastes without affecting any of the other users. The people at Apple think of everything, don't they?

**User Account Types**

Imagine that your Mac is a highly secured government building that you work in. In order for security to be, well, secure, there must be appropriate levels of access assigned to everyone who works in the building. You’re in charge of security in your building, and you have access that most others don’t have and don’t need. Some workers may have their own offices that they can decorate and furnish to their liking, and they can even lock the office door before they leave, but because you’re in charge of security, you still have a master key that can unlock that office.

**IN THIS CHAPTER**

- User account types
- Create new user accounts
- Set Parental Controls
Part I  The Basic Mac

Other workers may only perform their duties in cubicles that anyone can walk into, with virtually no privacy and with limits on how much they can personalize their workspace. People who don’t work at the building can only enter if they are given a guest pass; otherwise they can’t come in at all.

While perhaps not a perfect analogy, this closely describes the way your Mac handles security, and how you, as the administrator of your Mac, take an active role in telling the Mac who to let in, and to what degree they can tinker with its contents. Let’s have a look at the different types of user accounts made available in Mac OS X.

Administrator

Administrator accounts have the most control over the system. Administrator, or admin, accounts can alter file permissions, create and delete user accounts, install and remove software, and get invited to all the best parties. The account you created the first time you logged in to Mac OS X is an admin account, granting you the title and responsibility of administrator. Admins are limited in what they can view in other accounts’ home folders, but they do have the authority to completely remove any user account they see fit. You can certainly see by that last sentence that admin accounts have their pluses and minuses, and you don’t want to flippantly grant someone those kinds of responsibilities without knowing you can trust him to wield his power judiciously.

Standard

Standard accounts are typical for most users. They allow the user to tend to his own account, even letting him go so far as to install software for the strict use of those logged in to that specific account. However, a standard-account user can’t administer the system-wide goings-on of the Mac, completely preventing him from changing the content of other accounts and removing or adding software used by others on the system.

It’s always a good idea for those new to the Mac to create a standard account for them to do the bulk of their work under, and log in to their admin account only when system-wide tasks need to be performed. This prevents any accidents from occurring during normal use, in turn preventing some very large headaches that I discuss in more detail in Chapter 21.

Managed with Parental Controls

These accounts are used to restrict access to the Internet, and are basically just modified standard accounts. Parental Controls gives an admin the ability to allow or prevent access to material on the Web they may deem questionable or offensive. E-mail and chat are also kept in check using Parental Controls, giving the admin more than a modicum of peace of mind when users of these accounts are logged in.
The Root User Account

There is one other account type that I want to discuss with you: the root account. Remember your admin account and all the power you wield while logged on to it? Compared to the root account, admin accounts are child’s play. The root account has the ultimate word over your entire system. It can access any file at any time. This bodes well when it comes to resolving problems such as deleting stubborn files or stopping runaway processes, but strikes terror into the heart of most IT administrators due to the unfettered ability of a root account to completely destroy an entire system in a matter of seconds. However, sometimes an admin account may not be able to accomplish a task that you need performed, so enabling the root account is your only recourse. To enable the root account:

1. From within the Finder, press fn+Shift+U, and then double-click the icon for Directory Utility.
2. Click the lock icon in the lower left corner of the Directory Utility window, and then enter your account password.
3. From the menu, choose Edit ¦ Enable Root User.
4. Enter a password for the root account in both the Password and Verify fields, and then click OK.

Sharing Only

Sharing-only accounts work as advertised: They allow users to access only items that you (or other users) decide to share. A user of a sharing-only account can only log in to the account remotely (from another computer) and has absolutely no rights to make any changes at all to the Mac.

Group

A group account is one that other accounts can become members of. This type of account lets you share files with only those in the specific group. You cannot log in to Leopard using a group account.

Create New User Accounts

Now that you have a good understanding of each account type, we need to add a user account. There is only one place to begin, and that’s in System Preferences:

1. Click the Apple menu in the upper left of your screen and select System Preferences.
2. Click the Accounts icon in the System section to open the Accounts preferences pane, shown in Figure 6.1.
The Accounts preferences pane is where administrators control user accounts.

3. Click the lock icon in the lower left corner of the window to make changes to accounts. Enter the password for your admin account when prompted.

4. Click the + icon above the lock to open the new account creation window, shown in Figure 6.2.

5. Choose the type of account you want to create from the New Account popup menu.

6. Enter a name for the account. The Short Name field is automatically populated based on what you enter in the Name field, but can be changed if you prefer.
7. Enter a password for your account in the Password and Verify fields. If you’re having trouble coming up with a password on your own, click the key icon to open the Password Assistant window, illustrated in Figure 6.3.

![Password Assistant](image)

**FIGURE 6.3**
Use the Password Assistant to let Leopard choose a secure password for you.

---

**CAUTION**
A password is not necessary to create an account, but it is most definitely recommended that you have one. An account without a password can be accessed by anyone who touches your Mac, and if the account is an administrator type, significant damage can be done to your system.

8. Enter a password hint if you feel you need one. Apple recommends you use one, but this is an area that I will agree to disagree with them. In my opinion, a password hint only increases the chance that someone else can guess your password. I don’t need that kind of trouble, thanks.

9. If you want to use FileVault, check the Turn on FileVault protection box. Chapter 5 discusses FileVault in depth.

10. Click the Create Account button and Leopard activates the new account, creating a new directory for the account in the Users folder. The new account shows up in the list of accounts on the left side of the pane.

---

**Customize your account**
You’ve created an account, and now it’s time to see how to make adjustments to that account. You never know when the urge (or need) to change something as trivial as your login picture or as tantamount as your password will crop up.

**Change your login picture**
Every account created is represented by a login picture. This picture can be any of the default pics offered by Leopard (one is automatically chosen for you when you create the account), or you can make your own.
To set a login picture:

1. Click your account name in the accounts list to see the items you can make changes to.
2. Be sure the Password tab is selected at the top of the pane, as shown in Figure 6.4.

![Figure 6.4](image)
The Password pane for your user account will look similar to this screen shot.

3. Click the picture box to see a list of default pictures that come with Leopard.
4. Select the picture that you want to represent your account at login, or click Edit Picture to choose a different picture.
5. You have a few options in the Edit Picture window, shown in Figure 6.5:
   - Choose the Recent Pictures popup menu to quickly find a picture you’ve used recently.
   - Click the camera button to take a picture of yourself, if your Mac has a built-in camera.
   - Click the Choose button to browse your Mac’s hard drive for a picture you would like to use. Once you select the picture, use the slider to shrink or enlarge the picture to fit in the allocated space.
6. Click Set to define your custom picture as your login pic.

**Change your password and user name**
To change your user name, simply type a new name in the User Name field.

Change your password by clicking the Change Password button, enter your current password in the Old Password field, and then enter your new password in the New Password and Verify fields. Click the Change Password button when finished.
Manage User Accounts

**FIGURE 6.5**
The Edit Picture window allows you to personalize your account's login picture.

---

**Login Items**

Login Items can be a blessing or a curse. Login Items allows you to designate programs or utilities to start up, or launch, as soon as you log in to your account. This can save time and a lot of mouse-clicks if you have applications that you know you use every time you log in to your account, such as an e-mail program or word processor. On the other hand, it can be a source of frustration if some silly program automatically adds an item to this list without your knowledge, such as a certain printer manufacturer I won't mention here (no, not the one I work for). Applications that launch when you log in can increase the length of time it takes for your Mac to get to a workable state, so be careful what you allow to be in your Login Items. To modify your Login Items:

1. Select your account from the accounts list and click the Login Items tab at the top of the pane.

2. Figure 6.6 shows the Login Items pane. Apps and utilities that are set to launch when you log in are shown in the list. To launch any of these items in the background, simply check the Hide box next to their names.

3. Add items to this list by clicking the + button beneath it and then browsing your Mac's hard drive for the application or utility you want to toss in. Select your target and click the Add button to have it start up at login.

4. Remove an item from the list by highlighting it and then clicking the – button underneath the list.
Login Options

The Login Options button is at the bottom of the accounts list. Login Options determine exactly how your Mac goes about the process of allowing users to log in to their accounts. Table 6.1 discusses Login Options in detail.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic login</td>
<td>This option is only useful for automatically logging in to a single account, so if there are multiple accounts on the system, enabling it is pointless.</td>
</tr>
<tr>
<td>Display login window as</td>
<td>Determines how the list of user accounts is viewed when the login window displays. Choices are to view the account names in a list, or simply supply fields for users to enter their account name and password. The latter is the most secure, since a trespasser most likely won't know the exact account names to begin with.</td>
</tr>
<tr>
<td>Show the Restart, Sleep, and Shut Down buttons</td>
<td>Lets you decide whether these buttons are displayed on the login window. If security is what you are after, don't check this box. Malicious folks may be able to reboot your Mac using a CD or external hard drive and gain unauthorized access to its files.</td>
</tr>
<tr>
<td>Show Input menu in login window</td>
<td>Allows users to choose different keyboard input languages at login.</td>
</tr>
</tbody>
</table>
Option | Description
---|---
Show password hints | If you entered a password hint when creating a user account, this option allows the hint to be shown after three unsuccessful login attempts.
Use VoiceOver at login window | With this option checked and VoiceOver activated (see more about this topic in Chapter 5), a user can use the VoiceOver technologies when logging in to his account.
Enable fast user switching | One of my favorite Mac OS X features, fast user switching empowers multiple user accounts to be logged in at the same time. Use the View as popup menu to determine how account names are seen in the fast user switching menu, illustrated in Figure 6.7.

**Figure 6.7**
The fast user switching menu is in the upper right corner, and appears as the name of the currently active account. Click the menu and select a different account to log in to.

---

**Set Parental Controls**

Parental Controls is a godsend, plain and simple. Whether you are a parent or an IT administrator, there comes the time when you have to decide how much freedom a user can have. For children, the benefits are obvious: Parental Controls prevents access to sites on the Web you don't want your
Part I  The Basic Mac

kids to see, limits the people they can exchange e-mails and chats with, and can even tell the little computer whiz when it's time to go to bed. For some IT admins, these very same features (and sadly, for some of the same reasons) make Parental Controls useful for limiting how far employees in the company can go with their Internet access. To use Parental Controls for a user account:

1. Highlight the account you want to set limits for in the accounts list.
2. Check the box called Enable Parental Controls.
3. Click the Open Parental Controls button to immediately open the Parental Controls preferences pane, shown in Figure 6.8.

![FIGURE 6.8](image)
The Parental Controls preferences pane

4. You can also remotely manage Parental Controls. Check the Manage parental controls from another computer box to let you log in from another Mac using an admin account name and password for the Mac you are making changes to.
5. Select an account from the list on the left side of the pane to begin establishing boundaries.

The System tab

The System tab (Figure 6.9) determines the applications and utilities you can launch and use, as well as what kinds of tasks you can perform while logged in to this account.
Use Simple Finder

Simple Finder is a version of the Finder that is pared down to accommodate novice users, such as the very young or those who are new to computers and aren’t quite comfortable with them. Simple Finder, shown in Figure 6.10, is perfect for kids, but may be a little too restrictive for the average adult. Check the Use Simple Finder box in the System tab to enable the Simple Finder for the user account selected.

Limit application usage and tasks

Check the Only allow selected applications box to confine the user to just those programs you deem necessary for their use. Application categories are displayed in the list. Click the gray triangle to the left of each category to expand it and see items it contains. Check the boxes next to programs you want users of this account to utilize, as shown in Figure 6.11.

TIP
To quickly find an application, simply type its name in the search field, which is designated by the magnifying glass.

Select or deselect the boxes to determine whether the user can perform these tasks listed at the bottom of the System tab:

- Administer printers.
- Burn CDs and DVDs.
- Change the account password.
- Modify the contents of the Dock.
A user account logged in to a Simple Finder

Use the System tab to browse the list of applications and utilities for items the account can access.
The Content tab

The items of the Content tab help eliminate content you may feel is inappropriate for the user of the account to read or view.

Check the Hide profanity in Dictionary box to prevent, shall we say, the more colorful words in the English language from being seen by innocent eyes.

The Website Restrictions area of the Content tab gives you these three options:

- **Allow unrestricted access to websites.** I doubt most users of Parental Controls will want to click this option.
- **Try to limit access to adult websites automatically.** This option uses Leopard's built-in Web filters to prevent a user from going to certain sites. You can adjust what the filters look for in an acceptable or unacceptable site by clicking the Customize button.
- **Allow access to only these websites.** Leopard shows you a list of predetermined Web sites, shown in Figure 6.12, that are kid-friendly. You can add or remove sites to and from the list by clicking the + and – buttons, respectively.

**FIGURE 6.12**

Keep it clean using the Content tab.
The Mail & iChat tab

The Mail & iChat tab allows you to specify exactly who the user of the account can exchange e-mail and chats sessions with. The importance of this tab, which is shown in Figure 6.13, is self-evident, especially when it comes to protecting your children while they converse with the world that's outside their home. To make these specifications:

**FIGURE 6.13**
The Mail & iChat options help keep your children safe when exchanging e-mail and instant messages.

1. Check the boxes next to Limit Mail and Limit iChat to place restrictions on e-mailing and chatting, respectively.
2. Click the + button below the list window to add people to the list of allowed e-mail and chat participants.
3. If you would like to use your Address Book to add a person to the list, just click the downward-pointing arrow to the right of the Last Name field to see contacts just in your Address Book. Select the person from the list and click Add.
4. If you're manually entering the name of the person, as shown in Figure 6.14, type the person's first name and last name in the appropriate fields.
5. In the Allowed accounts area, enter the e-mail and/or instant messaging addresses for the person. Click the + button to add multiple addresses, or click the – button to remove them.

6. Check the Add person to my address book box to do just that.

7. Click Add.

![FIGURE 6.14](image)

Adding a person to the list of approved e-mail and chat participants.

First Name: Friendly
Last Name: Person

Check the box next to the Send permission requests to field so that you can be notified if the user of this account tries to e-mail someone who is not on the approved list. I love this feature! It makes me feel more secure knowing that I have control over who talks to my kids and who they initiate contact with.

The Time Limits tab

The Time Limits tab, shown in Figure 6.15, is a dream come true for parents. An admin can choose to limit the amount of time each day that a user of a managed account can utilize the Mac. You can even set different time limits for weekdays and weekends. Simply adjust the sliders to the amount of time you want to allow the user to have in front of the computer.

You can also limit the hours of the day the account can be logged in. Check the boxes next to the School nights and Weekend options, and adjust the times of day the computer can be used.

If someone tries to log in to the account during off hours or after the time limits for the day have expired, they are greeted with a message box explaining that they can’t log in without permission from an admin. If an admin feels the user of the account needs more time, they must enter their user name and password and specify the amount of extra time that can be allotted.
Part I  The Basic Mac

FIGURE 6.15
The Time Limits tab helps you keep your kids from zoning out in front of your Mac all day and night.

The Logs tab
Logs are the security-conscious parent’s and IT administrator’s best friend. Leopard keeps an ongoing tally of activities that have occurred for managed accounts, and admins can view that activity here in the Logs tab, as shown in Figure 6.16.

Information that can be tracked includes the following:

- Web sites the user of the account has successfully visited
- Which restricted sites the user of the account attempted to visit and were blocked by Parental Controls
- Applications opened by the account user
- Instant messages that have been sent with iChat

To view the logs, simply click one of the items in the Log Collections list. You can also view items, such as Web pages, by highlighting the item in the Logs window and clicking the Open button. Disable the user account’s ability to access a site by clicking the Restrict button.
Summary

Security is no laughing matter and should be taken seriously to safeguard not only the information on your Mac, but also the children we've been charged with protecting. This chapter has covered the management of user accounts in detail so that you can clearly understand the options available to you as the administrator of your Mac.
Part II

The Networked Mac

IN THIS PART

Chapter 7
Add Your Mac to a Network

Chapter 8
Sharing Files from Your Mac
Mac OS X Leopard is the easiest operating system around when it comes to setting up and working with a network. To make things even simpler, your Mac comes with all the hardware it needs to connect to both wired and wireless networks, taking that extra little step out of the equation. In short, if you want to network a computer, a Mac is what you should be using.

This chapter gives you all the ins and outs of setting up a simple network for your Mac in a home or small office. If you're using your Mac on a large network or connect to a Wide Area Network (WAN), you may want to get your Information Technology department or your Internet Service Provider involved. While the basics are the same when setting up your Mac on a large network, it's best to let your IT department help with any settings that may be needed to access specific segments of the network.

What Is a Network?

In computing terms, networking doesn't entail introducing your Mac to folks in the high places of business or academia for purposes of furthering its career or agenda. While you will be introducing your Mac to other entities, they will comprise computers and printers and the like, not flesh-and-blood people. Apple's Dictionary application (which ships as part of Leopard) cites the New Oxford American Dictionary when giving these definitions of a network or networking:

- A number of interconnected computers, machines, or operations—noun
- Link (machines, especially computers) to operate interactively—verb
These two definitions pretty plainly state the intention of a network, but how do you get from the definition to the actuality? I'm glad you asked, because that's what this chapter is all about!

There are several types of networks that you can set up, but we'll concentrate on the basic network that connects multiple computers to one central location, and also provides Internet access. This is by far the most common type of network and will receive the bulk of the attention here. However, in the strictest sense of the term, simply connecting two computers in one manner or another would constitute a network, as would connecting 5,000 computers around the world with a WAN.

Figure 7.1 illustrates a typical network layout, including several computers that are both wired and wireless, a router, a server, and a printer.
Network protocols supported by Mac OS X

Network protocols determine how devices connect to one another. They set the rules for the connection and the transfer of information between devices. There are more network protocols out there than most computer users will ever need to know about. Table 7.1 lists the network protocols supported by Mac OS X Leopard.

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IEEE 802.1x</td>
<td>Provides authentication for devices connecting to a LAN, either wired or wirelessly.</td>
</tr>
<tr>
<td>DHCP/BOOTP (Dynamic Host Control Protocol/Bootstrap Protocol)</td>
<td>Allows a device to be automatically assigned or to assign itself an IP address.</td>
</tr>
<tr>
<td>LDAP (Lightweight Directory Access Protocol)</td>
<td>Lets the user locate groups, individuals, and resources on the Internet or an internal network.</td>
</tr>
<tr>
<td>FTP/SFTP (File Transfer Protocol/Secure File Transfer Protocol)</td>
<td>Used for transferring files either securely or nonsecurely over a TCP/IP network.</td>
</tr>
<tr>
<td>DNS (Domain Name Services)</td>
<td>Maps the name of your computer with the IP address assigned to it, which makes it easier to find computers on a network.</td>
</tr>
<tr>
<td>NBP (Name Binding Protocol)</td>
<td>Utilized by the AppleTalk protocol for managing device names and services.</td>
</tr>
<tr>
<td>NTP (Network Time Protocol)</td>
<td>Used for synchronizing the time across multiple network clients.</td>
</tr>
<tr>
<td>HTTP/HTTPS (Hypertext Transport Protocol/Hypertext Transport Protocol Secure)</td>
<td>This protocol is the standard for transferring Web pages from their server to the Web browser on a client computer, both securely and otherwise.</td>
</tr>
<tr>
<td>PPP (Point-to-Point Protocol)</td>
<td>Used for dial-up modem access to the Internet.</td>
</tr>
<tr>
<td>PPPoE (Point-to-Point Protocol over Ethernet)</td>
<td>Allows PPP connections via an Ethernet network, such as with DSL.</td>
</tr>
<tr>
<td>SLP (Service Location Protocol)</td>
<td>Lets your computer automatically discover other devices running SLP on an IP network.</td>
</tr>
<tr>
<td>SSH (Secure Shell)</td>
<td>Allows remote computers to log in securely.</td>
</tr>
<tr>
<td>SOAP (Simple Object Access Protocol)</td>
<td>Allows for easy transmission of encapsulated messages through proxies and firewalls.</td>
</tr>
<tr>
<td>S/MIME (Secure MIME)</td>
<td>Lets you securely encrypt e-mail and digital signatures.</td>
</tr>
<tr>
<td>TCP/IP (Transmission Control Protocol/Internet Protocol)</td>
<td>Set of transmission layer protocols used to transmit information over the Internet and internal networks with IP.</td>
</tr>
<tr>
<td>UDP/IP (User Datagram Protocol/Internet Protocol)</td>
<td>Also a transmission layer protocol set that works with IP. Usually used for sending short messages known as datagrams quickly and without need for guaranteed delivery.</td>
</tr>
<tr>
<td>XML-RPC (Extensible Markup Language-Remote Procedure Call)</td>
<td>Sends remote procedure calls using XML via HTTP.</td>
</tr>
<tr>
<td>PAP (Printer Access Protocol)</td>
<td>Used for printing to network printers over an AppleTalk network.</td>
</tr>
</tbody>
</table>
Wired or wireless?

Which way to go: wired network or wireless network? That's a great question, and the best answer is that it depends. I know, I know, you can't get much more noncommittal than that, but it really does depend on several factors, such as:

- Do you need to move locations frequently while working with your Mac? If mobility is not a factor, a wired network is perfectly fine, but if you need the ability to roam, a wireless network is the only way to go. This benefit of wireless networks trumps all the other considerations in favor of a wired one for many people.

- Is cost a consideration? Wired networks are less costly than wireless, but the cost of wireless networks has dropped significantly over the years.

- Does network speed matter to you? Wired networks are typically much faster than wireless. If you are trying to push massive amounts of data over your network—for example, printing large graphics or during Internet gaming—wireless is not the most efficient method, whereas a wired network will zip the data to its destination in a much more timely fashion.

- Will running wires throughout your home or office be a difficulty? If you have computers located in multiple rooms throughout your home or office and are using a wired network, you will either have to run network cables through the walls or have network cables running all over the floors, which wouldn't exactly be considered the safest of practices. With a wireless network there is no need to run cable from the network access point to the computers; communication is handled through radio waves.

- Are you worried about security? A wired network is much more secure than wireless simply because the radio waves from your wireless access point can be picked up outside your home or office. Even though wireless networks have greatly improved security over the years, they still aren't as secure as a wired network, simply because of accessibility.

- Which one is more reliable? Wired networks are more reliable, bottom line. Wireless networks can be hindered by interference from other wireless devices and household appliances, such as a microwave oven or cordless telephone.

Wireless Networks

If you decide that a wireless network is the way to go, this section of the chapter gives you the basic ins and outs of setting up all the wireless tech goodies for wire-free communication.

The following section steps you through a manual setup of your Mac on a wireless network. If you prefer to try letting your Mac automatically discover and set up the network settings, skip to the section entitled “Using the Network Setup or Diagnostic Assistant” later in this chapter. I would suggest reading through this section, though, if only for educational purposes.
Wireless network hardware

If you are going to do any job the right way, you've gotta have the right tools handy. While you may be able to finagle your way through installing a kitchen sink with tools that aren't exactly the best to use, that's not the case for a network. Substituting pliers with a wrench is one thing, but there is no substitution for any of the following:

- **Wireless access point (WAP).** The wireless access point is the device, typically a router, that uses radio waves to broadcast signals to wireless network interface controllers. The technology used for wireless communications is typically known as Wi-Fi, and encompasses the range of 802.11 network standards as defined by the IEEE (Institute of Electrical and Electronics Engineers)—see the following sidebar. We will concentrate on wireless routers in this chapter, as opposed to other types of WAPs. Your Mac will work great with most wireless routers, but Apple has a range of them that will work flawlessly, not only with your Macs but with PCs and other network devices as well:
  - AirPort Extreme (www.apple.com/AirPort Extreme/)
  - Time Capsule (www.apple.com/time capsule/)
  - AirPort Express (www.apple.com/AirPort Express/)

- **Wireless network interface controller (WNIC).** The WNIC is the network card that receives and sends signals to your WAP. All new Macs ship with an AirPort Card or AirPort Extreme Card installed, but if you have an older Mac you can always purchase one from Apple and install it yourself. You can also use a third-party vendor, such as Linksys (www.linksys.com) or Belkin (www.belkin.com). If you don't have a slot in your Mac for a wireless network card, you can get adapters that have USB connections, and just use your USB port to communicate over the network.

Follow the installation and setup instructions for the WAP and WNIC (if necessary) provided by their manufacturer. If the printed documentation that came with the device isn't up to snuff, give the manufacturer's Web site a try, or call their support hotline.
CAUTION If you are using third-party network hardware, don’t bother calling Apple for support, at least not regarding the hardware’s setup or if it is not functioning properly. You will waste a lot of time because they won’t be able to help. Consult the documentation that came with your hardware to find support phone numbers, or visit the manufacturer’s Web site.

How to set up your Mac on a wireless network
Once you have the wireless hardware set up, you need to let Mac OS X in on the fun. Let’s walk through getting your Mac to hook up with a network:

1. Click the Apple menu in the upper left of your screen and choose System Preferences.
2. Click the Network icon in the Internet & Network section.
3. Click the AirPort icon in the services list on the left side of the Network preferences pane, as shown in Figure 7.2.

![FIGURE 7.2](image)
Click the AirPort icon to see its connection status and other items.

4. If the Status shows Off, click the Turn AirPort On button.
5. If the Status shows Connected, you are already communicating with your WAP and should be able to use the Internet or browse your network. You can skip the rest of these steps, unless you just want to learn a bit more.
6. If the Status is On, but you aren’t connected to a network, you need to add a network to your list of Preferred Networks:
   a. Click the Advanced button in the lower right corner.
   b. Click the AirPort tab, shown in Figure 7.3.
Add Your Mac to a Network

FIGURE 7.3
The AirPort tab lets you view wireless networks you’ve previously used.

- Click the + button underneath the Preferred Networks list to add a network.
- If the network you want to join is hidden from unauthorized users, enter its name in the Network Name field (Figure 7.4), select the type of security used for this network from the Security popup menu, and then click Add. Enter a password for this network if necessary (ask your IT personnel), and click Add.
- If the network you want to join isn’t hidden from unauthorized users, click the Show Networks button in the lower left.
- Select the network you want to join from the list, as shown in Figure 7.5, type the password needed, if any, to join the network (again, ask your IT personnel), and click Add.

FIGURE 7.4
Manually enter the name of hidden networks, which is a very secure way to run a wireless network.
The Networked Mac

FIGURE 7.5
Browse the list to find the network you want to join.

- Select the network you want to add.
- Select the network you want to add from the list, and then enter the network password if necessary.

KMPS-Data-MOB
KMPS-Data-Test
KMPS-Visitor
KMPS-Visitor-MOB
Konica Minolta

Remember this network
Password: ~~~

Show password

Other... Cancel Add

Check the Remember this network box to keep it in your Preferred Networks list.

g. The newly added network appears in the Preferred Networks list. If you have multiple networks listed, you can drag them into a preferred order so that your Mac can automatically choose the correct network to connect to.

h. Click OK to go back to the Network pane.

7. Check the Show AirPort status in menu bar box. This allows you to easily see the signal strength of your wireless connection (the icon looks like a broadcast signal; the more black bars you see, the stronger the signal is). You can also click the menu, as shown in Figure 7.6, to quickly access other wireless networks and AirPort options.

8. Click the Advanced button in the lower right corner to access numerous other options, some of which may be required for you to fully access your network. Table 7.2 discusses each tab and the options contained therein.

FIGURE 7.6
You can access lots of options in the AirPort status menu.

- Konica Minolta
- KMPS-Data-MOB
- KMPS-Data-Test
- KMPS-Visitor
- KMPS-Visitor-MOB
- Join Other Network...
- Create Network...
- Open Network Preferences...
### Advanced AirPort Options

<table>
<thead>
<tr>
<th>Tab</th>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>AirPort</td>
<td>Preferred Networks</td>
<td>Lists the wireless networks you regularly connect to. Networks can be arranged in your preferred order. Add networks by highlighting the + button. To remove networks from the list, highlight the network and click the – button under the list.</td>
</tr>
<tr>
<td>AirPort</td>
<td>Remember any network this computer has joined</td>
<td>Check this box to keep any network you join in your Preferred Networks list.</td>
</tr>
<tr>
<td>TCP/IP</td>
<td>Configure IPv4</td>
<td>This popup menu allows you to configure your IP address manually or automatically using a DHCP server. DHCP is the most common method, but if you are on a corporate network, you will want to consult your IT department for further instruction.</td>
</tr>
<tr>
<td>TCP/IP</td>
<td>Configure IPv6</td>
<td>Configure your Mac’s IPv6 addresses automatically or manually. Most networks don’t employ IPv6 yet; consult your IT department to see if this is something you need to configure or just simply turn off.</td>
</tr>
<tr>
<td>TCP/IP</td>
<td>Renew DHCP Lease</td>
<td>If you are using DHCP to get an IP address automatically from your server or router, click this button to lease a new address.</td>
</tr>
<tr>
<td>DNS</td>
<td>DNS Servers, Search Domains</td>
<td>Enter DNS server addresses and search domains to keep from having to enter complete addresses of Internet domains that you frequently access.</td>
</tr>
<tr>
<td>WINS</td>
<td>NetBIOS Name, Workgroup, WINS Servers</td>
<td>WINS (Windows Internet Naming Service) associates server names with IP addresses.</td>
</tr>
<tr>
<td>AppleTalk</td>
<td>Make AppleTalk Active</td>
<td>Enable or disable the AppleTalk network protocol by checking or unchecking this box.</td>
</tr>
<tr>
<td>AppleTalk</td>
<td>AppleTalk Zone</td>
<td>If your network uses AppleTalk zones, ask your IT department which one you should use.</td>
</tr>
<tr>
<td>AppleTalk</td>
<td>Configure</td>
<td>Set up your AppleTalk zone Node ID and Network ID automatically or manually. Again, your IT department can help out with this info.</td>
</tr>
<tr>
<td>802.1x</td>
<td>User Name, Password, Wireless Network, Authentication</td>
<td>802.1x is used to enhance security on a network. Your IT department can provide any items necessary for accessing this type of protected network.</td>
</tr>
<tr>
<td>Proxies</td>
<td>Configure Proxies</td>
<td>Some networks use proxy servers to protect computers behind their firewalls from outside intruders. If this is the case for your network, you will need to get the proxy information from (guess who?) your IT folks.</td>
</tr>
<tr>
<td>Ethernet</td>
<td>Configure, MTU</td>
<td>Configure your network speed settings here. Usually the automatic settings are correct, but check with your IT department to see if you need to make any changes.</td>
</tr>
</tbody>
</table>
At this point, you should be able to access your network wirelessly. Enjoy the freedom! Once you've seen how great it is to be untethered, you may not go back to wires again.

**Wired Networks**

Despite my unabashed endorsement of wireless networking at the end of the previous section, wired networks certainly do have their place. This section of the chapter will get you up to speed on connecting your Mac to a wired network.

**NOTE** The following section steps you through a manual setup of your Mac on a wired network. If you prefer to try letting your Mac automatically discover and set up the network settings, skip to the section entitled “Using the Network Setup or Diagnostic Assistant” later in this chapter. I would suggest reading through this section, though, if only for educational purposes.

**Hardware requirements for wired networks**

Your Mac will have an Ethernet port on it no matter what, so you're good to go in that regard, but what about the rest of the network? Here's all you need to get your wired network up and running:

- Ethernet cables
- Router, hub, or switch

Once you've got your hardware, it's time to get it all hooked up:

1. It's a good idea to wait until after you've got everything connected before turning on your hardware (computer, router, and so on).
2. Connect one end of an Ethernet cable to your Mac's Ethernet port.
3. Connect the other end of the cable to an open Ethernet port on your router, hub, or switch.
4. Turn on your router and your Mac. Most routers, hubs, and switches have connection lights to indicate whether there is an active connection, so be sure to check them out before continuing.

**TIP** In my experience, 95 percent of all Ethernet communication issues are related to a damaged cable. If you're experiencing difficulty in accessing your network, your first plan of action should always be to test a different cable than the one you're using, even if you have to temporarily borrow one from another device on your network.

**How to set up your Mac on a wired network**

Now we'll look at configuring the Leopard side of things. We'll use the Network System Preferences to connect to your wired network, just as we did with wireless:
1. Click the Apple menu in the upper left of your screen and choose System Preferences.
2. Click the Network icon in the Internet & Network section.
3. Click the Ethernet icon in the services list on the left side of the Network preferences pane, as shown in Figure 7.7. There may be more than one in the list if you have multiple Ethernet ports on your Mac.

**FIGURE 7.7**
Choose one of the available Ethernet icons to select an active wired network connection.

4. If the Status shows Cable Unplugged, try reseating the cable in the port. If the Status shows Connected, you're communicating with your router.
5. Consult with your ISP or IT department to find out how to set the Configure option. This option dictates how your Mac gets an IP address, which is necessary to communicate with other devices on the network. Here's a look at some of the options available:

- **Using DHCP.** The router or a DHCP server on the network will assign an address to your Mac automatically.
- **Using DHCP with manual address.** The router assigns all but the IP address. Most routers don't support this configuration.
- **Using BootP.** Automatically assigns an address to your Mac if the server is running the BootP protocol.
- **Manually.** You set the IP address, subnet mask, and the router address all by your lonesome.
6. Set the DNS Server and Search Domains fields only if instructed to do so by your ISP or IT department.

7. At this point, most users are ready to roll, but others may need to make a few more detailed settings before they can enjoy full network access. Once again, check with your ISP or IT department (that phrase is beginning to sound a little familiar, isn't it?) to see if you need to set any additional options. If so, click the Advanced button; if not, you can stop here and continue with the next section in the chapter.

8. The Advanced options for wired networks are nearly identical to those for wireless, with the exception of the absence of the AirPort tab and a couple of differences in the Ethernet tab. Take a look back to Table 7.2 for descriptions of the available settings. The differences in the Ethernet tab, shown in Figure 7.8, are thus:
   - **Speed.** Choose from 10baseT, 100baseT, or 1000baseT.
   - **Duplex.** Select from half or full duplex.

9. Click OK to close the Advanced options pane. By now you should be able to cruise your network in style. If not, go back and double-check your settings to make sure you didn't miss something. If need be, get your network administrators involved before pulling your hair out.
Using the Network Setup or Diagnostic Assistant

Apple has always liked to make things as easy for the user as possible, and networking is no different than anything else when it comes to ease of use, thanks to the Network Setup Assistant. The Network Setup Assistant is provided as part of Leopard, and its sole reason for existing on our little blue planet is to help you connect to a network and diagnose any issues you may have.

NOTE You probably want to know why I didn’t just mention the Network Setup Assistant instead of having you do all the manual setup in the previous sections, right? Well, the Network Setup Assistant is great for a small network, such as in your home, but may not be able to successfully connect you to some highly secured corporate or government networks. You can certainly feel free to give the Network Setup Assistant a go, but if it doesn’t work, you may need to bug the IT guys again.

To open the Network Setup or Diagnostic Assistant:

1. Click the Apple menu in the upper left of your screen and choose System Preferences.
2. Click the Network icon in the Internet & Network section.
3. Select a network from the list on the left of the Network preferences pane.
4. Click the Assist me button and select an option from the window shown in Figure 7.9.

Using the Assistant

If you clicked the Assistant button, this is where you will discover the Network Setup Assistant. Let’s take a tour of the Assistant to see how easily it can hook up with a network:

1. In the Introduction window (Figure 7.10), assign a Location Name and then click Continue.
FIGURE 7.10
Give the new connection a descriptive name.

2. Choose the method you are using to connect to the Internet from the list provided (Figure 7.11) and click Continue. If you need help making a decision, click the More Info button, which is available in most of the Network Setup Assistant windows. Figure 7.12 shows the kind of helpful information provided when you click the More Info button.

FIGURE 7.11
Which of these methods are you using to connect to the Internet?
Add Your Mac to a Network

Clicking More Info gives you helpful tips for using the Network Setup Assistant.

I'm illustrating how to hook up with a wireless network. If you're selecting any of the other types of connections, the screens you see past this point may differ from what I show here. Simply follow the directions provided for the type of connection method you chose and you'll be good to go.

3. The Network Setup Assistant scans the area for an available wireless network, which should appear in the given list, shown in Figure 7.13. Select the network you want to join, enter a password if required, and click Continue.

4. If you are successful in your attempt to sign on to the desired network, you will see the Ready to Connect? prompt, like that in Figure 7.14. If you are indeed ready, click Continue.

5. You should receive a congratulatory window, like that shown in Figure 7.15, if you are connected to the Internet. Click Done to close the Network Setup Assistant.
FIGURE 7.13
A list of networks discovered by your Mac

FIGURE 7.14
Click Continue to start using your network.
If you see this window, you are connected and ready to surf the Web.

Using Network Diagnostics

Network Diagnostics can help you track down and even resolve connection issues with your network. Click the Diagnostics button after you click the Assist me button in the Network preferences pane to get started:

1. Choose a network from the list to begin diagnosing issues, as I've done in Figure 7.16. Click Continue.
2. Select the network port configuration you want to use to connect to the network (Figure 7.17), and then click Continue.
3. I'm diagnosing a wireless connection, and I also have an Ethernet port connected to my router, so I'm prompted with the window shown in Figure 7.18. Because I want to use my AirPort connection, I'll select Use AirPort and click Continue.
4. I've selected the network I want to join in Figure 7.19; I'll click Continue to move on.
5. Click DHCP or PPPoE (Figure 7.20), and click Continue.
Click Diagnostics to figure out potential problems.

**FIGURE 7.16**

How are you connecting to the network?

**FIGURE 7.17**
Check the Use AirPort box if you want to diagnose issues with wireless connectivity.

Choose a network to troubleshoot.
6. "Qapla'!" (That's Klingon for "Success!", just in case your nerd quotient isn't quite as high as mine.) You are now connected to the Internet and free to hop on the Web or onto your network—after you click the Quit button, that is (Figure 7.21).

![Figure 7.20](image1)

Ask your Internet Service Provider if you need help with this question.

![Figure 7.21](image2)

Your Internet connection is just fine now.
Network Utility

You never know when your network may not be operating up to snuff. For example, you may be unable to access a shared folder that resides on another computer in your network. In that scenario, after you’ve made sure that you are using the correct user name and password to access the shared folder (if there are any assigned), you want to make sure that your Mac and the other computer are both operating correctly on the network. That’s where the Network Utility comes in very handy. This utility, whose icon looks like that shown in Figure 7.22, can be found on your hard drive in the Utilities folder, which in turn resides in the Applications folder at the root of your disk.

When you double-click the Network Utility icon, you are rewarded with the window shown in Figure 7.23.

FIGURE 7.22
I think the Network Utility icon is pretty cool.

FIGURE 7.23
So many choices . . . where to start?
The Networked Mac

This section of the chapter isn't meant to be an exhaustive treatise on the Network Utility, but I would like to point out a couple of really helpful items available in it.

First off, make sure your computer is working correctly on the network. Click the Info tab and choose the network interface you want to see information about from the popup menu. From here you can see the following about your Mac's network connection:

- The IP address assigned to your Mac
- The speed at which your Mac is communicating with the rest of the network
- The status of your network link
- The manufacturer and model of your network interface hardware
- The number of packets (signals) sent by your Mac to the network and the number of packets received by your Mac from the network

Now that you've checked out your computer, see if you can talk to the other computer over the network. To verify communication, you use the ping tool. Ping a device on a network means that you send a signal to that device and wait for a reply to that signal. If you receive replies for most (preferably all) of the pings you send, your connection is good; if you receive few or no replies, the connection to the device is bad. To ping a computer:

1. Click the Ping tab.
2. Type the IP address of the computer you are trying to talk to in the address field.
3. Decide how many pings you want to send to the second computer. Ten is usually plenty, but if you are testing long-term reliability of the connection, select the unlimited option.
4. Click the Ping button to begin the process, which you can view in the bottom half of the window.
5. To halt the ping process at any time, simply click Stop. Otherwise the pings stop after the number of pings you specified are sent.
6. After the process has stopped, you can see the results by scrolling to the bottom of the results viewer, as shown in Figure 7.24.

The Network Utility can be used for much more than I've just covered, such as network performance stats, scanning the network for active ports, checking AppleTalk connections, and so forth. To get more information about the Network Utility, choose Network Utility Help from the Help menu. For full details about each of the commands available in the Network Utility, open the Terminal (found in the Utilities folder) and type man followed by a space and the name of the command. Press Enter to see the complete description of the tool and its functions, as I've done in Figure 7.25 for the traceroute tool.

If you need more help, don't hesitate to hop on the Web or dash over to your nearest neighborhood bookstore to find tomes that deal exclusively with the topic of networks.

150
FIGURE 7.24
Pinging was a success in this case: ten pings were sent, and ten were received.

FIGURE 7.25
The tools in Network Utility are UNIX based, so more info can be found on them from the Terminal.

Summary
Networks are practically a necessity in today's world of multiple computers and broadband Internet. Most homes have more than one computer of some type or another, but only one Internet connection, so the most efficient way for each of the computers to access the Internet is through a network. This chapter gave you a good basic overview of setting up a network for your Macs, including wired and wireless, manually and automatically. By this point you should be able to surf the Web, share files, and enjoy all the other benefits of networking.
"It's mine and you can't have it!"

"No, it's mine!"

"I want it!"

"You can't have it!"

Anyone who's ever been around kids for any length of time has heard that exchange at some point. Such lovely banter, isn't it? Okay, maybe not, but it's an inevitable part of childhood; everyone eventually has to learn how to share with others. Before you think this has turned into a child psychology or parenting book, there actually is a connection in this example with your Mac. Children have the basic tools necessary for sharing with others (physical, emotional, and mental), but they need to be shown how to use those tools. By the same token, your Mac has all the tools it needs to share (file protocols, networking capabilities, and so on), but also has to be “taught” how to use those tools to communicate with other entities. That's what this chapter is all about, so let's get started.

Explore Leopard's Sharing Preferences

The first task to undertake is to become familiar with Leopard's sharing preferences. These preferences are where you tell Leopard what protocols to use when sharing via a network, and inform it how those protocols should be utilized.
To locate these preferences:

1. Click the Apple menu in the upper left of your screen and choose System Preferences.
2. Click the Sharing icon in the Internet & Network section.
3. Ogle the wonders of the Sharing preferences pane, shown in all its glory in Figure 8.1.

**FIGURE 8.1**

Remember, this is a Mac, so this is the Sharing pane, not sharing pain (sorry, I couldn't resist).

A quick glance at the Sharing preferences pane gives you some bearing on its features. The Computer Name field lets you give your Mac its own name on your network, which others on the network can use to find it and access any sharing it may be performing. Enter whatever name suits your fancy. I'll cover the other items in the pane as we go along in the chapter.

**TIP** It's a good idea to give your computers descriptive names if you have a network with several of them. For instance, if you and your wife both have iMacs, don't just name your computers "iMac." Make yours something like "Dwight's iMac" and your wife's something akin to "her name's iMac." This way if there is a third computer on the network, it can easily differentiate between the first two.

**Enable file sharing**

A primary concern is to enable file sharing and set up its options so that others can use the items you’re sharing from your Mac. The left side of your Sharing pane displays a list of sharing types and offers check boxes for enabling them. Enabling file sharing is as simple as checking the box next to the File Sharing type, as shown in Figure 8.2.
Once you have file sharing turned on, you need some folders to share files from, and that's where the Shared Folders and Users lists come into play.

Adding shared items
The Shared Folders list displays the folders and disks on your Mac whose contents you've authorized Leopard to share with other folks on your network. To add an item to the Shared Folders list:

1. Click the + button below the Shared Folders window.
2. Browse your Mac using the window provided, find the folder or hard drive you want to share, select that folder or driver, and then click the Add button (Figure 8.3).
3. To remove an item from the list, simply highlight it and click the – button below the Shared Folders window.

Setting user permissions
Now that you've got some items ready to share with the rest of the world (or just with a few trusty individuals), you need to tell Mac OS X who can access them and whether that access should be restricted. To set those rights, also known as permissions:

1. Select the shared item from within the Shared Folders list to highlight it.
2. The Users window will show you who currently has access rights to the shared item. To change those rights, highlight the user in question and select Read & Write, Read Only, or Write Only (Drop Box), as shown in Figure 8.4.
3. To add users to the list:
   a. Click the + button below the Users window.
   b. Select a user from the Users & Groups or Address Book section (shown in Figure 8.5), and click Select, or click the New Person button, at which point you would need to create a new account for that person.

4. After the user is added, assign him or her permission as you did earlier in step 2.

5. To remove a user, highlight the offending party and click the – button below the Users window.

![Image of folder selection](image)

You have now completed sharing a folder with the users you selected, but you're not quite finished. What if you want to share files with the unfortunate folks who have to use Windows-based PCs or through a specific network protocol? Well, I'm sure by this point you've noticed the Options button in the lower right below the Users window. Fear not, for we'll tackle that little bugger, along with the other questions, in the upcoming sections.

### File-sharing protocols supported by Mac OS X

Before we get to the Options button (can you feel the suspense building?), we first need to take a look at the network protocols used by Mac OS X for sharing files: AFP, FTP, and SMB. Table 8.1 gives an overview of each protocol.
FIGURE 8.4

Time to boss everyone around!

FIGURE 8.5

Choose a user from the available lists or create a new account.

TABLE 8.1

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AFP</td>
<td>AppleTalk Filing Protocol</td>
</tr>
<tr>
<td>FTP</td>
<td>File Transfer Protocol</td>
</tr>
<tr>
<td>SMB</td>
<td>Server Message Block</td>
</tr>
</tbody>
</table>
Now that I've built up the Options button, it's time to remove the mystery behind it. Click the Options button in the Sharing pane (with File Sharing highlighted in the list, of course) and you will be presented with the window shown in Figure 8.6.

You may be wondering why all the fuss about this little window. Well, this is where you tell Mac OS X how it should share files with other users on the network, and this can be a very big deal, especially when sharing with folks who aren't lucky enough to be using Macs.

The options here are fairly self-explanatory:

- **Share files and folders using AFP.** Check this box to share your items with other computers running the AppleTalk Filing Protocol, which are typically Macs, but some Linux boxes may run AFP if you download the right software for it.

- **Share files and folders using FTP.** Checking this box tells your Mac to let others access your shared items using File Transfer Protocol, which any major OS, including Mac OS X, Windows, and Linux, are all familiar with and can talk to each other through. One caveat, though: If you are looking for airtight, secure transactions, FTP may not be your best bet.

- **Share files and folders using SMB.** To share with your less-fortunate friends running Windows-based and Linux PCs, SMB is the way to go. You must choose the account you are enabling SMB sharing for and then enter the password for that account. To disable SMB sharing for a given account, uncheck the box next to its name.
Sharing Files from Your Mac

That’s pretty much enabling file sharing in a nutshell. To find out how to access other shared files and folders from your Mac, keep reading.

Explore the other sharing options

Don’t worry; I’m not going to ignore the other sharing options in the Sharing preferences pane! There’s quite a long list, so let’s get down to business.

DVD or CD Sharing

Did you know that other computers can use your Mac’s CD or DVD drive remotely? How cool is that? Enabling this option, shown in Figure 8.7, allows just that; they can access discs in those drives just as though the discs were inserted into their machine.

**FIGURE 8.7**

Always have your Mac ask you before letting other network users access your DVDs and CDs.

Screen Sharing

Some of you more nerdy readers may be happy to know that VNC, Virtual Network Computing, is built right into Mac OS X. For those of you who have a life outside of the 3-foot diameter encompassing your computer, VNC is the industry standard protocol used for remotely connecting to and controlling other computers, or allowing others to gain the same type of control of your Mac. These kinds of remote connections are extremely helpful when troubleshooting issues with other computer users over a network, or if you need to access files on your home or office computer when you’re away from the office.
Check the box next to Screen Sharing if this sounds like something you might like or need to give a go. With Screen Sharing on, as it is in Figure 8.8, you can decide who gets this kind of unfettered access to your beloved Mac.

**FIGURE 8.8**

Screen sharing allows you to drive somebody else’s Mac remotely, or have them drive yours.

Beneath the Screen Sharing: On alert you’re informed how people can access your Mac using a VNC connection, and you also find the Computer Settings button. Click that button to allow anyone to request permission to control your Mac or to allow VNC viewers (applications dedicated to administering VNC connections) to control your screen only when they provide a password that you specify.

As with file sharing, you can also limit screen sharing by only allowing a select few to control your Mac. To allow anyone to control the screen (which is not something I recommend), click All users. To be a really smart Mac aficionado, select Only these users and add or remove users from the list by clicking the + or – button, respectively.

**CAUTION** Never allow access for all users! Always limit access to only those people with whom you trust your computer and its contents.

**Printer Sharing**

You can share any print queues you have set up in the Print & Fax preferences by checking the Printer Sharing box and then selecting the printers you want to share (Figure 8.9).
When you share printers, others are routing their print jobs through your Mac to the printer in question. If they are sending very large print jobs, this could tie up resources on your Mac, causing it to slow down somewhat or even behave erratically. Be sure you and those accessing your Mac's shared printers are in agreement when it comes to printing large jobs. Also understand that if you turn off your Mac or remove it from the network, those using your shared printers will no longer be able to print.

**FIGURE 8.9**
Other people can use your Mac to route print jobs to printers you have already set up.

---

**Web Sharing**

Mac OS X keeps on surprising with its capabilities. Did you know you can easily host a Web site directly from your Mac that others on your network can access? You can keep anything you want on your Web site, from something elaborate to a simple list of files that others can download from your Mac as if they were hosted on a dedicated Web server. When you enable Web Sharing, you will see the addresses for both your computer's Web site and your own (Figure 8.10) so that you can tell others how to access your Web site using their computer's Web browser.

Search Mac OS X's Help section for more information on how you can use your Mac to create your own Web site.

**Remote Login**

Enabling Remote Login (Figure 8.11) allows you to access your Mac from another computer using SSH, which is the Secure Shell that can be run from Terminal. SSH allows you, or anyone you give your SSH address to, to run your computer from a command line interface.
Part II  The Networked Mac

FIGURE 8.10
Share your own Web site directly from your Mac.

FIGURE 8.11
SSH is for geeks only, so don't use Remote Login unless you know what you're doing.
As before with file and screen sharing, you can restrict access to your computer with the Allow access for settings.

For more information on command line interfaces, see Chapter 19.

Remote Management
Remote Management may sound a lot like screen sharing, but it's more detailed and is something you should only allow a network administrator access to. As a matter of fact, only someone using Apple's Remote Desktop software can access your computer using this method.

When you first enable Remote Management, you will be presented with tasks that you can allow the person remotely accessing your Mac to accomplish, as shown in Figure 8.12.

Only enable the features specified by your network administrator.

Click the Computer Settings button to set the options according to your IT department’s specifications, and as before, never allow access to all users!

By the way, using Remote Management disables Screen Sharing automatically.

Remote Apple Events
Mac OS X will allow applications from one Mac to control the actions of applications on another Mac when this feature is enabled. Remote Apple Events are commands that are sent over your network from the first Mac to the second. For instance, if you have an application installed on both Macs that allows Remote Apple Events, the first application can tell the second to open certain files, to print, and to perform other similar functions. Clicking the Options button allows you to configure access for applications running on the ancient Mac OS 9 operating system.
Don’t forget to restrict access to only the most trusted users, otherwise you may find your applications doing the strangest things and not knowing why.

**Xgrid Sharing**

Xgrid Sharing is something that 99.9 percent of the world will never have any need for, but for those who do, its worth can easily be seen. Xgrid Sharing allows you to share your Mac's CPU (central processing unit), or processor, with an Xgrid server. Why is this important? Well, an Xgrid server is used in a very highly intensive computational environment, such as a mathematical or scientific lab, to gather resources from other computers to use in its work. Sharing unused processor cycles can greatly increase the efficiency with which these enormous calculations are rendered.

If you choose to enable Xgrid Sharing, don’t be alarmed when you see the prompt in Figure 8.13. Simply click OK and enter a password if one is required in the Authentication method field.

To prevent the Xgrid server from accessing your processor when your Mac is in use, click the Configure button and select Only when this computer is idle for the Agent accepts tasks option, as shown in Figure 8.14.

**FIGURE 8.13**

Xgrid surprises you with this alert when you first try to enable it.

![Missing password alert](image)

**FIGURE 8.14**

Select Only when this computer is idle to keep your Mac from slowing to a crawl.

![Configure Xgrid Sharing settings](image)
Internet Sharing
Leopard can share your Mac's Internet connection with other computers on your network using this option.

Before you can enable Internet Sharing, you must select a connection on your computer to share the Internet from, such as your Ethernet or AirPort. Then choose which connections (you can choose multiple types) the other computers will use to access the Internet from your Mac, as shown in Figure 8.15. That's all there is to it.

**CAUTION** Heed my words when I warn you to check with your IT administrator or your ISP before enabling this option! It can wreak all kinds of havoc with your network or ISP, so be sure to ask first. I'm an advocate of the adage that it's better to ask forgiveness than permission, but this is most certainly an exception to that.

Bluetooth Sharing
Another way that your Mac can share files is through its built-in Bluetooth adapter. Other Bluetooth devices can be configured to talk with your Mac and vice versa, allowing you to create an ad hoc miniature network right on the spot. The options in this pane, shown in Figure 8.16, help determine how those devices interact with your Mac.
Accessing Shared Files on Your Network

You now know how to let others see shared files and folders that reside on your Mac, but what about accessing and utilizing shared items from other computers? In a networked environment where communication and sharing of ideas and information is vital, being able to find and use those resources can make or break you.

Accessing locally shared files and folders

Every user account on your Mac has a Drop Box, which is a shared folder that is generated automatically when the account is created. The Drop Box isn’t for other users to read, or get, items from, but for them to write, or drop, items into. If a fellow user of your Mac—or even another user on your network—wishes to share a document with you, all he or she has to do is drop it into your Drop Box. Similarly, if you want to share an item with someone else, you can just drop it in his or her Drop Box. The Drop Box is a very secure method of sharing documents, because the people dropping the files into the Drop Box have no further access in the account of the user they are sharing with.

To access a Drop Box of another user account on your Mac:

1. Open a new Finder window by pressing `⌘+N` from within the Finder.
2. Click the Hard Drive icon under devices in the sidebar on the left.
3. Open the Users folder and then open the folder for the user account you want to share with.
4. Browse to the Public folder to see the Drop Box.
5. Drag-and-drop the items you want to share with the owner of the particular account onto the Drop Box, as shown in Figure 8.17.

**FIGURE 8.17**
The plus sign on the cursor lets you know you’re about to add the item being dragged to the Drop Box.

Notice the dark gray bar labeled Shared Folder in the Finder window in Figure 8.17. This bar will appear any time you select or access a shared folder.

**TIP**

Accessing files and folders shared on your network

The zenith of sharing is to be able to access files and folders that reside on other computers, not just those on your own Mac. This can be one of the most important functions of any computer that operates in an environment where cooperation and shared goals is the lifeblood of the group. Not to mention it would be nice to be able to watch movies of your grandkids that are stored on your upstairs computer without having to get up off the couch downstairs. You can just use your laptop to access that upstairs computer via your network, assuming you had the foresight to share the Movies folder on that computer. Here’s how to find and get into those shared files and folders on your network:

1. Be sure you know the name of the Mac or PC you are trying to connect to on your network. Ask the owner of the computer in question to provide that information for you, or you can find out using these methods:
   - For Macs, click the Apple menu in the upper left of your screen and choose System Preferences. Click the Sharing icon in the Internet & Network section, and the Mac's name will appear in the Computer Name field at the top of the pane.
Part II  The Networked Mac

- For Windows XP, right-click the My Computer icon that resides either on your Desktop or in your Start menu, and select Properties in the resulting popup menu. In the System Properties window, click the Computer Name tab and make note of the Full computer name entry.
- For Windows Vista, choose Start button → Accessories → Welcome Center. The computer name is displayed in the Welcome Center window, as shown in Figure 8.18.

**FIGURE 8.18**
The Welcome Center in Windows Vista displays the PC’s computer name.

2. If you want to gain entry to files and folders shared by most computers, you will need to know an account user name and password for the system in question. If you don’t know what to use, ask the owner of the computer or your IT administrator for that info.

3. The sidebar on the left side of any Finder window contains a Shared section. Open a new Finder window (press ⌘+N from within the Finder) and click the arrow immediately to the left of the word “Shared” in the sidebar to expand the list, which shows you computers that are sharing files, as shown in Figure 8.19.

4. If you don’t see the computer you are looking for in the sidebar list, click All to see all the computers on your network that are sharing files, as shown in Figure 8.20.

5. Find and select the computer that you want to access. You must double-click the computer’s icon if you are viewing in icon or list mode, but you only need to single-click when viewing as columns. You will be automatically connected as Guest.
The list of computers that are sharing files and folders appears on the left of the Finder window.

You can now see all the computers on your network for which sharing is enabled.

6. Most computers don't allow guest accounts to do much, if anything at all; you typically need an account username and password to access their contents, as mentioned in step 2. To log in with an approved user account name and password, click the Connect As button, shown in Figure 8.21.

7. Select Registered User in the resulting window, enter your user name and password into their respective fields, and click the Connect button (Figure 8.22).
Enter your user name and password to gain access with the full rights granted to you by the owner of the computer.

You can see in Figure 8.23 that I now have access to folders that I didn't prior to logging in (Figure 8.21). From this point you can access the files you need from the host computer or copy items to it.

Finding other shared resources on a network

Computers can share other items besides files and folders, you know. You can share devices that you connect to as well, such as printers, scanners, cameras, and the like. You'll be surprised how simple it is to find these resources, too.
Shared printers

Sometimes it's necessary to share a printer from a computer, and Leopard keeps it as simple as possible. One such instance in which it may be necessary to share a printer would be if the printer only has a local connection, such as a USB or FireWire port. In this case, because there's only one connection, you will have to share the printer from the Mac it's connected to in order for other computers on the network to be able to send print jobs to it.

To find and install a shared printer:

1. Click the Apple menu in the upper left of your screen and choose System Preferences.
2. Select Print & Fax in the Hardware section.
3. Click the + button under the installed printer list.
4. If you are installing a printer shared from another Mac, click the Default button. Scroll through the list of available printers, and those that are shared will say so in the Kind column, as shown in Figure 8.24.
5. Select the printer, choose the appropriate driver from the Print Using popup menu, and click Add.
6. If you are installing a printer shared from a Windows-based PC, click the Windows button in the Add window.
7. Choose a network domain from the left column, the PC sharing the printer from the center column, and finally, the name of the shared printer in the right column (Figure 8.25).
8. Select the appropriate driver from the Print Using menu, and then click Add. You may need to visit the Web site of the printer manufacturer to find drivers.
If a printer is being shared by another computer, it will say so under the Kind column.

Use all three columns to find a printer that's being shared from a Windows PC.
Shared cameras
Another common hardware device that is easily shared from your Mac is a digital camera. Sharing your scanner will allow others to use your scanner to scan items to their Mac via your own computer. That’s a nice thing to do for a friend, don’t you think? Let’s do it:

1. Open the system-wide Applications folder by pressing `⌘`+`Shift+A` from within the Finder.
2. Browse and find the Image Capture icon, and then double-click it to open Image Capture.
3. Press `⌘`+`B` to open the Device Browser window.
4. Click the arrow next to Remote Image Capture Devices to expand its list and find the shared camera.
5. Select the camera, click Connect, and go to Chapter 13 to find out more on using a digital camera with Image Capture.

Using FTP clients
FTP clients are programs specifically designed to join servers that utilize the File Transfer Protocol to exchange files over networks, including the Internet. FTP can easily send and receive files between computers, regardless of the operating system they are running, and you can use FTP clients to manage these files and the folders they reside in on the given server. The vast majority of FTP clients use a graphical interface, so browsing an FTP server is very much like browsing the contents of your own Mac’s hard drive.

There are many worthy FTP clients out there, but I will only be able to briefly cover some of the most popular, and will offer up my own advice based on my experience with these clients. First, a good FTP client should have all of the following:

- An easy and intuitive interface that behaves like the rest of your Mac.
- The ability to easily transfer files reliably (no crashing!).
- The ability to support multiple simultaneous file transfers.
- Auto-resume features, which are critical for large transfers that are interrupted for one reason or another. This feature allows the FTP client to pick up with the transfer where it left off, as opposed to starting over again.
- The ability to support secure connections (SFTP, or Secure File Transfer Protocol).

Here is a list of FTP clients that I can feel comfortable recommending to you, along with a few screen shots so you can see them in action. I always like to see the interface of a program before I download it because the layout of an application is key to its usability.
Part II The Networked Mac

Fetch
Fetch, shown in Figure 8.26, is one of the oldest and most popular FTP clients available for the Mac. I've used Fetch on and off since the days of Mac OS 7! However, back in those days it was a free utility; now it will cost you $25. You can download a copy of Fetch from http://fetchsoftworks.com/.

FIGURE 8.26
Fetch has been retrieving files from FTP servers for a long, long time, and is a reliable app.

RBrowser
RBrowser is an FTP client that closely resembles the old file viewer in the now-defunct NeXT operating system (another Steve Jobs project from the 1980s). This is one of the first FTP clients I ever used on Mac OS X, and it has always been easy enough to use. A feature that I love is its ability to automatically detect the protocol being used to transfer data. RBrowser (Figure 8.27) is free (yes!) and can be found at www.rbrowser.com.

Transmit
Transmit, developed by Panic, has a great Mac OS X interface and is easy to learn to use. Of its many features, I enjoy the tabs and sidebar (Figure 8.28) the most, and I also like how they differentiate the two windows as "your stuff" and "their stuff." You can download Transmit at www.panic.com/transmit/index.html, and it will cost $29.95 to completely unlock all of its features.
Sharing Files from Your Mac

**FIGURE 8.27**
This screen shot will bring flashbacks to old NeXT gurus.

![Screen Shot](image)

**FIGURE 8.28**
The sidebar makes it easy to navigate to your favorite folders.

![Sidebar](image)
Yummy
This had better be one heck of an FTP client with a name like Yummy, and lo and behold, it is! Yummy (Figure 8.29) is a relative newcomer to the Mac FTP client foray, but it's certainly no slouch. I enjoy its ability to synchronize directories on different computers (which other clients support, too, but perhaps not quite as well) and its bevy of customization tools. Yummy is a product of Yummy Software, costs $25 for a single license copy, and can be grabbed at www.yummysoftware.com.

**FIGURE 8.29**
Yummy. What else is there to say?

FileZilla
This FTP client is my favorite, and I highly recommend it to anyone who needs a great client at an even greater price. FileZilla (no relation to Mozilla, creators of the Firefox Web browser) is an open source project and is free, but don't let that fool you; this is a feature-rich client that does its job very well. FileZilla, shown in Figure 8.30, is also a cross-platform client, meaning that there are versions of it for Windows, Mac, and Linux, which prevents you from having to learn different clients when using multiple operating systems. FileZilla also has the ability to resume stopped transmissions, an intuitive interface, dragging-and-dropping of files from one directory to another, remote file editing, and much more. Get FileZilla at [http://filezilla-project.org/index.php](http://filezilla-project.org/index.php).
Sharing Files from Your Mac

FIGURE 8.30

FileZilla is a monster of an FTP client!

Should none of these clients suit your fancy, here are a handful more that just might do the trick for you:

- **Cyberduck.** That's right, I said Cyberduck (don't ask): http://cyberduck.ch/.

- **CaptainFTP.** This is a Mac OS X mainstay for many, and those who use CaptainFTP don't like to ARG-ue about it: http://captainftp.xdsnet.de/.

- **Flow.** The new kid on the block: http://extendmac.com/flow/.

Sharing Files Without a Network

What about those unfortunate souls who don’t have access to a network? Don’t they have the God-given right to share files, too? They absolutely do (I’m sure it’s in the U.S. Constitution somewhere), and I’ll be more than happy to show you a couple of ways to do just that!
Burning data to discs

Chapter 2 briefly discusses using Burn Folders, which are folders dedicated to store files you will later burn to a CD or DVD. While Burn Folders are great, there are other ways to burn items to disc, which you may prefer to a Burn Folder.

**TIP**

Mac OS X is capable of burning discs that are readable by both Macs and PCs, using an HFS Plus/ISO 9660 hybrid file format.

To burn items to a CD or DVD:

1. Insert a blank disc into your Mac's disc drive, which is capable of reading both CDs and DVDs, but some models may not be able to write DVDs. Check your Mac's documentation to see if it came with a DVD burner.

2. You may see a dialog box like the one shown in Figure 8.31. If so, select an action from the menu and click OK. Check Make this action the default to have this selection occur automatically from now on.

3. The disc mounts and appears on the Desktop; its icon looks very similar to the one shown in Figure 8.32.

**FIGURE 8.31**

The Finder wants to know how to handle blank discs when you insert them.

**FIGURE 8.32**

This is a CD icon; a DVD icon will look slightly different.
4. At this point you are ready to add files to the disc. You can either drag files and folders you want to put on the disc directly onto its icon, or you can double-click the disc's icon to open its window, and then drag the desired content into the window, as illustrated in Figure 8.33. Don't worry about your original files; only aliases to the original files are placed on the CD at this point.

**FIGURE 8.33**

Notice the cursor icon has turned into a swish (it looks like a rotating arrow), which indicates the files being placed in the folder are only aliases, not the originals.

5. Now you can rename the files and folders the disc contains, and even rearrange the files and folders on the disc.

6. When you are satisfied with the layout of the items on the disc, it's time to burn it. If you opened the disc's window, simply click the Burn button in the upper right corner. You can also just drag-and-drop the disc's icon to the Trash icon in the Dock, which then changes to a Burn icon.

7. In the burn confirmation window, shown in Figure 8.34, give the disc a descriptive name, choose a burn speed (max is usually fine), and click the Burn button to begin the process. The time it takes to complete the burn depends on the amount of data on the disc. Remember, your original files are not moved or deleted!

**Utilizing USB flash drives**

Another method of sharing files is one that became popular rather recently, and that is to use USB flash drives (a.k.a. thumb drives). Flash drives are tiny and fit right in your pocket, and they will work on any computer that has a USB connection, which these days is pretty much all of them. These small devices used to have pretty limited capacities, but now you can find them upward of 8 gigabytes or more.
Part II  The Networked Mac

**FIGURE 8.34**

If you have trouble burning your discs, try lowering the Burn Speed option.

These drives work like any other external drive you connect to your Mac. Here's the rundown on using a flash drive:

1. Connect the drive to one of your Mac's available USB ports.
2. Leopard will mount the drive on your Desktop. Its icon should look identical to the one shown in Figure 8.35.
3. To add an item to the drive, simply drag-and-drop it onto the drive's icon, as shown in Figure 8.36.
4. Because the contents of flash drives can be organized just like any other disk or folder on your Mac, you may prefer to double-click its icon to open a Finder window revealing the contents. This way you can peruse the folders on the drive to find the proper location to copy the items you need.
5. To copy items from the drive, simply drag them from the drive's window to a location on your Mac.
6. **Do not** just disconnect the flash drive from your Mac when you're finished using it; it must be ejected first or the drive may become corrupt or data may be lost. After your file transfers are complete, drag-and-drop the drive's icon onto the Trash icon to eject, or unmount, it. If your flash drive has any flashing lights on it, wait until they stop flashing. Then remove the drive from your Mac's USB port.

**CAUTION** Be sure to check with the flash drive's manufacturer to find out whether the drive is Mac-compatible. Those that are will usually have a Mac or OS X logo somewhere on the packaging. At the very least they should explicitly state Mac support. Unsupported drives may use a file format that doesn't work with Mac OS X, or may require a Windows-only utility to access the data on the files. While most flash drives may work, even if they don't officially support the Mac, you don't want to risk it if you can help it.
Some Mac old-timers may notice the uncanny resemblance of this icon to the icon used for the now-extinct Zip drives of yesteryear.

Adding an item to a flash drive the simple way

Summary

This chapter has taught you the basics of sharing files with users of both Macs and PCs, as well as covered some topics that aren't so basic. I also discussed how to share files without the benefit of a network. Sharing files is one of the most fundamental tasks of using a computer in this electronic world of ours, and by this point you should be able to handle most file-sharing hurdles you may encounter.
Part III

The Working Mac

IN THIS PART

Chapter 9
Word Processing with Your Mac

Chapter 10
The Mac Does Spreadsheets and Presentations, Too

Chapter 11
Organize Life Using Your Mac

Chapter 12
Printing and Scanning with Your Mac
When most folks think of a Mac, terms like “multimedia,” “graphics,” “movies,” “photos,” “music,” and the like are what generally come to mind. But when something so seemingly arcane as word processing is mentioned, usually a Windows-based PC running Microsoft Word is the first thing that pops into most people's thoughts. That is a mindset that I hope to quash with this chapter, because, truth be told, Microsoft released Word for Mac several years before it did for Windows!

“What is word processing, anyway?” some may be asking. Word processing is the act of putting text, and in some cases graphics, on a page, whether printed or digital. Typically the first image conjured of someone using a word processor is a harried writer with tousled hair hunkered over a computer or old-fashioned typewriter, with an ashtray full of cigarette butts and crumpled pieces of paper scattered about the room, pounding out his or her latest creation on the poor, defenseless keyboard (kind of like me right now, minus the cigs).

Chances are almost certain that you will run into a word-processing application at some point if you use a computer, even on a semi-regular basis. You can use a word processor to create documents of almost any kind; most aren't limited to simply text files.

Word-processing apps can be used to make documents as diverse as books, leaflets, flyers, brochures, advertisements, church bulletins, envelopes, labels, résumés, and even the venerable grocery list. When it comes to putting text on a page, a word processor is what you'll need most of the time.

There are many options available to Mac users when it comes to these types of applications, and they are unparalleled in their ease of use. This chapter focuses on introducing you to some of the more popular word processors for
the Mac, and gives an overview of how to perform a few of their basic functions. I'm simply attempting to provide a good overview of these applications; this chapter isn't intended to be the final word on utilizing them to their maximum potential.

**Basic Word Processing with TextEdit**

You gotta love TextEdit: a simple word processor that you can use right out of the box when you first set up your Mac or upgrade to Leopard. As a matter of fact, TextEdit has been Mac OS X's de facto standard word processor since day one, but don't let that fool you about its capabilities. Apple has made significant strides in TextEdit (Mac OS X Leopard's version, 1.5, is shown in Figure 9.1) over the years, and it's probably the only word processor many Mac users will ever need.

![TextEdit's main window](image)

Let's explore TextEdit a little more and see what it has to offer and how to get a handle on using it.

**What can you do with TextEdit?**

TextEdit can do much more than what appears on the surface. Certainly you can use it for simple text documents, but you can also do a bit more:
- Dress up that text to make it as fancy or colorful as you may like.
- Utilize document elements such as tables and lists.
- Check your grammar and spelling on-the-fly.
- Open multiple document file types.
- View and write programming code, such as HTML (HyperText Markup Language).

Some of TextEdit 1.5's newest features include the following:

- Placing page numbers at the bottom of documents when you print them
- Moving to a specific line by entering a + or - followed by the number of lines you want to jump forward or move backward to
- Saving documents automatically
- Utilizing smart quotes, which are curly quotation marks instead of straight ones
- Automatically turning Internet addresses within your document into smart links that, when clicked on, will open a Web browser page to the specified address
- Using smart copy/paste to preserve proper spacing between pasted text and original text

I mentioned earlier that you could open multiple document file types, and Table 9.1 lists them for you.

### Table 9.1

<table>
<thead>
<tr>
<th>File Type</th>
<th>Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain Text</td>
<td>.txt</td>
</tr>
<tr>
<td>Rich Text Format</td>
<td>.rtf</td>
</tr>
<tr>
<td>Rich Text Format Directory</td>
<td>.rtfd</td>
</tr>
<tr>
<td>HTML</td>
<td>.html</td>
</tr>
<tr>
<td>Web Archive</td>
<td>.webarchive</td>
</tr>
<tr>
<td>Open Document</td>
<td>.odt</td>
</tr>
<tr>
<td>Microsoft Word 97</td>
<td>.doc</td>
</tr>
<tr>
<td>Microsoft Word 2003 XML</td>
<td>.xml</td>
</tr>
<tr>
<td>Microsoft Word 2007</td>
<td>.docx</td>
</tr>
</tbody>
</table>

**Note:** TextEdit's default format is Rich Text Format. If you open files of other formats from alternative word processors, such as Word (usually .doc) or OpenOffice (.odt), TextEdit may not be able to preserve all the formatting elements used by those applications.
Formatting text in your document

When I say “formatting” text, I mean to change the appearance or layout of it on the page. TextEdit affords you numerous tools for the task at hand. Figure 9.2 shows a ruler, which is at the top of all TextEdit windows by default. The ruler makes for easy formatting. If you don't see a ruler at the top of your document, choose Format ➪ Text ➪ Show Ruler from the menu, or press ⌘+R.

FIGURE 9.2
TextEdit's ruler makes formatting as easy as 1-2-3.

[Diagram of TextEdit ruler showing Justify, Align left, Line spacing menu, Tab stops, Styles menu, Align right, Lists menu, Center]

Stylizing text

There are lots of ways to make your text look exactly the way you want, so you can customize your documents.

To add style to your text:

1. Highlight the text you want to stylize. To highlight text, place the cursor next to the beginning of the text you want to highlight, click and hold the mouse button, drag the cursor over the desired text, and let go of the mouse button.

2. Choose one of the options from the Styles menu and select it with a click of the mouse. Figure 9.3 shows the effects of styles on text.

Text alignment

Some documents require text to be aligned differently than that of a typical letter. For example, the text on a party invitation may be centered as opposed to lined up with the left margin.

To align your text properly:

1. Highlight the text you want to align, as I've illustrated in Figure 9.4. To highlight all the text in a document, simply press ⌘+A.
2. Choose one of the alignment buttons in the ruler at the top of the window and click it. Figure 9.5 shows that I've chosen to center my text.

**FIGURE 9.3**
Styles can spiff up even the simplest document.

**FIGURE 9.4**
Highlight the text you want to align.

War Eagle, fly down the field,
Ever to conquer, never to yield!
War Eagle, fearless and true,
Fight on you orange and blue!
Go! Go! Go!
Setting margins and tab stops
Anyone who has used a typewriter or a computer to compose a document knows that setting margins and tab stops is essential to avoid unnecessary key presses and save you tons of time. Instead of pressing the spacebar five times every time you want to indent a paragraph, set the paragraph indentation for that amount of spaces and just press the tab key every time you need to indent.

To set margins, simply drag the downward-pointing triangles on the ruler to the position you desire. You cannot move them to less than one inch on either side of the ruler.

To set tab stops, drag the appropriate type of stop from the small oval window above the upper right side of the ruler to the location you want it to reside on the ruler. To remove a tab stop, just drag it off the ruler and it disappears into the land of forgotten tabs.

Working with fonts
You can do much more with fonts besides just stylize and align them. Choose Format → Font, as shown in Figure 9.6, and you will see a host of options to choose from. Select any of them from the menu to make changes to your fonts.

The first option in the Format → Font menu is Show Fonts; select it, or press ⌘ + T to display the Fonts window, shown in Figure 9.7.
The Format menu is a handy way to make adjustments to your text.

From within the Fonts window you can really customize your text, and even the document itself:

- Choose from multiple types of underlines and strike-throughs, using the popup buttons in the upper left corner.
- Change the color of text by clicking the text color button and selecting a color from the palette.
Part III

The Working Mac

- Select a different background color for your document.
- Add a shadow to your text and make adjustments to it using the appropriate sliders and by dragging the angle control knob.
- Choose a font by browsing your collections, families, and typefaces, and then use the slider on the right side to modify its size.
- Click the Actions button (it looks like a small gear) in the lower left corner to find even more font options for your characters and typography.

After you play around with it a bit, you will come to find that TextEdit may just be one of your most often used applications in your Mac OS X arsenal. For more information, don’t forget to consult the Help menu.

Now let’s get to know some of the other applications you can use for your word-processing needs.

Using Pages

Pages is one of the three applications that make up the iWork '08 suite of productivity applications from Apple. Pages is quite adept at handling not only your text, but also graphics, making it almost a hybrid word-processing/page layout application.

Here are just a few of the things you can do with Pages:

- Create brochures, letters, flyers, newsletters, manuals, books, envelopes, labels, posters, business cards, reports, and more.
- Use your own photos and movies in documents.
- Add charts and tables to your graphics.
- Save documents in a variety of formats.

Learn much more about Pages at www.apple.com/iwork/pages/.

Of course, before you can get started with Pages, you must install it. Follow the instructions for installing Pages using the documentation that you find in the box and on the installation disc.

Create new documents

You can create a new document from scratch or you can use one of the preconfigured templates that comes with Pages.
Choose a template

By default, when you first open Pages you are presented with the Template Chooser (Figure 9.8), from which you select a template to get started in creating your document.

FIGURE 9.8

The Template Chooser offers myriad document types and layouts to opt for.

![Template Chooser](image)

To select a template:

1. Browse the list on the left side of the Template Chooser to find the kind of document you want to create.
2. Select a template from the list of preconfigured layouts for the document type you want.
3. Click the Choose button to begin editing your template and building the document of your dreams! (Or is that a little too much excitement for a chapter on word processors?)

Getting around in the Pages interface

The main window of Pages offers many items to select from, so let’s take a look at them here. Figure 9.9 points out the highlights of the main window, and Table 9.2 gives you a brief explanation of each item.
Part III  The Working Mac

**FIGURE 9.9**

Pages’ main window affords you all kinds of functionality, right at your fingertips.

**TABLE 9.2**

**Pages’ Main Window Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>View</td>
<td>Select which items to view or hide when creating a new document, such as thumbnails or invisible items.</td>
</tr>
<tr>
<td>Sections</td>
<td>Add new sections to the document you are currently working in.</td>
</tr>
<tr>
<td>Text Box</td>
<td>Place a new text box wherever the cursor is positioned in the document.</td>
</tr>
<tr>
<td>Shapes</td>
<td>Choose a shape from the popup menu and it will be placed where the cursor is positioned in the document.</td>
</tr>
</tbody>
</table>
Placing images and shapes

When Apple set out to make a word processor, it seems they gave every function in it the uncanny ability to exceed your expectations, even a task like placing images and shapes in a document. Let's see how truly simple it is to work with images and shapes in Pages.

Images

Adding an image to a Pages document is as simple as dragging the image from a folder or any other location on your Mac to the place in the document you want it to reside and just dropping it in. That's it!

Here's an alternative method:

1. Position the cursor to the place in the document where you want to place the image.
2. Choose Insert ☰ Choose from the menu.
3. Browse your Mac for the image you want to add to the document, highlight it, and click the Insert button.
Still not satisfied? Well, there's one more way I can think of to get images into your documents, and this one is unique to Pages:

1. Click the Media button in the upper right of the Pages window to open the Media window.
2. Click the Photos button.
3. Browse your Mac's catalog of images until you find just the right one for the occasion.
4. Drag the image, as shown in Figure 9.10, to the location you want it to be placed in the document, and drop it in. Done!

Don't like where your images are located in the document? Well, it may be easier to readjust their layout than it is to place them in the document in the first place! You can move your images by simply clicking and dragging them from their old position to the new; that's all there is to it!

You can also resize the images:

1. Click the image you want to resize.
2. Drag one of the small white boxes found on each side of the image and in each of the corners to adjust the image to the desired size.

**FIGURE 9.10**
Adding media to your documents doesn't get any simpler than with Pages.

![Image of Pages window with Media and Photos sections open](image-url)
Shapes
Shapes add character to otherwise boring presentations. For instance, a bang in the middle of a sales flyer alerts you to a special price or event going on at a particular store. Pages makes it easy to add colorful shapes to your documents:

1. Click the Shapes button in the main window, as shown in Figure 9.11, and select a shape for what you need.

2. Resize the shape according to your wants. I chose a star (Figure 9.12), so I have the option to increase the number of points in the star as well as the ability to resize it.

Add tables and charts
If you are a business professional, what good is a document that doesn’t contain charts and tables? We can’t have that, now can we? Never fear, Pages is here! Apple isn’t just about the creative; they have the practical in mind, too.
To add a table to your document:

1. Place the cursor in the location you want the table to appear in the document.
2. Click the Table button in the main window, or choose Insert → Table from the menu.
3. A new table, like the one shown in Figure 9.13, is placed in the document, ready for you to add information to it.
4. You can make all kinds of adjustments to the table by highlighting it, and then choosing Format → Table. There are several options for modifying the table, such as adding rows or columns, or converting the table into text. You can also resize the table by dragging the handles on either side and in each corner.

A chart is just as simple to add, and it can really spice up that boring quarterly report, to be sure:

1. Place the cursor in the location you want the chart to reside in the document.
2. Click the Chart button in the main window, or choose Insert → Chart.
3. A chart appears in the desired place in the document, along with the Chart Data Editor window, shown in Figure 9.14.
4. Customize the chart to your heart's content with the Chart Data Editor. As with other items in Pages, you can resize the chart by dragging the handles on either side and in each corner.
The default table isn't much to look at, so you'll need to add data to illustrate your points.

![Figure 9.13](image1)

Charts always make even the most inane stats look more official, don't they?

![Figure 9.14](image2)
Import and export files

Pages supports many different file formats, both for import and export. However, you can't always expect perfection, because the way that Pages may handle some elements of a document is sure to be different than the ways some of its competitors handle those elements. Due to these differences, a document might import into Pages but not be properly formatted, as I'm being warned of in Figure 9.15.

Likewise, a Pages document can be exported in any number of formats, but that document may not function or appear identically in other applications such as Microsoft Word or OpenOffice.

To import a file, simply choose File → Open, find the file on your hard drive, highlight it, and click the Open button.

To export a document from Pages:

1. Choose File → Export from the menu.
2. Decide what type of file format to export to (Figure 9.16): PDF, Word, RTF, or plain text, and then click Next.
3. Give the file a descriptive name, choose a location on your Mac to save the exported file, and click Export.

Get to Know Word on Your Mac

I couldn't do this chapter without mentioning the holy grail of word processors, Microsoft Word. The fact that Microsoft actually makes software for the Mac may come as a surprise to some folks outside the Mac community, but it is indeed so. As a matter of fact, Microsoft has an entire division of their massive company solely dedicated to providing top-of-the-line apps for the Mac environment.

The latest incarnation of this application stalwart is Office 2008 for Mac, which includes Word 2008. (For more information on the entire Office suite, as well as other Microsoft programs for the Mac, check out www.mactopia.com.)

Word 2008 is a welcome upgrade, and somewhat of a departure, from its previous versions. It's actually become more Mac-like, while retaining its famous functionality and cross-platform capabilities. Yes, Word documents you create on the Mac will work for someone running a Windows version of the Office suite, and certainly the reverse of that is true, too. Kind of convenient, wouldn't you agree? Here's a brief look at some of the newest and coolest features in this latest version of Word:

- The **Elements Gallery** gives you quick access to some of the best formatting features to come around in quite a while, such as SmartArt Graphics and WordArt.
- **SmartArt Graphics** are information-oriented items, such as charts and diagrams, that can be easily created and edited.
- **WordArt** can apply 2-D and 3-D effects to your document text.
- **Themes** allow you to coordinate the color and design elements of your documents easily and hassle free.
- **Publishing layout view** is a great way to view your document as it will appear when printed, and can make adding and removing elements on a page that much simpler a task.
- **Document Elements** help you quickly and simply add vital components to complex documents, such as tables of contents, headers and footers, and cover pages.

Let's take a peek at this most venerable of software.

Utilize the Project Gallery

The Project Gallery is a holdover from earlier versions of Word, and for good reason: It helps you instantly pick the type of document you want to create and offers preconfigured templates to make constructing your document that much easier. The Project Gallery, shown in Figure 9.17, opens by default when you first open Word, but in case it doesn't open, just choose File → Project Gallery, or press ⌘+Shift+P.
To create a document using the Project Gallery:

1. Select a document type from the Category list on the left side of the window.
2. Browse through the different templates offered under the document type you chose in step 1.
3. Click Open to begin using the desired template.

Other items in the Project Gallery include the following:

- The Recent tab shows you documents that you've worked on recently.
- The Project Center tab helps you keep track of projects you are currently working on with others using the Project Center.
- The Settings tab lets you modify how the Project Gallery functions and what items it displays.
- Click the Open Other button to open documents from other locations on your computer or a server.

**New text and graphics features**

I'm going to take this time to show you what's unique about Word 2008 instead of showing you how to perform the most basic of tasks, which by now you should certainly be familiar with in TextEdit and Pages; that stuff's not much different in Word. Let's see the cool stuff!


**Document Elements**

Document Elements puts commonly used items that you might find in a complex document in a convenient thumbnail format that you can easily browse. Figure 9.18 shows a standard Word 2008 window with the Document Elements tab selected in the Elements Gallery.

**FIGURE 9.18**

Document Elements is an easy way to jazz up your documents.

To use a Document Element:

1. Choose one of the categories available: Cover Pages, Table of Contents, Header, Footer, and Bibliographies.
2. Select an element from the thumbnail list below the categories. Most have several sets of thumbnails, as evidenced by the oval button to the right of the thumbnails that shows which set of thumbnails you are currently viewing (for example, 2 of 7 or 3 of 5).
3. The elements have been laid out for you; all you have to do is enter your information where the placeholder text is.
Quick Tables
Like many things in life and document creation, tables can be really simple or ridiculously complex. Quick Tables makes it much simpler to add a table to your documents, as shown in Figure 9.19, than in previous versions of Word.

Charts
Charts can be easily inserted into Word documents (some with a little helping hand from another Office suite app, Excel), especially when using the Charts tab in the Elements Gallery. To add a really great-looking chart, select a chart type from the buttons and then choose your favorite thumbnail, as I did in Figure 9.20.

SmartArt Graphics
SmartArt Graphics helps you interestingly pack information into a really cool graphic, lending a professional look to your documents. I don't know about you, but my presentations and documents could always use a bit more spice to keep the audience awake. The Funnel graphic I chose under the Relationship category illustrates the filtering of ideas into one (Figure 9.21).

FIGURE 9.19
Difficult tables can be inserted quite easily with Quick Tables.
Word’s charts are exceptional in quality and in the number of variations available.

Info made interesting, the SmartArt Graphics way.
WordArt

WordArt allows you to stylize your document's text with all kinds of special effects. You can apply textures, outlines, shadows, and even rotate and stretch the text. Text can be so dry and boring . . . unless you put a spin on it, like I did in Figure 9.22!

FIGURE 9.22

WordArt lets you turn any old phrase into something that stands out and makes you read it.

Import and export files

As with other word processors of note, Word can handle itself quite well in the war of file formats. Table 9.3 lists most of the file formats supported by Word 2008.

TABLE 9.3

Word 2008 Supported File Formats

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.docx</td>
<td>This is the default format, which is based on XML and has become the standard for new Microsoft Word products as of Word 2007 for Windows.</td>
</tr>
</tbody>
</table>
Word Processing with Your Mac

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.dotx</td>
<td>XML-based template, which can be used to make new document creation much easier, as opposed to having to start from scratch.</td>
</tr>
<tr>
<td>.rtf</td>
<td>Rich Text Format, which can be read by most text-editing programs and word processors, but has limited formatting options.</td>
</tr>
<tr>
<td>.txt</td>
<td>Plain text documents.</td>
</tr>
<tr>
<td>.htm</td>
<td>This format can be used to export your Word documents into Web pages.</td>
</tr>
<tr>
<td>PDF</td>
<td>Portable Document Format is an option you can export to to guarantee that anyone viewing the file will see it the way it was intended, without worry of formatting issues.</td>
</tr>
</tbody>
</table>

To save a document in any of these illustrious formats (and a few other possibilities, too):

1. Choose File ➤ Save As from the menu.
2. Determine a location on your Mac to save the exported file and give it a descriptive name.
3. Select a document type from the Format popup menu (Figure 9.23).
4. Click the Compatibility Report button to see if there will be any problems with exporting elements of your document to the particular file type, and heed any warnings that may appear.
5. Click Save when you’re ready to complete the process.

FIGURE 9.23
Choose the particular format you wish to save your file in.
Alternative Word Processors

There are many more word-processing applications out there for your Mac, and many of them are very high-quality apps that rival those already mentioned. Because space is limited, however, I can't cover all the great programs in the field, but two of the most popular alternatives to Pages and Word are OpenOffice and NeoOffice. I'm focusing on these two because not only are they suites of applications containing very good word processors; they're both free as well!

OpenOffice.org Writer

According to their Web site, OpenOffice.org is both a product and a project. The product side incorporates a suite of office productivity software that rivals that of Microsoft's Office and Apple's iWork. The project side is a community of developers from around the world who are hard at work upgrading and maintaining the free suite of applications. OpenOffice.org is a relatively new player in the Mac field, but has been around the Linux and Windows worlds since 2000. Although OpenOffice has been around since that time, only recently has there been a Mac OS X native version that would work and behave like any other Mac application.

To give Writer, and OpenOffice.org in general, a test drive, go to www.openoffice.org and click the download link. The site will automatically detect that you are on a Mac and download the correct version of the software for you (pretty cool, huh?). After you've downloaded and installed the application (just drag the OpenOffice.org icon from the mounted disk image to your Applications folder to copy over the files), double-click the OpenOffice.org icon to launch the program. To open Writer, click the Text Document icon in the OpenOffice.org window (Figure 9.24).

FIGURE 9.24

The OpenOffice.org launch window helps you quickly create many different types of documents.
Writer, shown in Figure 9.25, is the OpenOffice.org word processor, and it is loaded with all the word-processing features you would come to expect from a modern application of its type. Like its competitors, it is just as adept at handling a complicated book full of illustrations and images as it is at making a memo.

**FIGURE 9.25**

Writer has most of the tools you will ever need to create great word-processing projects.

Writer also supports most word-processing file formats, including the most popular ones:

- OpenDocument file (default): .odt
- OpenDocument template: .ott
- HTML: .html
- Standard Word document: .doc
- Rich Text: .rtf
- Plain text: .txt
- Word 2003 XML: .xml

OpenOffice provides excellent documentation in its Help files (Figure 9.26). To get to the Help files, choose Help ➔ OpenOffice.org Help from the menu.
Why Pay for a Word Processor When Others Are Free?

I know you must be wondering at this point why in the world you would want to pay for a word processor like Pages or Word when you can get OpenOffice.org or NeoOffice for free. The bottom line is what you expect from the software and how familiar you are with it. If you expect top-of-the-line support from the developers of an application, paid is usually the way to go (there have been a few exceptions to that rule, however). If you expect frequent updates to fix common bugs, paid is also the way to go. If you're familiar with Microsoft's Office products or Apple's now-defunct AppleWorks suite and don't have time to learn anything else, paid is certainly the way to go. None of this means that you won't get good support from the free programs, or that bugs aren't resolved in a timely manner, or that you can't quickly pick up on the differences between these applications and those you are more familiar with. It does mean that people are getting paid to work on and maintain the paid applications, which can make a big difference because they are dedicated to these applications as part of their jobs; this is how they make their living. And those paid applications generally are supported by and more familiar to a greater number of users should you need help; your typical IT guy or gal knows how to make Word behave correctly, but most likely has never even heard of NeoOffice. Don't get me wrong: I highly recommend the free applications mentioned in this chapter, but only if you have the time to get to know something a little bit new and if you are patient when it comes to resolving any problems that may crop up.
NeoOffice

NeoOffice is a productivity suite of applications based on OpenOffice.org, but is dedicated to providing the user with Mac-specific features and a decidedly more Mac-like interface. Remember, OpenOffice.org is an open source project, which means other developers can take their code and improve upon it, which is exactly what the NeoOffice folks have done.

You can download NeoOffice, shown in Figure 9.27, from its Web site, www.neooffice.org.

NeoOffice Writer can do all the great things that OpenOffice.org can do, but in a more Mac-like way. There are even features incorporated into NeoOffice that OpenOffice.org will never be able to use on other computing platforms, like the iLife Media Browser (you can drag-and-drop pictures and other media directly into your documents, similar to Pages). When you first launch NeoOffice, it automatically opens a new text document, so you are always ready to begin word processing the instant you crank it up.

FIGURE 9.27

NeoOffice is another great suite of productivity tools for your Mac.

Should you take the RED pill or the BLUE pill?

(Taken from Matrix reference, 1999)

TIP There are lots of good word processors on the market for Mac, so get out there and give them a whirl. If you need more than what I've offered in this chapter, good old Google can help you find other Mac-specific word-processing applications that might suit your tastes or needs better.
Summary

You should have a good idea about the word-processing offerings available on the Mac OS X platform by this point. In this chapter I've shown you some of the most basic tasks that the most popular word processors can accomplish, from stylizing text to creating tables and charts. There's nothing you can do with a word processor on any other operating system that you can't do with your Mac, so get to processing those words!
In Chapter 9 I dispelled the notion that Mac OS X was only good for graphics work by showing the many world-class word-processing applications available for the platform, as well as how to use some of their basic features. This chapter takes the same approach by striving to shed some light on other more business-like uses your Mac can handle: spreadsheets and presentations. For years, most computer users have relegated these tasks to Windows-based PCs, believing the Mac to be more Photoshop-friendly than Excel-friendly. Won't those of you who have labored under that assumption be surprised to know that Microsoft not only offers Excel and PowerPoint for the Mac, but that both have thrived on Apple computers longer than they have on Windows PCs? It shocked me the first time I heard it, too.

While Microsoft certainly has a strong presence in both the spreadsheet and presentation fields, they are by no means the only players on the field. Apple recently introduced Numbers and Keynote as part of their iWork '08 suite of productivity applications. Numbers is a knockout spreadsheet app that makes creation of spreadsheets a dream. Keynote is the presentation offering from Apple, and it incorporates all of the ease-of-use and beautiful interface features you've come to expect from Apple products.

Since we are talking about Macs, let's look at Apple's participants first.

Using Numbers to Create Spreadsheets

Numbers was first introduced to the world of spreadsheets with the release of iWork '08. Apple recognized the need for a better interface in these types of applications that make it easier to create and understand spreadsheets and
the information they contain. Numbers delivers this “interface for the masses” (my term) in spades! I've used other spreadsheet applications in the past, and while I am familiar with them and can get around their menus and options quite nicely, Numbers simply surprised me with how much fun (yes, I said fun!) it can be to create spreadsheets the Apple way (see Figure 10.1). With Numbers, anyone, regardless of their computer or spreadsheet experience, can sit down at a Mac and within minutes put together easy-to-understand, professional, and beautifully rendered spreadsheets, charts, and graphs.

Numbers can help you design spreadsheets like never before with the simplicity of templates and drag-and-drop techniques for multimedia. If you are used to working with other spreadsheet applications, Numbers will really impress you.

Because Numbers is part of the iWork '08 applications suite, it cannot be purchased separately. Most new Macs come with at least a trial version of iWork '08, so if you don't own a copy you should still be able to follow along. If you do own a copy, install iWork '08, double-click the Numbers icon in the /Applications/iWork '08 directory, and let's get started.

For more information on Numbers beyond this chapter, go to www.apple.com/iwork/numbers/.

**Create a new spreadsheet**

When you first launch Numbers, by default you are prompted to create a new spreadsheet or open an existing file. Should you already have Numbers open, choose File→New to open the Template Chooser window (Figure 10.2).

---

**FIGURE 10.1**

A typically awesome Numbers spreadsheet
If you are embarking on a new spreadsheet journey, select one of the templates and click Choose. If you want to open an existing spreadsheet, click the Open an Existing File button, browse your Mac for the file, highlight it, and then click Open.

**Use templates**

The Template Chooser gives you a multitude of options, from starting fresh with a blank spreadsheet to using one of the beautifully designed preformatted templates. Preformatted templates contain pre-defined tables, sheets, graphs, placeholder graphics and images, and other items that make putting together a professional and eye-catching spreadsheet a snap, as long as you’ve got your numbers and statistics ready to plug in. There are templates for several types of spreadsheets, including:

- Checklists
- Budgets
- Loan comparisons
- Expense reports
- Invoices
- School grades

Pre-defined tables already come loaded with example data and formulas, but these can easily be edited to suit your needs.

Sheets help you to divide data based on defined criteria, such as one sheet for data concerning one branch of your business and another sheet for a second branch. Both sheets are contained in a single file for easy access.
Placeholder graphics and images are easily replaced by dragging-and-dropping your own images onto them. These are exactly what their name implies: simply placeholders to give you an idea of how your spreadsheet is laid out and how it will look with related images or graphics (such as a logo) placed inside.

**Tip**  
Every pre-defined element in a template can be modified to give the spreadsheet your personal touch, so don't feel like you can't tinker with their contents too much. Have fun, and make that spreadsheet yours!

**Getting around in Numbers**

To fully utilize Numbers, it's a good idea to get acquainted with where its features are located. Figure 10.3 gives you a map of the items you will find in Numbers' main window, and Table 10.1 tells you a little about each one.
The Mac Does Spreadsheets and Presentations, Too

<table>
<thead>
<tr>
<th>Numbers’ Main Window Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Option</strong></td>
</tr>
<tr>
<td>View options</td>
</tr>
<tr>
<td>Add a sheet</td>
</tr>
<tr>
<td>Tables</td>
</tr>
<tr>
<td>Function</td>
</tr>
<tr>
<td>Formula bar</td>
</tr>
<tr>
<td>Sheets pane</td>
</tr>
<tr>
<td>Styles pane</td>
</tr>
<tr>
<td>Calculations pane</td>
</tr>
<tr>
<td>Format bar</td>
</tr>
</tbody>
</table>

Format cells and rows

Numbers gives the option of starting with a blank spreadsheet or working with a preconfigured one, and formatting cells and rows for each kind is pretty much the same, with the major exception being that the preconfigured spreadsheets have placeholder information that you simply have to type over to replace. With a blank spreadsheet you literally have to start from scratch. So that you can get a better handle on how Numbers works, let’s start with a blank spreadsheet to give you an overview of using this neat program.

First, create a new spreadsheet:

1. Press ⌘+N or choose File ➤ New from the menu.
2. Select the blank template.
3. Click the Choose button.

At this point Numbers opens a new spreadsheet with a new table ready to go. Figure 10.4 shows the basic anatomy of a spreadsheet.

**Note:** Notice that columns are labeled A, B, C, D, and so on, while rows are numbered (1, 2, 3, and so on). Cells are referred to based on the column and row they coincide with; for example, A1, C3, D12, M2, L45, and so on.

For this example I’m going to create a table that lists quarterly and total earnings over the past three years for a fictional small company. Let’s enter some data into the rows and columns of our spreadsheet. Table 10.2 lists our example data.
The basic elements of a spreadsheet

Table handles

Columns

Cells

Rows

Example Data for Numbers Spreadsheet

<table>
<thead>
<tr>
<th>Year</th>
<th>2008</th>
<th>2007</th>
<th>2006</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quarter 1</td>
<td>10</td>
<td>11</td>
<td>8</td>
</tr>
<tr>
<td>Quarter 2</td>
<td>11</td>
<td>12</td>
<td>10</td>
</tr>
<tr>
<td>Quarter 3</td>
<td>8</td>
<td>6</td>
<td>6</td>
</tr>
<tr>
<td>Quarter 4</td>
<td>10</td>
<td>8</td>
<td>7</td>
</tr>
</tbody>
</table>

Entering data into Numbers

Table 10.2 is laid out in pretty much the same manner that we will lay out the contents of our table in Numbers, with the exception that we will have a Totals row in our Numbers table. To enter contents into a cell, simply double-click the cell and begin typing.

Let’s get started loading our data into the new table. Type the information exactly as shown in Figure 10.5. Place the text “Year” in cell A1, “Quarter 1” in cell A3, “2006” in cell D1, and continue with the rest until all the data is entered.

An annoyance you may have noticed is that our template has a slew of rows and columns, and for our purposes here we only need a few. Because there are only four quarters in a year and we’re only covering three years, the numbers of rows and columns needed is significantly less than what Numbers presents us by default. How do we change the numbers of rows and columns in our spreadsheet? Well, there are several ways to go about this, but let’s make it as simple as possible using the table handles:
1. Click and drag the column table handle in the upper right corner of the spreadsheet to the left until you get to column D. Don't go farther than column D because we have data entered into it.

2. Scroll to the bottom of the spreadsheet. Click and drag the row table handle in the lower left corner all the way to row 8. Don't go past row 8 or you will delete our Tables row.

The spreadsheet should look exactly like the one in Figure 10.6.

**FIGURE 10.5**

Enter the data exactly as I've done in order to follow along with this short tutorial.

**FIGURE 10.6**

The spreadsheet has just the right amount of columns and rows now.

*Using formulas with cell data*

Some tables don't require any interaction with the data in their cells, but others do, as in our case. We want the Totals row to reflect the sum of the quarters for each year, without us having to figure out the totals ourselves and enter them manually. Using a formula, we can have the Totals cells for...
each year add the contents of the appropriate quarterly cells to give us a correct sum for that year. Because we are using a formula, if those quarterly numbers change, the Totals cell or cells will change as well. The Function button in the Numbers toolbar helps you easily add a basic formula to a cell. Let's create a formula for cell D8, which will be a total sum of all the earnings for Quarters 1–4 of the year 2006:

1. Click the cell you want to apply the formula to, which is cell D8 in our table.
2. Click the Functions button and choose a formula from the popup menu, as shown in Figure 10.7. You need to select Sum for our purposes.

![FIGURE 10.7](image)

Choose a formula from the popup menu.

3. As you can see, Numbers automatically knows to add all the data from the previous rows that are in column D to acquire a sum for cell D8.
4. Perform steps 1 and 2 for cells B8 and C8 to create sums for the years 2008 and 2007, respectively.

**Give your table a name**

Now that we've got a table, it's a good idea to let others who may view the spreadsheet in on just what these numbers reflect, which is exactly what the table's name should do. Let's name our new table:

1. Check the Name box in the upper right corner area of Numbers' main window.
2. Right-click, or Ctrl+click, the title of our table ("Table 1") in the Sheets pane and select Rename, as shown in Figure 10.8.
3. When the name of the table is highlighted, type its new name.
4. Click outside the table and you will clearly see the new name above the table (Figure 10.9).
Spicing up your table with a chart

Charts and graphics make a spreadsheet a lot more interesting, and judging by the looks of the spreadsheet we just made, it could use all the "interesting" it can get!

To create a chart from our table:

1. Select the table in the Sheets pane to highlight it.
2. Click the Charts button and select the first chart you see, shown in Figure 10.10.
3. You should now see a basic chart.
Select a chart to help illustrate your table's contents for your audience.

4. Note that the chart lacks a title: Let's give it one:
   a. Right-click, or Ctrl+click, the name of the chart in the Sheets pane and select Rename.
   b. Once the name highlights, type in the new name for the chart.

5. Our new chart is also fairly small, so some of the titles in it cannot be seen. To resize the chart:
   a. Click the chart to highlight it.
   b. Click-and-drag the size handles (look like small white boxes on each side and corner) to the size you need. Figure 10.11 shows you how the chart now appears.

This is by no means all the information there is on creating a table and using charts, or all that you can do with either of them, but it should be plenty to show you the basic steps to get you started with Numbers. Consult the documentation that came with iWork '08 for more help, or for that matter, use the Help menu in Numbers itself.

**Import and export spreadsheets**

Numbers is a nice application, meaning that it knows how to work and play with other applications of its type rather well. Numbers can import spreadsheets created by other spreadsheet applications, and it can also export its spreadsheets in formats that other spreadsheet apps, like Microsoft Excel, can open, view, and edit.
When importing and exporting files, you may run into problems bringing in different style elements from another application into Numbers or vice versa. If that happens, you don’t have much recourse other than to re-create those portions of the spreadsheet using the new application.

**Importing spreadsheets**

Numbers is fluent in many types of spreadsheet file formats. You can import files created in Microsoft Excel, AppleWorks 6, CSV (comma-separated value) files, tab-delimited files, and OPX files (Open Financial Exchange).

To import a document into Numbers:

1. Choose File→Open or press ⌘+O.
2. Browse your Mac for the file you want to import and click to highlight it.
3. Click the Open button.
4. If there were issues importing all the elements used in the file into Numbers, a dialog box will be displayed. Click Review to see a list of warnings like the one shown in Figure 10.12.

**Exporting spreadsheets**

Numbers is also well versed in exporting its spreadsheets to different formats, such as PDF, Excel (XLS), and CSV.

To export a spreadsheet:

1. Open the spreadsheet you want to export from Numbers.
2. Choose File→Export from the menu.
3. Select a file type to export the file to, as shown in Figure 10.13.
Watch out for those warnings when importing files.

Choose whether to export to PDF, Excel format, or CSV.

4. Click the Next button.
5. Give the exported file a descriptive name and choose a location to save the file to.
6. Click Export to complete the process.

**Working with Excel**

Anyone who's ever used a spreadsheet is more than likely familiar with Microsoft Excel. Unbeknownst to some, however, Microsoft does indeed provide a version of Excel for Mac OS X! If you've ever used Excel on a PC, you won't skip a beat with Excel for Mac; all the goodies you're used to are here for you on the best operating system on the planet, just as they are on that other OS. Rejoice, Mac-converts, rejoice!
The Mac Does Spreadsheets and Presentations, Too

This section of the chapter isn’t intended to be a treatise on how to use Microsoft Excel for Mac, but rather an introduction to one of the Mac’s choice applications. We’ve gone over the basics of spreadsheet tables in the previous section on Numbers, so here we’ll just take a look around at Excel’s interface and discover what makes it unique to other spreadsheet apps.

Because Excel is a Microsoft product, you’ll be able to open Excel documents from Windows users, and they’ll in turn be able to open your Excel documents on their PCs, and everything will look just like you both intended it to, because Windows and Mac versions of Excel both use the same file format. Now that’s convenience, folks.

Excel 2008 shares some of the new features that Word 2008 has, such as the Elements Gallery, SmartArt Graphics, WordArt, themes support, and XML file formats. Other new features specific to Excel 2008 include the following:

- Ledger sheets, which are preformatted Excel documents that make it a snap to put together invoices, create expense reports, balance your checkbook, and more.
- Formula Builder, which helps you create formulas one step at a time without having to know the syntax for every available formula.
- Improved charting, which lets you include beautiful and modern charts in your Excel documents, and even share them across other Office applications.

You can purchase Excel as part of Microsoft Office 2008 for Mac. Find out more at www.macstopia.com.

Spreadsheet creation

Creating a spreadsheet in Excel is as straightforward as opening the application. Excel immediately starts up by displaying a new workbook for you to begin your spreadsheet, as shown in Figure 10.14. Figure 10.14 also shows you the major landmarks in a workbook window.

You are already familiar with columns, rows, cells, and sheets, but maybe not with the other features listed:

- The Standard toolbar gives you quick access to common tasks such as printing your workbook, copying, pasting, zooming in and out, opening, and saving documents.
- The Name box displays the name of the cell you are currently active in.
- AutoSum is a button that gives you instant access to pre-defined formulas, much like the Function button in the Numbers toolbar.
- The Elements Gallery can be found perched beneath the Standard toolbar. There are tabs that let you quickly place sheets, charts, SmartArt Graphics, and WordArt in your spreadsheets. We’ll get more familiar with the Elements Gallery a little later in this section.

If you read the section in this chapter on Apple’s Numbers, you pretty much have a handle on how to enter data into Excel; really, there is no difference. However, the ways you work with that data are somewhat different, as you’ll soon see.
Use the Toolbox to format your spreadsheet

The Toolbox will quickly become your buddy when using Excel. Using the Toolbox, you can modify many of the aspects of your spreadsheet, including items such as fonts, images, and formulas, and even find just the right word or check your file's compatibility with other versions of Microsoft Office.

To open the Toolbox, click the Toolbox icon in the Standard toolbar. The Toolbox will appear to almost shoot out of the Toolbar button! Conversely, if the Toolbox is already open, clicking the Toolbox button will cause the Toolbox to appear to be sucked into the button itself.

The Toolbox is divided into separate sections, each of which can be accessed immediately by clicking the respective icon in the topmost section of the Toolbox. The sections available in the Toolbox are as follows:

- The Formatting Palette, shown in Figure 10.15, is convenient for changing fonts used in cells; adjusting the number formatting, alignment and spacing; adding, removing, or modifying cell borders and shading; setting up the page orientation and scaling; and selecting a theme for your spreadsheet.
The Mac Does Spreadsheets and Presentations, Too

The Formatting Palette is a major help with changing the appearance of your tables.

![Figure 10.15](image)

- The Object Palette, shown in Figure 10.16, helps you easily add items such as clip art, shapes, graphics, and even images to your spreadsheets.
- The Formula Builder is a great benefit if you're lacking in formula skills. It can guide you in simply creating formulas, adding new functions and arguments in existing formulas, explaining how functions work, and searching for functions that perform your intended task.
- The Scrapbook is a nifty holding place for items such as images or text clips. You can then use those items in any Office application, and they remain in the Scrapbook even after the programs, or even the computer itself, have been shut down.
- The Reference Tools, shown in Figure 10.17, keep items such as a thesaurus and dictionary readily accessible. There's even an encyclopedia and bilingual dictionary!
- The Compatibility Report helps you check your spreadsheet to make sure that it will be compatible with other people you may share it with who have a version of the Office suite that is different than yours.
- The Project Palette connects you to the Project Center so you can keep track of any projects you may be working or collaborating on.
Add items to your spreadsheet with the Elements Gallery

The Elements Gallery is an awesome way to spice up that boring spreadsheet of yours. Using the Elements Gallery, you can quickly add great-looking charts and graphs, preconfigured sheets, and make some spiffy text alterations.

There are four tabs, or sections, in the Elements Gallery:

- **Sheets** (Figure 10.18) gives you a variety of pre-defined sheets for items such as reports, invoices, lists, portfolios, budgets, and accounts, as well as a handful of blank sheet styles.
- **Charts** (Figure 10.19) allows you to transform your table's data into knockout charts and graphs in a huge variety of different 2-D and 3-D styles.
- **SmartArt Graphics** gives you many different ways to relay various types of information to people, using pre-defined graphics that reflect certain concepts or ideas, such as relationships between items or the hierarchy of an organization.
- **WordArt** lets you add customized text to liven up your spreadsheet, as shown in Figure 10.20.
The Reference Tools really come in handy when you need to find just the right word.

Pre-defined sheets makes creating common types of tables a breeze.
There are some really cool charts available to represent your data.

You can add 2-D and 3-D text to your spreadsheet using WordArt.
Share your spreadsheets

The ability to share your spreadsheets with anyone you need to is a critical function of Excel. If you create the most incredible spreadsheet ever devised by humanity, but no one else can view it because their spreadsheet application is unable to open the file format you saved it in, what good is all your hard work? Now, to be honest, the likelihood of you using Excel and most people not being able to view your file is pretty low, but you get my point. For those folks who don’t use Excel for one reason or another (Numbers, anyone?), or don’t have a spreadsheet application at all, Microsoft has provided the ability to save a spreadsheet in a large assortment of file types, as described in Table 10.3.

### TABLE 10.3

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Excel Template (.xltx)</td>
<td>Saves the workbook as a template that you can use to create workbooks in the future. Templates retain the formatting settings and formulas of the original workbook.</td>
</tr>
<tr>
<td>Excel 97–2004 Template (.xlt)</td>
<td>Saves the workbook as a template that you can use to create workbooks in the future. Compatible with Excel 98 through Excel 2004 for Mac and Excel 97 through Excel 2003 for Windows.</td>
</tr>
<tr>
<td>Comma Separated Values (.csv)</td>
<td>Exports the data in your table to a plain text file, using commas to separate the values in each cell. No formatting is retained.</td>
</tr>
<tr>
<td>Web Page (.htm)</td>
<td>Saves the workbook as an HTML file, which can be viewed in any Web browser. This is particularly useful for sending your spreadsheets to folks who don’t have a spreadsheet application.</td>
</tr>
<tr>
<td>PDF</td>
<td>Saves your workbook as a PDF file, which can be opened by anyone with a PDF viewer installed on their computer, such as Preview or Adobe Reader.</td>
</tr>
<tr>
<td>Excel Binary Workbook (.xlsb)</td>
<td>The following formats are alternatives to the more popular ones detailed above. See Excel’s Help section for more information on these file types.</td>
</tr>
<tr>
<td>Excel Macro-Enabled Workbook (.xlsm)</td>
<td></td>
</tr>
<tr>
<td>Excel Macro-Enabled Template (.xltm)</td>
<td></td>
</tr>
</tbody>
</table>
Supported Excel File Formats

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Excel 2004 XML Spreadsheet (.xml)</td>
<td></td>
</tr>
<tr>
<td>Excel Add-In (.xlam)</td>
<td></td>
</tr>
<tr>
<td>Excel 97–2004 Add-In (.xla)</td>
<td></td>
</tr>
<tr>
<td>Single File Web Page (.mht)</td>
<td></td>
</tr>
<tr>
<td>UTF-16 Unicode Text (.txt)</td>
<td></td>
</tr>
<tr>
<td>Tab Delimited Text (.txt)</td>
<td></td>
</tr>
<tr>
<td>Windows Formatted Text (.txt)</td>
<td></td>
</tr>
<tr>
<td>MS-DOS Formatted Text (.txt)</td>
<td></td>
</tr>
<tr>
<td>Windows Comma Separated (.csv)</td>
<td></td>
</tr>
<tr>
<td>MS-DOS Comma Separated (.csv)</td>
<td></td>
</tr>
<tr>
<td>Space Delimited Text (.prn)</td>
<td></td>
</tr>
<tr>
<td>Data Interchange Format (.dif)</td>
<td></td>
</tr>
<tr>
<td>Symbolic Link (.slk)</td>
<td></td>
</tr>
<tr>
<td>Excel 5.0/95 Workbook (.xls)</td>
<td></td>
</tr>
<tr>
<td>Office Theme (.thmx)</td>
<td></td>
</tr>
</tbody>
</table>

Now that you know you have an army of file types to choose from, let me show you how to get there:

1. Choose File ⊗ Save As from the menu.
2. Give the file a descriptive name.
3. Choose a location in which to save the file using the Where popup menu.
4. Select a format to save your file with using the Format popup menu. The Description window below the Format menu gives you a brief explanation about the format currently selected, as shown in Figure 10.21.
5. Click the Options button to require a password be used by the person you send the file to; he or she will need to enter the password before being able to open and/or modify the file.
The Mac Does Spreadsheets and Presentations, Too

6. Click the Compatibility Report button to see if there will be any negative repercussions to saving your file in the desired format.

7. Click Save to save the file.

**FIGURE 10.21**

Save your spreadsheet in one of 25 different formats using the Format popup menu.

---

**Microsoft or Apple?**

By now you are probably wondering which way you should go: Apple’s Numbers or Microsoft’s Excel? I’m going to give you the answer most of us dread to hear: “It depends.” Before you pull your hair out, let me expound a bit. In my ever-humble opinion, both applications do what they do very, very well, but they both also have their pluses and minuses. If you work alone or don’t often need to open or create Excel files, Numbers can’t be beat due to its ease of use and pure elegance. That said, if you work in an office where the spreadsheet application of choice is overwhelmingly Excel (whether those in the office use PCs or Macs is irrelevant), it’s probably best for you to stick with Excel, too. I know that I told you Numbers can export to Excel’s file format, but you can’t guarantee that every single element, format, and object will translate well from Numbers to Excel. However, as I stated before, if you have Excel and the person you’re sharing your file with has Excel (again, regardless of the operating system), you will have no problems. One more very important caveat: Office 2008 for Mac doesn’t play nice with Visual Basic macros. This may not bother some of you, but for others it may be absolutely critical. For more information about why Microsoft pulled this functionality from this version of Office for Mac (previous versions supported these macros), please consult Microsoft’s www.mactopia.com site and type Visual Basic macros Office 2008 in the search field.
Creating Presentations Using Keynote

Keynote is Apple's phenomenally easy-to-use presentation application that makes putting together a truly great presentation a snap, even for the uninitiated. Keynote is part of the iWork '08 suite of applications, right along with Numbers and Pages. You'll see how easy it is to create a presentation using Keynote in this section of the chapter. Presentations are great ways to dispense information in a colorful and concise way through the use of slides, and Keynote is a great tool for this task.

Keynote is Apple's answer to Microsoft's PowerPoint, which I will also take a brief look at later in this chapter. For much more information about Keynote beyond this overview, visit www.apple.com/iwork/keynote/.

To get started, you'll need to open Keynote by double-clicking its icon in the /Applications/iWork '08 directory.

Learn your way around in Keynote

Similar to Pages' Template Chooser, when you first open Keynote you are presented with the Theme Chooser. The Theme Chooser, shown in Figure 10.22, lets you browse Keynote's list of preformatted presentation slides.
If you want to use one of the themes, highlight the desired theme and click Choose. Should you choose to open a presentation you've already been working on, click the Open an Existing File button, browse your Mac for the file, select it, and click the Open button. Once you've opened a presentation, you are ready to begin working within it.

Before we jump into working in a new presentation, let's look at the major features of Keynote's interface. Figure 10.23 points out the landmarks in Keynote's main window, and Table 10.4 gives you an explanation of their functions.

**FIGURE 10.23**

Keynote features an easy-to-navigate user interface.

- **Play slideshow**
- **Change view**
- **New slide**
- **Select themes**
- **Use Smart Builds**
- **Choose master slides**
- **Toolbar**
- **Show/hide Format Bar**
- **Slide canvas**
- **Slide navigator**

*Double-click to edit*

*Double-click to edit*
Use Themes to create a new presentation

Let’s create a basic slide show just to give you a feel for just how simple it can be with Keynote. We’ll start off with a new theme:

1. Close any themes you may have open.
2. Choose File > New from the menu, or press ⌘+N.
3. Select a theme from the Theme Chooser and click the Choose button in the lower right corner. I’m selecting the Harmony theme for my slide show.

**TIP**  You can change a slide’s theme at any time by highlighting the slide, clicking the Themes button in the toolbar, and selecting a new theme.

You should now have a new slide that’s ready and waiting to be transformed to your liking. If you also chose the Harmony theme, your Keynote window will look like Figure 10.24.

You’ll notice when working with slides that you have the benefit of Keynote basically telling you what to do. Notice in Figure 10.24 that the text boxes in my slide tell me to double-click them to edit their content. It doesn’t get much simpler than that! These kinds of text boxes and picture boxes are called placeholders, and they are mainly there to help you put together a professional slide show with minimal effort.
The Harmony theme is one of my favorites.

Spicing up your slide show

Now that you've got one slide, why leave it at that? You most likely want to share more information with others than just one slide's worth, I bet.

To add new slides to a slide show:

1. Click the + button in the upper left corner of the Keynote window.
2. Click the Masters button in the toolbar and select a Master slide (Figure 10.25).
3. Edit the contents of your new slide to suit your needs.

Your newly created slide should have text and possibly an image in it. I chose Photo-Horizontal so that I could demonstrate how to use your own images in the slides if the placeholders don't suit you. It's quite simple, really:

1. Click the Media button in the upper right corner to open the Media Browser.
2. Click on the Photos tab to insert a picture, or the Movies tab if you have pictures of the moving variety.
3. Browse for the picture you want to add, and then drag-and-drop it onto the placeholder image, as shown in Figure 10.26.
4. The new picture takes over for the placeholder in your slide and it should be selected automatically. If not, click the image to select it, and size handles will appear in each corner and on all four sides of the image. Use these handles to resize the images window.
5. To edit the image itself, click the Edit Mask button that appears in the Edit window below the image (see Figure 10.27), and then drag the size slider to adjust the size of the image, or click and drag the image to center it for your needs.

**FIGURE 10.25**
Select a preformatted slide by clicking the Masters button.

**FIGURE 10.26**
Use the Media Browser to find and insert your images.
A few more Keynote tidbits

There are many more things you can do with Keynote to create fantastic slide shows, but I think you've got a good idea by now just how easy Keynote is to use. Here are a handful of the other tweaks and tricks you can use with Keynote to make those slide shows even more useful:

- Add notes to help you present your slide show so that you can read them from your computer while your audience sees only the slides on the screen you are using to make the presentation. To add notes, click the View button in the toolbar and select Show Presenter Notes.
- Add audio files to your slide show by dragging an audio file from the Media Browser to the slide you want it associated with, or add a soundtrack to your entire slide show by using the Document Inspector (click the Inspector button in the toolbar, select the Document Inspector tab, and then choose Audio).
- Organize your slides by dragging them within the Slide Navigator pane.
- Use transitions to liven up the process of moving from one slide to the next. Open the Inspector by clicking its icon in the toolbar, go to the Slide Inspector, and use the Effects and Direction popup menus to use any of the really cool transitions supplied by Apple.
- To preview your slide show, click the Play button in the upper left corner of the window.
Sharing your slide show

Sharing your slide show is a pretty important aspect of using Keynote. As with Pages and Numbers, Keynote's siblings in the iWork '08 family, you have a variety of options to choose from when saving or exporting your files. To export a file:

1. Choose File → Export from the menu.
2. Choose from the several file types listed across the top of the window (Figure 10.28). To learn more about the file formats supported by Keynote, see page 178 of the Keynote User Guide (choose Help → Keynote User Guide from the menu).

![Figure 10.28](image)

Keynote can export to all kinds of file formats.

---

PowerPoint for Mac OS X

Microsoft's PowerPoint 2008 is one of the most famous applications of any kind on the market today. It's a tried-and-trusted presentation application that has been around for a couple of decades now. As is seemingly the rule with Microsoft's Office suite applications, PowerPoint was actually released for the Mac about three years prior to the first Windows version.

Although they are made by different companies, the way you perform basic tasks in PowerPoint very closely resembles the way you perform them in Keynote (or vice versa, I should say). If you
can create a slide show in Keynote, you won't have much difficulty doing so in PowerPoint. Hence this will be a lightning-fast tour of the PowerPoint interface aimed as more of an introduction than a tutorial.

To find out much more about PowerPoint for Mac, visit www.mactopia.com.

**Getting around in PowerPoint**

If you have PowerPoint installed (many Macs come with a trial version of the Microsoft Office suite that you can use if you haven't purchased a full copy), go to the /Applications/Microsoft Office 2008 directory and double-click its icon.

Let's get familiar with PowerPoint's interface layout so that you know where to find the tools you need to make a great presentation. Figure 10.29 gives you a look at the interface, and Table 10.5 helps you understand what you're seeing.

---

**FIGURE 10.29**

PowerPoint's tools and options are conveniently placed for minimum effort with maximum effect.

Elements Gallery

- Click to add title
- Click to add subtitle
- Slide thumbnails
- Slide
- Placeholders
- Notes pane
- Formatting Palette

---

241
**TABLE 10.5**

<table>
<thead>
<tr>
<th>Element</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Elements Gallery</td>
<td>Resides just below the toolbar and provides a single-click ability to apply themes, slide layouts, charts, tables, and the like.</td>
</tr>
<tr>
<td>Slide thumbnails</td>
<td>View the organization of your slides and select individual slides to work with.</td>
</tr>
<tr>
<td>Slide</td>
<td>The area in which you enter your data, images, graphics, and so on into placeholders. Slides can be customized in just about any manner you want.</td>
</tr>
<tr>
<td>Formatting Palette</td>
<td>Contains several types of palettes for modifying most elements of your slides, including fonts, images, and effects.</td>
</tr>
<tr>
<td>Placeholders</td>
<td>Preformatted areas of a slide in which you can enter your own data to customize the slide to your needs.</td>
</tr>
<tr>
<td>Notes pane</td>
<td>Presenters often need notes when speaking to an audience, and this area provides a convenient place for those notes. Only the presenter can see these notes during the presentation when using a projector or separate monitor for the audience to view.</td>
</tr>
</tbody>
</table>

When you first launch PowerPoint, a new slide is automatically created and is waiting for your input. This first slide is known as the title slide, and it already has placeholders for text that you can edit.

**Using themes and layouts**

One of the best features in PowerPoint 2008 is the Elements Gallery, and we're about to put it to good use. First, let's apply a theme to our presentation to liven it up a bit, and then choose a layout:

1. Select a slide from the thumbnails pane to apply a theme to.
2. Click on the Slide Themes tab in the Elements Gallery.
3. Choose a theme from the gallery (Figure 10.30). If there are more themes than can be displayed in the gallery, click the arrows on the far right of the gallery bar to see them.
4. Now that we have a theme, we need a layout. Click on the Slide Layout tab in the Elements Gallery.
5. Browse the layouts until you find one that suits you, and then select it to apply it to the slide you are currently working in (Figure 10.31).
6. Edit the text and image placeholders by entering your data into them.

You can further utilize the Elements Gallery for creating neat transitions between slides, inserting charts and tables, or using SmartArt Graphics and WordArt to polish the look of your presentation.
FIGURE 10.30
The gallery contains lots of pre-defined themes for you to choose from.

FIGURE 10.31
Select a good layout to help the audience's perception of your information.
Part III
The Working Mac

There is much more to PowerPoint than I can cover here, but here are a few other tidbits to whet your appetite:

- Use the Formatting Palette to select fonts, make alignment changes to the text, add background images to slides, put hyperlinks to Web pages in your slides, and much more.
- Use the Object Palette to easily add shapes and images to your presentation.
- Click the Picture, Shapes, and Media buttons in the toolbar to add these kinds of elements to your slides.
- Preview your presentation by clicking the Slide Show button in the toolbar, and exit a slide show at any time by pressing the ESC key.

Import and export presentations

As with Keynote, the ability to save your presentations and open those sent to you by others is a big deal.

There are several common and specialty formats you can use for saving your documents from PowerPoint. The common formats are as follows:

- The default format for PowerPoint 2008 for Mac and PowerPoint 2007 for Windows, PowerPoint Presentation (.pptx), which is XML-based.
- PowerPoint 97–2004 Presentation (.ppt), which is compatible with PowerPoint 98 through PowerPoint 2004 for Mac and PowerPoint 97 through PowerPoint 2003 for Windows.
- PowerPoint Template (.potx) preserves the settings used for fonts, themes, layouts, and graphics and saves them as templates, which can be used to create future presentations. This format is XML based.
- PowerPoint 97–2004 Template (.pot) is a template file compatible with PowerPoint 98 through PowerPoint 2004 for Mac and PowerPoint 97 through PowerPoint 2003 for Windows.
- The PowerPoint Package format saves the presentation and all of its linked files into one folder.
- Movie (.mov) format exports the presentation to a movie file that you can play using QuickTime.
- Web Page (.htm) allows your presentation to be viewed by Web browsers on both Macs and Windows-based PCs.
- PDF saves the presentation to a PDF file.
Summary

Mac OS X is just as comfortable in the office as it is in the studio. After all, photographers, advertising agencies, newspapers, motion picture and television producers, musicians, and cartoonists use computers, spreadsheets, and presentations, too. This chapter has shown you the basics regarding spreadsheets and presentations, but has also given you a glimpse of how powerfully the Mac can handle these tasks. Now you should have a good idea of how to use templates to create powerful and informative presentations and spreadsheets, both the Apple way and the Microsoft way. Enjoy your spreadsheeting and presentation-making!
What if your life was neat and orderly, perfectly scheduled, ran smoothly from one minute to the next, and was able to handle the slightest bump or hiccup? If that was the case you would be unlike the rest of the world and you would be daydreaming. Now that we've gotten past what your Mac can't do for you, take a look at these questions to get a better idea of what it can do:

What if every task was laid out neatly before you each day, and the list of tasks could be easily edited to suit your ever-flowing sea of activities?

How about if you could synchronize mountains of information such as phone numbers and e-mail contacts across multiple devices at the touch of a button?

Wouldn't it be awesome to be reminded of your scheduled appointments in a wide variety of ways, including on-screen alerts and e-mails, at intervals you decide on?

How would you like to easily share your schedule with friends, family, and coworkers, and notify them when changes have been made to your schedule?

All of this sounds great, doesn't it? Mac OS X can do all of the above for you, with applications that are already part of Leopard: iCal, Address Book, and iSync.

Getting to Know iCal

iCal's very name should be a pretty big hint as to what functions it specializes in. iCal is a wonderfully easy and intuitive calendaring application that helps you stay on top of your busy schedule, as well as that of other friends.
and acquaintances. It seems that with each passing year we as a society try to cram more and more into every available second of each day, and I for one am grateful to have a tool like iCal to help me sort it all out!

To open iCal from within the Finder, press \( \text{⌘} + \text{Shift} + \text{A} \), and then double-click the iCal icon. Figure 11.1 shows iCal's default window and points out important features in the interface, and Table 11.1 describes the features.

**FIGURE 11.1**

iCal lays many of its easy-to-use features right at your fingertips.

See today's events

Calendar list Window view options Search

Display notifications To Do list

View mini-month

Add a new calendar
Organize Life Using Your Mac

**Organize Life Using Your Mac**

**iCal User Interface Elements**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>See today’s events (Today button)</td>
<td>Clicking this button instantly takes you to today’s date on the calendar, regardless of what other day, month, or year you may be working in.</td>
</tr>
<tr>
<td>Window view options (Day/Week/Month buttons)</td>
<td>Click to see events in the daily, weekly, or monthly view.</td>
</tr>
<tr>
<td>Search</td>
<td>Type search words and iCal automatically displays all relevant events that contain references to them.</td>
</tr>
<tr>
<td>To Do list (pushpin button)</td>
<td>Expands the To Do list on the right side of the calendar.</td>
</tr>
<tr>
<td>Display notifications (envelope button)</td>
<td>Shows you the notification window in the lower left corner of the iCal window.</td>
</tr>
<tr>
<td>View mini-month (calendar button)</td>
<td>Displays a small calendar window in the lower left of the iCal window.</td>
</tr>
<tr>
<td>Add a new calendar (+ button)</td>
<td>Click this button to create a new calendar.</td>
</tr>
<tr>
<td>Calendar list</td>
<td>Presents a list of the calendars you have created.</td>
</tr>
</tbody>
</table>

**Working with calendars**

iCal helps you keep track of the important events in your life through the utilization of calendars. You can create a calendar for each area of your life, such as for tracking bills, keeping up with dates of important school functions, or remembering work deadlines. Once you begin creating new calendars in iCal, you may see that your life has more facets to it than you realized.

**Create new calendars**

There are four ways to create a new calendar:

- Click the + button in the lower left corner of the iCal window.
- Press `⌘`+Option+N.
- Choose File ➤ New Calendar from the iCal menu bar.
- Double-click in the blank space of your calendar list.

Once you’ve added a new calendar to the list, type a descriptive name for it, such as Bills, Work, School, Church, Auburn Tiger Football (“War Eagle!”), and so on.

**TIP** You can create groups of calendars to keep like items in the same area. Press `⌘`+Shift+N to create a group in the calendar list, name the group, and then drag associated calendars to the group.
**Editing calendars**

Editing your calendar entails making changes to its name, or changing the color that represents items in the calendar, and so on. To edit any calendar in the calendar list:

1. Click the name of the calendar to highlight it.
2. Press `⌘+I` to display the calendar's Info window, shown in Figure 11.2.

![Figure 11.2](image)

**FIGURE 11.2**

Edit calendars using the Info window.

3. Make the following changes if needed:
   - Rename the calendar by editing the Name field.
   - Click the color popup menu to select a new color for the calendar and its items.
   - Enter a description of the calendar.
4. Click OK when editing is complete.

**TIP** If you want to permanently remove a calendar from the list, simply right-click (or `Ctrl+click`) the calendar and choose Delete from the resulting menu.

**Publishing calendars**

A favorite iCal feature of mine is the ability to publish your calendars so that others can access them via the Internet, allowing you to share scheduling information with your family or a group, such as the PTA or football team.

To publish your calendar:

1. Highlight the calendar you want to share with the world and press `⌘+I`.
2. Click the Publish button in the lower left of the Info window to open the Publish calendar window (Figure 11.3).
3. Give the shared calendar a name.
4. Decide whether to share the calendar by using your MobileMe (formerly .Mac) account, or with a private server, using the Publish on popup menu.
   - If using MobileMe, sharing is handled automatically.
   - If you choose Private Server, enter the URL of the server and the login name and password used to access the server.

5. Check any other available options you wish to use, and then click the Publish button.

Exporting and importing calendars
Another way to share your calendars is to export them. You can then e-mail the exported calendar to its intended recipient or share it from your computer or other server for other network users to grab.

To export your calendars:

1. Highlight the calendar you wish to export.
2. Choose File ➤ Export from the iCal menu bar.
3. Save the exported calendar file and share it with others in one of the manners described.

What if someone is attempting to share their calendar with you? It’s time to learn how to import said calendars:

1. Choose File ➤ Import from the iCal menu bar.
2. In the Import window, shown in Figure 11.4, choose the type of calendar file to bring in to your iCal and click the Import button.
3. Browse your Mac for the calendar file you want to import, highlight the file, and then click the Import button to bring it into iCal.
There are three types of calendar files to choose from.

4. In the Add Events window, choose a calendar to add the imported events to. If this new calendar has nothing in common with your existing calendars, click the popup menu and select New Calendar and then click OK.

5. The new calendar is displayed in your calendar list.

Subscribe to calendars
Earlier I showed you how to publish your calendars. Now I'll show you how to subscribe to calendars that others have published:

1. Press ⌘+Option+S.
2. Enter the URL of the calendar you are subscribing to.
3. Click the Subscribe button.
4. If someone e-mails you the link to her shared calendar, simply click the link in Mail to automatically add it to your calendar list.

Apple provides access to tons of calendar subscriptions. Open a Web browser such as Safari and go to www.apple.com/ical/library to subscribe to calendars covering anything from religious and national holidays to performance dates for your local opera.

Add events to your calendar
Your calendars look great in the calendar list, but are pretty near useless if you don't associate events with them! Events are simply dates and appointments that you add to each specific calendar.

Create an event
You can set up one-time events, or events that occur bi-weekly, semi-annually, and just about any other time increment you wish.

To create an event:

1. Select the date of the event using the monthly view, the day and time of the event using the weekly view, or the time of the event in the daily view.
2. Highlight the calendar the event will be a part of.
3. Press ⌘+N.
4. Type the name of your event.

**Set reminders for your events**

Events are easy to edit and to set reminders for:

1. Double-click the event to open its window.
2. Click the Edit button to make changes, as shown in Figure 11.5. Table 11.2 provides a breakdown of each option in the editing window.
3. Click Done when you're finished.

![FIGURE 11.5](image)

You can adjust your events to fit your schedule.

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name field</td>
<td>Edit the name of the event by clicking the name and typing the new info.</td>
</tr>
<tr>
<td>all-day</td>
<td>Check the all-day box if this event is a day-long affair.</td>
</tr>
<tr>
<td>from and to</td>
<td>Select the portions of the from and to dates you want to change, and enter the data as needed.</td>
</tr>
<tr>
<td>repeat</td>
<td>If this is a recurring event, click the repeat popup menu and select its frequency.</td>
</tr>
<tr>
<td>calendar</td>
<td>Select a calendar with which to associate this event.</td>
</tr>
</tbody>
</table>

*continued*
TABLE 11.2 (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>alarm</td>
<td>Determine what kind of alarm to use to remind you of this event, if any.</td>
</tr>
<tr>
<td>attendees</td>
<td>Add e-mail addresses of other people you want to invite to your event. If</td>
</tr>
<tr>
<td></td>
<td>the person is already in your Address Book, their name is automatically</td>
</tr>
<tr>
<td></td>
<td>listed. To select a name from the list, use the up or down arrows and</td>
</tr>
<tr>
<td></td>
<td>click Return on the name you want. Click the Send button at the bottom of</td>
</tr>
<tr>
<td></td>
<td>the editing window to alert the invitees.</td>
</tr>
<tr>
<td>attachments</td>
<td>Click to add a file attachment, such as an important document needed for</td>
</tr>
<tr>
<td></td>
<td>a meeting, to the event.</td>
</tr>
<tr>
<td>url</td>
<td>If there is a Web page that pertains to your event, enter its address</td>
</tr>
<tr>
<td></td>
<td>here.</td>
</tr>
<tr>
<td>Note</td>
<td>Add personal notes and descriptions to this box that are important to</td>
</tr>
<tr>
<td></td>
<td>know or remember for this particular event.</td>
</tr>
</tbody>
</table>

Using the Address Book

You've probably had one of those old Rolodex devices to store information for your important contacts at some point, especially if you've ever worked in an office environment. The days of flipping through, and usually losing, those paper address cards are long gone, thanks to Address Book. There's no need for a clumsy Rolodex or even the trusty notepad for storing addresses and phone numbers with such a truly handy utility like Address Book around. However, Address Book does use a convention of the Rolodex system, keeping the information of contacts on cards.

Mac OS X relies on Address Book to store your contact information in a central location, which is easily accessible to all applications that need this information. Mail and iCal are prime examples of applications that use Address Book's information. The neatest feature of Address Book is that those applications can access the stored info, or cards, without even needing to open Address Book, illustrating just how tightly woven into Mac OS X's fabric Address Book really is.

Add contacts and groups

The first order of business is to add new contents to Address Book. Let's get started:

1. Open Address Book by pressing ⌘+Shift+A from within the Finder. Find the Address Book icon and double-click it to open the application.
2. The Address Book window, shown in Figure 11.6, allows you to see your list of contacts and edit their information.
3. In the Group column, click All, and then click the + button under the Name column to begin adding a contact.

4. Enter information such as the contact's name, phone numbers, address, their relationship to you, and so on.

5. To save the card, click the Edit button under the card window.

**FIGURE 11.6**

See groups of contacts, individual contacts, and information contained for each contact in this window.

Creating groups of contacts is really easy to do:

1. Click the + button under the Group column.

2. Type a name for your new group.

3. In the Group column, click All, and then drag-and-drop contacts from the Name column onto the new group's name under the Group column, as shown in Figure 11.7. This does not remove contact cards from the All group; it creates a copy of the card in the new group. Make multiple selections by holding down the ⌘ key while clicking the contacts.

**TIP**

You can quickly search for a contact by typing the contact's name or other relevant info in the search field at the upper right corner of the Address Book window.

You can switch between views by clicking the buttons in the upper left corner of the Address Book window. The view you see by default displays the Group and Name columns, as well as a window for viewing the card for the selected contact. The card view, shown in Figure 11.8, simply shows the currently selected card, and allows you to scroll through all cards by clicking the arrows in the lower right of the window.
Edit contact information

As we all know, things change, and this certainly applies to contact information. Your cards are not set in stone, so they are easily edited when new or updated info is available. To edit card info:

1. Highlight the card to be edited.
2. Click the Edit button under the card window.
3. Modify the information as necessary.
4. To add fields, click the + button next to one of the field names or choose Card • Add Field from the menu, and select the field type you want to use. To delete fields, click the – symbol next to the field name.
5. Click the Edit button when you are done.
You can delete contacts altogether by highlighting them from within the All group and pressing the Delete key. You can remove them from another group but still leave them in Address Book by highlighting them in the group you want to take them out of and pressing the Delete key.

**Importing and exporting address books**

Some people have only a few contacts in their Address Book, while others have what amounts to a small town's phone book in theirs. No one, regardless of the number of contacts they've amassed, wants to lose those contacts and have to start over with entering them one by one. Thankfully, Address Book is well equipped to help you back up your contact cards—and recover them if necessary at some point. Address Book allows you to export your contact info so that you can save it as a backup, e-mail it to others who may need your list of contacts, or create a central address book file that all interested users—for example, those on your corporate network—can access and import into their Macs or PCs.

You have two options of formats when exporting: vCard and Address Book Archive. vCard allows you to export your contacts in a format that is supported by most calendaring applications, so you can share with your friends and family members who aren't as fortunate as you are to be using a Mac. The archive option is great for backing up your archive in case you need to recover those precious contacts on your Mac.

To export your contacts:

1. Export a group of contacts or a single contact:
   - To export a group of contacts, highlight the group and choose File ➤ Export. Select either Export Group vCard or Address Book Archive.
   - To export a single contact, highlight the contact's card and choose File ➤ Export. Select either Export vCard or Address Book Archive.
2. Name the exported file and click Save to complete the process.

To import contacts into Address Book:

1. Choose File ➤ Import and select which file type to import. Address Book supports importing vCard, Address Book Archive, LDIF, or Text files (tab-delimited or CSV).
2. Browse your Mac for the files to be imported.
3. Highlight the files you want to add, and then click the Open button.

**Address Book preferences**

Like most other applications, Address Book allows you to modify certain aspects of its behavior so that it acts more like you want it to, rather than how its original programmers felt it should.

Press ⌘+, (comma) to open the Address Book preferences window. Table 11.3 gives simple explanations of the major options available here.
TABLE 11.3
Address Book Preferences

<table>
<thead>
<tr>
<th>Tab</th>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Show first name/ Sort by/ Address Format/ Font Size</td>
<td>Formatting and appearance options.</td>
</tr>
<tr>
<td>General</td>
<td>Synchronize contacts using .Mac / Synchronize with Exchange / Synchronize with Yahoo!</td>
<td>Keeps contacts consistent with that of other computers and supported servers automatically.</td>
</tr>
<tr>
<td>Template</td>
<td>-</td>
<td>Change the default card format to fit your needs.</td>
</tr>
<tr>
<td>Phone</td>
<td>Formats</td>
<td>Choose a format for your phone numbers.</td>
</tr>
<tr>
<td>vCard</td>
<td>vCard Format</td>
<td>vCard 3.0 is the latest version of the vCard format. If you have problems with others being able to import your exported vCards, change this setting to 2.1.</td>
</tr>
<tr>
<td>vCard</td>
<td>Enable private me card</td>
<td>Maintain your privacy. When you check this box, you can edit your private vCard and uncheck the items in it that you don’t want to share with others, as I’ve done in Figure 11.9.</td>
</tr>
<tr>
<td>vCard</td>
<td>Export notes in vCards/Export photos in vCards</td>
<td>Check these boxes if you want to include these items in your exported vCards.</td>
</tr>
<tr>
<td>LDAP</td>
<td>-</td>
<td>LDAP servers are used by large institutions and corporations to store databases of contact information. Enter the appropriate info here for your LDAP server, and your Address Book automatically populates with the contacts found on that server.</td>
</tr>
<tr>
<td>Sharing</td>
<td>Share your address book</td>
<td>Check this option to share your contacts with other users on your network.</td>
</tr>
</tbody>
</table>

FIGURE 11.9
Only show folks the personal information you want to share.
This is my default Desktop. I like to keep things as simple as possible. My mind is cluttered enough, so my poor Desktop shouldn't have to suffer the same fate!
You can easily change your Desktop background image, or wallpaper. Just right-click on the current Desktop background and choose Change Desktop Background from the popup menu. Select a source from the list on the left side of the window and then browse through the images contained in that source until you find a background that currently suits your taste. Click the Change Picture checkbox if you like your background to change often.
Use the Dock preferences pane in System Preferences to alter the way the Dock looks and works. Here I’ve placed the Dock on the left side of the screen and am using the Genie effect to minimize a window.
I like keeping a link to my Applications folder in the Dock. This makes it much easier to launch an application that I might not use frequently enough to give it valuable real estate in the Dock.
Dashboard can run as many widgets as you want to launch. These are a few of my favorites doing what they do best.
The stationery feature is one of my favorites in Mac OS X Leopard's Mail application. I'm creating a birth announcement in this shot by dragging-and-dropping the baby's picture into the template.
Viewing Events in iPhoto '08. I like to view them with the reflections turned on. It may be a waste of CPU cycles, but it sure looks cool!
Playing a song in iTunes takes on a whole new level of coolness when using the Visualizer in full-screen mode.
The Classic iTunes Visualizer running in the iTunes window will keep you mesmerized for hours.
You can shop for movies while listening to your favorite music tracks with iTunes.
Some of the finest institutions of higher learning in the land offer instruction in iTunes U.
I enjoy viewing playlists in Cover Flow view. Cover Flow makes it easy to spot your favorites while zipping through the many songs in your iTunes Library.
Cooliris is one of my favorite recent discoveries. It’s a Web browser plug-in that allows you to use Safari to fly (almost literally) through thousands of images and videos that you can search for and discover on the Web. Check it out at www.cooliris.com.
You can customize Terminal’s shell windows to look almost any way you want. This keeps the mundane world of command-line interfaces from putting you to sleep entirely. Oh, and it does make your computer screen look less archaic than a typical shell window would.
Press the F9 key to have Exposé align all of your open windows so that you can easily pick out the item you need.
In Sync with iSync

iSync is a great utility that synchronizes your e-mail addresses and contact information with your Mac and other devices. There's just something really cool about being able to almost effortlessly keep all your contacts synchronized across multiple computers and other devices such as cell phones and PDAs.

Set up a device to sync with

The first thing to do before syncing your data is to make sure that you have a second device capable of such syncing. This device, whether computer or otherwise, must be Bluetooth-capable, and Bluetooth must be turned on in order for your Mac to communicate with it.

**TIP**

Consult your device's documentation to find out how to enable and use Bluetooth technology with it.

To set up a device with iSync:

1. Open iSync. It can be found from within the Finder by pressing `⌘`+`Shift+A`.
2. Choose Devices & Add Device, or press `⌘`+`N`, to have iSync scan for devices using your Mac's Bluetooth hardware. If you see a message like that in Figure 11.10, click the Turn Bluetooth On button.

![FIGURE 11.10](image)

You will see this warning if Bluetooth is disabled on your Mac.

3. The Bluetooth Setup Assistant opens, ready to help you establish a connection with the other Bluetooth-enabled device of your choosing. Click Continue.
4. Select the type of device you are setting up and click Continue.
5. Select the device from the list after your Mac discovers it, which in my case is my cell phone, and then click Continue, as shown in Figure 11.11.
6. Enter the code on your device that your Mac provides when prompted.
7. Choose what services to use with your newly connected device. In this case, simply check the Set up iSync to transfer contacts and events box in the Bluetooth Setup Assistant window. Click Continue.
My cell phone is ready to converse with my Mac.

Your device should now appear in your iSync window, as it does for me in Figure 11.12. If you don’t see the options available for your device below the iSync window, click the devices icon in the iSync toolbar.

**Synchronize information between devices**

Now that iSync is friends with your device, it’s time to let them share more than just a handshake. You need to configure how your device and Mac synchronize with one another before you actually begin the process. Table 11.4 explains the functionality of the options available to you through iSync.

| **TABLE 11.4** |  |
| **Synchronization Options** |  |
| **Option** | **Function** |
| For first sync | You can either merge the information on both devices or completely erase the contacts on the device and load your Mac’s contacts to it. I recommend a merge on the first go-around, just to be certain you don’t lose any contacts you really need. Once this first sync is complete, there’s no going back to recover any lost contacts. |
| Turn on device name synchronization | Enables synchronization for the device. |
Organize Life Using Your Mac

### Option Function

<table>
<thead>
<tr>
<th>Contacts</th>
<th>Choose which contacts to sync.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calendars</td>
<td>Select the calendars you want to sync with your device.</td>
</tr>
<tr>
<td>More Options button</td>
<td>This button allows you to customize the items you sync between the computer and device. Click OK when you are finished configuring.</td>
</tr>
</tbody>
</table>

#### FIGURE 11.12

Your device is shown in the toolbar at the top of the iSync window.

To synchronize the devices:

1. Click the Sync Devices button in the right corner of the iSync toolbar.
2. If the synchronization changes more than 5 percent of the info on your Mac, you see an alert window like the one in Figure 11.13.
3. iSync alerts you when syncing is complete. Quit iSync and rest assured that all your contacts on both devices are up to date.
Third-Party Organizational Tools

As you've seen throughout this chapter, Mac OS X comes loaded with tools to help organize your existence on this beautiful planet, but there are other applications and utilities available from third parties that can enhance these tools, and in some cases add completely new functionality. I've taken the liberty of discussing two of these applications with you because I'm impressed with how well they do their respective jobs: Bento and Today.

**TIP** Bento and Today only scratch the surface of organizational tools the Mac community offers. Search the Web for even more of these tools—you never know when you might stumble across that perfect application that does everything for you but make your morning coffee!

**Bento**

Bento is a personal database application developed by the database giant FileMaker. With Bento, shown in Figure 11.14, you can very easily organize any kind of information you want—such as photos, Address Book contacts, iCal events, and files—all from one location. Download a trial version of Bento at www.bentotrial.com.

The following list is provided by FileMaker in the Bento Editorial Reviewer's Guide, and skims the surface of tasks you can accomplish with Bento:

- Manage unlimited contact details.
- Coordinate events, parties, and fundraisers.
- Track projects, assignments, and deadlines.
- Connect related information together to see more details.
- Prioritize things that need to get done.
Catalog inventory, donations, and items for sale.
- Record hours worked and payments due.
- Assign ratings to service providers and sellers.
- Create libraries for music, movies, and media.
- Store files and photos related to projects and events.

The feature that really elevates Bento to a superior program is the ability to totally customize your information. Even better, you can make those customizations by simply dragging-and-dropping components you want to add to the form into their preferred position, as shown in Figure 11.15.

If any of these examples appeal to you, I recommend giving Bento at least a trial run (it can also be purchased from FileMaker for $49). I've begun running Bento for the last few months, and use it often to keep track of projects and to edit my contact information. So far, so very good!

Today
Today, developed by Second Gear, is an extremely handy companion utility to iCal and Mail. Today lets you see your iCal events and your Mail tasks in one small window. You can view the small window, shown in Figure 11.16, all the time, or hide it until you want to get a quick view of your day's schedule.

![Figure 11.14](image)

Bento has a very attractive and elegant interface that makes it simple to work with.
Today also lets you create new events for iCal and new Mail tasks without ever having to open either of those applications. But because Today is built using the same code as iCal and Mail, it automatically synchronizes everything you do with these apps, as well as the iPhone and Apple's MobileMe Web services.

**TIP** For seamless use throughout the day, create a keyboard shortcut that allows you to show or hide Today. To create a keyboard shortcut, open Today's preferences by clicking the Open preferences button (it looks like a gear) at the bottom of the Today window, select the Window tab under the General pane, and click the Set button next to the Global Hot Key text field. Press the key combination you want, and then click OK.

Today is available for download from Second Gear's Web site: http://secondgearllc.com/today/. You can purchase Today for $15, or try a fully functional version for several days before paying for it.
Your events and tasks are quickly and easily viewed in Today’s simple user interface.

**Summary**

This chapter has tackled the applications and utilities that handle the tasks you may have purchased your Mac for to begin with: to help you organize your life. You saw how to schedule your daily activities, keep current contact information, and keep your Mac and other organizational devices in tune with one another. We also took a look at a couple of third-party offerings: Bento, which is a great personal database application; and Today, which keeps you abreast of iCal events and Mail tasks.
The idea of a paperless office was once the promise of the future. The workspace would be less cluttered, the trees had a little less to worry about, and there would be a lot less spent from your budget for paper and toner. Alas, as we are all too aware, that dream never came to pass. To be honest, I like having paper in hand, so the paperless office never quite held the appeal for me (or the majority of others, apparently) that it did for some. If anything, the technological advances of the 1980s ushered in a new age of even more printers, still more paper, toner, and ink being budgeted for, and sent fear into the hearts of every arbor on the planet.

The Mac has always been renowned for its printing capabilities, and that hasn't changed with its latest incarnation, Leopard. The print system in Leopard, CUPS (Common UNIX Printing System), is the most advanced ever used in a Mac OS, and is capable of handling many more printers right out of the box than ever before.

Getting something out of your Mac, in this case a print job, is one thing; getting something into your Mac, such as an image to print, is something else entirely. Thankfully Leopard is just as adept at scanning as it is at printing, so setting up and using a scanner is almost too simple, and in some cases may even be automatic.

Your Mac thrives on working with images, whether scanning them in or printing them out. Jump in and let's start printing and scanning!

**Using a Printer**

A printer is one of the most important accessories you can pair with your Mac, so it's imperative you choose the right one for your needs and budget. There are two basic types of printers: inkjet and laser. Those two types can
be broken down into subcategories, such as color or monochrome laser, and four- or six-color inkjet. A thorough treatment of the pros and cons of each type are beyond the scope of this book, but Table 12.1 lists a few of their qualities.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Inkjet</th>
<th>Laser</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
<td>Generally small footprint</td>
<td>Usually larger than inkjet, especially color models</td>
</tr>
<tr>
<td>Price</td>
<td>$75–$350</td>
<td>$150 (low-end monochrome models)–$2,000 and higher</td>
</tr>
<tr>
<td>Consumable cost</td>
<td>Inkjet printer ink is a pretty costly substance. The price of a small ink cartridge may not seem like much, but if you were to fill a gallon bucket with ink from those cartridges you would spend several thousand dollars!</td>
<td>Laser toner is expensive at first glance, but you get much, much more out of a single laser cartridge than an inkjet cartridge, thus the cost per page is much less with laser than inkjet.</td>
</tr>
<tr>
<td>Connectivity</td>
<td>Typically USB or FireWire</td>
<td>USB, Ethernet, FireWire</td>
</tr>
<tr>
<td>Text quality</td>
<td>Inkjet technology has improved greatly over the years, but text output still leaves something to be desired due to the paper's tendency to absorb the ink and make text appear slightly blurry.</td>
<td>Text is very sharp and crisp since the toner is dry and there is no absorption by the paper.</td>
</tr>
<tr>
<td>Image and graphics quality</td>
<td>Color images, or photos, are usually of very high quality and are glossy due to the properties of the ink.</td>
<td>Images aren't as defined, color isn't quite as true as with an inkjet, and typically has a matte finish due to the nature of dry toner.</td>
</tr>
</tbody>
</table>

Whichever printer type you select, be certain that it is compatible with Mac OS X. There are some printers on the market that are designed to work exclusively with Windows, although their numbers are dwindling due to the Mac's increasing popularity.

**TIP**  
If you are moving from Windows to Mac, you may have a printer that is designed to work only with Windows. Double-check with the manufacturer to see if they have a work-around that allows you to use the printer with your Mac. If not, don't toss the printer in the trash heap just yet. Check the Linux Foundation's Web site at www.linuxfoundation.org/en/OpenPrinting/MacOSX to see if there is a third-party driver available for your printer that allows it to work with Mac OS X.

**How to Connect Your Printer to Your Mac**

The most important items you need to connect your printer to your Mac are cables: one for power and one for the type of port you are connecting with.
The power cable is a no-brainer and should come in the box with your printer. The connection cable should be appropriate for the port type you decide to use. For some printers you have only one choice, and others have multiple connections to select.

**USB**

USB cables don't usually ship with printers, so you'll most likely have to purchase one at the same time you get your printer. Be sure to get a USB device cable, meaning one that has a USB A connector on one end (for connecting to the Mac) and a USB B connector on the other (for the printer connection). Simply put the connectors in the appropriate ports on each device and that's it.

> **TIP** Be sure to buy a USB 2.0 cable. USB 2.0 is the latest version of the USB standards and is much faster than USB 1.1. USB 2.0 cables can connect to both 1.1 and 2.0 USB ports and run at the native speeds of those ports. However, while USB 1.1 cables can connect to 1.1 and 2.0 ports, they are limited to 1.1 speeds, meaning that print jobs will take a good deal longer to print than they need to. Most, if not all, of today's devices use the 2.0 standard.

**Ethernet**

Ethernet cables, which resemble oversized telephone cables and jacks, are used to connect your printer (typically only lasers have built-in Ethernet ports) to your local area network. One end of the Ethernet, or RJ-45, cable connects to your printer while the other end plugs into your network router. Ethernet is a very fast and stable connection, and printers connected via Ethernet are available for all users on the network without the need of a print server. Today the need for print servers is increasingly rare, as there are better ways to monitor and restrict traffic for a printer, not to mention that if the server goes down, no one can print.

**Basic Printer Installation**

Connecting your printer to the Mac is only half the battle: You need to install its driver software and create a queue in order to use the printer.

**Install a driver**

To install a printer in Mac OS X you must have a driver for it. A driver is software that tells your Mac what options and features your printer supports, how to communicate with it, and characteristics of the device (color or black and white only, supported resolutions, and so on). Your Mac's installation disks come with a plethora of printer drivers for most printer manufacturers, but the printer should also come with a disk containing drivers and possibly other utility software provided by the manufacturer. I suggest inserting the disk that came with your printer into your Mac and installing any drivers and utilities as instructed by the manufacturer.

If you really want to be sure that you've got the latest and the greatest, visit the Web site of your printer's manufacturer and download the newest drivers for your printer model. There may have been problems with the earlier versions of the driver that has been updated since the printer or
Mac OS installation disks were made. Downloading drivers usually ensures that you are using the most compatible and bug-free driver available, increasing the likelihood you’ll enjoy your printer as opposed to using it as a boat anchor.

**TIP** Software, utility, and driver installations can vary so widely from printer to printer that there is no universal instruction I can give you. Consult the support team for your printer manufacturer if you have difficulty installing their software.

### Create a printer queue

You may think that once you’ve installed the drivers and other miscellaneous software that your job is finished; however, there’s another little task you need to complete before you can print: creating a **printer queue**. The printer queue is Mac OS X’s representation of your physical printer. Jobs you send to the printer are retained in the queue, and you can make configuration changes to the queue to reflect when your printer has been modified (such as adding memory or a paper tray to it). Let’s learn how to create a printer queue.

#### USB

Creating a printer queue for a USB printer is the very essence of simple, as you can see by following these steps:

1. If you haven’t connected the printer to your Mac, go ahead and do so.
2. Click the Apple menu in the upper left of your screen and select System Preferences.
3. Click the Print & Fax icon to see the Print & Fax preferences pane, shown in Figure 12.1.
4. The printer list is on the left side of the pane, and initially says “Click + to add a printer or fax.” If you have printers already installed, you will see them in the list in lieu of that message. Click the + button beneath the printer list to begin creating the print queue.

**TIP** Sometimes your Mac automatically generates a printer queue for a printer it detects via USB. If you see your printer already in the printer list at this point, you are finished creating the queue and can move on to the next section of this chapter. If not, continue with step 5.

5. Click the Default icon in the upper left corner of the Add Printer window, shown in Figure 12.2.
6. Click the name of your printer as it appears in the list, and the Print Using popup menu at the bottom of the window should reflect the printer you are creating a queue for. If this is correct, skip to step 8; if not, continue with step 7.
7. If the Print Using popup menu doesn’t specify the type of printer you are using, click the popup and choose Select a driver to use from the menu, as shown in Figure 12.3. Scroll through the list of available drivers and select the one that matches your printer.
8. Click Add and you will see your new printer queue in the printer list.
FIGURE 12.1

Leopard awaits your help with creating a USB printer queue.

Click to add a printer or fax

No Printer Selected

Default Printer: Last Printer Used

Click the lock to prevent further changes.

FIGURE 12.2

Use this window to find your printer and create a queue for it.
FIGURE 12.3
To make your search faster, type the first few letters of your printer’s manufacturer or model name in the search field.

TIP
If you see a window open that indicates your Mac is Determining Installable Options, don’t be alarmed: Your Mac is trying to communicate with your printer to see if you have added any nonstandard items to the printer, such as a duplexer, optional trays, or more memory. Click the Configure button, located in the Determining Installable Options window, if you want to speed up the process and manually select any options you have added.

Network
Installing a printer on a network entails connecting it via an Ethernet cable to a router or switch. Once connected, the printer can communicate with your Mac using one of three network protocols: AppleTalk, Bonjour, and TCP/IP. Please see the sidebar later in this chapter entitled “Network Printing Protocols” for more information on these three types of network communications.

Once you’ve connected your printer to your network hardware, it’s time to add a printer queue:

1. If you haven’t connected the printer to your network, go ahead and do so.
2. Click the Apple menu in the upper left of your screen and select System Preferences.
3. Click the Print & Fax icon to see the Print & Fax preferences pane.
4. The printer list is on the left side of the pane, and initially says "Click + to add a printer or fax." If you have printers already installed, you will see them in the list instead. Click the + button beneath the printer list to begin creating the print queue.

5. Click the Default icon in the upper left corner of the Add Printer window if you are using Bonjour or AppleTalk to connect with your printer. If you are using TCP/IP, skip to step 8.

6. Click the name of your printer as it appears in the list, and the Print Using popup menu at the bottom of the window should reflect the printer you are creating a queue for (Figure 12.4). If this is correct, skip to step 11; if not, continue with step 7.

7. If the Print Using popup menu doesn't specify the type of printer you are using, click the popup and choose Select a driver to use from the menu. Scroll through the list of available drivers and select the one that matches your printer, and then skip to step 11.

8. Select the IP icon in the toolbar and set the protocol you wish to use. If you aren't sure, contact the printer manufacturer for help.

9. As shown in Figure 12.5, enter the IP address of the printer into the Address field, and the appropriate information for the Queue field, if needed. The Name and Location fields can be modified to your specifications.

10. The Print Using popup menu at the bottom of the window should reflect the printer you are creating a queue for. If not, click the popup and choose Select a driver to use from the menu. Scroll through the list of drivers and select the one for your printer.

11. Click Add to create a new queue in the printer list.

**FIGURE 12.4**

AppleTalk and Bonjour printers should show up in this window if they are properly connected to your network.
Utilizing the printer queue

Now that you have a print queue, you’re ready to print, right? Not quite—there are a couple of things I want to show you first. To start, let’s open the print queue you just created:

1. Highlight the printer queue on the left side of the Print & Fax preferences pane.
2. Click the Open Print Queue button in the middle of the window.
3. A printer queue window, similar to the one shown in Figure 12.6, should open.

You can view your printer’s current status, manage print jobs, and even check the current levels of printer supplies (with some models) using the printer queue. When the printer queue is the active window, it has its own menu options next to the Apple menu, similar to other applications. Table 12.2 explains the buttons and menu options for the printer queue.

<table>
<thead>
<tr>
<th>Button/Option</th>
<th>Menu/Keyboard Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete</td>
<td>-</td>
<td>Removes a highlighted print job from the queue.</td>
</tr>
<tr>
<td>Hold</td>
<td>-</td>
<td>Keeps selected jobs in the queue until you are ready for them to print.</td>
</tr>
<tr>
<td>Resume</td>
<td>-</td>
<td>Resumes printing of selected jobs after they are held.</td>
</tr>
</tbody>
</table>

**TABLE 12.2**

**Printer Queue Buttons and Menu Options**
### Printing and Scanning with Your Mac

<table>
<thead>
<tr>
<th>Button/Option</th>
<th>Menu/Keyboard Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pause Printer/</td>
<td>-</td>
<td>Click this button once and the queue pauses all jobs. Click it again and the jobs resume printing.</td>
</tr>
<tr>
<td>Resume Printer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Info</td>
<td>-</td>
<td>Displays information about the printer, such as its driver version, host name, and so on.</td>
</tr>
<tr>
<td>Supply Levels</td>
<td>-</td>
<td>Displays the remaining amounts of supplies, such as toner and ink, if your printer supports this functionality.</td>
</tr>
<tr>
<td>Customize Toolbar</td>
<td>Printer</td>
<td>Opens the Customize Toolbar window, where you can modify the toolbar contents to match your preferences.</td>
</tr>
<tr>
<td>Make Default</td>
<td>Printer/⌘+D</td>
<td>Makes the highlighted printer the default for your Mac.</td>
</tr>
<tr>
<td>Print Test Page</td>
<td>Printer</td>
<td>Sends a CUPS printer test page to your printer, verifying the printer is working properly with your Mac.</td>
</tr>
<tr>
<td>Log &amp; History</td>
<td>Printer</td>
<td>Opens the Console utility to the CUPS logs, where you can view the access_log, error_log, and page_log.</td>
</tr>
<tr>
<td>Show Printer List</td>
<td>Printer</td>
<td>Causes the Printer &amp; Fax preferences pane to open so that you can view printers in the printer list.</td>
</tr>
<tr>
<td>Show Completed Jobs</td>
<td>Jobs</td>
<td>Displays a list of all completed jobs in the queue window, similar to the one shown in Figure 12.7.</td>
</tr>
</tbody>
</table>

**FIGURE 12.6**

The queue window for my magicolor 5550
Network Printing Protocols

Let's take a closer look at the three network protocols Macs typically use to connect and communicate with network-capable printers: AppleTalk, Bonjour, and TCP/IP.

AppleTalk is an older protocol that Apple developed in the 1980s that allows devices running the protocol to discover one another automatically, without the need for much configuration, if any at all. Macs running AppleTalk see printers on the network that are running AppleTalk, the user tells the Mac to use that printer, and away you go. As neat and simple as this sounds, AppleTalk is a bit long in the tooth and Apple is slowly trying to wean users from it to Bonjour.

Bonjour is the protocol du jour, and is automatically enabled on your Mac. Bonjour is becoming increasingly common in network printers and other devices, and can even be installed on Windows-based PCs. Bonjour's concept is the same as AppleTalk—to simply allow devices running it to automatically discover it. However, Bonjour doesn't bog down a network and requires no configuration whatsoever.

TCP/IP is the protocol your Mac uses to access the Internet, and is common to pretty much every network printer on the market. To use TCP/IP you must know the IP address of the printer, which you can usually get from the printer itself or from a network administrator in your company.

FIGURE 12.7
You can view the history of jobs you've sent to your printers by choosing Jobs ➤ Show Completed Jobs.
If the toolbar tends to cramp your style, you can close it by clicking the small oval button in the upper right corner of the queue window, or by choosing Printer::Hide Toolbar.

**Change your printer's configuration**

You can always make any necessary changes to a print queue. To do so, follow these steps:

1. Open the Print & Fax preferences pane and highlight the queue in the printer list.
2. Click the Options & Supplies button to see the configuration window, illustrated in Figure 12.8.

![FIGURE 12.8](image)

Change your printer's configuration using this window.

3. Make necessary changes using the tabs across the top of the configuration window:
   - The General tab is used to rename the printer queue and edit its location, if desired. You can also see vital information such as its host name and driver version.
   - The Driver tab can be used to change the driver currently assigned to the printer queue and make changes to the printer's installed options (if available).
   - The Supply Levels tab displays the amounts of consumables (toners, ink, OPC drums, and so on) remaining for the printer. This functionality may not be supported by some printers, or may be provided by some other utility that installed with the printer software supplied by the manufacturer. Consult your printer's manufacturer for help concerning this matter.
4. Click OK when you're finished configuring the queue.
Printing a Job

Finally we can get down to business and print a job (other than the printer test page, I mean)! Printing jobs means sending the data in your document from your application to Mac OS X's CUPS, which renders that data into a language the printer understands and passes it into the queue, which in turn sends the rendered data to the printer so it can reconstruct the data and put it on paper.

To get started, open an application you would like to use or a document you would like to print. When you have the document or image you want to print, do the following:

1. Press ⌘+Shift+P to open the Page Setup dialog box, shown in Figure 12.9.

2. Select the printer you are sending the print job to from the Format for popup menu.

3. Choose the paper size you are printing to and click the orientation you need, and then click OK.

4. Press ⌘+P or choose File→Print to open the standard print dialog box (Figure 12.10).

5. Click Print to send the job to the printer, Cancel to nix the print job, or Preview to see what your final output will look like on the page.

As you can see, the standard print dialog box lets you perform a few tasks, but that's about it. Now, that may be perfectly fine for most users, but if you need the ability to select optional paper trays or to change color settings, you may want a little more. That's where the advanced print dialog box comes into play. To open an advanced print dialog box:

1. Press ⌘+P or choose File→Print to open the standard print dialog box.
2. Click the blue square containing the black triangle (to the right of the printer name) and an advanced print dialog box opens, as shown in Figure 12.11.

3. The left side of the advanced print dialog box displays a preview of your document based on your Page Setup settings. If your document has multiple pages, you can scroll through a preview of each page using the arrow keys under the preview image.

4. Set all desired print options using the available menus and submenus. The top half of the right side of the advanced dialog box allows you to choose from a list of installed printers, select from a list of presets (custom settings created by the user), adjust the number of copies, and change page setup options. The bottom half of the window, separated from the top half by a thin line containing a popup menu, grants access to options that vary depending on the application used and the printer's driver capabilities. Click the popup menu to select the available categories and explore the options they provide. Table 12.3 gives an overview of some of the major categories and options offered.

5. Click Print to send the print job to your printer.

FIGURE 12.10

The sparse standard print dialog box gives you only a couple of options when printing.

FIGURE 12.11

The advanced print dialog box is chock-full of options for your print jobs.
### Advanced Printing Options

<table>
<thead>
<tr>
<th>Category</th>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layout</td>
<td>Pages per Sheet</td>
<td>If you have multiple pages in your document, you can use this option to print several pages on one sheet of paper.</td>
</tr>
<tr>
<td>Layout</td>
<td>Border</td>
<td>This option is very helpful if using the Pages per Sheet option. It creates a printed border around each individual page, easily distinguishing it from other pages on the sheet.</td>
</tr>
<tr>
<td>Layout</td>
<td>Two-Sided</td>
<td>This is only available if you are using a printer that has an automatic duplexer installed.</td>
</tr>
<tr>
<td>Color Matching</td>
<td>ColorSync/ In Printer</td>
<td>Choose ColorSync to let your Mac handle the color matching of the document, or In Printer to hand the duties off to your printer.</td>
</tr>
<tr>
<td>Paper Handling</td>
<td>Pages To Print</td>
<td>Choose to print all pages, or only the odd or even ones.</td>
</tr>
<tr>
<td>Paper Feed</td>
<td>All pages from</td>
<td>Use this option if your printer has multiple trays attached and you want to select one manually instead of allowing the printer to automatically choose based on its default tray or your document settings.</td>
</tr>
<tr>
<td>Paper Feed</td>
<td>First page from</td>
<td>Useful if you want to print the first page of a document, such as your cover page, on a different stock than the rest of the pages.</td>
</tr>
<tr>
<td>Cover Page</td>
<td>Print Cover Page</td>
<td>This option is helpful to distinguish between multiple-users jobs. For example, if you are in an office and everyone prints to the same printer, printing a cover page differentiates the pages before or after it as belonging to a certain user.</td>
</tr>
<tr>
<td>Scheduler</td>
<td>Print Document</td>
<td>Choose when to print your documents.</td>
</tr>
<tr>
<td>Summary</td>
<td>-</td>
<td>Provides a list of all the settings you have determined for this particular print job, so that you can look them over in a central location before sending the job to the printer.</td>
</tr>
</tbody>
</table>

### Printer Sharing

Mac OS X has the nifty ability to share printers you have created queues for. This is especially handy if you want to manage print jobs that other users are sending, or if there is one printer in the office and it can only connect USB to a single computer. The first thing that must done is to enable printer sharing in Mac OS X:

1. Click the Apple menu in the upper left of your screen and select System Preferences.
2. Click the Sharing icon.
3. In the Sharing preferences pane, check the box next to Printer Sharing in the Services list to the left.
Share with other Macs

Sharing printers with other Macs running Mac OS X 10.2 and higher is a breeze:

1. Click the Apple menu in the upper left of your screen and select System Preferences.
2. Click the Print & Fax icon.
3. In the printer list on the left side of the Print & Fax pane, select the printer you wish to share.
4. Check the box next to Share this printer, as shown in Figure 12.12.
5. Other Mac OS X users on your network can now add your shared printer to their printer list. Any documents they send to print are stored in the printer queue on your Mac until such time as they are sent to the printer.

**FIGURE 12.12**

My magicolor 5550 is available for all other Mac users on my network who want to use it.

Share with Windows users

Mac OS X is even so kind as to allow users of “the other operating system” access to its shared printers. The simplest way for Windows users to access printers shared from Mac OS X is to install Bonjour for Windows on their PC, which allows the PC to run the Bonjour network protocol. Once Bonjour is installed, they can use the Bonjour Printer Wizard to discover your shared printer and begin sending print jobs to it. Bonjour for Windows can be downloaded from Apple’s Web site: www.apple.com/support/downloads/bonjourforwindows.html.
You do have another option available if you prefer to do things the old-fashioned way, or as some old-schoolers would say, the tried-and-true way, and that is to use SMB (the network protocol standard to Windows-based PCs). To share your printers with Windows users in this manner:

1. Click the Apple menu in the upper left of your screen and select System Preferences.
2. Click the Sharing icon.
3. In the Sharing preferences pane, check the box next to Printer Sharing in the Services list to the left.
4. Check the File Sharing box.
5. Click the Options button.
6. Select Share files and folders using SMB, as shown in Figure 12.13.
7. Check the On box next to the account of the user you want to share files with.
8. The Windows user should follow Microsoft’s instructions for installing a network printer at this point.

**FIGURE 12.13**
Enable sharing for the SMB protocol so Windows users can see your shared files, folders, and printers.

Scanners Made Easy

Scanners are great for converting paper documents and printed pictures to digital files that you can save on your computer or send to other people via e-mail. These Image Capture devices have been affordable for a couple of decades now, and are must-haves for a great deal of computer users for both work and play.
There are a wide variety of scanners out there, but most home and small office users are familiar with the flatbed type of scanners that you typically see in electronics stores. There are color scanners, monochrome-only scanners, varying ranges of resolutions, and many other factors you need to consider before committing to a particular model. Check with the manufacturer of the scanner to make certain it is Mac-compatible before ponying up the dough for it.

**Install drivers for your scanner**

Like every other external device you hook up to your trusty Mac, a scanner needs a driver in order to work properly with your operating system. As with printers, Leopard ships with lots of scanner drivers built right in, so your scanner may work flawlessly without your having to lift a single driver-installing finger. However, you know by now that I recommend you take that extra step of checking the scanner manufacturer’s Web site for any updated drivers that may have been released even since the CD that came with it was burned. While any updates to the driver could be minor ones that you may never have noticed in the first place, some of them might save you from suffering major problems with the scanner, installed applications, and even the Mac OS itself.

Another reason for installing the drivers from the manufacturer (whether you download them from the Web or use the CD that came with your scanner) is that they may contain options or even provide other utility software that extends the functionality of your scanner. I’ll provide an example of this later in the chapter.

You can install your scanner’s drivers in one of two ways:

- Use the CD that came with your scanner.
  1. Insert the CD into your Mac’s disc drive.
  2. If it opens an installer program automatically, follow its prompts until installation is complete.
  3. If an installation program doesn’t automatically open, double-click the icon of the CD on your Desktop and browse its contents for the installer application.

- Download the driver from the scanner manufacturer’s Web site.
  1. Decompress the downloaded driver files (see Chapter 4 for more info) and open the resulting disk image or folder.
  2. Double-click the installer application icon and follow the instructions, as shown in Figure 12.14.

**Connect your scanner**

Some scanners have FireWire connections, but the vast majority support USB. Before you walk out the door of the store or complete an online checkout, read the specifications of your scanner to make sure that:

- You determine whether a cable is included with the scanner.
- You purchase the kind of cable you need to connect to your Mac. If your scanner has both FireWire and USB connections, you can either buy both types of cables or choose
which one you want to connect with. If you are going to scan extremely large, very high-resolution files, FireWire would be a good choice due to its ability to handle heavy amounts of data. For the other 95 percent of us, however, USB does quite a nice job, thank you very much.

Once you've got the right cable, connecting the scanner to your Mac is a no-brainer: Insert one end of your USB or FireWire cable in the scanner, and insert the other end in the appropriate port on your Mac. Your Mac should automatically detect your scanner, select the correct driver for it, and make it available for use by any application that supports the use of scanners, such as Adobe Photoshop, Microsoft Word, and Apple's own Image Capture.

Use Image Capture to scan documents and images

Apple includes a great utility with Leopard called Image Capture, which allows you to use your scanner without breaking the bank to purchase a professional program such as the aforementioned Adobe Photoshop. Image Capture is also great for working with digital cameras and other devices, but we'll concentrate on scanning in this chapter.

You'll find Image Capture in the Applications folder of your Mac's hard drive; double-click its icon to launch it. If you see a window like the one shown in Figure 12.15, telling you that no Image Capture device is connected, check that your scanner is turned on. If it is on, double-check the connection to make sure the cable is secure to both the scanner and your Mac. If you still are a no go, restart your Mac with the scanner on.
If you see this alert, Image Capture cannot detect your scanner.

When you first open Image Capture, with your scanner attached and turned on, it automatically opens a scanning window for you and shows a preview of a document you've placed on the scanner's glass. Assuming your scanner is connected and functioning properly, you should see something similar to Figure 12.16 when you open Image Capture.

Image Capture is ready to start scanning your images.
This window uses a generic scanner driver that may be fine for most, if not all, of your needs. Table 12.4 tackles the options that are available in this scanner dialog box.

### TABLE 12.4

**Typical Scanning Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan Mode</td>
<td>Change the mode of your scanner, if your scanner supports more than one method of scanning.</td>
</tr>
<tr>
<td>Document</td>
<td>Select the type of document you are scanning.</td>
</tr>
<tr>
<td>Bit Depth</td>
<td>Determines the level of detail in your scan.</td>
</tr>
<tr>
<td>Resolution</td>
<td>Choose the DPI (Dots Per Inch) that suits your needs. The higher you take this number, the larger the resulting scanned image will be in terms of file size. However, the lower you go, the less detail you will retain in the scan.</td>
</tr>
<tr>
<td>Scan To Folder</td>
<td>Determine which folder on your hard drive is the default folder for newly scanned images.</td>
</tr>
<tr>
<td>Name</td>
<td>Enter the name of the scanned file.</td>
</tr>
<tr>
<td>Format</td>
<td>Choose the file format of your image.</td>
</tr>
<tr>
<td>Automatic Task</td>
<td>Allows your Mac to perform a task automatically when it is finished performing the scan, such as opening the scanned image in Preview.</td>
</tr>
<tr>
<td>Image Correction</td>
<td>Lets you choose to manually (as shown in Figure 12.17) or automatically perform corrective modifications to the scanned image, or to simply leave it as is.</td>
</tr>
</tbody>
</table>

### FIGURE 12.17

Make adjustments to your scanned images manually if you need to correct color flaws.

![Image Correction: Manual](image)

**Scan an item**

Click the Overview button to have Image Capture perform a preview scan of the image in your scanner. You want to do this if you decide to change documents or make adjustments to the current one. This offers you a way to see what your scanned image will look like in its final stage.
To scan your image at this point, just click the Scan button at the bottom of the window. You may notice that my Scan button is grayed out, and this is because my particular scanner needs to use its own TWAIN driver in order to properly scan with Mac OS X. If your Scan button is like mine, don’t fret. Just follow these steps:

1. Choose Devices> Browse Devices in the Image Capture menu bar, or press ⌘+B to open the Image Capture Device Browser window, as shown in Figure 12.18.

2. Click the Use TWAIN UI button to the right of the scanner name.

3. The resulting window lets you choose these options:
   - Where to save your scanned images
   - What to name the images
   - The format to save the scans in
   - Which automatic task to perform once scanning is complete

4. Click the Scan button. This invokes your scanner’s custom software (Figure 12.19) and avoids using the generic scanner drivers. The resulting window for your scanner may not look quite like mine due to differences in the way the manufacturers design their layouts. Follow the instructions of your scanner’s manufacturer for any special instructions beyond this point, or for help with understanding the options they provide.
My scanner's software offers plenty of options that the generic driver simply couldn't.

Share your imaging devices
As with printers, you may also need (or simply want) to share your imaging devices (scanners, cameras, and the like) with other Macs and their users. Image Capture is hip, and provides an easy way for you to perform this kind of service:

1. Press ⌘+B to open the Image Capture Device Browser window.
2. Click the Sharing button in the bottom left corner.
3. Check the box called Share my devices, shown in Figure 12.20.
4. Give your shared devices a name.
5. Assign a password to your shared devices if security is a concern.
6. Click OK to enable sharing of your devices.
Sharing devices allows other Macs on the network to use your locally attached imaging devices. Aren’t you nice!

![Sharing devices](image)

**Summary**

What have we learned today, class? Well, we saw how great Mac OS X works with external devices, specifically scanners and printers. You should know the basic printing commands you have at your disposal and how to manage print jobs, and you should be a semi-pro at installing printers with the Print & Fax preferences pane. Installation of scanners and using them to import documents and images to your Mac should be almost second nature by now, too.
Part IV
The Multimedia Mac

IN THIS PART
Chapter 13
Mastering Digital Images
Chapter 14
iMovie Magic
Chapter 15
Musical Mac
We all love taking photos of friends and family, right? Since the advent of the digital camera, the art of picture-taking has made leaps and bounds for those of us who aren't professional photographers. Not only can we take photos and instantly see them (yes, all of you youngsters, there was a time in history when this wasn't possible), we can print them out and frame them in just a few minutes, e-mail them to relatives halfway around the globe, share them via personal Web sites or services like Apple's MobileMe, edit and adjust colors and red-eye on-the-fly, and much more. Old-fashioned film cameras, for better or for worse, have almost gone the way of the vinyl record; they're still around, but increasingly difficult to find. Who wants to mess with replacing film, taking it somewhere to have it developed, hoping most of the pictures turn out reasonably well, and so forth? I know there are some die-hards out there who think it's a cardinal sin to take pics without film, but the majority of us have moved on from Polaroids and film canisters to megapixels and memory cards.

Apple is the king of user-friendly media, so naturally using your digital camera with your Mac is as easy and intuitive as we've come to expect from them. Mac OS X Leopard includes Image Capture, which is an easy way to move pictures to and from your digital camera, but it doesn't have any editing or organization abilities. Apple developed iPhoto to handle these tasks, as well as a host of others. I concentrate mainly on iPhoto in this chapter, but briefly tackle Image Capture as well before all is said and done.
Get to Know iPhoto

iPhoto is fantastic for organizing your pictures, but it's also much more than that. Here's a partial list of the cool things you can accomplish with iPhoto:

- Import pictures from your camera or iPhone, or from a file on your hard drive.
- Export files in several formats.
- Easily share pictures in a variety of ways, including e-mail and slide shows.
- Enhance photos by adjusting colors, removing red-eye, and a whole host of other options.
- Print photos using custom textures and borders.
- Design customized photo albums from your pictures.
- Use your photos to create your own calendars and greeting cards.
- Publish your photos to your MobileMe account or your own Web site.
- Order prints directly from within iPhoto.
- iPhoto '08 can group pictures as events, based on the date they were taken.

iPhoto '08, which is the most current version, is part of the iLife suite of applications provided by Apple to make our digital lives oh-so-simple. You can learn more about the entire line of iLife applications by visiting www.apple.com/ilife/. If you have iPhoto installed, let's get started. If not, you can skip to the section on Image Capture to learn how to use it to retrieve photos from your digital camera or iPhone.

First things first: We need to get our bearings on where everything is in the iPhoto interface. To get the ball rolling, open iPhoto:

1. From within the Finder, press ⌘+Shift+A to open a new Finder window in the Applications folder.
2. Locate the iPhoto icon, shown in Figure 13.1, and double-click it to open the application.

When you first launch iPhoto, you may be asked if you want to use iPhoto when you connect your digital camera. This is totally your call, but I would think you'd want to.

Here's what the default iPhoto window looks like (Figure 13.2). Table 13.1 details the major points of interest.
The iPhoto icon is a dead giveaway as to what the application is for, wouldn’t you say?

![iPhoto icon](image)

**FIGURE 13.1**

**TABLE 13.1**

**iPhoto’s Major Landmarks**

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source list</td>
<td>Easily access your pictures by selecting one of the items in the source list, such as recently imported pictures, the main photo library, calendars, albums, and so on.</td>
</tr>
<tr>
<td>Information pane</td>
<td>When a picture or event is highlighted, click this button to see all the important info about it. Dates the event or pictures were created, the size of the image(s), and other pertinent information can be found here.</td>
</tr>
<tr>
<td>Toolbar</td>
<td>Options in the toolbar help you interact with the items you are currently working with, be they individual pictures, customized calendars, or what have you. Elements available in the toolbar vary depending on what you are doing at any given time.</td>
</tr>
<tr>
<td>Viewing area</td>
<td>Displays items you’ve selected from the source list.</td>
</tr>
<tr>
<td>Add source</td>
<td>Click to create a new album, book, card, and so on.</td>
</tr>
<tr>
<td>Information</td>
<td>Provides info such as the dimensions and data size of a picture.</td>
</tr>
<tr>
<td>Full screen</td>
<td>Select to activate iPhoto’s full-screen mode.</td>
</tr>
<tr>
<td>Play slide show</td>
<td>Plays a slide show using the photos or albums you selected.</td>
</tr>
<tr>
<td>Search</td>
<td>Search the photo library by entering text that matches the date, keyword, or rating you are looking for.</td>
</tr>
<tr>
<td>Size slider</td>
<td>Drag the slider to increase or decrease the size of the elements in the viewing area.</td>
</tr>
</tbody>
</table>
Part IV The Multimedia Mac

FIGURE 13.2
Your window will look considerably different if you haven’t already loaded pictures into your iPhoto library.

Information pane

Source list Toolbar Viewing area

Import Images

Importing an image means to bring it from some other medium or source into iPhoto’s library. There are a couple of ways to import images into iPhoto: with a camera or via a file. We’ll take a look at both methods in this section.
Import from a camera

Consult your camera’s documentation for information on connecting the camera to a computer. It should tell you where to connect the USB cable to your camera and how to change the settings on your camera to make it discoverable by the computer. If you don’t have the documentation for your camera, visit the camera manufacturer’s Web site for support.

To import items from your camera, you must have a USB cable to connect the camera to your Mac. These cables are usually shipped with the camera. To import images from a camera:

1. Open iPhoto if it’s not already running.
2. Turn off your camera.
3. Connect the camera to your Mac.
4. Turn on the camera and it should appear in the source list after a few seconds (if not instantly). I am using my iPhone 3G to import photos, as you can see in Figure 13.3.

**FIGURE 13.3**
The name of your camera appears in the source list under Devices.

5. The viewing area should automatically display the pictures that are on the camera, as shown in Figure 13.4. If not, click the camera in the source list to highlight it.

6. Enter an event name and a description in the appropriate fields under the viewing area, if you so desire. It’s not a commandment, but a suggestion. Events are an easy way to browse through your iPhoto library, making it easy to spot the pics you want. This will become increasingly useful as your library grows.
7. At this point you have two options: Import all of the photos in the viewing area or only those photos that you select.
   - To import all the photos, simply click the Import All button in the lower right corner.
   - To import selected photos, highlight the photos you want to add to your iPhoto library and click the Import Selected button. To highlight multiple photos, hold down the ⌘ key while clicking. Release the ⌘ key when you're finished selecting photos.

**TIP**
To prevent you from having to view and scroll through pictures you may have already imported, check the Hide photos already imported box under the viewing area.

8. When the import process starts, iPhoto checks to see if the photos you are importing already exist in iPhoto's library. If one or more of them does already exist in the library, you will see a Duplicate Photo window, like the one in Figure 13.5, that asks you what to do with the photo you are importing. Choose whether to import or not, and check the Apply to all duplicates box if you don't want to be prompted for each picture that may have a duplicate already in the library.

9. When the import process is complete, you will see a prompt like the one in Figure 13.6 that wants to know if iPhoto should delete or keep the original photos that are on your camera. Choose wisely, my friend.
To clone or not to clone, that is the question!

Do you want to keep or delete the originals on the camera?

When you choose to delete the originals, they are wiped from the camera completely. Should something go wrong at this stage (if you lose power, for example), your pictures are gone forever! There is no wishing them back into existence. Be safe and keep the originals until after the import process is finished. Then, if you still want to clear the originals from your camera, consult your camera's documentation for how to delete them.

Import from files

The other way to get pics into your iPhoto library is to import them from your hard drive or another disk. Why would you need to do this? Well, I'm glad you asked! There are plenty of instances where you may have a photo that isn't residing on a digital camera but you still want to import it; for example:

- Someone may e-mail photos to you.
- You might download photos from a Web site.
There may be picture files shared from another computer.
A friend may want to exchange pictures with a USB thumb drive.

To import images from files:

1. Open iPhoto.
2. Press `⌘`+Shift+`I`, or choose File→Import to Library from the menu.
3. Browse your Mac (or whatever device the desired photos reside on) and find the picture(s) you want to import. Select the pictures and click the Import button in the lower right, shown in Figure 13.7.

![Figure 13.7](image)

Hunt down that special pic you want and import it.

4. iPhoto takes you to the Last Import section of the source list so that you can have a look at the items you just imported, as shown in Figure 13.8.

**TIP**
If you are using Apple’s Mail program to receive e-mail, you can simply drag a photo out of the e-mail that it is contained in right into iPhoto. It doesn’t get any easier than that!
View and Organize Images

Now that you've gotten some images into iPhoto, it's time to do something productive with them. In this section you'll learn how to view your images, as well as how to organize them better.

iPhoto allows you to see all of your images individually or to separate them into Events, which are groupings of photos based on the date they were taken. Notice under the Library heading in the source list that you can select either Events or Photos. If you select Events, you will see your photos arranged by Events, as shown in Figure 13.9.

To view the photos contained in an Event (Figure 13.10), simply double-click the Event. To return to the list of Events, click the All Events button in the upper left of the viewing area, or to view the pictures in other Events, select the right or left arrow button in the upper right.
Part IV  The Multimedia Mac

FIGURE 13.9
Viewing your library with Events

FIGURE 13.10
Viewing the photos that are in an Event
Assigning keywords to images

Keywords are extremely helpful when it comes to sorting and searching your images. Keywords should be simple and descriptive of the picture’s topic or setting. For example, “birthdays,” “school,” and “family” would be good keywords. To assign a keyword to an image:

1. Select the image or multiple images that you want to add keywords to.
2. Press ⌘+K or choose Window > Show Keywords to open the Keywords window, shown in Figure 13.11.

3. Select a keyword from the list in the bottom half of the window. You can also create a custom keyword:
   1. Click the Edit Keywords button to open the Edit Keywords window.
   2. Click the + button to create a new keyword.
   3. Enter the name of your new keyword, as shown in Figure 13.12, and click OK.
   4. Close the Keywords window when finished by clicking the red button in the upper left (it’s the darkest button in Figure 13.11, or by pressing ⌘+K again.

FIGURE 13.11
Use keywords to make it easier to find items.

FIGURE 13.12
Make up your own keywords to customize your iPhoto experience.
Creating albums and Smart Albums

Events are helpful when browsing your iPhoto library, but albums and Smart Albums make it much easier to group like items together. The album resides in the source list so it's always within easy reach.

Making a standard album

To make a standard album:

1. Click the + button in the lower left of the iPhoto window.
2. Click the Album icon in the toolbar. You can go straight to this window, skipping step 1, by pressing Option+N.
3. Enter a name for the new album, as shown in Figure 13.13.
4. Click Create to complete the process.

![FIGURE 13.13](image)

Albums make organization much easier.

**TIP**

To create a new album from pictures you've selected in the library, press Option+Shift+N. Notice that the Use selected items in new album box is automatically checked.

Making a Smart Album

Smart Albums can be configured to search both newly imported items and items already in the iPhoto library that match their criteria. If the items match, they will be added to the Smart Album. This is a really quick and easy way to have iPhoto do a great deal of the organization for you. To create a Smart Album:

1. Click the + button in the lower left of the iPhoto window.
2. Click the Smart Album icon in the toolbar. You can go straight to this window (displayed without the toolbar), skipping step 1, by pressing Option+N.
3. Enter a name for the new album and add criteria that items must meet to be included in it. Use the popups to configure the criteria, and add or remove criteria using the + and – buttons, respectively. In Figure 13.14 I've created a Smart Album that contains all the beach trips we took in 2008, using the Date and Keyword options to whittle down the list of items that can be contained in it, such as beach trips that took place in years other than 2008.
4. Click OK to create the Smart Album.

**FIGURE 13.14**
Now that’s one intelligent album!

Utilizing slide shows
Slide shows are great for displaying images automatically. iPhoto does a great job of moving from picture to picture in the slide show, and even allows you to add music to your creations. You can create slide shows from albums or from items you select in the iPhoto library.

Create slide shows
Let’s make a slide show to wow family and friends:

1. Choose an album from the source list or select photos from the library that you want to use for your slide show.
2. Click the + button in the lower left of the iPhoto window.
3. Click the Slideshow icon in the toolbar.
4. Enter a name for your new slide show and check the Use selected items in new slideshow box, as shown in Figure 13.15.
5. Click Create to add the slide show to your source list.

**FIGURE 13.15**
Creating a new slide show in iPhoto.
The Ken Burns Effect

Apple popularized the term “Ken Burns Effect” when it was included as a feature in iMovie and iPhoto software. Ken Burns is a documentary filmmaker who has made some of the most popular and acclaimed documentaries in history, including Civil War, which really familiarized much of the general public with the technique of zooming and panning on still images to give the illusion of motion. This zooming and panning is what came to be known as the Ken Burns Effect because he uses it so effectively in his documentaries.

Setting up and playing slide shows

Now that you have a slide show, I bet you’d like to play it, right? To do so, simply select the slide show in the source list and click the Play button underneath it (in the toolbar). Your slide show will play until you stop it by pressing the Esc key or the mouse button.

Isn’t that cool? You can leave well enough alone at this point, or configure some of the options in the toolbar (Figure 13.16) to tweak the way the slide show plays. Let’s have a look at the options afforded by iPhoto:

FIGURE 13.16
A bird’s-eye view of your slide show
• The Preview button lets you see a short preview of the slide show in the iPhoto viewing area.

• Use the Effect and Transition popups to make these changes only to the slide currently being viewed. Click the popups to see the options available.

• To use the Ken Burns Effect for this slide only, check its box. (See the sidebar on the previous page for more on the Ken Burns Effect.)

• Click the Adjust button to open the Adjust This Slide window (Figure 13.17). You can make settings in this window that affect only the slide you are currently viewing. You can choose a different slide from the menu above the viewing area.

**FIGURE 13.17**

Changes made here affect only the slide currently selected.

![Adjust This Slide](image)

- The Settings button is used to change the settings for the entire slide show; changes made to individual slides by using the Adjust button are preserved, though. Modifications you can make, which you can see in Figure 13.18, include:
  - Determining the delay time between slides
  - Selecting the type of transitions to make between slides and how fast those transitions should occur
  - Repeating the slide show and the music, or making the length of the slide show correspond to the length of the music

• Click the Music icon to open the music selection window, shown in Figure 13.19. Select from the preinstalled music or from your iTunes library.

• Use the arrows to move to the previous or next slide.
These changes affect the entire slide show.

Adding music to your slide show really creates a great atmosphere when viewing it.
**Edit Images**

When I say, "edit images," I mean exactly that: You can change or modify images to your liking in one way or another, or in a combination of ways. iPhoto has some really nice tools for editing images, probably the finest of any of what I term "image editors for the common folk." These "common folk" editors are those aimed at the average computer user, not the high-end graphic artist who uses Adobe Photoshop on a daily basis. Photoshop is the king of image editors, and you will pay a kingly sum for its wares, but most of us will make do just fine with the likes of good old iPhoto.

iPhoto can edit images with methods ranging from something as simple as removing red-eye (you know, when the eyes of someone in the photo makes him or her look like some creature out of Dante's Inferno) to correcting color balance.

**Remove that pesky red-eye**

Getting down to it, then, here's how to remove red-eye from an image:

1. Find the image you want to edit in the iPhoto library.
2. Double-click the image to bring it to the fore, and then click the Edit button on the left of the toolbar to enter editing mode.
3. Zoom in on the eyes of the subject you want to remove the red-eye from to make the selection of the eyes easier.
4. Click the Red-Eye icon in the toolbar.
5. Place the cursor, which should look like a cross-hair at this point, over the red portion of the eye and click. iPhoto automatically removes the red from the eye, as shown in Figure 13.20.
6. When you've finished removing red-eye from all the subjects, click the Done button to exit editing mode.

**Advanced image editing**

I'm sure the other options in the toolbar that are available while in editing mode have captured your attention by now. Yes, there are myriad other tricks and treats you can use to enhance the images in your library, and I'll be happy to delve into them for you now (be sure you're in editing mode so you can follow along and try each item out as you go):

- The Rotate icon works as advertised. If you have an image that isn't viewable without cocking your head to a 90-degree angle, the Rotate icon is for you. Simply click the Rotate icon to turn the image counterclockwise until it looks correct in the viewing area.
- Use the Crop icon to clip portions of the image that you want to keep. If you want to remove a section of the image, or concentrate on a particular item in it, click the Crop icon, and then click-and-drag the cropping borders to encompass the section you want to keep (Figure 13.21).
Even in this grayscale shot you can see the dramatic difference between the eyes after removing red-eye from the one on the left.

Cropping the coach and me ("War Eagle!")
The Straighten icon helps to correct photos that may have been taken slightly off-kilter.

Enhance allows iPhoto to make automatic adjustments to your photo that it feels is necessary to achieve a better result.

Use the Retouch icon to touch up portions of images that have blemishes or marks. Select the brush size you want to use to retouch the offending mark on the image, and then click (and in some cases drag) the brush over the area. Press the Shift key when retouching an image to compare the edited version against the original.

Any changes you make to an image are applied to every instance of it throughout iPhoto, including slide shows, books, and so on. To prevent this from happening, create a duplicate of the photo by choosing Photos •: Duplicate from the menu. You can always restore the original image by choosing Photos •: Revert to Original.

The Effects icon opens the Effects window, which lets you choose from eight different effects that can be applied to your image, as shown in Figure 13.22. You can revert to the original image by clicking the Original button.

The photography experts in the crowd who don’t have a copy of Photoshop are probably screaming for me to get to “the good stuff” by this point. The Adjust icon is just what the doctor ordered for you. Clicking on this icon opens the Adjust window (Figure 13.23), which offers those “in the know” many an option for modifying things such as the image’s exposure and contrast, highlights and shadows, saturation, temperature, and more.

**FIGURE 13.22**
Applying the B&W effect to two wild and crazy guys
Export Images

You already know how to get images into iPhoto, but what if you want to get them out? Exporting photos is something you might not do very often, but it's good to know how to do so if the need arises.

Exporting as a file

The most common method of exporting items from iPhoto is to export them as a file, which is pretty much the same thing as creating a copy of the image somewhere other than the iPhoto library. To export as a file:

1. Find and select the image(s) you want to export in the iPhoto library.
2. Choose File → Export from the menu, or press ⌘+Shift+E to open the Export Photos window, shown in Figure 13.24.
3. Click on the File Export tab at the top of the window to see the export options:
   - **Kind.** Select the file format that you want the exported file to use. JPEG and TIFF are the most typical file types for photos, but Current retains the current format of the image in the library.
   - **Include.** Check this box to include the title and keywords in the picture's metadata.
• **Size.** This popup changes the physical dimensions of the image. You can also choose your own size by selecting Custom.

• **File Name.** Determine if the exported files should be in order of the sequence in which they were taken, or in order of their names, titles, or the name of the album in which they reside.

4. Click the Export button and then select a destination for the exported files.

---

**FIGURE 13.24**

Exporting images to files is simple with the options provided.

![Export Photos dialog box](image1)

---

**Exporting via e-mail**

The next most common method of exporting photos is by e-mailing them. iPhoto can create an e-mail in your default e-mail application using the photos you've selected. To export via e-mail:

1. Find and select the image(s) you want to e-mail in the iPhoto library.
2. Choose Share → Email from the menu, or select the Email icon in the toolbar, to open the Mail Photo window, shown in Figure 13.25.

---

**FIGURE 13.25**

Prepping your photos for e-mailing

![Mail Photo dialog box](image2)
Select the size of the image you want to be included in the e-mail and whether to include iPhoto's titles and comments.

Click the Compose button to have your e-mail application open a new message window that includes the selected photos, as shown in Figure 13.26. Follow your typical e-mail procedures from this point, such as entering addresses of folks to send the images to and such.

**FIGURE 13.26**

Tell Mail who to send your beautiful photos to (don't forget a subject line!).

---

To use a different e-mail client than Mac OS X's Mail, choose iPhoto ➤ Preferences ➤ General, and then use the Email photos using popup menu to select a third-party e-mail application on your Mac. Unfortunately, you are limited to using Mail, Microsoft Entourage, Eudora, or AOL e-mail clients. Maybe Apple will allow us to select the e-mail application of our preference in a future update.
Print Your Images

Sometimes there's just no substitute for a picture that you can carry around in your wallet or purse or hang on your wall, and iPhoto's got your printing needs covered. iPhoto not only helps you print your treasures on your favorite printer, but does it in style! To print your pictures:

1. Select the picture you want to send to your printer.
2. Tell iPhoto to print using one of these easy methods:
   - Click the Print icon in the toolbar.
   - Press ⌘+P.
   - Choose File ➤ Print from the menu.
3. In the print window, shown in Figure 13.27, select a theme from the list on the left.

![Figure 13.27](image)

Printing is easy to configure with iPhoto.

4. Choose the printer you want to use from the Printer popup menu, along with the Paper Size and Print Size.
5. Click Print to send the job to the printer.
Observant readers may have noticed the Customize button under the print preview window. This button opens the door to more advanced printing options for iPhoto, shown in the toolbar of Figure 13.28.

These advanced options include choosing themes, background, and borders for the print job; adjusting the layout of the picture on the page; and modifying the fonts used when printing text or titles. You can even perform some editing on the photo to be printed (no need to fret, as this editing only affects the printed image, not the original in the iPhoto library):

- Click the picture and use the slider to adjust the size of the picture in the frame, or click the hand icon to the right of the slider to change the picture's position in the frame.
- With the picture highlighted, click the Adjust icon in the toolbar to see the Adjust window (Figure 13.29). From here you can experiment with a slew of options, including Exposure, Contrast, Tint, and Sharpness.

When you're ready to print the picture after performing your editing magic, click the Print button in the toolbar.
If you are using a laser printer, be absolutely certain that you are using paper that is safe to use in laser printers. Temperatures inside of a laser printer get extremely hot and may melt coatings that are on some papers specified for use only in inkjet printers.

**FIGURE 13.29**

Fine-tune your photos like an expert.

Create Customized Books, Calendars, and Greeting Cards

The neatest feature in all of iPhoto is the ability to create customized books, calendars, and greeting cards using your very own images. Basically, you provide the pictures for the item, select the themes and layouts you want to use, and send them off to Apple via iPhoto to be processed. In a few days you will have beautiful renditions of your projects in your hands. Of course, each type of item has its own pricing structure, which you can investigate as you purchase the product. To get your project off the ground:

1. Select the images you want to use for your project.
2. Click the + button in the lower left of iPhoto's window to open the add window.
3. Choose the type of project you want from the items in the menu bar.
The Book icon walks you step-by-step through creating an actual photo book from your pictures. Give your book a name, choose the type of book you want printed, and then select a theme from the list on the left. Make adjustments to the book’s layout and add titles and comments if you desire, using the tools available in the toolbar, as shown in Figure 13.30. When it’s perfect, click the Buy Book button to select options and prices.

Make a custom calendar by clicking the Calendar icon, and then choose when the calendar starts and what holidays to add to it, if any (I love how you can use your iCal calendars to create entries as well). When you click OK you are rewarded with a really neat calendar using your own photos (Figure 13.31)! Click the Buy Calendar button when you’ve made sure the layout is exactly the way you want it.

Customized greeting cards are one heck of a personal touch (guaranteed to make grandmothers and grandfathers proud, that’s for sure). Click the Card icon, assign a name to the card, select a theme for it, and click the Choose button to see a preview of your creation (Figure 13.32). Add text to the card to further personalize it, make any other tweaks you deem necessary, and then click the Buy Card button.

FIGURE 13.30
Setting up a book may seem daunting, but iPhoto makes it ridiculously simple.
These custom calendars are so great to have!

Who can resist smiling when they open a card like this?
Image Capture

If you read Chapter 12, you're familiar with Image Capture's scanning abilities already, but it can also capture images from your digital camera. Those Mac users who don't have iPhoto have the capability of getting those images on their computer without having to purchase additional software, but understand that while Image Capture does a great job of getting pictures from your camera, it has no organizational or editing abilities.

Acquiring images

Open Image Capture to get the ball rolling:

1. Press `⌘`+`Shift`+`A` from within the Finder to open the Applications folder.
2. Locate and double-click the Image Capture icon (Figure 13.33) to open the application.

![FIGURE 13.33](image)
The Image Capture icon is a picture of a camera (pretty big hint of what it does, I'd say).

When you open Image Capture without having connected your camera to your Mac, you will see a window informing you that no Image Capture device is connected to your Mac. But when you connect your camera, you will see a window displaying information about the device and options to save its contents, as shown in Figure 13.34.

![FIGURE 13.34](image)
Image Capture has discovered my iPhone 3G, similar to how iPhoto discovered it.
You can now use this window to download the pictures from your camera. The options are fairly straightforward, but still bear some explanation:

- The Download To popup menu lets you select the folder on your Mac that you want Image Capture to save the pictures to.
- Use the Automatic Task popup menu to have Image Capture perform an operation on the images being downloaded, such as create a slide show or Web page from them, and crop or expand images to fit certain paper sizes.
- The Options button opens the Options/Information window, shown in Figure 13.35.

**FIGURE 13.35**
Image Capture has discovered my iPhone 3G, similar to how iPhoto discovered it.

Use the Delete items from camera after downloading option carefully. If something were to happen during the download process, you could lose all of your images before they are successfully saved. It’s best to delete the items from the camera later.

Clicking the Download All button does exactly as specified, but what if you don’t want to download all the items on your camera? In that case, it’s a good idea to click the Download Some button instead. A window similar to that shown in Figure 13.36 opens and displays all of the items that can be downloaded from your camera.
Select the images you want to save by holding down the ⌘ key while clicking the images. When you've finished the selection process, click the Download button to save the images to the folder you specify.

**Deleting and adding images to and from your camera**

The Download Some button affords you some options that aren't advertised but work very well. From the Download Some window, you can delete individual items from the camera, and you can even add items to it!

**Manually delete images from your camera**

To manually remove images from your camera:

1. Connect the device and open Image Capture.
2. Click the Download Some button to open the expanded window.
3. Select the image you want to remove. You can choose multiple images by holding down the ⌘ key while clicking.
4. Click the Delete button in the toolbar at the top of the window.
5. You are prompted, as shown in Figure 13.37, to verify that you do indeed want to delete the file(s). Click OK to delete the file, or Cancel to abort the process.
Add images to your camera
One of the coolest features of Image Capture is the ability to add items to your camera. Why would you want to add anything to your camera? The best answer I can possibly come up with is so that you can restore an image you mistakenly deleted. To accomplish this Herculean feat:

1. Connect the device and open Image Capture.
2. Click the Download Some button to open the expanded window.
3. Select the image(s) you want to add to your camera and drag-and-drop them into the Download Some window, as shown in Figure 13.38.

Drag the files into the window and drop them right in.
4. Image Capture displays a list of the files you dragged into the window, as illustrated in Figure 13.39. Click the Upload button to begin the process. Your images are now copied to your camera.

**FIGURE 13.39**

Verify the images you are copying to your camera and click Upload.

<table>
<thead>
<tr>
<th>Name</th>
<th>Date Modified</th>
<th>Size Kind</th>
</tr>
</thead>
<tbody>
<tr>
<td>IMG_5685.jpg</td>
<td>Saturday, September 6</td>
<td>1614198 public.jpg</td>
</tr>
<tr>
<td>IMG_5648.jpg</td>
<td>Saturday, September 6</td>
<td>1995861 public.jpg</td>
</tr>
<tr>
<td>IMG_5639.jpg</td>
<td>Saturday, September 6</td>
<td>1615792 public.jpg</td>
</tr>
</tbody>
</table>

**NOTE** Both iPhoto and Image Capture have excellent help systems that cover many of the topics that are beyond the scope of this book, so don’t be shy about accessing the Help menu.

**Summary**

At this point you should be rocking and rolling with your digital camera and Leopard. You've seen how to get images from your camera to your Mac and from your Mac to your camera; edit your images; e-mail them to compatriots; print them; and create customized books, calendars, and greeting cards. You've even learned a little about Mr. Ken Burns and his Effect. And while iPhoto is the best choice for organizing your pictures, Image Capture is a fine utility to have on hand if you haven't gotten around to purchasing the iLife application suite from Apple.
If you're like me, you have a closet full of digital videotapes of family events and other sundry good times. These tapes are stacked high and reach deep into the closet. This is a good thing, mind you; I love the fact that we have all those old memories digitally preserved for years to come. I look forward to cuddling up with my wife in our later days and reminiscing, certainly shedding a few tears as we watch our beautiful children grow up again before our eyes, or showing our grandchildren videos of their mom's or dad's first Christmas. These items are precious to us, but there's a problem, or more accurately, an inconvenience, when it comes to watching them. In order to view these videos we have to take out the video camera, put the tape that we want to view in the camera, and then connect the camera to the television. Who wants to do that every time you want to watch something?

Also, if you're like me, no one can commend you for having been nominated for an Oscar because of your directing, editing, or cinematography prowess. I won't disparage myself too viciously; I can hold a camera as still as the next guy, but my work won't be confused with a sweeping and picturesque motion picture epic.

For all of us who didn't attend a prestigious film school, Apple offers iMovie. iMovie, which was first introduced in 1999 and can be purchased as part of the iLife suite of applications, helps you import your digital video from your camera, create and edit a movie using your imported video, and share your finished creations with anyone you please. And it does all of this with Apple's trademark ease and polish.

Learn much more about iMovie '08, which is the most current version, by visiting its Web site at www.apple.com/ilife/imovie. For support and detailed instruction, check out www.apple.com/support/imovie.

IN THIS CHAPTER
- Get to know iMovie
- Import video into iMovie
- Create new iMovie projects
- Sharing your projects
Get to Know iMovie

There are lots of video-editing software options out there, but one glance at most of their interfaces will make a novice give up the idea of editing his or her own video in a heartbeat. iMovie successfully cuts down on the clutter, offering you a lean and clean interface while still providing lots of great tools for successfully creating a great movie. Figure 14.1 shows you the default interface of iMovie '08 and points you to some of its more interesting landmarks, while Table 14.1 provides brief explanations of each item.

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Library</td>
<td>This is a list of all the projects you have created using iMovie. Select one to view or edit it.</td>
</tr>
<tr>
<td>Viewer</td>
<td>Displays your currently selected video.</td>
</tr>
<tr>
<td>Project window</td>
<td>This area is where you assemble the elements of your iMovie project, like video clips, music, and the like.</td>
</tr>
<tr>
<td>Toolbar</td>
<td>Instantly access most of iMovie's controls from this conveniently located toolbar.</td>
</tr>
<tr>
<td>Event Library</td>
<td>This is a list of all the videos you’ve imported into iMovie.</td>
</tr>
<tr>
<td>Source pane</td>
<td>Select portions of video from within this area that you have selected in the Event Library.</td>
</tr>
</tbody>
</table>

iMovie '08 Is Totally Different from Previous Versions

In terms of its layout and much of its functionality, iMovie '08 is a total departure from previous versions of iMovie. iMovie '08 is a complete rewrite from top to bottom. As a matter of fact, it’s so much of a departure from previous versions that it has garnered more than a small share of criticism. To be honest, iMovie '08 does have a dramatically reduced feature list compared to iMovie 6, which was the prior version. Apple has taken some hits over these changes, which included a reduction of supported media formats and slower performance.

If you would like to recapture the benefits of iMovie 6, Apple has been kind enough to provide it as a download for owners of iMovie '08. iMovie 6 can be downloaded from http://support.apple.com/downloads/iMovie_HD_6. I would suggest giving it a try, but only after you've become familiar with iMovie '08.
iMovie '08 sports an interface that's as easy to use as it is to look at.

![Diagram of iMovie interface]

**Import Video into iMovie**

You've got a wide variety of options when it comes to importing digital video with iMovie. Bring digital video into iMovie:

- By downloading it from your digital video camera
- Through importing movie files, which include the MOV, MPEG-4, 1080i, and DV formats, among others
- By opening iMovie HD projects that were created in previous versions of iMovie

**CAUTION** Something I like to warn folks of frequently if they have a video camera that uses mini-DVDs is to not insert those mini-DVDs into their Mac's disc drive. It might be a natural inclination by some folks to say, "Hey, the disc works in my video camera, so it should work in my Mac." That may sound good, but it's totally incorrect; don't do it. The mini-DVD will get stuck in your Mac's slot-loading disc drive.
Importing from a video camera

Bringing digital video into iMovie using a digital video camera is the most commonly used method. Note that when you import video from a camera, the digital video is copied and the original video on the camera is not erased or compromised in any way.

There are two types of digital video cameras available today:

- **Random Access Devices**, or RADs, are cameras that can selectively import video clips without having to play through an entire recording during the import process. They use media such as DVDs, hard disk drives, or flash memory to store the digital movies you record, and they connect to most computers with USB.

- **Tape-based digital video cameras**, which come in formats such as mini-DV, Digital8, and others, allow you to select portions of recordings that you want to import, but you must do so by playing through the recording. If the part of the recording you want to import is near the end of the tape, you will have to fast-forward all the way through the tape to the part containing the desired video. You must have a FireWire port and cable to transfer video from tape-based digital video cameras.

**Random Access Devices**

Most of today's newer digital video cameras are RADs. Because they use hard drives or flash memory, they are much faster when it comes to transferring video to the Mac than tape-based cameras.

To import video from a random access device:

1. Open iMovie by pressing `⌘`+`Shift`+`A`, finding its icon, and then double-clicking it.
2. Set the camera to PC or computer mode and power it on (consult the camera's documentation if you don't know how to do this).
3. Connect the camera to the Mac and the Import window will open.
4. You can import video clips in one of three ways:
   - To import all of the video on the camera, select Import All.
   - To import most of the clips, select Manual in the Import window. Uncheck the boxes beneath the clips you don't want to import, and then click the Import Checked button.
   - If you want to import only a few clips, select Manual in the Import window. Click the Uncheck All button and check the boxes under the clips that you want to import. Next, click the Import Checked button.
5. Choose a location on your Mac in which to save the imported data. The disk can be internal or external, but if it is external it must be connected with FireWire, not USB.
6. Determine if you are creating a new Event or adding the video clips to an existing Event. An Event is simply what an individual imported clip is called in iMovie.
7. Choose the size of your 1080i video, if this applies to your clips.
8. Click OK to start the import process, which can take a long time if you are importing all the video from the device.
Check the documentation that came with your video camera or consult the Web site of the manufacturer that made it to determine if it supports the 1080i format. 1080i is a high-definition format that can save videos in huge sizes (up to 1920 x 1080 pixels), but these files take up enormous disk space.

**Tape-based digital video cameras**

If you have an older digital video camera, most likely it supports the use of digital videotape, such as mini-DV or Digital8. Many people still prefer the tape-based devices due to their archival ability; tapes don't lose their data when your hard drive crashes. However, they can be a bit slow when importing, and while the quality is a bit better than RADs, the difference won't be enough to matter to most general consumers.

**TIP**  
Don't forget: You can only connect your tape-based device to your Mac with FireWire. USB will not transfer the video to the computer.

Here's how to import video with a tape-based digital video camera:

1. Open iMovie by pressing Command+Shift+A, finding its icon, and then double-clicking it.
2. Set the camera to Play, VTR, or VCR mode and power it on.
3. Connect the camera to the Mac and the Import window will open.
4. You can import all or only some of the video on the tape:
   - To import all the video on the tape, set the option on the left side of the Import window to Automatic, and then click Import. iMovie will stop importing when it reaches the end of the recording.
   - To import only portions of the video, set the option on the left side of the Import window to Manual. Utilize the controls in the Import window to rewind or fast-forward the tape to where you want to begin the import, and click the Import button. Click the Stop button when you want to stop the import.
5. Select a location on your hard drive in which to save the video.
6. Determine if you are creating a new Event or adding the video clips to an existing Event.
7. Choose the size of your 1080i video, if this applies to your video.
8. Click OK, power off your camera, and then disconnect it from your Mac.

**Importing from a file**

iMovie can import movie files created by other sources, as well, such as a video file or an iMovie HD project. To import a video file stored on your hard drive:

1. Click on the File menu and choose Import Movies from the list.
2. Browse your Mac's hard disks for the video file you're importing.
3. Select the desired video file and choose a drive for the Save To destination.
4. Determine if you are creating a new Event or adding the video clips to an existing Event.
5. Choose the size of your 1080i video, if this applies to your video.
6. Decide if you just want to copy the video file or move it from its original location. (I suggest copying it first, just in case something goes awry during the import. That way you’ll still have the original video file intact.)
7. Click the Import button. The newly imported video will display as a new Event in your Event Library.

Here’s the scoop on importing an iMovie HD project:

1. Click on the File menu and choose Import iMovie HD Project from the list.
2. Browse your Mac’s hard disks for the folder containing the iMovie HD project you’re importing.
3. Highlight the project folder and select a Save To location.
4. Choose the size of your 1080i video, if this applies to your video.
5. Click Import.
6. When the import process is finished, the new project shows up in the Project Library. A new Event is also added to the Event Library, and the imported video clips are automatically added to the Project window.

NOTE: None of the effects, titles, still images, or music tracks from the old iMovie HD project will be imported into iMovie.

Viewing your imported video

Now that you’ve got your video imported into iMovie, I bet you’d like to take a peek at it, huh? The displayed video you see in the source pane will resemble a strip of film, called a clip. Clips begin where you started recording video and end where you stopped recording. Each time you start and stop recording you are creating a new clip. Clips contain all the images, or frames, and audio of the imported video.

To view the video, follow these steps:

1. Check out the Event Library and you will see the Event that was created when you imported the video.
2. Highlight the Event and the imported video displays in the source pane, as shown in Figure 14.2.
3. There are two ways you can choose to view the video:
   ■ Skimming is a technique new to iMovie '08. To skim through the video, drag your mouse pointer over the clips (don’t click; just drag). As you drag over the clips, the frames in them move and any audio associated with the clips plays. The frames can also be seen in the viewer window.
   ■ Play the entire video by selecting a point in a video clip and pressing the spacebar. You can also double-click a point in a clip to begin playback from there.
Create New iMovie Projects

Creating a project, you can edit your video, add content such as background music or clips from other Events, and add transitions and titles to create a completely customized movie. In this section of the chapter I walk you through putting together a new iMovie project. Let’s get going by creating the project:

1. Press Option+N, click the + button under the Project Library pane, or choose File→New Project from the menu.
2. You will want to give the project a descriptive name so that it's easy to discern the topic.
3. Select an aspect ratio you want to use from Standard, iPhone, or Widescreen, as shown in Figure 14.3.
4. Click Create and you can get started adding video and audio.
Select clips

We've got a new project, and we have video that we've imported into iMovie. Now it's time to meld the two together. You won't have much of a project without video! Follow these steps to add video to any project:

1. Choose the Event containing the video clips you want to use from the Event Library.

2. Select a clip, or a portion of a clip, that you want to use in your project. Here's a quick how-to for selecting clips:
   - Click anywhere in the video clip and iMovie will place a yellow border box around a four-second section of the clip.
   - Shrink or expand the selected portion of the clip by clicking-and-dragging the handles on the right and left sides of the yellow box.
   - If you want to select an entire clip, hold down the Option key while clicking the clip (Figure 14.4).

3. To add the selected clip to your project, click the Add Selection to Project button in the toolbar. You can also drag the selection to the Project pane and simply drop it in.

4. Keep adding video clips to your project until you are satisfied that you have the video you need. Feel free to use as many clips as you want and to choose them from any Event in your Event Library.

5. Drag-and-drop the clips into any order you like within the Project pane.

6. Click the Play Project from Beginning button (it looks like a black arrow) below the Project Library to see the current state of your project.

Mark your favorite clips

Although some of the video you record is undoubtedly Oscar-worthy, the rest may not be fit to show. With iMovie '08 you can mark your best video clips as favorites, and mark the not-so-good video for rejection. The buttons used to mark the video you select are located in the iMovie toolbar. The black star is the Mark Selection as Favorite button, the white star is the Unmark Selection button, and the X is the Reject Selection button.
To mark clips:

1. Choose the clip or portion of a clip that you want to mark, as described in the previous section.
2. Click the marking button you intend to use for the chosen clip, whether it is the Mark Selection as Favorite button or the Reject Selection button.
3. Remove marks by clicking the marked clip and then clicking the Unmark Selection button.

Favorites are displayed with a green bar running across the top of the frames, and rejected clips are shown with a red bar.

Add music and sound effects

Any movie worth its salt has a sweeping musical score, and because you're creating the next *Gone with the Wind*, you need to add a little audio magic to your iMovie project. But you're not limited to just adding music; you can also add some really neat sound effects to your creation. For example, you could add a tiger roar that plays during your grandfather's yawn, or overlay the sound of crickets to a video of your brother-in-law telling you a really bad joke. Let's do this:
1. Open the iMovie project you want to add music or sound effects to.

2. Open the “Music and Sound Effects” browser, which displays in the lower right corner of iMovie's window, in one of three ways:
   - Press ⌘+1.
   - Choose Window ➤ Music and Sound Effects from the menu.
   - Click the Show or Hide Music and Sound Effects browser button on the right side of the toolbar.

3. Click the popup menu at the top of the Music and Sound Effects browser to choose music or sound effects from any of the sources it lists.

4. When you’ve decided on an item, click-and-drag it to the background of your project. Be sure that you don’t drop it onto your video clips, but rather behind them.

5. A green box will appear in the background behind the associated clip with the title of the music or sound effect.

6. You can compare the length of the song or sound effect to the length of the associated clip to see if it will work for what you need. The music or sound effect will fade at the end of the clip if it is longer than the clip.

7. You can adjust the playing time of your music or sound effects. Click the green box to highlight it and choose Edit ➤ Trim Music from the menu. Click-and-drag the selection handles at the beginning and end of the song to adjust its length.

**TIP** If you decide you don’t like the music or sound effect, it's easy enough to remove. Simply click the green box associated with it and press the Delete key on your keyboard.

**Using transitions**

I’m sure you’ve seen movies that move from one scene to the next with a wipe or a fade-out. This effect is called a transition, and iMovie '08 has several cool ones to choose from. To use a transition in your project:

1. Open the Transitions pane, shown in the lower right corner of the iMovie window in Figure 14.5, in one of three ways:
   - Choose Window ➤ Transitions from the menu.
   - Press ⌘+4.
   - Click the Transitions button on the right side of the toolbar.

2. Click the transition you want to use and drag-and-drop it between the two clips you want to transition with one another.

3. To see how well the transition works with your project, double-click the clip anywhere in front of where you placed the transition.
Sharing Your Projects

Because there's no danger that any of the major movie studios will be beating down my door, I had to figure out the best ways to share my iMovie projects with the rest of the world. Fortunately there wasn't much figuring involved, because iMovie makes it easy to share your movies in several ways:

- Publish your iMovie on YouTube.
- Publish the movie to your MobileMe Gallery.
- Create a movie to view on your iPod, iPhone, or Apple TV.
- Create a movie that can be shared with other applications, such as iDVD.
- Export into a movie format that you can e-mail or upload to a Web site.

Publish your iMovie to the Web

iMovie makes it oh-so-simple to publish your movie to the World Wide Web via YouTube or a MobileMe Gallery. Anyone with Internet access can see your movie using either a PC or Mac from anywhere in the world, assuming you provide them with the address where the video is located. They can even use an iPhone to view your video using YouTube.
To publish video to your MobileMe Gallery:

1. Highlight the project you want to publish in the Project Library pane.
2. Choose Share $\Rightarrow$ MobileMe Gallery to open the Publish your project to your MobileMe Gallery window, shown in Figure 14.6.

3. Make changes as you deem necessary to the selection options in the window. I advise you to make the title descriptive of the video's subject.
4. Click Publish.

Would you rather publish your masterpiece to YouTube? No problem:

1. You will need to create a YouTube account if you don't already have one. Go to www.youtube.com to set one up.
2. Select a project from the Project Library that you want to publish.
3. Choose Share $\Rightarrow$ YouTube from the menu to open the Publish your project to YouTube window, shown in Figure 14.7.
4. Click the Add button to enter your YouTube account name, if it doesn't already show up.
5. Choose the category that best suits your video.
6. Give your movie a descriptive name and add a short description, if you like.

7. Select a size for the video.

8. Click the Next button, read the YouTube Terms of Service section, and then click Publish.

9. You will be notified what URL to use for viewing the movie after the process is complete.

Create a movie for your iPhone, iPod, or Apple TV

iMovie '08 can easily create a movie from your project that you can view on your iPhone, iPod (if it has video capabilities), or Apple TV. There’s nothing to it:

1. Select the project you want to publish from the Project Library.

2. Choose Share►iTunes from the menu to open the Publish your project to iTunes window, shown in Figure 14.8.

3. Select the size you want to create. Note that some sizes aren’t supported for all devices.

4. Click the Publish button and wait while the process finishes.
The Multimedia Mac

Share a movie with other applications

You may have other applications installed on your Mac that you use your iMovie projects with, such as iWeb or iDVD. There's a really simple way to bring those projects into those applications:

1. Select the project you want to use with other apps from the Project Library.
2. Choose Share ➤ Media Browser from the menu to open the Publish your project to the Media Browser window (Figure 14.9).

3. Select the size you want to use for the movie.
4. Click the Publish button and wait until the process finishes.
Export your iMovie

Finally, you can export your movie into a standard video format, such as 3GP, MPEG-4, or QuickTime, that you can play using most media player software, such as QuickTime or iTunes. To export your project to a movie file, perform one of the following:

- Choose Share ➤ Export to export your project into an MPEG-4 or 3GP file (the format depends on the size you select). Select the size for the exported file and click the Export button (Figure 14.10).

![FIGURE 14.10](image)

Name your new project and choose an aspect ratio based on how the final movie will be viewed.

- Choose Share ➤ Export Using QuickTime to export the project as a QuickTime movie. Check out the Export and Use popup menus in the QuickTime export window to customize the QuickTime export options. Click Save when you’re ready to begin the export process.

Summary

Once you get used to making your own movies with iMovie '08, it's hard to stop. Before you know it you'll be digging through your closet hunting down old digital video tapes to import. You should now be able to use iMovie to edit those videos, and even add a little "movie magic" to them, such as a soundtrack and special effects. This has by no means been an exhaustive treatise on everything iMovie, so be sure to check iMovie's Help functions for more information and documentation. Don't forget to check out iMovie 6 to see if you like it, too.
Chapter 15

Musical Mac

We're all familiar with the splash Apple has been making with computers for more than three decades now, but they haven't confined themselves to the world of operating systems and computer hardware. Apple has always been known for making products that the more artistic among us, musicians included, have favored over the alternative operating systems out there. However, Apple wasn't content with just regularly changing the way we interact with computers, so they've now changed the world of music as well. Since the advent of the iPod, the way we buy and listen to our music has changed like never before.

Mac OS X comes with iTunes, which is the default music application for Macs. iTunes not only helps you organize your music and create playlists of your favorites, it's also the doorway to the iTunes Store, where you can browse a gigantic catalog of music, movies, television shows, podcasts, iPhone and iPod games and applications, and more. This chapter is all about the ins and outs of iTunes, and even takes a brief look at other music utilities that may be worthy of your attention.

Getting Around in iTunes

iTunes started out as a really cool music player way back in 2001, but has since morphed into a cultural icon. Anyone who has owned an iPod or iPhone has inevitably used iTunes (you have no choice), and iTunes is routinely mentioned on newscasts and in articles about the iPod or iPhone. If you're not an iPod/iPhone owner who has moved from Windows to Mac, you might be surprised to know that Apple has provided a version of iTunes for Windows since 2003. Needless to say, iTunes (which is up to version 7.7.1 as of this writing) is used far and wide all around the world by millions of computer-using music lovers to play and organize their music, and to synchronize their iPods and iPhones.
Initializing iTunes

The first time you launch iTunes, you must initialize some of its settings. To open iTunes:

1. Press \( \text{⌘}+\text{A} \) from within the Finder to automatically open the Applications folder.
2. Locate the iTunes icon, which looks like a CD with a musical note over it, and double-click the icon.

The iTunes Setup Assistant walks you through prepping your Mac and iTunes before you get your groove on. Here are the initial steps:

1. iTunes greets you with a Welcome screen, like that shown in Figure 15.1. Click Next to continue.

![Friendly iTunes welcomes you with the iTunes Setup Assistant.](figure15_1.png)

2. You are asked whether you want iTunes to be the default application for playing audio content that you access with your Web browser (Safari, Firefox, and so on), as illustrated in Figure 15.2. The choice is yours to make; there’s really no earth-shattering difference here, other than content plays in iTunes instead of in the browser. Click Next once you’ve made your decision.
3. iTunes wants to know if it can automatically scour your hard drive for any MP3 and AAC files, which are simply audio files, as shown in Figure 15.3. If it finds any it will go ahead and add them to your iTunes Library, which is where iTunes stores your music. I personally don’t like to do that because some audio files on my computer I simply would rather keep out of iTunes. Click Next to continue.

343
4. You will see a blurb about iTunes downloading album artwork for the music in your library. Smile and nod, and then click Next.

5. iTunes now gives you the chance to browse the wares at the iTunes Store or to go directly to your iTunes Library (Figure 15.4). I suggest heading to the library, but if you want to check out the store (which you’ll do a little later in this chapter anyway) then go ahead, I’ll be here when you get back.

![FIGURE 15.4](image)

Head on to the iTunes Library unless you can’t resist the allure of the iTunes Store.

**Navigating the iTunes Jukebox interface**

By now the main iTunes Jukebox window should be open, ready, and waiting for you to add some funky sounds or twangy country classics. Before you get too far ahead of yourself, though, you need to learn what all the fancy buttons, columns, and windows are for. Figure 15.5 shows the iTunes interface using Cover Flow view, and Table 15.1 details the important stuff whose functions are not glaringly obvious.
### Get to Know the iTunes Jukebox

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Library</td>
<td>Lists different types of items that are contained in your iTunes Library, such as movies, music, television programs, and podcasts.</td>
</tr>
<tr>
<td>Store</td>
<td>Your one-stop shop for purchasing and downloading music, movies, television shows, podcasts, iPhone applications, university lectures, and all sorts of other cool stuff.</td>
</tr>
<tr>
<td>Playlists</td>
<td>You can create playlists of your favorite songs and access them all from here.</td>
</tr>
<tr>
<td>Album artwork/Video viewer</td>
<td>Click to see the album artwork of the song you’re playing or to view a video.</td>
</tr>
<tr>
<td>New playlist</td>
<td>Click this button to create a new playlist.</td>
</tr>
<tr>
<td>Shuffle</td>
<td>Click this button to have iTunes play songs in random order.</td>
</tr>
<tr>
<td>Repeat playlists</td>
<td>Click this button to cause your playlist to play in an endless loop.</td>
</tr>
<tr>
<td>Track list</td>
<td>Gives you a list of your music that you can order in any number of ways by clicking the column names, such as Name, Artist, or Album.</td>
</tr>
<tr>
<td>Cover Flow slider</td>
<td>Drag to fly through all of your music when in Cover Flow view.</td>
</tr>
<tr>
<td>Browse</td>
<td>Click to open the browser when in List or Album view.</td>
</tr>
<tr>
<td>Full screen</td>
<td>Click to enter Full screen mode. This button is only available from Cover Flow view.</td>
</tr>
<tr>
<td></td>
<td>You can also open Full screen mode by choosing View → Full Screen or pressing ⌘+F.</td>
</tr>
<tr>
<td>Search</td>
<td>Type in the name of the song or artist you want to search for to find it quickly and easily.</td>
</tr>
<tr>
<td>View</td>
<td>Choose whether to view your library in a list, grouped with the album art, or using Cover Flow.</td>
</tr>
<tr>
<td>Status</td>
<td>View the progress of a song that is playing, a disc that’s being burned, items that are being copied, and so on.</td>
</tr>
</tbody>
</table>

You can select between three different viewing options in iTunes: List, Album, and Cover Flow. Figure 15.5 shows Cover Flow, while Figures 15.6 and 15.7 illustrate what the same song selections look like in List view and Album view, respectively. Figure 15.8 shows a fourth view, which is Full screen (exclusive to Cover Flow view).
FIGURE 15.5
The default iTunes interface is at your disposal.

Playlists
Store
Library
Rewind
Play/Pause
Volume
Fast forward

Status
View
Search

Full screen

Track list
Cover Flow slider
Eject disk

Hide/Show album artwork
Repeat playlists
Shuffle
New playlist
Album artwork/Video viewer
List view makes it easy to browse your library in alphanumeric order.

Album view groups all the songs contained on a particular album and displays the album artwork.
The Browser is an easy way to fly through your library. Click the Browse button when in List or Album view to open the Browser above the track list. You can peruse your library using the artist, genre, or album name.

### Getting music into iTunes

There are several different ways to start filling up your library, but I'll go over two of the three most common with you here. The method I don't discuss here is purchasing a song from iTunes, which is covered later in this chapter. The other two methods involve importing audio from a file or from a CD.

iTunes supports the playback and conversion of all sorts of different file types, including:

- MP3
- AAC
- AIFF
- WAV
- MPEG-4
- Apple Lossless
Importing audio files
You can import audio files directly into iTunes very simply:

1. Press `⌘+O` or choose File ➤ Add to Library from the iTunes menu.
2. Browse your Mac and locate the audio file you want to import.
3. Select the file and click Open, adding the file to your library (Figure 15.9).

![Figure 15.9](image)

You can import a variety of audio file formats into iTunes.

Importing from a CD
Most of us have vast collections of CDs that we'd like to use for adding songs to our iTunes Library. To add songs from a CD:

1. Put the CD into your Mac's CD/DVD drive.
2. The list of songs contained on the CD appears in the iTunes Jukebox window. If you don't want to import all of the songs, uncheck the boxes next to those you don't want to add, as shown in Figure 15.10.
3. Click the Import CD button at the bottom of the window to begin adding the selected songs to your iTunes Library.
4. The progress of the importing is seen in the Status window. Click the X on the right side of the Status window to stop the import process.
5. Once the import is finished, you can eject the CD by clicking the eject disc button in the lower right of the window.
iTunes preferences

iTunes works the way Apple wants it to by default, but you can make it work the way you want it to by changing its preferences. To access iTunes’s preferences, either press ⌘, or choose iTunes → Preferences from the menu.

iTunes performs a lot of functions, so it stands to reason that it also has a wealth of preferences to tweak those functions. Let’s take a look at each section of the iTunes preferences to see what they hold in store.

General

The General section, shown in Figure 15.11, offers basic options for configuring the iTunes interface.

The options are self-explanatory and don’t bear much delving into beyond this:

- Select the font sizes for the Source Text and Song Text. Source Text modifies the names of items in the Source pane of the iTunes window, and Song Text refers to adjusting the font size of the listed song names.
- Decide which items to show in the Source pane.
- Assign a name to your Shared iTunes folder, which is used for sharing your audio files with others on your network.
- Determine whether iTunes can check for updates to itself automatically.
Podcasts

Podcasts are sort of like radio shows you can download and listen to when you’re ready, not when the radio station wants you to be ready. Podcasts cover a huge range of topics and interests. To check out the podcasts iTunes has to offer, click the Podcasts source in the Source pane. The first time you click the Podcasts source you see this window (Figure 15.12).

FIGURE 15.11
Set basic options in the General section of iTunes’ preferences.

FIGURE 15.12
iTunes wants to know if you want to see its podcast offerings.
Click the Go to Podcast Directory button to see the mountain of podcasts available for subjects spanning the arts, education, comedy, family, religion, politics, sports, technology, and much more.

To modify how your iTunes handles podcasts you subscribe to, open the Podcasts section of the iTunes preferences, shown in Figure 15.13. Tell iTunes how often it should check for new episodes of the podcast, what to do when new episodes are available, and which episodes it should keep in your library.

**FIGURE 15.13**

Let iTunes know what you want it to do with your podcasts.

---

**Playback**

The playback options, shown in Figure 15.14, are used for precisely what they say, adjusting the way iTunes plays back your audio files.

Some of the playback options are self-explanatory, but others may bear a little investigation:

- **Crossfade Playback** causes the currently playing audio file to fade out as it ends and the audio file that's next in line to begin playing by fading in. The time lapse between the fades can be adjusted with the slider.

- **Sound Enhancer** purports to automatically improve the sound of audio files by increasing the treble and bass responses.

- **Sound Check** adjusts the playback volume of all songs so that they are approximately at the same level (see the following sidebar).

- **Smart Shuffle** modifies the way that iTunes selects songs to play when Shuffle is enabled. Use the slider to tell iTunes how often it should play songs that are from the same artist or album.
Musical Mac

Keeping Volume in Check

Musical purists get almost violent arguing this point with me, but I like the Sound Check feature. They point out (rightly so, mind you) that you lose some of the sound quality when you adjust its volume automatically, but if there's any detectable loss it's usually more than acceptable to the average user. The alternative is to be playing a song that's so quiet you have to crank up the volume to ridiculous levels just to hear it, but then right behind that song in the playlist is another that is so outrageously loud you run the risk of frying a few brain cells when it starts. I recommend using Sound Check, but it's entirely your call.

FIGURE 15.14

iTunes' playback options can make your audio and video play your way.
Sharing
If you're like most folks, your mother taught you that it was nice to share with others, and I don't see why your music shouldn't be included in that line of thinking. Thankfully, Apple agrees, as they've provided the means to share your audio files from within iTunes preferences using the Sharing section (Figure 15.15).

Tell iTunes to look for shared libraries from other computers running iTunes (remember, iTunes runs on both Macs and Windows-based PCs), to share all of your music or only some of your playlists, and whether to require those accessing your shared audio to use a password or not. If you just want to be selfish with your tunes, simply don't check the box entitled Share my library on my local network.

Store
Figure 15.16 shows the Store section of iTunes preferences. Here you can determine how to make purchases at the iTunes Store, whether to check for downloads automatically, and if pre-purchased items should download automatically. If you're on a slow network, you might want to check the Load complete preview before playing box to speed things up a bit.
Advanced
The Advanced section has more options than you can throw a stick at (excuse my southern vernacular), and there are three tabs that house these options: General, Importing, and Burning. Let’s take a look at all three individually, shall we?

General
The General tab, illustrated in Figure 15.17, is loaded full of selections.

Here’s a breakdown of some of the General tab’s offerings:

- Click the Change button next to the iTunes Music folder location window to select a different location to store your iTunes Library. Some folks prefer to keep their iTunes Library on a server or removable disk.

- You can let iTunes handle the organization of your audio files by checking the Keep iTunes Music folder organized box, which I highly recommend. Otherwise, it’s up to you to keep everything neat and tidy, and who wants to do that for hundreds, or possibly thousands, of audio files?

- The Visualizer is a really cool representation of your audio files that you can see by pressing 36+T while they are playing. Use the selections at the bottom of the General tab, called Visualizer Size and Display visualizer full screen, to change the Visualizer’s behavior.

- Checking the Keep MiniPlayer on top of all other windows box prevents the iTunes MiniPlayer (Figure 15.18) from being buried under all the other windows you may have open.
Part IV  The Multimedia Mac

FIGURE 15.17
The General tab of the Advanced section in iTunes preferences

![Advanced tab in iTunes preferences]

FIGURE 15.18
To use the iTunes MiniPlayer, click the green (bottom) button in the upper left corner of the iTunes window. Return to the standard window by clicking the same button in the MiniPlayer.

![MiniPlayer in iTunes]

**Importing**
The Importing tab, shown in Figure 15.19, gives you a few different options for bringing audio files from CDs into iTunes.
As is the norm, the functions of most options are easy to glean from their title, but others may need some explanation:

- The On CD Insert popup menu lets you choose to import its audio automatically, simply show the CD, begin playing the audio content on the disk, ask if the disk’s audio can be imported, or automatically import the audio and then eject the disk.

- The Import Using popup menu lets you choose the default file format for audio files that are imported. Leave this at its default (AAC Encoder) unless you understand the other file formats.

- The Setting of High Quality should be sufficient for most audio files. Remember, each file you import takes up hard disk space, and the higher the quality you select, the larger the files will be.
Burning
The Burning tab, shown in Figure 15.20, lets you choose what type of format to use for your disc: audio, MP3, or data, as well as what speed to use when burning the disc.

**FIGURE 15.20**
The Burning tab allows you to adjust CD formats and burning speeds.

**TIP** If you’re getting a lot of errors when trying to burn a disc, change the Preferred Speed setting in the Burning tab to increase the chance of success. Interestingly, though, to increase your success, you should decrease your speed.

Parental
All of us parents get a little frazzled at the thought of giving our youngsters unfettered access to the Internet, and unfortunately there are some items available on iTunes that are best left unseen and unheard by the youngest among us. The Parental tab, shown in Figure 15.21, is a fantastic tool for regulating the content your little ones (and even some of the big ones) can gain admittance to.
Parents can take control of their children’s iTunes experiences with these settings.

Be sure to click the lock at the bottom left of the preferences window to prevent someone (you know who you are, kids) from changing these settings without an administrator user name and password.

Apple TV and Syncing
The Apple TV tab simply lets you see which Apple TVs are available to connect with your iTunes, and the Syncing tab is where you view backups of your iPhone or iPod (more on this later in this chapter).

Playlists and Smart Playlists
I loves me some playlists! Playlists let you create a customized list of your favorite music/audio files. You can make a playlist any way you want. You can create a playlist for your favorite band, certain types of music (jazz, opera, bluegrass, and so on), special events (like creating a playlist for a party or wedding), or any other topic or reason you can come up with. The cool thing is that it’s all up to you! After you’ve created your playlist, you can then share them with other users on your network or burn them to a disc.

There are standard playlists, which I just went over, and then there are Smart Playlists. Smart Playlists can add items to themselves when those items meet pre-defined criteria. For example, you could create a Smart Playlist that included every song made by Prince, and every time that you add one of The Purple One’s songs to your iTunes Library it would automatically be added to the Smart Playlist without you so much as lifting a finger.
Create a standard playlist

Making a standard playlist is simple:

1. Add a new playlist in one of three ways:
   - Click the + button in the lower left of the iTunes Jukebox window.
   - Press ⌘+N.
   - Choose File ➤ New Playlist from the menu.
2. Give the playlist a descriptive name. In my case I created one for up-and-coming jazz vocalist Erin Bode.
3. Locate the songs or audio files you want to add to the new playlist from your iTunes Library.
4. Drag the files to the new playlist, as shown in Figure 15.22, and drop them. To select multiple files that are in sequential order, highlight the first file, hold down the Shift key, and click the last file in the sequence. To highlight files that aren't in sequential order, highlight the first file, and hold down the ⌘ key while clicking each individual file.

**FIGURE 15.22**

Adding songs to a playlist is as simple as dragging and dropping.

---

**TIP**

You can also quickly create a playlist from a selection of songs. Simply select the songs you want to make the playlist from and press ⌘+Shift+N.
Create a Smart Playlist

Smart Playlists are a little bit more involved than standard playlists, but then they do the heavy lifting for you instead of you having to do all the work. To create a Smart Playlist:

1. Press ⌘+Option+N, or choose File ➤ New Smart Playlist, which opens the Smart Playlist window, similar to that shown in Figure 15.23.

![Figure 15.23](image)

Make your Smart Playlist even smarter by adding criteria for it to follow.

2. Decide whether an item has to match all or some of the items in the criteria list using the Match popup menu.
3. Add or remove criteria using the + and – buttons to the right.
4. Check the Live updating box to have iTunes automatically match items to the criteria when said items are added to the library.
5. Click OK to create the Smart Playlist.
6. Be sure to give your new Smart Playlist a descriptive name, and you’re done.

You can edit the criteria for your Smart Playlist, too. Either highlight the Smart Playlist in the Playlists pane and choose File ➤ Edit Smart Playlist, or right-click (Ctrl+click) the Smart Playlist and select Edit Smart Playlist.

Spend a Buck (Or Not) at the iTunes Store

You gotta love the iTunes Store! One thing can be said about the iTunes Store that you can’t say for many other retail outlets: There is something to suit almost every taste. The iTunes Store has thousands and thousands of songs, along with audio books, movies, television shows, podcasts, music videos, games for your iPod, the App Store for your iPhone and iPod touch, and educational audio and video from some of the top universities around.
Don’t be fooled by its name, though. Unlike most other stores, the iTunes Store is chock-full of free items, hence the title of this section. Just because you visit the iTunes Store doesn’t mean you have to drop a dime in it, but when you see the plethora of items offered, you might not be able to help yourself.

**Getting around in the iTunes Store**

When you first click the iTunes Store link in the Source pane, you are zipped to the iTunes Store homepage (Figure 15.24).

**FIGURE 15.24**
The iTunes Store homepage has so many things to check out it’s hard to know where to begin.

Navigating the iTunes Store is much like getting around in a Web browser:

- Click words and pictures to go to another page related to them.
- Click the Home button (it looks like a house) to return to the iTunes Store homepage.
- Use the forward and back buttons to see next and previously viewed pages.
- Search for songs or artists using the Search iTunes Store field in the upper right of the iTunes window.
- Choose an item from the iTunes Store window on the left to go to different areas of the Store.
Creating an iTunes Store account

To purchase items from the iTunes Store, you must have an account (also known as an Apple ID), which is simple to set up:

**TIP** If you already have an Apple ID or an AOL account, you can use it for your iTunes Store account instead of creating a new one.

1. Choose Store ➔ Create Account from the menu.
2. Click Continue in the Welcome to the iTunes Store window, shown in Figure 15.25.

---

**FIGURE 15.25**
The iTunes Store welcome screen, where you go to create an iTunes Store account

---

3. Read and agree to the iTunes Terms and Conditions, and click Continue.
4. Enter your e-mail address, a password for your iTunes Store account, and a question (along with the correct answer) to help iTunes verify your identity (Figure 15.26), and click Continue.
5. Enter the information for the credit card you want to be billed when you make purchases. Click Continue to set up the account.

When you purchase items and aren't signed in to your iTunes Store account, you may be prompted to sign in, as shown in Figure 15.27. Simply enter your account user name and password for your Apple ID or your AOL account.
Part IV  The Multimedia Mac

FIGURE 15.26
Use your e-mail address for your iTunes Store account user name.

FIGURE 15.27
Enter an Apple ID or AOL account user name and password when prompted.

Using iPod and iPhone with iTunes
iTunes is an absolute necessity when using your iPhone or iPod, so it's a good thing you've already learned so much about it. Your iPhone/iPod uses iTunes for all kinds of things:
- Updating your iPhone or iPod's software
- Restoring your iPhone's settings
- Creating ringtones for your iPhone
- Synchronizing media (music, movies, and so on), contacts, calendars, bookmarks, and e-mail account settings
- Backing up your iPhone
- Viewing your iPhone/iPod's information

Some of these functions bear further discussion, so let's continue on in this chapter to check them out.

**Viewing information about your iPhone/iPod**

You can see all the important info about your iPhone or iPod using iTunes. When you connect the iPhone/iPod, it will show up in the Source pane, like mine is in Figure 15.28.

**CAUTION** Keep in mind that items in my screen shots pertain to my personal iPhone 3G, and will certainly vary depending on the device you have (iPhone, iPhone 3G, iPod, iPod touch, and so on). Some items you see in these figures may not be available in yours, and you may have some selections that aren't available to me. Your device came with all manner of documentation that can give you a much better idea of options and features it supports, and how to access them.

**FIGURE 15.28**

All the goods on my iPhone 3G
Part IV  The Multimedia Mac

From the Summary tab I can see the amount of available space on the iPhone, the software version currently installed, and my iPhone’s serial number and phone number, and I can even check for available updates.

Synchronizing libraries and other information
The other tabs that are available give you the ability to synchronize lots of other information. Table 15.2 gives you an overview of what can be done with each tab.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Available Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Info</td>
<td>Contacts, calendars, and mail account settings can be synchronized from this tab. If you have a MobileMe account, it will handle these settings if you allow it to.</td>
</tr>
<tr>
<td>Ringtones</td>
<td>Sync ringtones that you made or purchased from the iTunes Store.</td>
</tr>
<tr>
<td>Music</td>
<td>Synchronize all the music in iTunes with your iPhone/iPod, or only certain playlists. Read your device’s documentation very carefully before syncing anything!</td>
</tr>
<tr>
<td>Photos</td>
<td>Sync photos that are in your iPhoto library or in other folders on your Mac’s hard drive.</td>
</tr>
<tr>
<td>Podcasts</td>
<td>All podcasts that you are subscribed to or have downloaded can be synced with your iPhone/iPod from this tab.</td>
</tr>
<tr>
<td>Video</td>
<td>Any video you’ve downloaded from iTunes, including movies, rented movies, or television shows, can be synchronized from here.</td>
</tr>
<tr>
<td>Applications</td>
<td>Keep the applications you’ve downloaded from the Apps Store synchronized with your iPhone/iPod using this tab. Sync them all at once, or select only individual apps.</td>
</tr>
<tr>
<td>(iPhone/iPod touch)</td>
<td></td>
</tr>
</tbody>
</table>

Viewing other items on your iPhone/iPod
As I mentioned, your iPhone/iPod will show up in the Devices section of your Source pane in iTunes. Click the small triangle to the left of its name to view its contents. To see items in one of the categories, simply select the category in the list, as I’ve done for my ringtones in Figure 15.29.

**TIP** You can drag-and-drop items into the iTunes window for the categories on your iPhone/iPod to manually add them to your device.
Other Music Utilities

iTunes is certainly capable of handling most of your music organization and purchasing needs, but what if you want to make your own music or edit your audio tracks? Continue on, dear reader, to look into those topics.

GarageBand

GarageBand is an awesome application that is only part of the iLife suite of applications available from Apple. GarageBand turns your Mac into a personal recording studio, allowing you to create your own music with incredible ease. You can actually create your own onstage band, and even play an instrument in the band, all from your quaint keyboard and mouse. Of course, GarageBand can utilize real instruments as well! For the complete skinny on GarageBand, visit www.apple.com/ilife/garageband/.
Audacity

Audacity, shown in Figure 15.30, is a free open source application for editing and recording sounds on your Mac (there are also versions for Windows-based PCs and Linux).

![Figure 15.30](Image)

Audacity is a very versatile app, and the price is definitely right.

You can do much more with Audacity than I can list here, but I give you a good overview of its features:

- Record live audio from a host of different devices.
- Natively import and export WAV, AIFF, AU, and Ogg Vorbis audio files. You can also import and export MP3s with third-party plug-ins (which are free, too).
- Edit audio files by the tried-and-true methods of cutting, copying, pasting, and deleting.
- Mix an unlimited number of tracks.
- Remove background noises, such as hiss and static, from audio files.

For more information and to download Audacity, go to [http://audacity.sourceforge.net/](http://audacity.sourceforge.net/).

Songbird

For those of you who like to live on the edge and experiment with new things, Songbird may be right up your alley. Songbird, shown in Figure 15.31, is an open-source customizable music player (their words) that is still in beta, which means it’s not quite ready for prime time, but it’s functional.
The Songbird team has some very lofty goals for their application, and they appear well on their way. One of its neatest features is the ability to customize through the use of plug-ins, much like the Firefox Web browser.

To give Songbird a go (it's a free application, so why not?), download it from http://getsongbird.com/.

**FIGURE 15.31**

Songbird is an up-and-coming music player that aims to be more than just an iTunes replacement.

Note: For lots more information on iTunes, use the iTunes help feature (choose Help: iTunes Help from the menu) or go to the iTunes portion of Apple's Web site (www.apple.com/itunes/overview/). Be sure to check out the tutorials and tips on that site, too!

**Summary**

In this chapter you learned how to organize and play your music with iTunes. You saw how to set iTunes' preferences, view your music with the Visualizer, and apply parental controls to the music and movies your children listen to or view. We also took a look at some of the popular third-party applications that are available, such as Songbird and Audacity. Have fun with your musical Mac!
Part V

The Surfing Mac

IN THIS PART

Chapter 16
Staying Connected Through E-Mail

Chapter 17
Cruising the Internet with Web Browsers

Chapter 18
Chatting Across the Miles
E-mail is almost as common these days as a mailbox in front of a home. People all over the world send messages to one another in the blink of an eye. We're so close to living in the age of the Jetsons that I can almost hear Astro barking a "Ruh-roh!" in the background! Part of the promise of the computer age was that communication would be almost instant, and I would certainly say that we have arrived with the advent of e-mail.

E-mail has come a very long way from its earlier days, though. When you combine e-mail with a fast Internet connection, you have the ability to quickly send pictures and even video without causing your Mac to so much as break a sweat. And of course, when it comes to doing e-mail the right way, no one can touch Apple. The Mail application that ships with Leopard is a top-notch e-mail utility that is so easy to set up and use that you can't mistake Apple's signature on it. Let's get started with learning how to use Mail, and even some alternative e-mail applications, to keep you in touch with family, friends, and co-workers.

You've Got Mail

Mail has been the e-mail application of choice since the first release of Mac OS X way back when. Mail has matured by leaps and bounds with each subsequent version, and version 3, which ships with Leopard, is a very big step forward from its previous incarnations. Some of the new features in Mail 3 include:
The Surfing Mac

- Creating notes so that you don’t forget that fantastic idea you just had.
- Using Stationery to create awesome e-mails using graphics and images. You can customize the way items in the e-mail are placed in the layout using templates.
- Getting the latest news while checking your e-mail using RSS feeds.
- Easily backing up mailboxes with the Archive feature.
- Organizing your life with to-do lists.

Get Rolling with Your First Account

It’s time to fire up Mail and begin sending and receiving messages from folks near and dear to you (and everybody else you have to communicate with, too). Start by opening Mail:

1. Press ⌘+A from within the Finder to automatically open a window to the Applications folder.
2. Double-click the Mail icon, which looks like a postage stamp, to open Mail.

When you open Mail for the first time, Apple greets you with the warm welcome shown in Figure 16.1.

Basic Info You Will Need to Set Up Your E-Mail Account

You must have an e-mail account with an ISP (Internet Service Provider), a corporate e-mail account, or an e-mail account with a Web-based e-mail provider, such as Google or Yahoo!, to set up an account in Mail. The provider of your e-mail address will also know the answers to some of the information that may be necessary to complete your Mail account’s setup, such as:

- Your mail server’s account type
- A user name and password for your e-mail account
- The incoming mail server’s hostname, port number, authentication method, and whether the server supports SSL (Secure Sockets Layer)
- The outgoing server’s hostname, port number, authentication method, whether it requires a user name and password, and if it supports SSL.
I know I told you to gather all the basic information for your e-mail account from your ISP (see the previous sidebar), but Apple has endowed Mail with superpowers that may render that information unnecessary. Mail has the ability to automatically gather the necessary setting information for many of the more popular ISPs and e-mail providers. Here's how:

1. Simply enter your e-mail address and the password for your e-mail account in the appropriate fields.
2. Check the Automatically set up account box in the welcome window, as shown in Figure 16.2.
3. Click Create to have Mail query your ISP or e-mail provider's servers for all the settings it needs to successfully set up your account.
4. Your e-mail account is set up and ready to go.
Mail tries to make things as easy as possible, especially during the initial account setup process.

If you don't have any luck with the automatic setup, don't worry; I'm happy to walk you through a manual installation using all the info I had you wrest from your e-mail provider earlier:

1. Enter your e-mail address and the password for your e-mail account in the appropriate fields.
2. Uncheck the Automatically set up account box in the welcome window and click Create.
3. Type in the appropriate information for the account type, incoming mail server address, your e-mail account's user name and password, and give the account a description such as Work or Home (I entered Comcast in Figure 16.3). Click Continue.
4. Enter the outgoing mail server info, such as the outgoing mail server address, and enter your user name and password if the server requires authentication (your ISP or e-mail provider has that info if you don't already know), as shown in Figure 16.4. Click Continue.
5. Look over the information in the Account Summary window (Figure 16.5) to make sure it's accurate, check the Take account online box, and then click Create.
FIGURE 16.3
Entering the incoming mail server information

FIGURE 16.4
Typing in the outgoing mail server information
TIP Checking the Use only this server box makes all of your outgoing e-mail pass through the same SMTP server, regardless of how many accounts you have on your Mac, even if they are from different providers.

Get to know Mail’s interface
Once you’ve created you first account, Mail will open to its standard Message Viewer window. Figure 16.6 points out all the exotic locales you need to know, and Table 16.1 gives you a brief report on each.

<table>
<thead>
<tr>
<th>Item</th>
<th>Functionality</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retrieve new mail</td>
<td>Click to have Mail query the e-mail server for any new messages you may have been sent.</td>
</tr>
<tr>
<td>Delete mail</td>
<td>Highlight an e-mail you no longer need and click the Delete button to send it to the Trash.</td>
</tr>
<tr>
<td>Set as junk mail</td>
<td>Highlight an e-mail you consider to be junk, and click the Junk button to move it to your Junk folder.</td>
</tr>
<tr>
<td>Reply options</td>
<td>Click Reply, Reply All, or Forward to respond to your e-mail pals or to send the message to someone else.</td>
</tr>
<tr>
<td>Mailbox pane</td>
<td>List all the mailboxes you have created.</td>
</tr>
</tbody>
</table>
### Item | Functionality
--- | ---
Create new mailbox | Click to create a new mailbox in the mailbox pane.
Mail activity button | Show or hide the mail activity window.
Make a new message | Click this button to open a new message window.
Create a note | Click to jot down a note to yourself or others.
Create a to-do item | Add an item to your to-do list (as if you didn’t have enough to do, right?).
Search mailboxes | Quickly search your mailboxes for any text you enter into the Search field.
Mail list | Display a list of all e-mails in the mailbox you’ve highlighted in the mailbox pane.
Viewing pane | Choose an e-mail in the mail list to display it in the viewing pane.
Action button | Click to perform a number of actions on the mailbox or e-mail you have selected.

**FIGURE 16.6**
Learn where everything is in Mail.

![Mail Interface Diagram]

- **Mailbox pane**
- **Viewing pane**
- **Mail list**
- **Action button**
- **Mail activity button**
- **Create new mailbox**
- **Set as junk mail**
- **Create a note**
- **Retrieve new mail**
- **Delete mail**
- **Make a new message**
- **Reply options**
- **Create a to-do item**
- **Search mailboxes**
Modify Mail’s toolbar

Like all the best applications, Mail allows you to customize to your heart’s content. The toolbar is one of the most frequently used aspects of Mail, and Apple makes it easy to add or remove items from it through simple dragging-and-dropping (Figure 16.7).

Choose View → Customize Toolbar to open a sheet displaying all the available tools that can be added to Mail’s toolbar. Simply drag the item you want to the location you want it to reside in the toolbar, then drop it in. To remove an item, simply drag it from the toolbar and drop it. To reinstitute the default toolbar, drag-and-drop the default icons from the bottom of the sheet into the toolbar.

![FIGURE 16.7](image)

Drag any of these items to the toolbar and drop them right in.

A look at Mail’s preferences

To get the most out of Mail you must know how to adjust its wheels and cogs to make it run the way you would expect it to. Mail’s preferences are loaded with options to let you tweak it to your needs. Open Mail’s preferences by pressing @cmd+, (comma) or by choosing Mail → Preferences from the menu.

General

The General section, shown in Figure 16.8, lets you set the behavior of some of the basic functions in Mail. Table 16.2 explains the functions in a bit more detail.
FIGURE 16.8
The General section of Mail’s preferences

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default e-mail reader</td>
<td>If you have multiple e-mail client applications installed, you can use this popup menu to select one as your Mac’s default.</td>
</tr>
<tr>
<td>Check for new mail</td>
<td>Decide how often to have Mail query the e-mail server for new messages.</td>
</tr>
<tr>
<td>New mail sound</td>
<td>Select a sound to alert you when new mail arrives.</td>
</tr>
<tr>
<td>Dock unread count</td>
<td>The Mail icon in the Dock displays the number of unread e-mails. Use this option to determine whether it shows unread messages for a particular mailbox, for all of them, or not at all.</td>
</tr>
<tr>
<td>Add invitations to iCal</td>
<td>Set this option to Automatically if you want Mail to put invitations you may receive through e-mail into iCal without your input.</td>
</tr>
<tr>
<td>Downloads folder</td>
<td>Select a default folder for all attachments to be saved to.</td>
</tr>
<tr>
<td>Remove unedited downloads</td>
<td>Tell Mail when or if it should delete attachments that have been downloaded but not edited or saved.</td>
</tr>
</tbody>
</table>

(continued)
TABLE 16.2  (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>If outgoing server is unavailable</td>
<td>Let Mail know what it should do if your default outgoing mail server is unavailable.</td>
</tr>
<tr>
<td>When searching all mailboxes, include results from</td>
<td>Allow Mail to search for messages in the Trash and Junk mailboxes, as well as all the others.</td>
</tr>
<tr>
<td>MobileMe button</td>
<td>Set up e-mail synchronization with your MobileMe account.</td>
</tr>
</tbody>
</table>

**Accounts**

Accounts is where you go to configure accounts you’ve already created, and where you can add or delete accounts. Figure 16.9 shows the Account Information tab in the Accounts section of the Mail preferences, Figure 16.10 illustrates the Mailbox Behaviors tab, and Figure 16.11 is a typical Advanced tab. Table 16.3 details the information seen in each of the three tabs; available options will differ depending on the account type (POP, IMAP, or Exchange).

**FIGURE 16.9**

Basic account information goes here.
Tell mailboxes how to behave using this tab.

Some of the options in this list may require a helping hand from your IT department or ISP.
### TABLE 16.3

<table>
<thead>
<tr>
<th>Tab</th>
<th>Option(s)</th>
<th>Function(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Information</td>
<td>Description, Email Address, Full Name</td>
<td>Add the basic information for your e-mail account, such as the account’s e-mail address and your name.</td>
</tr>
<tr>
<td>Account Information</td>
<td>Incoming Mail Server, User Name, Password</td>
<td>Enter the address of your ISP’s mail server, as well as the user name and password required to log in to it.</td>
</tr>
<tr>
<td>Account Information</td>
<td>Outgoing Mail Server (SMTP)</td>
<td>Type in the address of your ISP’s SMTP server.</td>
</tr>
<tr>
<td>Account Information</td>
<td>Outlook Web Access Server (only available for Exchange accounts)</td>
<td>Your IT administrator will be able to help you with the address name that you need to enter here, assuming you are using an Exchange account.</td>
</tr>
<tr>
<td>Mailbox Behaviors</td>
<td>Drafts (available for IMAP and Exchange accounts only)</td>
<td>Allows you to save drafts of messages on your ISP’s server.</td>
</tr>
<tr>
<td>Mailbox Behaviors</td>
<td>Notes</td>
<td>Lets you store notes in your Inbox or on your ISP’s server.</td>
</tr>
<tr>
<td>Mailbox Behaviors</td>
<td>Sent</td>
<td>Choose whether to store the messages you send to others on your ISP’s server.</td>
</tr>
<tr>
<td>Mailbox Behaviors</td>
<td>Junk</td>
<td>Select from several junk mail options, such as keeping junk messages on your ISP’s server. The options available depend on the type of account you have.</td>
</tr>
<tr>
<td>Mailbox Behaviors</td>
<td>Trash</td>
<td>Choose where to store and when to permanently remove deleted messages.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Enable this account</td>
<td>Check this box to have Mail use the account for sending and receiving e-mail.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Include when automatically checking for new mail</td>
<td>Choose this option to have Mail automatically check the account for new e-mail.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Remove copy from server after retrieving a message (POP accounts only)</td>
<td>Choose this option to delete the original message from the server after you download it to your computer. I don’t recommend using this option because of the possibility of losing an important e-mail forever if something goes wrong with Mail.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Prompt me to skip messages over ____</td>
<td>Specify a maximum size for messages you want to be automatically downloaded from the server.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Compact mailboxes automatically (IMAP and Exchange accounts only)</td>
<td>Decide whether to compact deleted messages or keep them until you manually remove them.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Keep copies of messages for offline viewing (only for IMAP accounts)</td>
<td>Allows you to store complete messages on your computer so you can view them without an Internet connection.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Advanced options</td>
<td>Check with your network administrator before you make any changes to the default settings in the lower portion of the Advanced tab.</td>
</tr>
</tbody>
</table>
RSS
Mail can double as an RSS feed reader. RSS stands for Really Simple Syndication, and is a way that some Web sites let subscribers to their RSS feeds know when there is updated information available. The RSS section (Figure 16.12) allows you to set Mac OS X's default RSS reader (set to Mail if you want to use Mail, or choose another application if you like), how often the RSS reader should check feeds for updates, and when to remove articles. See Chapter 17 for much more on RSS.

FIGURE 16.12
Modify Leopard's RSS capabilities in Mail's preferences.

Junk Mail
Mail has the uncanny ability to determine which e-mails you receive are junk and which are legit. You can choose whether to turn on junk mail filtering from the Junk Mail section of the Mail preferences (Figure 16.13).

FIGURE 16.13
Your e-mail mailboxes can get stuffed with junk, just like your home's mailbox.
You also need to tell Mail what to do with any e-mails it classifies as junk. The When junk mail arrives options let Mail know whether to simply mark the e-mail as junk but leave it in your Inbox, or to move it to the Junk mailbox. Click the Perform custom actions option and then click the Advanced button at the bottom of the window to customize how Mail should treat these vagabond messages, illustrated in Figure 16.14.

**FIGURE 16.14**
Set up rules for filtering your junk mail from your legitimate e-mails.

![Figure 16.14](image)

Remember, your Mac is only a computer and can’t know everything; it needs to be taught, too. The e-mail you received from the Vanilla Ice fan club may very well be junk, but one telling you that you’ve won a million dollars may not be (nah, it’s probably junk, too, but you get the point). Check your junk mail often just in case Mail accidentally classifies something really important as unworthy of your attention.

**Fonts & Colors**
The Fonts & Colors section, shown in Figure 16.15, lets you pick the default fonts to use in Mail and decide which colors to use for previous messages in a thread.

**Viewing**
These self-explanatory options in the Viewing section (Figure 16.16) allow you to modify what you see, and how you see them, in Mail.

The two most useful options, in my opinion, are Display unread messages with bold font, which helps to easily delineate them from those you’ve read, and Highlight related messages using color, which makes it easy to find messages in your Inbox that deal with the same subject.
Modify the way text looks in Mail.

The Viewing section of Mail's preferences

Composing
The options in the Composing section, shown in Figure 16.17, determine how Mail acts when you are writing a new message or replying to another.
There are three main parts to the Composing section:

- **Composing.** Select either plain or rich text for your e-mails, when to check spelling (if at all, you genius, you), and whether to copy yourself on your own messages.

- **Addressing.** Set up an LDAP server to automatically get addresses for co-workers from your company's servers, and determine what accounts to use when sending new mail and when creating Notes and To Do's.

- **Responding.** Decide if you will reply to others using the same format as they did (which is usually the best idea), whether to quote their messages in your reply, and what text to quote from their messages.

**Signatures**

Signatures are sort of like a calling card, and can be used for simply identifying yourself to your recipient. Of course, you can put anything you like in your signature, being as formal or as silly as you want to be. The Signatures section (Figure 16.18) is where you go to create signatures for each account.

To create a signature, highlight the account the signature is going to be used for, click the + button under the signature column, and then edit your signature in the editing column.
Create signatures for each e-mail account, if you like.

Rules

All of us need a few rules to help maintain the natural order of things, and our Mail application is no exception. The rules you create in the Rules section, shown in Figure 16.19, are used to filter e-mails. For instance, if you are part of a club that sends newsletters every month, you can tell Mail to move those messages to a mailbox you've created specifically for that club.

Click the Add Rule button to create new rules as you need them. Figure 16.20 shows options available for creating new rules.

Add rules to help Mail sort your e-mail to your specifications.
Sending E-Mail

It's time to get down to business with using e-mail, and we're going to get started in the best place to begin: at the beginning! To kick off your first e-mail, simply click the New Message button in the upper left of the Mail window, and you will be rewarded with a New Message window, like the one shown in Figure 16.21.

Here are four simple steps to getting your first e-mail out the door:

1. Type your recipient's e-mail address in the To field.
2. Enter the topic of your e-mail in the Subject field.
3. Type the contents of your e-mail in the main body of the window.
4. Click the Send button in the upper left corner of the window, and then listen for the swoosh sound that Mail makes once the message has been sent.

**TIP**

Want to save your message and send it later? Just click the Save As Draft button in the message window's toolbar and the message will wait in the Drafts mailbox for you to get back to it.

Format your message

If you're content with sending e-mails to your compatriots using the same old boring fonts and tired colors, be my guest. But if you want to spice things up a bit, Mail has the tools you need. To change the fonts used in your e-mail, simply click the Fonts button in the toolbar of your message window to open the Fonts window shown in Figure 16.22.
My new message is ready to roll.

How you doin', PG? You're looking good sitting on the shelf above me.

-MB

Select the perfect font for your new message.
Once you’ve got the perfect font, you need to add a splash of color to make the text stand out. Highlight the text you want to change, and then click the Colors button in the message window's toolbar to open the Colors palette (Figure 16.23).

**FIGURE 16.23**
Use the color options to create your own unique colors for your messages.

Letting other files tag along

Sometimes you may want to send your friends and family an attachment, such as a photo or document, in your e-mail. This is akin to placing a photo in an envelope when using regular mail. To add an attachment to a message:

1. Click the Attach button in the toolbar (it looks like a paper clip).
2. Browse your Mac for the item you want to attach, highlight it, and then click the Choose File button (Figure 16.24). If you are sending the e-mail to your less-fortunate friends who are still using Windows computers, be sure to check the box labeled Send Windows-Friendly Attachments.

Customize your messages with Stationery

Stationery is one of the coolest additions to Mail, as of version 3.0. Use it to transform your e-mail into a work of art.

Click the Show Stationery button in the upper right corner of a message window to see the Stationery toolbar, as illustrated in Figure 16.25.
Sending an attachment is a snap.

Stationery makes an ordinary e-mail something truly special.

Choose the right stationery template for your e-mail from the list of options on the left side of the Stationery toolbar, and then edit the text in the stationery template to your needs. Some templates have placeholder images; you can add your own images by dragging-and-dropping them onto the placeholders.
Receiving and Replying to E-Mail

It stands to reason that if you send e-mail to folks, you probably will receive some as well. When e-mails show up in your Inbox, simply click them to read their contents, as shown in Figure 16.26.

It should also stand to reason, then, that you might want to reply to the person you're engaging in conversation with. To do so, simply click the Reply button in the toolbar.

**TIP**  
Click the Reply All button to send a response to everyone copied on the original e-mail, and click Forward to send the message to a different recipient entirely.

Saving attachments

You know how to send attachments, so now it's time to see how to save those attachments that someone sends to you. It's simple:

1. Highlight the e-mail containing the attachment you want to save.
2. Note the attachment under the To field in Figure 16.27.
If the e-mail you are viewing contains an attachment, you will find the attachment under the To field.

3. Click the Save button next to the attachment.
4. Select either Save All or select an individual attachment from the list if there are multiples. All attachments are saved in your Downloads folder, which you can access from your Dock (unless you’ve removed it, of course).

**Add people to your Address Book**

You can add folks to your Address Book just as easily as you can save attachments:

1. Select an e-mail in your Inbox that is from the person you want to add to the Address Book.
2. Hold your mouse over the person’s e-mail address in the From field to highlight it and reveal the white arrow to its right.
3. Click the white arrow and select Add to Address Book from the list, as shown in Figure 16.28.
Alternative E-Mail Clients

While Mail is quite the adequate application for most e-mail needs, it may not have some of the tools offered by other e-mail applications, or simply may not suit your tastes (it's okay to admit it; I promise I won't tell Apple). Some e-mail applications may provide more, or better, functionality than Mail. For example, while Mail will handle Exchange server accounts, it will only do so if Outlook Web Access is enabled for the Exchange server (this may change in future versions of Mail, but it's the fact of the matter with version 3.0). To get around such a situation, you could use Microsoft's own e-mail application, Entourage. Let's take a look at a couple of the most popular e-mail alternatives for Mac OS X; having used both extensively, I can vouch for their worthiness to at least be given a test drive.

Thunderbird

Admittedly, Thunderbird sounds much more like an automobile than an e-mail client, but in spite of its name it is quite capable of doing the job. Thunderbird is developed by Mozilla, the makers of the very popular Web browser, Firefox (discussed in Chapter 17). An advantage Thunderbird has over Mail is that there are versions for Mac, Windows, and Linux, so you can install it on all the operating systems you may have and not have to learn a new e-mail client for each. Another advantage Thunderbird has over Microsoft Entourage, which I discuss next, is that it's free.
How to get and install Thunderbird
You can download Thunderbird from Mozilla's site at www.mozilla.com/en-US/thunderbird/. The disk image file containing Thunderbird will automatically begin downloading and, if you are using Safari, will automatically mount. Drag the Thunderbird icon to your Applications folder and drop it in to complete the installation. (Note to former Windows users: Be sure not to get drool in your keyboards after staring, mouth agape, at how simple application installment can be on a Mac.)

Set up your account
As with Mail, you will need to set up an account to get started with Thunderbird:

1. Open your Applications folder and double-click the Thunderbird icon to launch it for the first time. You will be immediately prompted to create a new account, as shown in Figure 16.29.

2. Choose Email account and click Continue.
3. Create a name for your identity and enter your e-mail address, and then click Continue (Figure 16.30).
4. Select the type of server your e-mail account uses (POP or IMAP), enter the names of your incoming and outgoing servers in the fields provided (Figure 16.31), and click Continue.
5. Provide your incoming and outgoing user names in the appropriate fields (Figure 16.32) and click Continue again.
Create an identity for your account.

Identity
Each account has an identity, which is the information that identifies you to others when they receive your messages.

Enter the name you would like to appear in the "From" field of your outgoing messages (for example, "John Smith").

Your Name: Mac Billie

Enter your email address. This is the address others will use to send email to you (for example, "user@example.net").

Email Address: macbillie@comcast.net

Your ISP can provide you with incoming and outgoing server addresses.

Server Information
Select the type of incoming server you are using.

POP IMAP

Enter the name of your incoming server (for example, "mail.example.net").

Incoming Server: mail.comcast.net

Uncheck this checkbox to store mail for this account in its own directory. That will make this account appear as a top-level account. Otherwise, it will be part of the Local Folders Global Inbox account.

Use Global Inbox (store mail in Local Folders)

Enter the name of your outgoing server (SMTP) (for example, "smtp.example.net").

Outgoing Server: smtp.comcast.net

6. Assign your account an appropriately descriptive name, such as Work or Dwight's Personal E-mail, and then click Continue.

7. Verify that all the information is correct in the resulting Congratulations! window and click Done.
Enter your user name for each server (they are usually the same).

Account setup is now complete (that wasn't too bad, was it?) and Thunderbird’s main window is staring you in the face waiting for you to take action, as shown in Figure 16.33.
POP Account Users: Don't Lose Your E-Mails!

At this point you may be tempted to click the Get Mail button, but hold off just a second. If you are using a POP account, Thunderbird's default settings will cause it to download all messages from your server and remove them from the server. I highly recommend you don't do this because if something goes wrong with your Mac you will not be able to retrieve all those lost e-mails (unless you are properly backing up your Mac, which I discuss in detail in Chapter 22). Leaving those e-mails on the server will prevent this type of accident from occurring. To make sure Thunderbird doesn't remove all e-mail from your POP server:

1. Choose Tools ➔ Account Settings from the menu.
2. Highlight the Server Settings option under your account name.
3. Check the Leave messages on server box under the Server Settings section, as illustrated here.

To retrieve mail for the first time, click the Get Mail button in the upper left corner of the window. You will be prompted to enter the password provided by your ISP for your e-mail account; do so and click OK.

**Caution** Do not check the Use Password Manager to remember this password box (it displays when prompted for the user name and password) if you're a stickler for security. Otherwise, every person who uses your Mac from this point on will be able to access and compose e-mails using your account.
Staying Connected Through E-Mail

Composing e-mail is just as easy. Simply click the Write icon in the upper left of the toolbar and start e-mailing.

Extensions

Another really cool aspect of Thunderbird is the ability to broaden its functionality with extensions. Extensions allow you to add features in a modular fashion, installing only what you want. This prevents Thunderbird from being a grotesquely bloated application if loads of options were included in it that most users wouldn't need or want to begin with.

See what extensions are available for Thunderbird by one of these two methods:

- Choose Tools—Add-ons from the menu, select Extensions in the upper left of the Add-ons window, and click the Get Extensions link in the lower right.

Instructions for installing extensions may vary and can be found on each particular extension's site. As an example of the kind of functionality extensions can provide, I installed the Lightning extension to give me a built-in calendar, as shown in Figure 16.34.

FIGURE 16.34
I love Thunderbird’s Lightning extension, which gives me a calendar right there in my e-mail client, as opposed to having to open a different application entirely.
Entourage

Microsoft's entry into the Mac OS X e-mail client battles is the venerable Entourage. Entourage is a really good e-mail client that I recommend if you have an Exchange server that hosts your e-mail account. I'd be happy to recommend Mail for this, but to repeat from earlier in this chapter, you must have Outlook Web Access enabled on your Exchange server to use it. Not so with Entourage, which may make your company's IT director a little happier. Entourage is a full-fledged e-mail client, and it can adeptly handle just about anything you can throw at it. As of this writing, Entourage 2008 is the latest version, but you can only get it by purchasing the Office 2008 for Mac suite of applications from Microsoft.

Create an account

Follow Microsoft's instructions for installing the Office apps, and launch Entourage by going to the location on your hard drive you installed it to and double-clicking its icon. Now let's set up an account for you:

1. In the Welcome screen, click the Start using Entourage without importing anything button (Figure 16.35), and then click the right arrow in the lower right corner of the window.

![FIGURE 16.35](image)
The first step upon launching Entourage

2. Like Mail, Entourage will attempt to automatically configure your account settings based on your e-mail address, as shown in Figure 16.36. If you are using an Exchange server, check the My account is on an Exchange server box. Click the right arrow in the lower right corner to continue.

3. You will be notified whether the account was successfully configured automatically. Either way, click the right arrow in the lower right corner to move on.
4. Double-check the configuration settings that Entourage entered automatically, or enter the information manually, and then click the right arrow to continue.

5. Click the Verify My Settings button, shown in Figure 16.37, to have Entourage check the incoming and outgoing servers to make sure all the settings and passwords are correct.

6. Give your account a descriptive name and click Finish to complete the account setup. You will be whisked away to Entourage’s main window.

![FIGURE 16.36](image)

Setting up an account automatically in Entourage

![FIGURE 16.37](image)

Entourage checks your settings with the server to make sure everything is functioning correctly.

7. Click the New button in the toolbar to launch the new message window, type something really witty as shown in Figure 16.38, and then send the message along!
Your first message from Entourage is ready to be sent.

Utilize My Day
My Day is a utility that is part of Entourage. It helps you stay on top of your tasks and to-do lists that are in Entourage, without Entourage even running. My Day acts like a widget that displays Entourage info. To open My Day, shown in Figure 16.39, click its icon in Entourage's toolbar.
Staying Connected Through E-Mail

The bottom of the My Day window provides a toolbar for extra functionality. Click the check and + button in the left side of the toolbar to create a new task, the printer icon on the right side to print out the day's activities, and the preferences button on the far right to modify how My Day works with Entourage and Mac OS X.

Summary

By this point you should have the nuances of e-mail pretty well down pat. We've covered most of what there is to know about Mail, and have even dipped our toes in the waters of two of the most popular third-party e-mail clients in the world of Mac. Start sending those e-mails about your cool grandkids to all your friends whose offspring's offspring aren't quite as awesome as yours. Go ahead, start rubbing it in (and don't forget to attach pictures)!
The world has experienced great leaps in communication technology that have radically changed how we exchange information with one another. From beating on drums to messengers on horseback, from the telegraph to the telephone, getting in touch with one another has become much faster and more reliable with each major advancement.

No other technology has been as responsible for bringing the world so much closer to each of us than the Internet. The tool we all use to access the Internet is called a Web browser, and there is no shortage of them available for Mac OS X. Leopard comes with one of the industry's best browsers, Safari, but there are other very popular options, such as Firefox, that are out there for you to download. In this chapter we get to know the ins and outs of surfing the Web with a Mac and how to handle compressed files that you may download.

**Internet Technologies Built Right into Your Mac**

Mac OS X comes loaded with many of the technologies used by Web pages that provide functionality and pizzazz to their subjects. Back in the not-so-good days of the Internet, you would have to download third-party plug-ins to view much of the multimedia contents of some of the Web's fancier pages. As the Internet advanced, so did operating systems, in particular Mac OS X. Today, Leopard has most of the tools you will need already nestled within its System folder. Some of the major tools used are Java, QuickTime, and PDF.
Java

Java is a programming language that is platform-independent, meaning you can run any application created with Java on any computer running a Java Virtual Machine (JVM), regardless of the computer's operating system. You can create a Java application on Linux and then send it to your Windows and Mac buddies for them to use on their computers (this concept is also known as "write once, run everywhere"). Java was developed by Sun Microsystems, and they provide JVMs for every major computing platform. Many corporations use Java to deliver Web-based utilities and software to their employees so they can all use the same applications regardless what OS is on their computer. Many Web sites use Java tools as well.

Mac OS X is the first and only major operating system that includes Java right out of the box. All the tools you need to run Java applications and Web utilities are built right into Leopard, making it one flexible cat. As of this writing, the most recent version of Java in Mac OS X Leopard is j2SE 1.5.

QuickTime

QuickTime is Apple's very own multimedia software architecture that makes much of the Internet's media, such as movies and music files, work flawlessly on your Mac. QuickTime enables you to use your Web browser to watch movie trailers at www.apple.com/trailers, listen to sound files that are in several formats, display some images on Web sites, watch instructional videos and streaming video and audio from online educational sites, and the like.

Since QuickTime supports most standards for audio and video, the chances are good it will play or open most of your media files. Here are some of the major file formats supported by QuickTime:

- MPEG-4
- MPEG-2
- MPEG-1
- AVI
- H.264
- H.263
- TIFF
- MIDI
- SMIL
- XML
- JPEG2000
- JPEG
- AAC
Purchasing QuickTime Pro allows you to save movies you view in some Web pages, and also export video and audio in all of QuickTime’s supported formats. You can purchase QuickTime Pro from Apple’s Web site at www.apple.com/quicktime/pro/.

**PDF**

PDF stands for Portable Document Format. Adobe gets the credit for coming up with this great technology that changed the way we exchange documents across the office and the Internet. PDF files are the main standard by which most companies and Web sites distribute information internally and to the rest of the world because of their platform independence and their relatively small file sizes. For example, when you download tax forms from the IRS, they are in PDF format.

Apple uses PDF technology (which it refers to as Quartz) to do much more than just view documents, though. Because this PDF technology is built right into Mac OS X, unlike any other operating system around, you can open, and even create, PDF files without having to use a third-party application.

**Safari**

Safari is Mac OS X’s default Web browser. Safari has been a part of Mac OS X since the beginning, and has become one of the premier browsers on both Mac and Windows platforms. You can open Safari by clicking its icon (Figure 17.1) in the Dock, or press ⌘+Shift+A in the Finder to open a Finder window to the Applications folder, then locate and double-click the Safari icon.

**FIGURE 17.1**

The distinctive Safari icon

**Getting from point A to point B**

Figure 17.2 shows you the typical Safari window, and Table 17.1 gives an explanation of the landmarks you need to associate yourself with.
Part V  The Surfing Mac

FIGURE 17.2
Find your way around a Safari window.

- Bookmarks button
- Show previous/next page
- Refresh page
- Open part of page in Dashboard

Add bookmark  Address field  Google search  Toolbars

- Bookmarks bar

Mac OS X Leopard

Add a new Mac to your Mac.

With 300+ new features, Leopard is the most impressive Mac OS X version yet. Switch to another window.

Page viewer  Status bar

TABLE 17.1  Safari Landmarks

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toolbar</td>
<td>Contains buttons that allow quick access to features. You can customize the toolbar to add or remove buttons as you like. To customize, choose View → Customize Toolbar.</td>
</tr>
<tr>
<td>Show previous/next page</td>
<td>If you've viewed multiple pages from within this window, you can click these buttons to instantly jump from one page to another.</td>
</tr>
</tbody>
</table>
## Cruising the Internet with Web Browsers

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh page</td>
<td>Click this button to reload the page you are currently viewing. Sometimes items on a Web page may not load correctly or may not update as you might expect, so clicking this button causes Safari to open the page from scratch.</td>
</tr>
<tr>
<td>Open part of page in Dashboard</td>
<td>Use this tool to select part of a Web page that you want to open in Dashboard, in effect creating a new Dashboard widget.</td>
</tr>
<tr>
<td>Add bookmark</td>
<td>When you find a page that you like well enough that you decide you want to visit it often, click this button to create a bookmark for that page, making it easily accessible.</td>
</tr>
<tr>
<td>Address field</td>
<td>Type the addresses for Web pages you would like to visit and press the Return key.</td>
</tr>
<tr>
<td>Bookmarks bar</td>
<td>Access your most frequently visited pages here.</td>
</tr>
<tr>
<td>Bookmarks button</td>
<td>Click to open the Bookmarks window for easy organization.</td>
</tr>
<tr>
<td>Google search</td>
<td>You can instantly search Google by typing your search terms into this window and pressing the Return key.</td>
</tr>
<tr>
<td>Page viewer</td>
<td>Your window to the Internet. Web pages that you visit are displayed here.</td>
</tr>
<tr>
<td>Status bar</td>
<td>Displays the status of the last action you performed. For example, when you open a Web page, the status bar shows how many items are loading, or if you hold your mouse over the link to a Web site, the status bar shows you the address connected to the link.</td>
</tr>
</tbody>
</table>

### Set Safari's preferences

Like most other applications, Safari has its own preferences that let you make Safari work the way you want it to. To open Safari's preferences, press ⌘, (comma) or choose Safari → Preferences from the menu.

### General

The General tab, shown in Figure 17.3, lets you select your Mac's browser of choice using the Default web browser popup menu. You can also choose how new windows open, what site to use as Safari's default homepage, and how often to delete items from Safari's history. Use the Save downloaded files to popup menu to select where files that you download from the Internet are saved, use the Remove download list items popup menu to clear old items from the list, and check the Open “safe” files after downloading box to do just that.

### Appearance

This tab, shown in Figure 17.4, allows you to select Safari's default fonts and to decide whether to load images contained in Web pages when you visit them. The Default Encoding popup menu shouldn't be changed unless the text on Web pages does not appear correctly.
Part V  The Surfing Mac

**FIGURE 17.3**
The General tab of Safari's preferences

![General tab of Safari's preferences](image)

**FIGURE 17.4**
Choose how Web pages appear by default in Safari.

![Appearance tab](image)

---

**Bookmarks**

Decide whether or not to include your Address Book and Bonjour items in the Bookmarks bar, Bookmarks menu, and your Collections. You can also choose to keep your Safari bookmarks consistent across multiple Macs by checking the Synchronize bookmarks using MobileMe box, shown in Figure 17.5.
Syncing your bookmarks is a great way to make sure all your favorite sites are within easy reach.

**FIGURE 17.5**

Tabs gives you several options for using tabbed browsing in Safari, which I discuss in more detail later in this chapter. The bottom half of this window, all of which is shown in Figure 17.6, teaches you a few nifty keyboard shortcuts to make tabbed browsing even more convenient.

**FIGURE 17.6**

The Tabs tab is all about tabs.

**RSS**

You can also use Safari, as well as Mail, to view RSS (Really Simple Syndication) feeds, which are discussed in more detail later in this chapter. These options, shown in Figure 17.7, dictate how you use RSS feeds with Safari.
Part V  The Surfing Mac

**FIGURE 17.7**  
Set up Safari for use with RSS feeds using this preferences tab.

![Safari RSS Preferences Tab](image)

**AutoFill**  
Some Web sites contain fields for items such as addresses and names that you tell Safari to populate automatically by using these options.

**CAUTION**  
Unless you are using the most securely secured Mac in the history of security, I advise you to absolutely not check the box for User names and passwords in the AutoFill preferences! If you check this box, those items will automatically be entered for all Web sites that you access that require them. Basically, anyone who uses your Mac under your user account can access any Web site you can if you select this option. This probably would not be a wise move.

**Security**  
Speaking of security, this tab (Figure 17.8) lets you decide what Web content to enable as well as whether or not to accept cookies from Web sites. Cookies are simply text files that help a Web site keep track of your browsing habits or authenticate you as a user.

**TIP**  
I suggest setting the Accept cookies option to Only from sites you navigate to. Clicking this option limits sites that you don’t visit from invading your privacy, but leaves cookies enabled for those sites that require them.

Some Web sites let you create and edit documents and they often save these documents on your hard drive. Use the Default space for database storage option to set the amount of space on your hard drive for this kind of activity.
Advanced

The options in this tab, shown in Figure 17.9, allow you to set a minimum font size so that text in Web pages doesn't get too small for you to read. Check the Press Tab to highlight each item on a webpage box to navigate sites without need of the mouse. Also decide which style sheet to use and whether to use proxies for accessing the Internet on your network (ask your network administrator if you don't know). I discuss the Develop menu later in this chapter.
Part V  The Surfing Mac

Private browsing

Are you an alien who is clandestinely living among us poor, unsuspecting humans, and who needs to keep all of your Web surfing secret from our prying eyes? Well, it’s your lucky day, my extraterrestrial friend! Safari allows you to enable Private Browsing, which gives you the freedom to roam the Web without any other user of your Mac being able to trace your steps. To perform this shady feat, simply choose Safari › Private Browsing. You will see the disclaimer shown in Figure 17.10; click OK to proceed.

FIGURE 17.10
Click OK to enter the covert side of Web browsing.

Block those annoying popups

There are arguments for the pros and cons of popups, which are advertisements that literally pop up in front of the Web page you’re viewing, intruding on your otherwise pleasant Internet browsing experience. The simple fact that they do jump in front of what you are legitimately trying to view is enough of a con to sway me past any pro that can be offered up, and I’m sure most (probably all) of you will agree with me once you experience these little gems, if you haven’t already. Thankfully, Safari has the uncanny capability to deter these pests. To block popups, simply choose Safari › Block Pop-Up Windows, or press +Shift+K.

Tabbed browsing

As is usually the case with Apple, Safari was the first major browser to show up at the tabbed browsing party. Eventually the other browsing big dogs joined in and incorporated their own versions of tabbed browsing, with some good results (Firefox) and some not-so-good results (for the sake of anonymity and good sportsmanship, I’ll only give you the initials of that browser: I.E.).

Why is tabbed browsing such a big deal? Well, back in the old days, if you wanted to have multiple Web pages open at once, you had to have multiple windows open, too (one for each page). If you had to switch from one page to another with any frequency, things could quickly get quite confusing. Along came tabbed browsing, which lets you open several Web pages at once in several tabs (one page per tab) but using just one window. You can easily click on whichever tab you want to view instead of having to find the window that holds the page you need.
Cruising the Internet with Web Browsers

The tab bar is hidden from view by default, but when you open a second Web page using tabs, the tab bar appears (Figure 17.11).

**FIGURE 17.11**

Tabs prevent confusion and frustration by keeping everything together in one window.

Tab bar

A few tips for browsing with tabs:

- Hold down the ⌘ key while clicking a link in a Web page to open the link in a new tab.
- Press ⌘+T to create a new tab in the current window.
- Close tabs by clicking the X in the left corner of the tab.
- Rearrange tabs by clicking-and-dragging them in the tab bar.
- Move tabs from one window to another by clicking-and-dragging the tab from its current window to the new one. To open a new window with the tab, simply drag the tab to the Desktop.
- If you have several Safari windows open, you can combine them all into one window using multiple tabs by choosing Window ➤ Merge All Windows.
Develop menu

There is a “hidden” menu in Safari that provides a little extra functionality to surfers of the World Wide Web. The Develop menu is mainly for use by developers who create Web sites, but it can also benefit the rest of us, too. To enable the Develop menu:

1. Choose Safari►Preferences or press ⌘+, (comma).
2. Click the Advanced tab in the preferences window.
3. Check the box at the bottom of the window called Show Develop menu in menu bar.
4. The Develop menu appears in the Safari menu bar between the Bookmarks and Window menus.

The Develop menu can benefit the average user in a couple of ways. First, if a Web page doesn’t display correctly in Safari, you can have the page open in another browser (if you have one installed, which I get to later in this chapter). To do so, simply choose Develop►Open Page With and select another browser from the menu (Figure 17.12).

FIGURE 17.12
Open the problematic page with another browser.

The second benefit is that you can fool a Web site into thinking you are running another browser. Let’s say that the developer of a Web site decides to limit access to only those running Internet Explorer for Windows (for absolutely no good reason at all, I might editorially add). You can thumb your nose at this so-and-so by having Safari pretend it is Internet Explorer for Windows—or almost any other browser, for that matter—by choosing Develop►User Agent and selecting an option from the list (Figure 17.13).
Using bookmarks

Bookmarks are addresses of Web pages that you most often visit. You can simply select a bookmark and you are whisked away to the wondrous site.

Organize bookmarks

The key to using bookmarks efficiently is to organize them so that you can find them easily. To access the Bookmarks window, shown in Figure 17.14, click the bookmarks button (it looks like an open book) in the Bookmarks bar.

Add a new bookmarks folder by clicking the + button in the lower left of the window. Give the folder a descriptive name, such as “Football Sites” or “Work-related.” To create a bookmark for a site, open the site and press ⌘D. Choose the bookmarks folder to save the new bookmark in using the popup menu, and then click Add.
Import/export bookmarks

Bookmarks are a portable commodity. You can export them from one browser and import them into another. To export bookmarks from Safari:

1. Choose File † Export Bookmarks.
2. Name your bookmarks file; I suggest using the current date in the filename.
3. Select a location to save the file, and then click Save.

To import bookmarks:

1. Choose File † Import Bookmarks.
2. Locate the bookmarks file you want to import using the Import Bookmarks window.
3. Select the bookmarks file and click the Import button.

Using RSS

Really Simple Syndication, more commonly known as RSS, is used by Web sites that update their content often, such as news and weather sites. RSS documents, or feeds, are updated every few minutes to include the newest information found on the site. They allow a subscriber to the feed to
use a program such as Safari, or another utility called an RSS reader, to be notified when there are updates to the site. Safari or the RSS reader then shows a summary of the contents of the site. If users want to see more information about a particular article, they usually just have to click a link to access the full page on the origin site.

You can determine if a site has an accompanying RSS feed that you can subscribe to by looking in the address field. If the site has an RSS feed, there will be a blue RSS logo on the far right side of the address field, like the one shown in Figure 17.15.

**FIGURE 17.15**

Apple's homepage has an RSS feed to which you can subscribe to get the latest info from Apple.

Click the RSS logo to see the feed for a particular site, like I've done in Figure 17.16 for ESPN's homepage.

**FIGURE 17.16**

The typical layout of an RSS feed in Safari
Great Third-Party RSS Readers

As a Mac OS X user, you are lucky to have lots of world-class dedicated RSS reader applications at your disposal, and all the best ones are free! RSS readers simply read and display RSS feeds; that's all they do, so they usually do it very well. The best RSS readers display the latest updates for your favorite feeds and a summary of articles that interest you, and they provide a link to the full page. The best of the best RSS readers give you all of that, plus open the page itself instead of using your Web browser to display it. My favorite readers are, in no particular order:

- Shrook (www.utsire.com/shrook/)
- NewsFire (www.newsfirerss.com/)

You can bookmark RSS feeds the same as you would a regular Web page. Simply click the + button in the toolbar and save the bookmark for the feed in the location you prefer.

TIP Because the object of an RSS feed is to keep you up to date, save the RSS feed in your Bookmarks bar or Bookmarks menu so that Safari displays the number of new items that have been posted to the site next to the name of the bookmark. This number is your tip that new articles are available.

Firefox

Firefox, developed by Mozilla, is the third-party browser that's taking the Internet by storm. Firefox, which is free, is the only major browser not made by either Apple or Microsoft, but it works on both platforms, which is a big plus for those of us who sometimes have to use both Mac OS X and Windows on a daily basis. Being able to use the same browser on both operating systems maintains continuity and familiarity, which is a breath of fresh air. Figure 17.17 shows you a typical Firefox window.

Like Safari, Firefox uses tabs very well, and is an easy application to learn. It can be both a simple Web browser and complex enough to satisfy the geekiest Web surfer.
Cruising the Internet with Web Browsers

**FIGURE 17.17**

Firefox 3 is the latest version of this fine browser as of this writing.

How to get and install Firefox

As mentioned, the fine folks at Mozilla have provided us with this great tool, and their Web site is where you can go to get a hold of it: [www.mozilla.com/en-US/firefox/](http://www.mozilla.com/en-US/firefox/). Enter that address into Safari’s address field and follow these instructions for installing Firefox on your Mac:

1. Click the Firefox download link and Safari will automatically begin downloading the Firefox disk image.
2. Safari should automatically mount the disk image, but if not, click the Downloads folder in your Dock and double-click the Firefox disk image file (the file will have a DMG extension).
3. In the disk image window, shown in Figure 17.18, drag-and-drop the Firefox icon onto the Applications folder alias.
4. Press ⌘+Shift+A from within the Finder to open the Applications folder.
5. Double-click the Firefox icon to open your new browser.
Add-ons

A major benefit of using Firefox is that its capabilities can be greatly expanded with the use of add-ons, such as extensions and themes. Extensions add functionality to Firefox that it otherwise wouldn't have, or enhance a feature that it already possesses. Themes let you decorate Firefox and customize the appearance of its buttons.

To see the add-ons currently installed, choose Toolsomination Add-ons from the menu. The Add-ons window, shown in Figure 17.19, lets you see recommended add-ons, and the extensions, themes, and plug-ins that your Firefox browser is currently loaded with.
Other Web-Browsing Alternatives

There are a slew of other Web browsers out there for Mac users, but there are only a couple that I consider good enough to recommend to you: Opera and Camino.

**Opera**

Opera is another cross-platform browser like Safari (Mac and Windows) and Firefox (Mac, Windows, and Linux) and is developed by Opera Software.

Opera is free and customizable, and it provides cool features like Speed Dial to set itself apart from its competitors. The current version, as shown in Figure 17.20, is 9.51 as of this writing, and it can be downloaded from [www.opera.com/](http://www.opera.com/).

**Camino**

Camino (Figure 17.21) is an open source project whose aim is to provide Mac users with an alternative to Safari while at the same time maintaining the unique Mac look and feel that some other browsers don’t quite provide. Get Camino for free and give it a spin by checking out this link: [http://caminobrowser.org/](http://caminobrowser.org/).
Working with Downloaded Files

If you use your Mac on the Internet at all, at some point you will download files using your Web browser. What to do after you've downloaded the files, though? What is meant by compressed and disk image files? Let's find out, shall we?

Where to save downloaded files

Every user account in Leopard is afforded a Downloads folder, which is the default destination of all files downloaded while using Safari. The Downloads folder is located in the Users -> User Account folder, and there is an alias to it in the Dock. You can change this location if it's not what you prefer. To do so:

1. Open Safari.
2. Choose Safari -> Preferences, or press ⌘+, (comma) to open the preferences window.
3. Click the General tab.
4. Use the Save downloaded files to popup menu to select a new destination.
5. Close the preferences window.
Archived and compressed files

Most files that you will download from the Internet are archived and compressed, meaning their contents are made up of several files rolled into one and the size of the data has been reduced to facilitate speedier transmission due to a smaller file size and to save hard drive space. Mac OS X leans heavily on the disk image format for files it downloads and can also create disk images quite easily with Disk Utility, which is part of Leopard. Disk images are mounted much like a hard disk or removable media such as CDs and DVDs.

When you download a disk image file, which typically ends with a DMG extension, Safari attempts to mount it by default, exactly as I described earlier in the Firefox section of this chapter. If you've changed Safari's settings, or if the file fails to mount, double-click the file to mount it, or try to mount using Disk Utility:

1. Open Disk Utility. Press ⌘+Shift+U from within the Finder to open the Utilities folder, and then double-click the Disk Utility icon.
2. Choose File→Open Disk Image, or press ⌘+Option+O.
3. Locate the disk image file on your Mac from within the Select Image to Attach window, select it, and click Open.

Once you've mounted the disk image, follow the instructions of the company or person whose site you downloaded the file from to learn how to handle the disk image's contents.

Supported file compression types

Mac OS X Leopard supports opening other types of archived and compressed files as well, such as:

- ZIP
- GZ
- BOM
- TAR
- TGZ
- TBZ

The Archive Utility built into Leopard automatically opens and decompresses these types of files when they are double-clicked, but there is no other way to open the Archive Utility.

Archive and compression utilities

There are other archival and compression utilities than those that ship as part of Mac OS X. Some are designed to open, create, compress, and decompress file formats not natively supported by Mac OS X, such as Stuffit files, but most are simply tools to help you better use the file formats Mac OS X already supports. Here are a few:
7xz. I've only run into a couple of files that use the 7z compression, but this utility bailed me out. Get it at http://sixtyfive.xmghosting.com/.

DropDMG. This is a simple utility for easily creating disk images, and it can be downloaded from http://c-command.com/dropdmg/.

Bezipped. This utility uses bzip2 to compress and archive your files. It's handy for creating smaller archives than the Finder. Download it from http://fruitstand software.com/bezipped/Bezipped.html.

Stuffit Deluxe and Stuffit Expander. Stuffit files used to be the de facto standard of file compression and archiving for the Mac OS before the advent of Mac OS X. Stuffit files are relatively rare to run across nowadays, but you still find them here and there. Download Stuffit Deluxe from http://my.smithmicro.com/mac/stuffitdeluxe/index.html if you need to create Stuffit archives. Otherwise, if you just need to decompress Stuffit files, simply download Stuffit Expander from http://my.smithmicro.com/mac/stuffitexpander/index.html.

Summary

By this point you should be quite confident in your ability to at least take a dip in the Internet waters, if not be ready to grab a board and surf the waves of the Web. You should be a pro at setting Safari's preferences and importing and exporting bookmarks to customize your browsing experience. From using Safari and its fellow browsers, to downloading and handling compressed files, you have the basic tools to make your Mac Web-browsing experience a fantastic one!
Ever wished you could instantly communicate with someone without being tied down to a telephone? I know e-mail is one way to converse, but it’s not instant, or real time. Cell phones are great (especially the iPhone), but in certain situations, like when you’re at the movies or in a meeting, a voice conversation just isn’t an option. What to do? Well, if you’re part of the Internet generation, you’re no doubt familiar with the term instant messaging. With instant messaging (IM), also known as chat, you can have a text conversation via the Internet with someone across the room or across the world in real time! In today’s world of “tell me now—oops, too late” conversation, IM is a fantastically handy tool to use.

There are myriad chat applications for Mac OS X. In this chapter I concentrate on Apple’s offering in this arena: iChat. iChat is IM at its best, in my opinion, but the third-party alternatives will be given some coverage in this chapter also.

**Discover iChat**

iChat is Apple’s take on instant messaging, and as usual, it’s among the best applications of its type. iChat has a great interface that makes for the most Mac-like chatting experience around.

While iChat is fantastic at sending and receiving text messages instantaneously, it’s also quite adept at video chatting, screen sharing, file sharing, and saving audio and video chats.
To get started, open iChat:

1. Press ⌘+Shift+A to open a Finder window in the Applications folder.
2. Find and double-click the iChat icon to launch the app.
3. Thank iChat for the nice welcome it gives you, shown in Figure 18.1.

**FIGURE 18.1**

iChat is so well-mannered it even welcomes you the first time you launch it.

Before we jump too far ahead, I want to make you aware of the various types of IM accounts iChat is comfortable with using. Table 18.1 gives you the lowdown on these accounts.

**TIP**

It's a good idea to have your accounts set up before you get started with iChat. You will only be able to chat with others who are using the same protocol you're using, by the way.

**TABLE 18.1**

<table>
<thead>
<tr>
<th>Account</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MobileMe and .Mac</td>
<td>If you have signed up for a MobileMe or .Mac account, you can use your MobileMe or .Mac user name and password to log in to iChat. You can sign up for a free MobileMe trial (.Mac is no longer available) at <a href="http://www.mobileme.com">www.mobileme.com</a>.</td>
</tr>
<tr>
<td>AIM (AOL Instant Messenger)</td>
<td>AIM is the most popular instant messaging protocol on the planet, and iChat supports it to the tee. Use your existing AIM account, or you can sign up for one at <a href="http://dashboard.aim.com/aim">http://dashboard.aim.com/aim</a> (click the Get a Screen Name! link to begin).</td>
</tr>
</tbody>
</table>
Jabber

Jabber is an open instant messaging technology that can be used with multiple chat utilities. To find out more about Jabber, and to get a login name, visit www.jabber.org/.

Google Talk

If you have a Google Gmail account, you can instant message with Google Talk users via iChat by simply signing in with your Gmail account user name and password. Check out Google Talk at www.google.com/talk/.

Setting Up Your Account

You should have an account set up by this point with one of the providers listed in Table 18.1. Now it's time to put that account to work. As you saw earlier in the chapter, when you launch iChat for the first time, you are greeted with a welcome message. Beginning from that point, let's proceed to tell iChat about our new IM account:

1. Click the Continue button in the iChat welcome screen.
2. Choose an item from the Account Type popup menu, the choice of which depends on the chat services you created accounts with.
3. Enter the required information for the account type you selected in the Account Setup window (shown in Figure 18.2), and then click Continue.
4. Click Done in the Conclusion window to add your account to iChat.

FIGURE 18.2
Enter all your account information here.

<table>
<thead>
<tr>
<th>Account</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jabber</td>
<td>Jabber is an open instant messaging technology that can be used with multiple chat utilities. To find out more about Jabber, and to get a login name, visit <a href="http://www.jabber.org/">www.jabber.org/</a>.</td>
</tr>
<tr>
<td>Google Talk</td>
<td>If you have a Google Gmail account, you can instant message with Google Talk users via iChat by simply signing in with your Gmail account user name and password. Check out Google Talk at <a href="http://www.google.com/talk/">www.google.com/talk/</a></td>
</tr>
</tbody>
</table>
Start Chatting

Now that you have an account set up in iChat, it’s time to begin chatting it up with your online friends and family.

Add people to your Buddy List

When you log in to your new account, the Buddy List window appears, as shown in Figure 18.3. This is where you can add buddies to chat with, view their online status, and initiate chats with them.

**FIGURE 18.3**
The Buddy List is, oddly enough, where all your buddies are listed.

First things first: Without a buddy to chat with this would be a really short chapter. Here’s how to add a buddy to your Buddy List.

You will need to know your buddy’s user name (account name) to connect with him the first time. Be sure to get this information from the person you’re trying to add to your Buddy List before you begin.

1. Click the + button in the lower left corner of your Buddy List window and choose Add Buddy from the popup menu (Figure 18.4).
2. Enter your friend’s account information in the window and click Add. My new buddy now shows up in the Buddy List, as shown in Figure 18.5.
Adding a buddy to the Buddy List is simple.

Finally, someone I can call a friend—or more precisely, a buddy!
Different ways to chat

iChat offers three different ways to chat with your buddy: text, audio, or video. While you may have the ability to communicate with each of the different chat types, some of your buddies may not. For example, if they have a slow Internet connection, or if their account type doesn't support it, video chat will be out of the question. To find out the type of chat you can conduct with a particular buddy:

1. Highlight the particular buddy you want to investigate within the Buddy List.
2. Choose Buddies ➤ Show Profile from the menu.
3. The capabilities of the buddy in question are listed in the Profile tab of the Info window.

Let's check out the various chat methods next.

Text chats

Text chatting is certainly what most folks prefer these days. It's simple to type quick messages to one another and be done with it. Text messages just seem to give you more flexibility than audio or video because you can perform from any type of Internet connection, whereas audio and video require faster connections with more bandwidth. Text also won't hog all of your bandwidth, allowing you to perform other network-intensive tasks while chatting.

To begin a text chat with a friend:

1. Select the buddy you want to chat with from your Buddy List.
2. Click the A button in the bottom of the Buddy List window to begin instant messaging with your buddy.
3. Type your message in the text field at the bottom of the new chat window and press Enter. Your message will be sent to your buddy and will appear as a word balloon in the iChat window.
4. When your buddy responds, her text will also appear in a word balloon.
5. Reply to your buddy by typing a message and then pressing Enter, and your buddy will do likewise. Keep corresponding until you are all chatted out!
6. You can use emoticons in your messages to convey thoughts or emotions, as shown in Figure 18.6. Click the emoticon icon in the text field to see all the silly faces you can choose from.

Audio chats

The ability to audio chat is pretty cool, but may seem like a waste of time if you've got a telephone or cell phone. The best explanation I can think of is that audio chatting is free, while using your phone may not always be, as in the case of many international calls. You will need to have a microphone and speakers when audio chatting; because most newer Macs have both built right in, this probably won't be a problem.
Emoticons convey your feelings quickly and easily.

Audio chats are easy to get rolling:

1. Select the buddy you want to converse with from your Buddy List.
2. Click the phone button (it looks like a ringing phone) in the bottom of the Buddy List window to initiate the audio chat session. If the phone button is grayed out, your buddy can’t audio chat with you, because either his computer or chat program doesn’t support it.
3. Your buddy will receive an invitation. He is given some options at this point:
   - He can accept your invitation and you can chat away.
   - He can send a text reply instead of speaking with you (don’t take it personally).
   - He can turn down the invitation (don’t worry; I’m sure he has a good reason!).
Too Many Chats Going On at Once?

Some folks simply can't get enough of chatting, and not with a few folks, mind you, but with tens at a time. If your Mac's screen real estate is being hogged by chat window upon chat window, you can rest easy knowing that Apple has an answer to unclutter your chat life: tabbed chatting. Tabbed chatting moves all of your open chats into one window, making for a much more organized IM experience. Just like tabbed browsing in a Web browser, each individual chat is given a separate tab in the main chat window. To move from one chat to another, just click the tab to go to the chat you want to resume. To turn on tabbed chatting:

1. Choose iChat and select Preferences.
2. Click the Messages tab.
3. Check the box next to Collect chats into a single window.

Video chats

For decades now we've all wondered at the prospects of being able to see one another when conversing over the telephone or via some other method. Well, with iChat 4 (which ships as part of Mac OS X Leopard) you will wonder no more, as such a thing has become a reality. You can now video chat with friends and relatives from anywhere at any time, and for free! Of course, you and your fellow chatter must have a broadband Internet connection, such as cable or DSL, to experience video chat because it has to use so much bandwidth. You must also both have cameras and microphones, which are built in to most of the newest Macs.

There are all sorts of practical uses for video chat:

- Grandparents can keep up with their grandchildren who may live far away.
- Friends can show off each other's new cars from across the miles.
- Businesses can benefit from very affordable live video teleconferencing.

... And the list goes on and on!

Video chats are easy to start:

1. Select the buddy you want to video chat with from your Buddy List.
2. Click the video button, which resembles a video camera, in the bottom of the Buddy List window.
3. Your buddy will receive an invitation, just like in the audio chat. As with audio chats, your buddy can choose to accept your invitation, send a text reply instead of video, or turn you down flat.
4. If your buddy decides to grace you with her presence and accepts your invite, it may take a few seconds for you to connect to one another, depending on the speeds of your and your buddy's Internet connection.
5. When a connection is established, you will see your buddy in the larger iChat window, and you will see yourself in a smaller preview window. It’s good to see the folks you love!

6. You can add some flair to your video chats by clicking the Effects button in the lower left of the iChat window. This is a pretty cool trick Apple has added to iChat!

**Other Cool Uses for iChat**

iChat is the greatest IM tool around, in my humble opinion, but it can do even more than simply being used for various types of chat. Let’s take a quick look at sending and receiving files, and using iChat Theater.

**Sending files via iChat**

One great thing about a good IM client is that you can send files of any type to your buddy while chatting with him. This ability really comes in handy for things like sending pictures of the kids to relatives or sending documents to business colleagues. To send a file to a buddy:

1. Begin chatting with a buddy, or if you don’t want to chat, you can simply highlight her name in the Buddy List.
2. Choose Buddies→Send File from the menu, or press ⌘+Option+F.
3. Browse your Mac for the file you want to send, as shown in Figure 18.7. Select the file and click the Send button to fire it to your buddy through cyberspace.
4. Your buddy can decide whether to accept your file or reject it.

**FIGURE 18.7**

Browse your Mac for that important file you want to send your buddy.
Receiving files in iChat

What to do when a buddy sends you a file? There are two scenarios in which you can receive a file: within a currently active chat, or by invitation.

By invitation:

1. You will receive an invitation similar to the one shown in Figure 18.8.
2. Click the Save button to save the file, or the Decline button to turn down the file and hope your friend isn’t gravely offended.

![FIGURE 18.8](image)

You are hereby cordially invited to download this file.

From within a chat:

1. As shown in Figure 18.9, when someone sends you a file, it shows up in the chat window.
2. Click the arrow next to the filename and the file will automatically be saved to your account’s Downloads folder.

![FIGURE 18.9](image)

The file shows up right in the chat window.
Make Presentations with iChat Theater

iChat Theater is new to Leopard's version of iChat, and it allows you to make presentations to others in a really cool way. You can present documents, slide shows, iPhoto album slide shows, QuickTime movies, and more. You are in full control of the presentation from your Mac while others can view your presentation on their Macs. As with audio and video chats, a broadband connection is required. To make a presentation using iChat Theater:

1. Choose File -> Share a File with iChat Theater from the menu, or if showing an iPhoto slide, choose File -> Share iPhoto with iChat Theater.
2. Browse your Mac to find the file you want to share, select it, and click the Share button.
3. You will be prompted to begin a video chat with your recipients.
4. When the video chat starts, a control window will open. If you are presenting an iPhoto album, iPhoto will open so you can use its controls. If you're presenting a Keynote slide show, Keynote will open so you can drive things from there.
5. Close the control window when you're finished making your presentation.

Third-Party Chat Utilities

I will reiterate that I believe iChat to be the best IM utility I've ever used. Having gotten what may be perceived as my obvious Apple bias out of the way, there are some great third-party alternatives out there for Mac OS X.

Yahoo Messenger

Yahoo's Messenger chat utility is one of the Web's most popular. You can use it as a chat client, of course, but you can do much more as well:

- Send text messages to mobile phones.
- Conference in multiple friends to one chat.
- Make free computer-to-computer calls.

Yahoo Messenger for Mac OS X can be found at http://messenger.yahoo.com/mac/.

Microsoft Messenger

Microsoft Messenger can be used on corporate networks with Microsoft Office Communications Server 2007, or individual users can utilize its features with a Windows Live account. Microsoft Messenger is capable of text, audio, and video chatting. Download Microsoft Messenger from www.microsoft.com/mac/products/messenger/default.mspx.
AIM

AOL Instant Messenger (AIM) is one of the oldest and most reliable instant messaging tools anywhere. The AIM client for Mac OS X can be acquired by visiting www.aim.com/get_aim/mac/latest_macosx.adp.

Adium

Adium is my favorite of the third-party chat clients due to its ability to handle multiple chat platforms with ease, and it’s just a fun application to use. Facebook users can even use Adium to chat! Adium also uses Growl to notify you of chats and other events. The interface is highly configurable and utilizes other advances such as tabbed browsing and Address Book integration. Download Adium from www.adiumx.com and have a blast!

Summary

You now have a better-than-average handle on instant messaging from your Mac. You know what account types iChat supports, how to initiate video and audio chats, how to exchange files using iChat, and what other chatting applications are available for Mac OS X. There are a surprising number of options to choose from; now you just need to decide which is best for you. Happy chatting!
Part VI

The Advanced Mac

IN THIS PART

Chapter 19
UNIX

Chapter 20
Alternative Operating Systems

Chapter 21
Doctor Your Ailing Mac

Chapter 22
Backing Up Your Mac
Underneath Mac OS X's ravishing exterior beats the heart of one of the oldest operating systems in use today: UNIX. When most folks hear the term "UNIX," they may not necessarily be thinking about computers. However, those who do understand UNIX as being related to computers may exhibit excessive sweating and tremors when the topic arises. Okay, maybe that's a slight exaggeration, but UNIX can be a sore subject with some due to its complexity and foreign nature.

UNIX is one of the most stable and reliable operating systems ever developed. Mac OS X's core software is based on UNIX, which comes in seemingly more flavors and varieties than Baskin Robbins can serve up. The variety of UNIX used in Mac OS X is called Darwin, and even it is a variation of another flavor of UNIX called BSD (Berkeley Software Distribution).

Whenever you direct your Mac to perform a task, such as dragging an item from one folder to another or emptying the Trash, you are causing it to carry out an equivalent UNIX command. If you will excuse the gastronomical term, UNIX is the guts of Mac OS X.

Most of us in this era of graphical user interfaces, or GUIs, are used to pointing and clicking our cursor with a mouse, but up until the mid-1980s this method of interacting with a computer was an alien concept. Prior to that time, if you wanted to use a computer, the keyboard was your only way to give it commands. The interface wasn't a GUI, it was a command line, which basically means it was all text with none of the beautiful icons and Desktop backgrounds we use today. "How did people function in those dark ages?" you may ask. Well, you're about to find out!
Part VI  The Advanced Mac

Using a Command Line Interface

The Terminal, shown in Figure 19.1, is your doorway into the UNIX universe in Leopard. Its interface is reminiscent of the old-style computer terminals of the 1970s, and it’s where you enter commands to interact with your Mac.

![Figure 19.1](image)

Take a trip down memory lane with Terminal’s command line.

To open Terminal:

1. Press `⌘`+`Shift`+`U` to open the Utilities folder.
2. Find the Terminal icon and double-click it.
3. A new Terminal, or shell, window opens and is ready for your input.

**TIP** You can have multiple Terminal windows open at once, each one performing a different task. To open new windows, press `⌘`+`N`.

Looks pretty simple, doesn’t it? As a matter of fact, at this stage there’s nothing going on but a single line listing the name of your computer and your user account name (sometimes there will be another line detailing the last time you logged in to Terminal).
Using the Terminal

Let's find out how to get around your computer from within Terminal, and then have a look at its preferences, which are so important in customizing your CLI (command line interface) experience.

Getting around in Terminal

To get around in a CLI with maximum efficiency, you need to understand how UNIX sees the contents of your hard drive. In UNIX, a folder is known as a directory, and disks are volumes. The top level of your startup disk is known as the root directory, which is represented by a slash (/). Your home directory, which is represented by a tilde (~), is what new windows open in by default.

To move to a different directory than the one you're in, type the change directory command in the command line and enter the path of the directory you are moving to. For example, to move to the root directory of your hard disk:

1. Type `cd`, which stands for change directory.
2. Press the spacebar and follow with a `/`.
3. Press the Return key, and the ~ after your computer name will change to a /, indicating that you're now in the root directory.
4. To move back from the root directory to your home directory, simply type `cd ~` and press the Return key. The history of your moves will appear in each line, just like mine does in Figure 19.2.

FIGURE 19.2

I've made a round trip from my home directory to the root and back again, all in two short lines.
Subdirectories are directories contained inside of other directories. Moving to a subdirectory can be more difficult unless you know which directories contain others. Directories are separated by slashes when typing their path in the CLI. To give you an example of moving into subdirectories, follow these steps to move to the Preferences directory in your home’s Library directory:

1. Type `cd`.
2. Press the spacebar and then type `Library/Preferences`.
3. Press the Return key and the `-` after your computer name will change to `Preferences`, indicating that you’re now in the Preferences directory.
4. To move back from the Preferences directory to your home directory, simply type `cd -` and press the Return key, as shown in Figure 19.3.

**FIGURE 19.3**
Move to subdirectories with the help of a slash (/) between each directory name in the path.

---

**Tabbed windows**
I like my Terminal windows the way I like my Web browser pages: tabbed. Figure 19.4 shows a single Terminal window that has multiple tabs opened. Tabbed windows cut down on Desktop clutter, and that can be a valuable commodity if you’re using a laptop.

To create a new tab:

2. Select the setting for the new tab.
Super Superuser!

The superuser sounds like a guy sitting in front of your Mac wearing a cape, but unless you’re fond of flowing capes that flap in the breeze as you walk around, this probably isn’t the case. The superuser is another word for the root account, which is the account of ultimate power on your Mac. While an administrator has significant power, only the root account can access any and every folder and file on your Mac. Now this is certainly an account you want to be familiar with, but you will not want everyone who uses the Mac to have access to it, for obvious reasons! If you are logged in as the superuser and make a mistake in deleting some important system files, you could take down the entire system in one fell stroke. This is why this account is disabled by default in Mac OS X, and has to be enabled using the Directory Utility if you want to benefit from its power. If you decide to take the leap of enabling this root account, you will need to set a good password for it, since its default password is blank (for the love of all that is Mac, please don’t leave this password blank; you will regret it!). To enable the superuser account and set its password, follow these steps:

1. Press ⌘ + Shift + U from within the Finder to open a Finder window directly into the Utilities folder.
2. Find and double-click the Directory Utility icon.
3. When Directory Utility opens, click the lock in the bottom left of the window, and then enter an administrator account name and password to unlock the application.
5. Assign a new password by choosing Edit → Change Root Password from the menu.
6. Enter the new password in both the Password and Verify fields; click OK when finished.

Please enter a new password for the root user.

Password: ******
Verify: ******

Enter the password for the root account in both fields.

Close tabs by clicking on the X in the upper left corner of the tab.

You can also save tabbed windows as window groups by choosing Window → Save Windows as Group and giving the group a descriptive name.
Modify Terminal's preferences

Terminal will work exactly the way it wants to unless you bend it to your will. As with the majority of other applications, Terminal has preferences that can be adjusted to suit your individual needs. Choose Terminal > Preferences from the menu, or press ⌘+, (comma) to open the Preferences window (Figure 19.5).
Let's take a look at each tab in the Preferences window.

**Startup**

When you first open Terminal, it automatically opens a new Terminal window. The Startup tab lets you tell Terminal which state it should start up in:

- Decide which settings to use for the new window, or whether to open a series of windows, called a window group. These settings are a godsend if you can't stand the default look of Terminal. Figure 19.6 shows a screen shot of one window of each type of Terminal's preset configurations.

- Determine whether to open Terminal in its default shell, which is called *bash*, or in a different shell.

**FIGURE 19.6**

One window each of Basic Default, Grass, Homebrew, Novel, Ocean, Pro, and Red Sands

---

**TIP**

Shells are the operating environments (commands and utilities) that are available for you to use in UNIX. There are lots of different shells that vary in their commands and abilities, and Mac OS X supports the bash, csh, zsh, and ksh shells. More shells can be installed if you so choose.
Settings
The Settings section (Figure 19.7) lets you customize the look and behavior of your Terminal windows, and it is one of my favorite features. The list on the left side shows the available preset window types, which you can set as your default by highlighting the desired setting and clicking the Default button. Make your own custom settings or delete them by clicking the + or - button to add or remove them from the list.

Table 19.1 fills you in on what options are available for each tab.

**FIGURE 19.7**
The Settings window lets you customize your Terminal windows.

**TABLE 19.1**

<table>
<thead>
<tr>
<th>Tab</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>Alter the text in the Terminal windows, including the font and the colors used for plain text, bold text, and selected text. Vary the way the cursor works and appears on-screen.</td>
</tr>
<tr>
<td>Window</td>
<td>Set the default title of windows, as well as what other information appears in the title bar, such as the shell command names and settings names. Change the default background color of windows, as well as their default size and how far to allow a user to scroll back through the command history.</td>
</tr>
<tr>
<td>Shell</td>
<td>Cause the shell to issue a command as soon as a new window is opened, and tell Terminal how to act when a user exits a shell window.</td>
</tr>
<tr>
<td>Keyboard</td>
<td>Assign keyboard shortcuts to make entering commands in the shell go much faster.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Change the Terminal emulation, bell, and international character encodings.</td>
</tr>
</tbody>
</table>
Window Groups

Window Groups (Figure 19.8) are great for opening and using several windows at once to run multiple tasks. When you create a Window Group, the settings for each of those windows are retained. You only need to open that group to have every window in the group open and run automatically, using the same settings they had before you closed them in the last session.

To create a window group:

1. Open the windows you will be working with and make sure they are set up in the format that you need.
2. Click the Window menu and select Save Windows as Group.
3. Give the window group a descriptive name, like “Network Diagnostics,” and click Save. Check the box in the Save window to have this window group open automatically when you first open Terminal.

Encodings

The Encodings options allow you to enable and disable international character encodings so that Terminal can display international characters. These are options that most of us will never need to use; basically, if you don’t know what they are, you don’t need them.
Common UNIX Commands

Mac OS X is a real UNIX-based operating system (some folks need convincing, because it's so simple to use) and therefore can understand and execute UNIX commands. In this section we'll take a look at some of the most common UNIX commands and how to implement them.

**man**

All UNIX commands have instructions for how to use them properly and/or more efficiently. These instructions are called manuals, or are better known as *man pages*. To view the man page for just about any common command, simply type `man` followed by the name of the command you want to learn more about, and then press Return. Figure 19.9 shows the man page for the `ls` command.

![Fig 19.9](image)

The `ls` man page tells you all about using the `ls` command.

Navigating a man page can be a bit confusing at first. Follow these tips:

- Press the up or down arrow on your keyboard to scroll up or down one line at a time.
- Press the spacebar to move to the next page.
- Press Q to exit the man page.

**ls**

`ls` (the lowercase letters `l` and `s`) lists all the files in the directory you are currently working in. It's a great way to see what subdirectories and files are contained within a directory.

To run `ls`, simply type `ls` and press Return. In Figure 19.10 I've performed an `ls` command while in my home directory, and its contents are displayed.
FIGURE 19.10

Seeing the goods in a directory is as easy as typing `ls` and pressing Return.

`ls -a`

One of the best options you can use with the `ls` command is `-a`, which lists all the files in the directory. You're probably saying, "I thought that was what `ls` was for?" If so, you're right, but what about the invisible files in the directory? Oh yes, UNIX likes to hide files throughout the system, and typing `ls -a` will show you not only the visible files, but also the hidden ones, as shown in Figure 19.11.

FIGURE 19.11

Hidden files have a dot in front of their names.
Part VI
The Advanced Mac

**cd**
I cover the `cd` (change directory) command early in the chapter, but it bears repeating here because it is one of the most common commands you will use. `cd` is a command used to navigate the directories of your hard drive. Simply type `cd` followed by the path of the directory you want to change to, and then press Return.

**su**
The `su` command invokes the power of the superuser to execute other commands over any item on the computer. You can also use `su` to log in as another user. But use it with caution! When you use this command, even if logged in as a non-administrator, it temporarily enables the root account. To enable the superuser account, type `su` and press Return. You will be prompted for a password, in which case you must enter the password for the superuser account. (See the sidebar earlier in this chapter for more on enabling the superuser account and setting its password.)

**sudo**
sudo works much the same as `su`, except that you aren’t logging in as the superuser or another user account, you’re only using the power of the superuser or other account to execute a single command. After the command is executed, the superuser or other account is logged out and you revert to the original account you opened the Terminal window with.

**mv**
`mv` simply moves or renames a file. Type `mv` followed by the name of the file you want to move, and possibly the path to the file if it’s a different directory than you are in, and then enter the path and name of the file you want to move it to. This action creates a new file in the new location, and deletes the original. For example, if you wanted to rename a file called “business” in your home directory to “work,” you would type the following command from within the home directory:

```
mv business work
```

When you press Return, a perfect copy of “business” would be created and entitled “work,” and then the original “business” file would be immediately deleted.

Should you want to save the new “work” folder on your Desktop, you would have to enter the entire path of the file and its name:

```
mv business ~/Desktop/work
```

Pressing Return causes a perfect copy of “business” to be saved to the Desktop of my user account while deleting the original “business” folder from its original location.
Notice that I used a ~ to represent my home directory in the previous example, instead of typing the entire path unnecessarily. There are lots of shortcuts like this one available that can help you utilize the CLI more efficiently. For example, if you know that a file in a particular directory that you want to jump to is the only one in its parent directory that begins with a "b," simply type b* instead of the entire name of the file.

**cp**

`cp` copies a file and retains the original, making it a close cousin to the `mv` command with the notable exception of not deleting the original file. Type `cp` followed by the path and name of the file you want to copy, enter the path and name of the file you want to copy it to, and then press Return. This command creates a new file in the new location, but again it also retains the original.

**mkdir**

The `mkdir` command creates a new directory, which is essentially the same as pressing `⌘+Shift+N` from within a Finder window. Type `mkdir`, and then enter the path and name of the new directory.

**pwd**

It's easy to get lost when you are zipping around a hard drive from within a command line interface, so don't feel bad or be discouraged if this happens to you. To find your way again, or more accurately, to see where you are in the hard drive, type `pwd` and press Return at the prompt to display the path to the directory you are currently working in.

**rm**

To simply delete a file, just use `rm`. Enter the command followed by the path and name of the file you want to delete, and press Return. You cannot use this command to delete a directory; it will only work with files.

**CAUTION**

When you use the `rm` command, the file is gone—poof! It's outta here! You can't go into the Trash to retrieve it later as you could a document you deleted from within the Finder, so be sure that you really want to delete the particular file before applying `rm` to it.

**rm -r**

Tacking a `-r` on the backside of an `rm` command lets you delete a directory and all of its contents. To use this command, type `rm -r` followed by the directory name, and press Return. Again, the caution offered for the `rm` command certainly follows for `rm -r`: Should you invoke this command, you can't take it back, so be careful!
What Is X11?

X11, also known as the X Window System, is an interface for running UNIX applications that don't have the ability to run natively inside of Mac OS X. Darwin is a fully certified version of UNIX, and is therefore capable of compiling and installing thousands of available UNIX applications. X11 is an optional install that you can run from your original Mac OS X Leopard installation discs. To learn more about X11 on Mac OS X, please visit http://developer.apple.com/opensource/tools/runningX11.html.

Summary

After reading this chapter, your geek quotient has skyrocketed to near nerd-like proportions. You know how to use Terminal to get to the heart of Mac OS X without a graphical user interface, and what the most common UNIX commands are that you can utilize within Terminal. Now that you know more about Mac OS X's UNIX underpinnings, you won't be caught off guard the next time you're at the water cooler chatting up the fine folks from your IT department. Oh, who are we kidding? Like they know anything about UNIX!
Yes, I must admit that there are other operating systems out there, and to be honest, they're not so bad. Of course, your Mac is most at home when using its own operating system, Mac OS X, but since the migration to Intel processors in Apple's venerated computer line, the world of alternative operating systems has been forever opened to Mac users. Now you can give the likes of Linux, Windows, Solaris, and even DOS the chance to fly on your Mac, which is what I think they've all secretly wanted to do for the longest time anyway.

**Why Install Other Operating Systems on Your Mac?**

Your Mac comes with the best operating system on Earth; I'm sure that's quite apparent to you by this point in the book, if you didn't know this truth before you even began reading. In terms of functions and tasks, there really isn't anything you can do with other operating systems that you can't do with Mac OS X. Let me clarify before some of my Windows-leaning and Linux-loving friends throw this big book across the room. There isn't a task that you can perform on a Windows or Linux PC that you cannot accomplish on a Mac using Mac OS X, but the software or commands you need to perform that task may differ. If this is indeed the case, why would you want to install alternative operating systems?
Why Intel Processors?

The processor (a.k.a. microprocessor or CPU, which stands for central processing unit) is that part of your Mac where all the information the computer receives or transmits goes to or comes from. They are the workhorses of any computer, processing most of the millions (and in some cases, billions) of calculations your Mac performs.

For years PowerPC processors (which were developed jointly by IBM, Apple, and Motorola) were Apple’s choice for handling the tasks required of their Mac computers. PowerPC processors, which are still in use today in many different types of devices, were lightning fast and capable of handling anything you could throw at them, especially in their G4 and G5 iterations. There finally came a point in which the development of the PowerPC wasn’t able to meet the demands that would be required of it in the near future, so Apple had to make a switch: Enter Intel. The long and short of it is that Intel was able to meet the demands of Apple’s upcoming products, and thus they are now the brains in every Mac sold. This decision turned out to be a hit all the way around, as developers expressed more interest in Mac OS X and you can now run other Intel-based operating systems on your Mac, either alongside or in lieu of Mac OS X.

Here are a few scenarios that may give you some idea:

- Perhaps you are a new Mac user who is migrating from a Windows-based PC. You’ve probably purchased software that you don’t want to have to repurchase on the Mac. Install Windows on your Mac and you can still use your full library of software, including all those games your kids love to play.
- Let’s say you work with a company that owns copies of Microsoft Office for Windows, but doesn’t have Microsoft Office for Mac. Install Windows on your Mac and you can then install the Windows version of the Office suite.
- Perhaps you’ve heard lots of good things about Linux and want to give it a go, but don’t have an extra PC to install it on.
- Maybe you’re a developer who creates applications for multiple operating systems. Having all the operating systems on one computer is a great convenience and time-saver.

Certainly there are many other reasons one could conjure, but I think you get the drift.

You can install any operating system that has been compiled to run on Intel processors using one of these two methods: Boot Camp or a virtualization utility.
Boot Camp

Boot Camp is a utility that Apple developed solely for the purpose of helping you to install Windows on your Mac. That sounds like an incredibly odd thing to say, but it's true. The only function Boot Camp provides is that of a Windows-on-your-Mac tool, and it performs this single task quite effectively.

You must understand that Boot Camp isn't going to erase your Mac OS X installation and replace it with Windows. Rather, it partitions (divides) the space on your hard drive into a section for Mac OS X and another section dedicated to Windows. Here's a list of Boot Camp's functions:

- Partitions your hard disk, which tricks your Mac into thinking you have more than one disk installed.
- Boots from the Windows installation disk.
- Installs drivers in Windows that are necessary for using the hardware that comes with your Mac.

A copy of the Windows operating system doesn't ship with your Mac, so you'll have to purchase one from Microsoft if you don't already own it. You can install Windows XP Home or Professional (the installation disc must include Service Pack 2), or Windows Vista Home Basic, Home Premium, Business, or Ultimate. Oh, and it must be the 32-bit version, not 64-bit.

There are some requirements for installing Windows on your Mac:

- At least 10GB of free space must be available on your hard drive.
- Your Mac must have an Intel processor.
- You will need a Mac OS X Leopard installation disc.
- You will also need a Windows installation disc.
- You will need at least 2GB of memory if you are installing Windows Vista.
- You need to install all firmware updates available for your Mac using Software Update.

Installing Windows

Before performing your Windows installation, back up your Mac. This is a critical step—you don't want to lose any data!

Refer to Chapter 22 for more information on backing up your Mac.
When that's done, you're ready to get the Windows install rolling by jumping into Boot Camp:

1. Open the Utilities folder by pressing 3C+Shift+U.
2. Double-click the Boot Camp Assistant icon to launch it. You are greeted by the window shown in Figure 20.1.
3. Click the Print Installation & Setup Guide button to print this incredibly valuable information.
4. Click the Continue button.

FIGURE 20.1
Boot Camp Assistant is ready to help you with your Windows installation.

NOTE Let me reiterate how important printing the Installation & Setup Guide really is. I'm not saying it to make you waste paper or ink/toner. This guide is crucial for using Boot Camp, and you must follow it as closely or closer than you do this chapter. This chapter is a good overview of installing Windows with Boot Camp, but it is no substitute for the 26 pages of instruction Apple has put together. You can also download this guide at www.apple.com/support/bootcamp/.

5. At this point Boot Camp Assistant prompts you to partition your Mac's hard drive, as illustrated in Figure 20.2.
6. Now you must determine how much of your Mac's hard drive space you want to use for your Windows installation. When making this determination, you need to consider these things:

- How much space is required to install the version of Windows you want to use?
- How much space will your third-party applications take up when they are installed?
- How much free space do you want to make available on the Windows partition for saving your files?

**FIGURE 20.2**

Partition a section of your hard drive specifically for Windows.

7. Once you've made those calculations, it's time to partition the disk; of course, Boot Camp Assistant makes it almost absurdly easy to do so. Simply drag the button located between the Mac OS X and Windows boxes to the left or to the right to increase or decrease the size for each partition.

- Click the Divide Equally button to quickly allocate the same amount of space to each partition.
- Click the Use 32GB button if you will be using the FAT format when installing Windows and you want to use the maximum amount of disk space that the format allows.
If you partitioned your Mac's hard drive prior to this process, you will be shown a window asking you if you want to create or remove a Windows partition or start the Windows installer. Choose to start the Windows installer and click the Continue button.

8. Once your hard drive has been successfully partitioned, Boot Camp Assistant alerts you to insert the installation disc for the version of Windows you want to install. Insert the disc into your Mac's CD/DVD drive and click Start Installation, as shown in Figure 20.3.

9. After your Mac boots up using the Windows installation disc, follow the instructions on your screen to install Windows.

TIP

Don't forget to use the Boot Camp Installation & Setup Guide!

FIGURE 20.3

Time to begin your Windows installation.

10. When you are prompted to select which partition you want to install Windows on, make sure you choose the one called BOOTCAMP.

CAUTION

Be absolutely sure to select the correct partition in step 8! You don't want to take a chance on wiping away your Mac OS X partition!

11. Choose either NTFS or FAT32 as the file format for your Windows partition. NTFS will be your only option if you're installing a version of Windows Vista.

12. When the Windows installation is completed, your Mac will reboot into Windows. How cool is that!
13. Remove the Windows installation disc from the Mac:

1. Click the Start menu in the bottom left corner and select My Computer for Windows XP or Computer for Windows Vista.

2. Click the drive containing the Windows installation disk to highlight it, and then click the Eject this disk option in the Systems Tasks (upper left corner of the window) when using Windows XP. If you installed Vista, select the drive containing the installation disc to highlight it and click the Eject button in the toolbar of the window, as illustrated in Figure 20.4.

**FIGURE 20.4**

Eject the Windows installation disc so you can insert the Mac OS X installation disc.

14. Insert the Mac OS X Leopard installation disc and the Boot Camp installation program will start up. Follow the instructions on your screen. If you see a message that says the software hasn’t passed Windows logo testing, click the Continue Anyway button. When the Boot Camp installer has finished, your Mac will reboot. After that you are finished with your Windows installation. Give yourself a big pat on the back, my friend!

15. At this point you will see the Boot Camp help window, shown in Figure 20.5. This window isn’t there for show; use it! The information contained here can help you utilize your Mac’s hardware with Windows and sort out any differences there may be.
Selecting a startup volume

Your Mac is now twice as good as before, having two operating systems on it (some may argue the point that putting Windows on your Mac certainly does not make it better, but let’s not go there). Are you going to use Windows as your primary operating system now? You bought a Mac for a good reason, and I doubt it was to solely run Windows. So if you don’t want to use either Windows or Mac OS X exclusively, how do you switch from one to the other? I’m glad you asked! Setting the default operating system for your Mac to start up with is a snap, as you’re about to see.

Choosing a startup volume within Windows

Because you are probably running Windows on your Mac at this stage, assuming you’ve been following along in this chapter, we should start with selecting a startup, or boot, volume from within Windows. Here’s how:

1. Click the Start menu and choose Control Panels.
2. I recommend you choose Classic view so that you can easily see all the control panels installed.
3. Double-click the Boot Camp icon to open the Boot Camp controls. The function of control panels in Windows is very similar to System Preferences in Mac OS X.
4. Click the Startup Disk tab, shown in Figure 20.6.
5. Choose the operating system you want your Mac to start up with by default and click the OK button, or click the Restart button if you want to reboot into the OS now.
Choosing a startup volume within Mac OS X

If you're running Mac OS X and need to boot into Windows, here's how to do it:

1. Click the Apple menu in the upper left of your screen and choose System Preferences.
2. Click the Startup Disk icon.
3. Choose the default operating system for your Mac, as shown in Figure 20.7.
4. Click the Restart button if you want to boot into Windows; otherwise, close System Preferences.

Selecting a boot volume from within Leopard
Restoring your Mac’s hard disk

If you ever decide you no longer need the Windows partition of your hard drive, it’s a simple task to restore it to its former glory. Boot Camp Assistant is all too happy to help:

1. Press cmd+Shift+U from within the Finder to open the Utilities folder and double-click the Boot Camp Assistant icon.
2. Click Continue.
3. Click the Create or remove a Windows partition button and click Continue.
4. Click the Restore button (Figure 20.8) to remove the Windows partition from your disk. You can now use all the freed space for your Mac partition.

**FIGURE 20.8**

Boot Camp Assistant can also help you remove the Windows partition from your hard drive.

---

Virtual Machines

Boot Camp Assistant is great if you have the space on your hard drive available and you want to install only one copy of Windows XP or Vista. However, if you want to install other versions of Windows, or some other operating system altogether, you’re out of luck. I have personally never
been too keen to allocate a portion of my hard drive's free space that I won't be able to touch if I need extra space on the Mac side. If having to partition your hard drive doesn't sound like the greatest option for you, there is an alternative: virtual machines.

**What is a virtual machine?**

Virtual machines are great, that's what they are. I guess you'd like a little more of an answer than that though, huh? Very simply stated, virtual machines are fake computers. Virtualization software allows you to create virtual machines that you can use to install almost any Intel-based operating system on. You can have as many operating systems on your computer as you have space available on your hard drive. The virtual machine lets you run its operating system within Mac OS X, and you can switch between the two operating systems with a keystroke! You can have multiple operating systems running at once if you like, although you'll need to make certain your Mac has plenty of RAM (memory) installed to avoid bogging down everything.

---

**TIP**

I recommend getting a second hard drive (external is best for portability) to store your virtual machines on. This way you have a dedicated space for your virtual machines and you don't have to hog your Mac OS X drive's space.

**Virtualization software for Mac OS X**

Ever since Apple decided to use Intel processors in Macs, virtualization software companies have jumped all over the chance to be the virtual machine utility of choice for Mac OS X users. But virtualization on the Mac didn't just recently come about; there have been virtual machine utilities for the Mac for years. Before Intel processors were used in Macs, virtualization software had to emulate, or pretend your Mac had, an Intel processor. Tricking the operating system into thinking it was running on an Intel processor while it was actually using a PowerPC processor made for some very slow computing. So while some people did use virtualization in those days, it never really took off until Macs ran natively with Intel processors.

**Which virtualization software should you use?**

There are two main players in the virtualization arena at this point: Parallels Desktop for Mac and VMware Fusion. Other options are out there, but these two are the most polished efforts to date, and either can handle your virtual machine duties fantastically. I have used both and can't really recommend one over the other. Both are paid applications, so you'll have to fork over a modest amount of cash for the privilege of using them.

What operating systems are supported by Parallels Desktop and VMware Fusion? Table 20.1 breaks down most of the major operating systems.
## TABLE 20.1

<table>
<thead>
<tr>
<th>Mac</th>
<th>Windows</th>
<th>Linux</th>
<th>Other</th>
<th>Parallels Desktop for Mac</th>
<th>VMware Fusion</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mac OS X Server 10.5 (32- and 64-bit)</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>3.1</td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.11</td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>95</td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>98</td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NT Server</td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2000</td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2000 Server</td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2003 Server (32- and 64-bit)</td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XP Professional (32- and 64-bit) and Home</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vista Business, Ultimate, Enterprise, Home, and Home Premium (32- and 64-bit)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>2008 Server (32- and 64-bit)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ubuntu (32- and 64-bit)</td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SUSE</td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>openSUSE (32- and 64-bit)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Red Hat</td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Red Hat Enterprise (32- and 64-bit)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fedora Core (32- and 64-bit)</td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Xandros</td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Debian</td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
This is not a comprehensive list, by any means. I suggest checking the Web sites of each company to see if their lists of supported operating systems have been updated.

By the way, there is a third, and free (!), alternative called VirtualBox that I discuss later in the chapter.

Parallels Desktop for Mac
Parallels Desktop for Mac (Figure 20.9) was the first virtualization utility to take off on the Mac when Intel processors come into the picture. Developed by Parallels, Inc., this program just keeps getting better with each new version (which is what's supposed to happen, of course, but that's not always the case for some developers). Some of the major features of Parallels Desktop for Mac 4.0, which is the current version as of this writing, are as follows:

- Run your Windows and Mac applications side by side with Coherence technology.
- SmartX allows you to do cool things such as open Windows documents with Mac applications, use removable devices like external hard drives in both Windows and Mac OS X at the same time, access Windows and Mac files across operating systems, and more.
- Remotely start, stop, and manage your virtual machines with your iPhone.
- Use voice commands to boss Parallels around.
- Access the Windows Start menu from the Mac OS X Dock.
- Copy and paste and drag-and-drop between both Windows and Mac operating systems.

Download and learn much more about Parallels Desktop for Mac by visiting www.parallels.com/en/products/desktop/.
Part VI The Advanced Mac

FIGURE 20.9
A Windows Vista virtual machine ready to go in Parallels Desktop for Mac

VMware Fusion
VMware has been in the virtual machine business for a long time, but has only recently come to the Mac. However, when they did come over, they made quite a splash with Fusion. Fusion, shown in Figure 20.10, is VMware's virtualization software for Mac, and it is as much of a joy to use as is Parallels Desktop for Mac.

Some of Fusion's great features include the following:

- Unity technology lets you do all kinds of great things, like run your Windows applications just like you would your Mac apps, even keeping a shortcut for the app in the Dock.
- You can also drag-and-drop files back and forth and copy and paste between the operating systems.
- Driverless printing makes your Mac's printers available to your Windows applications without having to install Windows-specific drivers.
- If you have a Boot Camp partition, you don't have to reboot your Mac to use it. Fusion can run Windows directly from Boot Camp.
- McAfee VirusScan Plus is built-in, providing virus and spyware protection for your Windows virtual machines.
- It is fully integrated with Mac OS X Leopard technologies like Cover Flow and Quick Look.

Please go to http://vmware.com/products/fusion/ for much more information on this great utility.

**FIGURE 20.10**
VMware running Internet Explorer in Unity mode

*Courtesy of VMware*

**VirtualBox**
Sun Microsystems has a really cool, and again I'll say, “free,” virtual machine application that is Open Source, and its name is VirtualBox. Shown running Windows XP in Figure 20.11, VirtualBox sports many of the same features that Parallels and VMware offer (although certainly not all), such as modality and shared folders. This application is certainly worth a look, and there are also versions available for Windows and Linux.
Summary

In this chapter I've shown you the options for using alternative operating systems with your Mac, such as dedicating a portion of your hard drive for Windows using Boot Camp, and using specialized applications to run other operating systems alongside Mac OS X. Whether you choose to install Windows using Boot Camp or prefer to go the virtualization route, having Windows on your Mac can double your computing pleasure. I would advise using VMware Fusion or Parallels Desktop for Mac as opposed to Boot Camp, simply because you can also use them to install other alternative operating systems and you don't have to partition your hard drive.
As impossible as it may be to fathom, your Mac will most likely, at some point, have a problem. Relaying this information might not help me in my bid to join the Mac Geeks of America United (I just made that up), but I feel you must be informed if you are a new computer user or simply a new Mac user. While it is true that Macs typically have far fewer troubles and much less maintenance costs than PCs, they are still devices created by human hands. In other words, at some point something will go wrong. This chapter is all about fixing those pesky issues that crop up from time to time. I also tell you about some other great places you can venture to for more help should you need it.

There is one key to troubleshooting that I always stress in my books or when teaching classes: The number-one worst thing you can do when a problem arises is to panic. When you panic you lose your ability to think clearly, and when your Mac is acting up, the last thing you need is to be a problem unto yourself. I know it's in some people's nature to panic in a perceived crisis, but if you want to resolve the issue in the least amount of time, a little restraint goes a long way.

Having successfully embarked on my no-panic diatribe, let's get to some troubleshooting.

---

**IN THIS CHAPTER**

- Restart: It's just that simple!
- Utilize a troubleshooting account
- Keep software up to date
- Your Mac won't start up or shut down properly
- Problematic external devices
- Thaw your frozen Mac
- Straighten out that misbehaving application
- Fixing permissions
- Maintenance and troubleshooting utilities
- Starting from scratch
- Helpful resources
Restart: It’s Just That Simple!

Guess what the most common troubleshooting tool for the Mac is? Some fancy software that costs $100 or more? A cryptic diagnostic tool that requires a doctorate in the field of computer sciences to make sense of? How about some difficult-to-execute key combination that requires more manual dexterity than a game of Twister? If any of those were your answers, my responses are “nope, nope, and still nope.” Have I kept you in enough suspense? Okay, okay, here I go . . .

Restart.

You read that correctly: Restart. This ridiculously simple troubleshooting tool is the answer to most of the ailments that you may experience with your beloved Mac. To restart your Mac:

1. Click the Apple menu and choose Restart.
2. Mac OS X will prompt you to see if you’re sure you want to commit to this action (Figure 21.1). If you do, click the Restart button.

![FIGURE 21.1](image)

Restart is still a tried-and-true method of taking care of many problems.

If you want to avoid Leopard asking if you are sure you want to do this, hold down the Option key while choosing Restart from the Apple menu. When you do so, your Mac begins the restart process without prompting you, so make sure rebooting is what you really want to do at this point.

A Quick Word About Backing Up

Backing up your Mac is one of the most important, but oh-so-boring, tasks a user can do. To back up means to make copies of your important files, folders, and settings on another drive or some other medium. This is a vital procedure that you are heartily advised to undertake, because if you do start having problems with your Mac, the last thing you need is to lose your life’s work because you didn’t take the time to back it up. Chapter 22 is all about backing up your Mac’s files and folders, and I suggest you give it its due time to avoid the heartbreak associated with starting completely over. (Unfortunately I speak from experience, so heed my words, please!)
Utilize a Troubleshooting Account

One of the most basic troubleshooting steps you can take is to log in to another user account and see if your issues persist. If the problems don't resurface in the new account, it can be isolated to your user account only, which is better than the alternative. If they do resurface, the offending party is either the system-wide software or hardware, which may be not-so-good. I highly advise creating a troubleshooting account in System Preferences. This account should be used only for troubleshooting purposes to avoid causing any problems with it that can occur with frequent use.

Keep Software Up to Date

Apple does a great job of releasing timely updates to Mac OS X and other software titles (Safari, Mail, Pages, and so on). These updates correct issues that weren't discovered prior to the release of a given operating system or application. Bugs (that is, problems) are an inevitable part of computers, operating systems, and software. Apple has typically been very proactive when it comes to fixing bugs and usually rectifies the problems relatively quickly. Leopard has a great utility installed that takes care of updates in a flash: Software Update.

Using Software Update

Software Update is one of the simplest updating methods I've ever come across. Simply open it, make a couple of clicks, and sit back (for the most part). Let's check it out:

1. Open Software Update by clicking the Apple menu and choosing Software Update. Software Update instantly begins to search Apple's servers for updates to the Apple software you have currently installed.
2. Apple's servers dump a list of software versions to Software Update, which it then uses to compare against the versions currently installed on your Mac. If there are newer versions available, you see them listed (Figure 21.2).
3. Decide which updates you want to perform by checking the boxes next to each item.
4. Click the Install button in the bottom right corner to continue the update process.
5. When the new updates have been installed, Software Update checks the servers again to see if there are any other updates that may need to be applied in addition to the ones you just installed. This is because some updates can't be made until other updates have been performed.
6. If Software Update doesn't find any more updates, you see a message telling you that your software is up to date.
7. Click Quit to close the Software Update application.
Sometimes you must restart your Mac after certain types of updates have been performed. Software Update will tell you if a restart is necessary to install some updates; you can postpone those updates if you aren’t ready to restart your Mac. However, when you do allow Software Update to install these updates, your Mac will reboot and the new software will be applied.

**Update your third-party software**

Software Update is great for updating Mac OS X or other Apple applications you’ve installed, but what about third-party applications you may have installed? Software Update simply won’t work for those, so how do you keep those programs, such as Adobe Photoshop or Microsoft Excel, current? When a third-party program’s developers release an update to their software, those updates can be critical to how both you and the application in question perform.
Some applications, typically the more popular ones like those I just mentioned, come with extra utilities that are installed on your Mac and work very similarly to Software Update. These utilities contact the developer’s servers to find out if any new versions of the software have been released. If there are new versions available, you can decide whether to upgrade at that point or not. My advice is to upgrade; the developer usually has a good reason for putting updates on their servers.

**CAUTION** Although it is rare, some updates have been known to cause more issues than they resolve, so you might want to visit Web sites that cater to the applications in question. There may be forums or chat sites where you can see what kinds of experiences others have had when they’ve performed these updates.

It’s always a good idea to check the Web sites of developers to see if there are updates to their applications, because many don’t find it a necessity to provide an automatic updater for their software. Registering your software is a good idea because developers may choose to send an e-mail to customers informing them of a product’s updates.

---

**Your Mac Won’t Start Up or Shut Down Properly**

You’ve pushed the power button on your Mac, but its screen is staring back at you, completely unresponsive. Is it time to panic? Not yet, try it again. It still won’t power up? Don’t panic just yet, although it’s perfectly understandable if you are feeling some pretty sharp pangs of anxiety. Usually this problem isn’t quite as serious as you might think, and most of the time it can be solved with just a few steps.

**The Mac simply won’t power on**

When your Mac simply won’t power up at all, you need to follow these troubleshooting tips:

- Not to insult your intelligence, but check to make sure the power cable is connected.
- If you’re using a laptop, are you using the power adapter or are you running off the battery? Will the Mac work with the power adapter connected? If so, you may have a bad battery.
- Does the power outlet or strip you’re connected to work with other electrical items, such as other computers or lamps? If so, you may have power supply problems on the Mac itself.
- Does the startup problem coincide with the addition of new external or internal hardware? If it does, remove the hardware and reboot. If your Mac starts up okay, the hardware may be defective or your Mac may not support it.
• If your Mac doesn’t have a built-in display, have you checked to see if it’s just the display that’s not coming on? If so, you could have a bad display. Try connecting another display to your Mac to see how it responds. If the second display doesn’t work, or if your display works with another computer, your Mac’s video card could be defective.

• Try to reset the System Management Controller, or SMC, if you own an Intel-based Mac. There are three ways to reset the SMC, depending on the type of Mac you own:

  For Mac Pros, iMacs, and Mac minis, shut down the computer and remove all connected cables, including your mouse, keyboard, power cord, and anything else you may have. Wait at least 15 seconds, and then reconnect only the power cable, mouse, and keyboard in that exact order. Push the power button and hopefully you’ll be up and running.

  For MacBooks and MacBook Pros, remove the battery and unplug the power adapter. Hold the power button down for a minimum of 5 seconds and then release it. Reinsert the battery, connect the power adapter, and then press the power button.

  For MacBook Air, connect the power adapter to the computer. Simultaneously press the Shift, Option, and Control keys on the left side of the keyboard (they must be the keys on the left!) along with the power button one time. Wait for 5 seconds before pressing the power button once again to turn on the machine.

• If you have a PowerPC-based Mac, you need to reset the Power Management Unit, or PMU. I suggest you check Apple’s Web site for instructions on how to do this, because the procedures can vary widely depending on the model.

**Hanging at startup**

There are several scary symptoms that can occur when your Mac is hanging while in the startup process. For example, you could see a folder with a blinking question mark, or the screen may be stuck at the gray Apple logo with the spinning gear. Typically these kinds of problems can be taken care of easily. Follow these tips (preferably in the order listed) to kick-start your Mac:

• Force a reboot by holding down the power button for 10 seconds or more until the Mac turns off. Restart the Mac and hopefully it will boot correctly.

• Start your Mac in Safe Mode. Hold down the Shift key immediately after the startup sound, and don’t let go until you see the gray Apple logo.

• Zapping the PRAM is a time-honored tradition on Macs. Zapping the PRAM means to reset the parameter RAM. Restart your Mac and immediately hold down the ⌘+Option+P+R keys at the same time. Keep holding down all four keys until you’ve heard your Mac’s startup sound at least two times. Let go of the keys after the second startup sound and see if it boots normally.
You can start up your Mac using your Leopard installation disk. Simply insert the disk, restart your Mac, and hold down the C key when the Apple icon appears on the display. Once the screen comes up, select Disk Utility from the Utilities menu. Click the icon for your hard drive in the left column and click the Repair Disk button in the lower right side of the window. Reboot your Mac when the repair process is finished and hope for the best.

If none of these options fix the problem, give Apple a call at 1-800-APL-CARE (1-800-275-2273). Their support team should be able to help you resolve the problem, one way or another.

Your Mac can't shut down

Your Mac can also have problems shutting down, though this is an exceedingly rare issue. Try one of these methods to force your Mac to shut down or restart properly:

- Force a shutdown by pressing and holding the power button down for at least 10 seconds.
- Force a restart by pressing Ctrl+⌘ simultaneously with the power button.

Problematic External Devices

Sometimes the external hardware devices, like printers or scanners, that we connect to our Macs don't play nice. They may lose their connections or simply wreak havoc with the system. Here are some tips for troubleshooting those devices that we all can't seem to get along without:

- Here's a no-brainer: Check the power to the device. Make sure the power is turned on at the device, and that the power outlet or strip it's connected to is working properly.
- Check the cables that connect the device to your computer. Make certain the cable is securely seated in the ports at both ends (the device and the computer), and is not damaged. Check the length of the cable if you tend to have inconsistent communication issues. Try a different cable if you have one (borrow one from another device that you know is functioning properly, if you can), or try connecting your cable to a different port on the Mac.
- If you're connecting the device to your Mac with a USB hub, try connecting the device directly to your Mac. If the device works properly without the hub, then the hub, or a port on it, is the problem.
- Check the support Web site of the manufacturer of the device to find out if new drivers or firmware have been released for the device. These updates may cure the problem you're experiencing.
- As your last resort, contact the manufacturer of the problematic device. You never know; someone on the other end of the phone may have seen and resolved your very issues.
Thaw Your Frozen Mac

Have you ever been zipping along with your work only to discover that your Mac didn’t respond to the last command you gave it? You tried again, but still received the same blank stare from your Mac. Your Mac has just frozen up, or more possibly, just the application you are currently working in has frozen up. There are a number of options to explore with this scenario:

- First, make certain your mouse and keyboard are properly connected to your Mac. Disconnect and reconnect them to see if they respond.
- If the application you were working in is simply having a devil of a time completing the last task you assigned it, try stopping the troubled process by holding down `Option`+.(period) for several seconds to see if you can regain control.
- Try forcing the troubled application to quit (sometimes you’ve got to show those guys who’s boss). To force quit:
  1. Simultaneously press `Shift`+`Option`+Esc, which opens the Force Quit Applications window (Figure 21.3).

![Figure 21.3](image)

Force quit an application if it is no longer responding to you.

2. Choose the name of the misbehaving application and click the Force Quit button.

- If all else fails, force the Mac to reboot. See the section earlier in this chapter for information on forcing a reboot or shutdown.
Straighten Out That Misbehaving Application

Sometimes it's not the operating system that's at fault, but rather the application you are currently using. Applications are just as susceptible to crashes, freezes, and the like as Mac OS X (to be honest, probably more so). How do you handle these misbehaving characters? Here are some questions and tips for troubleshooting software issues:

- Are the latest updates for your software installed? Check the Web site of the application developer to see if there are any updates. Did the issue occur only after you installed an update to either the application or Leopard itself? Check with the application developer's support team for any known issues with the update. To see what version of the software you are currently running, click the name of the application in the menu bar (next to the Apple menu) and click the About application name option. For example, if you are using Microsoft Word, choose Word → About Word from the menu. The resulting window will show you the version you are currently using, as illustrated in Figure 21.4.

**FIGURE 21.4**

This window shows me the version of Microsoft Word I'm currently working with.
The Advanced Mac

- Narrow the issue down to see if it only occurs with a certain document, or a certain page within a document. As a test, create a new document, copy and paste the contents of the old document into the new one, and see if the issue goes away.
- If you consistently get a particular error message, check the application’s documentation or its support Web site for help interpreting the message.
- Are you having problems with the application working with a particular piece of hardware? For example, if you have a problem with iPhoto freezing when you try to import images from your camera, try using Image Capture to do the import. If Image Capture experiences the same problem, the camera may be at fault. If Image Capture does not have the same problem, iPhoto is causing it. The same theory applies to all other types of applications.
- You may need to throw away the application’s preferences files, but I highly suggest you seek the advice of the application’s developer before doing so to make certain how to do it and to avoid any potential disasters.
- If the issue persists after all of the above have been tried, you should reinstall the application. Check your documentation or check with the developer before doing so to be aware of any precautions you should take.

Fixing Permissions

Permissions are a critical part of every file in Mac OS X Leopard. These permissions tell Leopard exactly who can access the file and what they can do with it. However, for various and sundry reasons, these permissions can become corrupted and must be repaired in order for normal behavior to return. Here are some examples of the most common issues that occur when permissions have become corrupted (this is by no means an exhaustive list):

- You're not able to empty a file from the Trash.
- Applications may crash when attempting to print from them.
- You cannot open a document that you do have permission to open.
- An application can only be launched by one user account, even though it's been installed for use by all accounts.
- The Finder restarts when you are trying to change permissions in a particular file.
- You can't open folders on your Mac or on network servers that you normally have permission to access.

Repairing permissions is a surprisingly simple thing to do using Disk Utility, which is a utility that is part of any standard Mac OS X Leopard installation:
1. Open Disk Utility by pressing ⌘+Shift+U from within the Finder (to open a Finder window directly in the Utilities folder) and double-clicking its icon.

2. Choose the drive that contains the files with permissions problems.

3. Click the Repair Disk Permissions button in the lower left portion of the First Aid tab, as shown in Figure 21.5, and follow the instructions given by Disk Utility.

**FIGURE 21.5**

Repairing permissions can be done with Disk Utility, even when booting from the Leopard installation disc.

---

**Maintenance and Troubleshooting Utilities**

There are some fantastic third-party utilities in the Mac software universe that can save your hide if you’re having severe system difficulties. Mind you, I have used all of the utilities I mention here, and all are worth trying out.
Disk utilities

Disk utilities perform a wide range of functions, from repairing damaged files on your hard drive to rescuing files you accidentally deleted, and there are several that I highly recommend. For my money, the four best utilities for discovering and repairing disk issues are:

- Alsoft DiskWarrior (www.alsoft.com/DiskWarrior/)
- Prosoft Drive Genius (www.prosofteng.com/products/drive_genius.php)
- Prosoft Data Rescue (www.prosofteng.com/products/data_rescue.php)
- Micromat TechTool Pro (www.micromat.com)

Virus-proof your Mac

Antivirus applications for the Mac do indeed exist, to the surprise of some. To be honest, there hasn’t been a serious virus threat on the Mac for a very long time, although minor ones may creep up from time to time. There are several feasible reasons why this is so, but no matter the reason, it is a fact. This doesn’t mean that virus protection is not a wise idea, especially if “better safe than sorry” means anything to you. Here are the “big three” of Mac antivirus applications:

- Norton Antivirus (www.symantec.com)
- McAfee VirusScan for Mac (www.mcafee.com)
- Intego VirusBarrier X4 (www.intego.com/virusbarrier)

Check the Web sites for fees and other information.

Maintain your Mac

Mac OS X Leopard is a UNIX-based operating system, and therefore benefits from being able to run UNIX maintenance scripts, which are already installed unbeknownst to you until now (does that mean they are now knownst to you?). Maintenance scripts keep the UNIX system running right by removing system logs and temporary files, clearing old information in the process, and they also make backups of important databases needed to ensure Mac OS X’s ability to operate properly.

See Chapter 19 for more information about UNIX.

There are three individual scripts, each of which performs its designated set of tasks. These scripts run in the background in daily, weekly, and monthly cycles, which means you should never really notice that they are working. They are designed to run between 3:15 and 5:30 a.m. local time, which means they probably don’t get to run very often because your Mac is most likely asleep or turned off at that time of day. The best option is to run those scripts yourself, but the only way to do this with Mac OS X is to use the Terminal and launch the script commands from there. I doubt
most of you really want to touch the Terminal if you don't have to, so there's good news in this scenario: You don't have to! There are several good third-party utilities available for you to download that can do the job using a graphical user interface, and all are free:

- OnyX, shown in Figure 21.6 (www.titanium.free.fr/pgs2/english/onyx_leopard.html)

**FIGURE 21.6**

OnyX is my favorite maintenance tool for Mac OS X, but it can do a great deal more.

---

TIP

OnyX can do much, much more than just system maintenance, however. Explore OnyX to discover all the cool things it can do for you, such as clearing the multiple caches on your hard drive to free up more space and offering access to hidden features of the Dock and other apps—all for free!

- MacJanitor (http://personalpages.tds.net/~brian_hill/macjanitor.html)
- Cocktail (www.maintain.se/cocktail/index.php)
System Profiler

Leopard ships with a great utility called System Profiler. System Profiler does just what its name implies: It profiles every aspect of your system, giving you the lowdown on the hardware and software your Mac deals with every day. This can be extremely helpful in some troubleshooting scenarios or when you're simply trying to find out what your Mac is capable of. To open and use System Profiler:

1. Press ⌘+Shift+U from within the Finder to automatically open a window to the Utilities folder.
2. Find the System Profiler icon and double-click it.
3. Select items from the categories on the left side of the System Profiler window to explore your Mac's hardware and software information.

The System Profiler window lists everything you need to know about your Mac's hardware and software.

Starting from Scratch

There comes a time in every person's life when you just simply have to start over. If the tips and techniques I've discussed up to now haven't resolved your woes, starting over may be your only alternative.

**CAUTION** Don't take my word for it if you don't feel comfortable doing so! I always suggest you contact Apple first if you have any doubts whatsoever about reinstalling your operating system and all that it entails. "What does it entail?" you ask. You will completely erase your computer's hard drive and will start with a completely new installation of Mac OS X. Backing up might be a good idea at this point, too, if at all possible!
You have two options when reinstalling, one of which may not require you to lose everything. You can attempt to reinstall Mac OS X without erasing the disk, which will only install Mac OS X and the software that comes with it. The other option is to completely erase the disk.

To reinstall Mac OS X and all the software that was bundled with your Mac, preserving other third-party software and your home folders, insert your Mac OS X installation disc and double-click the Install Mac OS X and Bundled Software icon. Follow the instructions to reinstall the operating system and bundled software.

If that doesn't take care of the problems, completely erasing the disk is your only option. As before, insert the Mac OS X installation disc and double-click the Install Mac OS X and Bundled Software icon. Follow the instructions until you get to the Select a destination window, click Options, and then click the Erase and Install button.

For more help on completely reinstalling Mac OS X, please review Apple's support site at www.apple.com/support.

Helpful Resources

Of course, your second recourse for troubleshooting help (besides this book) should be Mac OS X's built-in help functions. Choose Help☞Mac Help from the menu while in the Finder to see all there is to discover within Leopard itself.

There are also a lot of Web sites out there dedicated to the Mac, but I've given you a short list here of sites that can help you get the most information regarding troubleshooting, maintaining, and learning more about the inner workings of your Mac (I even include some of the must-read Mac news sites):

- Apple's support site should be your first stop (www.apple.com/support)
- MacFixIt (www.macfixit.com)
- Mac OS X Hints (www.macosxhints.com)
- Accelerate Your Mac (www.xlr8yourmac.com)
- AllMac (www.allmac.com)
- iFixit (www.ifixit.com)
- Macworld (www.macworld.com)
- MacInTouch (www.macintouch.com)
- The Mac Observer (www.macobserver.com)
- MacNN (www.macnn.com)
- TidBITS (www.tidbits.com)
Summary

In this chapter you've learned many helpful tips and tricks for assisting your Mac when it's going through a difficult time, such as utilizing a troubleshooting account and running maintenance software. I've also introduced you to some of the Internet's most popular Mac Web sites, which can provide you with even more troubleshooting resources.
This chapter is all about saving the important data on your computer so that you don't lose it. When you put funds into a savings account, you are essentially protecting that money from getting lost or spent on something other than what it was intended for. When you back up, or save, your information, you are protecting it as well, whether from yourself, someone else, or the Mac itself.

In this chapter we'll explore Time Machine, Apple's simple-to-use backup utility that ships as part of Mac OS X Leopard. I'll show you how to set it up and keep it going to make sure you don't lose any files. And if Time Machine isn't your cup of tea, I'll tell you about some third-party backup utilities as well.

Why and What to Back Up

This section of the chapter is for those of you who can't think of a good reason to take time regularly to back up, or for those who aren't certain what files they should be backing up.

Why back up?

What if your home burned to the ground and you lost everything inside? All of your family photographs were gone. Insurance papers and financial documents were completely destroyed. Heirlooms that have been passed down to you from several generations won't be passed down to your children. The books you've always loved to read were some of the first items to go up in the flames. Sentimental items such as your wife's wedding gown or your grandmother's Bible are gone forever. That's a horrific scenario that would break anyone's heart and spirit, but it's a reality of life that many face.
What do you think happens when you lose all the data you’ve stored on your computer? If you are like most computer users today, you have many important and precious items on your Mac: family photos that you can’t replace, tax documents and bill statements, important e-mails from close friends that mean as much to you as if they were written on the finest parchment, digital movies of family events, and the like. In our digital world we keep many of our most treasured items in one digital form or another, and losing them because of a computer crash can be devastating, because once they’re gone you cannot get them back. While the experience of a house fire may be far more traumatic than a computer crash, the weight of the material items lost can be very significant. However, unlike a house fire, your lives aren’t in danger and there is a way to avoid losing everything even if your Mac goes down the tubes: It’s a little technique called backing up.

Backing up is simply saving copies of your files. You can’t make copies of your home and its belongings, but you can make copies of items on your computer. Backing up is simply a task that you must do, or you may pay the consequences of your inaction sometime down the road.

If you do experience a crash and don’t have backups, you may have one last hope. There are some third-party disk recovery applications on the market that may be able to save some or all of your data, or you can take your Mac to a computer professional and pay a very hefty sum to have him attempt a recovery for you.

What files should you back up?

A question I often field is what files a Mac user should back up. The easy answer is anything that’s important to you. I don’t say that to be smart, but to emphasize that if you care about the files at all, back them up.

Can you back up an entire system if you like? Well, sure, but there’s no real need to do so for 99 percent of users. The only reason I can think of for such a backup would be that you were planning to copy the same configurations on multiple Macs (be sure you have the proper number of licenses to do such a thing!).

The most important folder for you to back up is your home folder. Your account’s home folder contains all your e-mails, Internet bookmarks, iPhoto pictures, iTunes libraries, iMovie projects, application preferences specific to your account, your Documents folder, and much more. This one is pretty essential to back up, to say the least.

If you have any other folders that you created at the root level or in other directories besides your home folder, you will most likely want to back them up, too. There’s no real need to back up any other folders on the system because they can be restored with another installation.

See Chapter 21 for more information on reinstalling Mac OS X.
Discover Time Machine

Leopard is chock-full of great features, but Time Machine is one of the best functional additions to the Mac OS in a long time (in my humble opinion). Time Machine backs up your Mac behind the scenes, saving any new or changed files while leaving unmodified files alone. This preserves your older files while making backup times much shorter by concentrating only on files that have changed. The first time that Time Machine backs up your files may take quite a while, but every backup after that is transparent to you, unless you perform a manual backup.

The simplicity of Time Machine is its real appeal. Set it up and forget it; your files are still backed up on time, every time. This is one heck of a utility.

Using a disk to store backups

Time Machine can use a disk to back up your files, whether the disk is external, internal, or somewhere else on your network.

Hardware requirements

Time Machine needs disk space to save your backups to. The rule of thumb, regardless of which configuration you use, is to make certain you have enough free space on the disk to back up all of your data. Here are the three configurations that Time Machine can utilize to back up your data:

- An external hard disk is the best recommendation I can make. Don’t skimp on the size of the drive; the bigger the better.
- A file server or backup server is a good idea for larger networks.
- A partition on your Mac’s main hard drive can be used if the drive has already been partitioned. When you partition a drive, you divide its free space into several sections, which causes the computer to see the disk as multiple disks. This is not the best way to go at all! If your hard disk ever fails, you will lose all your data, even the backups.

Set up a backup disk

Before you can begin making backups, you must be certain that your hard disk is formatted properly and that Time Machine is aware of its presence on the Mac.

**CAUTION** Make certain you have copied any data that you don’t want to lose off of the disk if it is one you have used in the past. Once you format it, all the data will be gone for good.

Formatting a hard disk

formatting a drive is the first thing you should do before it can be used with Time Machine. To format a disk means to get it for use by adding a file system to it. Formatting a new disk is always a good idea, whether you are using it with Time Machine or not. To format the disk:
1. Open Disk Utility by pressing \( \text{Strg} + \text{Shift} + \text{U} \) from within the Finder to automatically open a Finder window in the Utilities directory, and then double-click the Disk Utility icon.
2. Connect the disk drive to your Mac with USB or FireWire.
3. Highlight the disk drive in the list on the left of the Disk Utility window.
4. Click the Erase tab near the top of the window, as shown in Figure 22.1.

**FIGURE 22.1**
The Erase tab is where you format the disk for use by Time Machine.

5. Choose Mac OS Extended (Journaled) from the Volume Format popup menu. This is a must; no other format will work with Time Machine.
6. Give the formatted volume a name in the Name field.
7. Click the Erase button, and then click the Erase button again in the verification window.
8. Click the Eject button in the Disk Utility toolbar when the format is complete, and disconnect the hard disk from the Mac.

**Tell Time Machine about the backup disk**
The first time you connect an external disk to your Mac, Time Machine uses its sixth sense to find it and asks you if you want to use this disk to back up your files. Be careful here! Should you click Yes, Time Machine will set up the disk automatically and will basically highjack the disk. You won’t be able to use the disk for anything but Time Machine backups, so if that’s not your intention, you want to click No. If you planned to use this disk solely for Time Machine backups, by all means click Yes and be done with it.
If you did click No, you will want to manually set up the drive for use by Time Machine. Open Time Machine's preferences, shown in Figure 22.2, by clicking the Apple menu and choosing System Preferences, and then clicking the Time Machine icon in the System category.

**FIGURE 22.2**
Set up a backup drive using the Time Machine preferences pane.

Follow these steps to set up the drive for Time Machine:

1. Connect the disk to your Mac and click No if Time Machine prompts you to use the disk for backups.
2. Click the Choose Backup Disk button.
3. Choose the disk from the menu, as shown in Figure 22.3.

**FIGURE 22.3**
Choose the disk you want to use for backups.
Before you click the Use for Backup button, I need to give you a little heads-up. You need to decide at this point if you want to back up everything on your system or only certain files and folders. Be sure to read step 5 before you perform step 4!

4. Time Machine starts to count down to the first backup, similar to what is shown in Figure 22.4. If you want to back up everything on your system, you can skip step 5 and just wait for the backup to finish. If you don’t want to back up everything on your system, go to step 5.

**FIGURE 22.4**

The countdown has begun!

5. Immediately click the On/Off switch on the left side of the Time Machine preferences pane to stop the automatic backup process. At this point you need to tell Time Machine what files you do indeed want to back up, which is covered in the upcoming section.

## Tell Time Machine what to back up

Time Machine will automatically back up all your information unless you tell it otherwise. Sometimes you may need to back up only a few folders, or you may want to use your hard drive for something other than just Time Machine backups. Time Machine works a little differently than you might expect; instead of telling it what you want it to back up, you tell it what you do not want it to back up. To manually tell Time Machine what folders you want to back up, do the following:

**NOTE** Time Machine should be set to the Off position in its preferences pane before beginning. Clicking the On/Off switch will turn it on or off.

1. Click the Options button in the preferences pane.
2. Click the + button on the left side of the Do not back up window.
3. Browse your computer and select the folders and files that you do not want to be included in your backups, and then click the Exclude button. This adds the items to the
Do not back up list, as shown in Figure 22.5. Click Done when you are finished excluding folders from the backup process.

**FIGURE 22.5**

Remember, this is the list of files you don’t want backed up, not what you desire to back up.

Working with your backups

You aren’t relegated to just sitting back and twiddling your thumbs if you prefer a more hands-on approach to your backups. You can view the progress of a backup currently taking place, back up your files manually, and even pause and resume backups in progress.

Viewing the progress of a currently running backup is easy enough. Simply open the Time Machine preferences pane to see the progress of a backup procedure, as shown in Figure 22.6.
Manually back up your stuff
While letting Time Machine perform automatic backups is certainly convenient, sometimes you need to do a backup on your own time. Time Machine keeps hourly backups for the past 24 hours, but if a backup an hour doesn’t fit your schedule, you can always do it yourself. Here’s how:

1. Click the Apple menu and choose System Preferences, and choose Time Machine from the System Category.
2. Click the check box next to Show Time Machine status in the menu bar to see a Time Machine icon in the menu.
3. If Time Machine is off, turn it on by clicking the On/Off toggle switch in the preferences pane.
4. Click the Time Machine icon in the menu bar and choose Back Up Now (Figure 22.7).

FIGURE 22.7
The Time Machine menu bar icon makes it convenient to back up when you want to.

An alternative way to do the same thing is to click the Time Machine icon in the Dock. Click and hold the icon in the Dock and choose Back Up Now from the menu.

Pausing and resuming backups
You can pause or stop a backup in progress, and even resume the process again if you want, with Time Machine picking up right where it left off. This is all too easy using the Time Machine menu bar icon again:

1. Click the Time Machine icon in the menu bar.
2. Choose Stop Backing Up, as shown in Figure 22.8.
3. To continue with the backup, click the Time Machine icon in the menu bar again.
4. Choose Back Up Now this time, and the backup will begin again exactly where it left off.
Retrieving backed up information

What good is a backup if you can't or don't know how to retrieve information from it? With Time Machine, retrieving backed-up files is not only a cinch, it's ridiculously cool! Let's check out how to both retrieve single files and how to restore an entire disk's contents.

Restoring single files

What to do if you accidentally delete a file or folder, or make changes to a file that you can't undo? Time Machine makes it simple to retrieve previous versions or current backups of individual files and folders, and does so in one of the neatest ways: by traveling through time! That's right, all you Trekkers: you no longer need a USS Enterprise to slingshot you around the sun to go back in time: Apple makes it much easier and less taxing on your ship's warp drives with Time Machine. Here's how it's done:

1. Open the Time Machine application by doing one of the following:
   - Click the Time Machine icon in the Dock.
   - Choose the Time Machine icon in the menu bar and choose Enter Time Machine (that kind of sounds ominous, doesn't it?).
   - Press Ô+Shift+A to open a Finder window automatically in the Applications folder, and then double-click the Time Machine icon.

2. When Time Machine opens (Figure 22.9), you are flying through space while simultaneously viewing a series of Finder windows that extend off into the universe.

3. You can now zoom through time to find previous versions of your files and folders. To navigate through the Time Machine interface:
   - Select a date from the timeline on the right side of the window.
   - Click the arrows to fly forward and backward through the windows.
   - If you are not in the directory that you need to find a particular file, use the Finder window just as you normally would in a regular Leopard Finder window to browse the contents of your Mac.
4. Browse the files in the Finder window to find the item you want to retrieve and then select it. Select multiple items by holding down the ⌘ key while clicking each item.

5. Click the Restore button in the bottom right of the Time Machine window. Buckle up while the file zooms forward from the past to the present. Close your mouth and continue on to the next section.

**FIGURE 22.9**
Soaring through the galaxy of previous backups

---

**Restoring entire disks**

I would never wish this scenario on anyone, but the chances are good that at some time over the life of your Mac you will have to blow all the data from your hard drive and start everything over from scratch. With the advent of Time Machine, that chore has become infinitely less monotonous. Time Machine can back up and then help you completely restore the contents of an entire disk. This will save you tons of time over reinstalling the operating system and all your applications, and then copying over all your files.

You must first have a backup of your entire Mac; without that you can't restore the entire disk. It's a good idea to make such a backup the first time you use Time Machine, as opposed to backing up individual files and folders.

To restore an entire disk:

1. If it isn't already, connect your backup disk to the Mac and turn it on.
2. Boot your Mac from the Leopard installation disk or from the disks that came with your computer (these disks must be running Leopard; older versions of Mac OS X will not work).

3. Once the Mac boots all the way up, choose Utilities→Restore System from Backup in the menu.

4. Click Continue.

5. Select the backup disk and then choose the backup files you want to restore to your Mac.

6. Follow along with the instructions given you. The entire process can take a while, so just sit back and relax.

Delete files from Time Machine backups
Sometimes you may need to make room on your backup disk by deleting files and folders. If a file has been backed up only once or twice, you can simply open the disk in the Finder and browse the backup files, and then drop the file into the Trash. What if you want to delete all the backed-up versions of a file, though? There could be hundreds of copies, so the method of using the Finder would take much too long and be more tedious than watching Dharma and Greg reruns. Here’s how to delete all the copies of a backed-up file:

1. Open Time Machine and choose an instance of the file or folder you want to delete.

2. Click on the Action menu, which resembles a gear, in the Finder window’s toolbar and choose Delete All Backups of filename (Figure 22.10).
Third-Party Backup Utilities

Time Machine isn't the only tool available for your backup needs, to be sure. There are many very good alternatives to Time Machine, but I must say that none are as simple to use or even come close in the “wow!” department. Of course, if simply and powerfully backing up your files is what you really care about, the “wow!” factor won’t affect your backup solution decisions much, if at all. Here are a few of my favorites for making just such a decision.

Carbon Copy Cloner

Carbon Copy Cloner (Figure 22.11), by Mike Bombich, is a tried, true, and reliable backup utility for Mac OS X. Create bootable backups with ease. Carbon Copy Cloner is free to use until you learn to trust it, at which point you should pony up the $10 donation. Get better acquainted by visiting www.bombich.com/software/ccc.html.

![FIGURE 22.11](image)

Carbon Copy Cloner is a stalwart in the Mac OS X backup market.

SuperDuper!

SuperDuper! is another easy-to-use backup utility, but several features must be unlocked by purchasing the program to use it to its fullest. Downloaded it from www.shirt-pocket.com/SuperDuper/SuperDuperDescription.html.
Personal Backup

Personal Backup, shown in Figure 22.12, is a utility that I enjoy using to synchronize information across disks. Check it out at www.intego.com/personalbackup/.

FIGURE 22.12

I use Personal Backup to quickly sync data across volumes.

Time Capsule

One of Apple’s neatest hardware offerings is their Time Capsule. The Time Capsule is a wireless network router, like Apple’s AirPort, that uses the super-fast 802.11n Wi-Fi protocol for blazing wireless networking speeds. However, a Time Capsule isn’t just another AirPort or other wireless router; it also doubles as a wireless backup hard drive. A Time Capsule automatically and wirelessly backs up your files from any Mac running Leopard. Multiple Macs can back up to the same Time Capsule without the need for any wires at all! Time Capsule comes in both 500GB and 1TB models, so space won’t be a problem. Learn more about Time Capsule by visiting its Web site at www.apple.com/timecapsule/.
What About MobileMe?

MobileMe is Apple's synchronizing service (www.apple.com/mobileme/) that also offers storage space you can use to back up files to. This storage is called an iDisk and is accessible from any computer in the world via the MobileMe Web site. You can store files to your iDisk from one computer, and access those same files from iDisk on another one, and it doesn't matter if it's a Mac or Windows-based PC. MobileMe is certainly cool in many respects, and its iDisk feature is very nice, but I wouldn't recommend it for longtime storage of must-have, can't-lose files.

Retrospect

Retrospect is another one of the longtime players in the Mac backup world. I've enjoyed using Retrospect for years. The current version of Retrospect, 6.1, can be found at www.emcinsignia.com/products/software/retroformac/. However there is a new version called Retrospect X (www.emcinsignia.com/products/software/retrospectxformac/) that you should also look into; it really sounds promising.

Summary

Backing up your files and folders is one of the most important tasks you can perform with your Mac. By now you should have a good handle on backing up those files using Apple's awesomely easy-to-use Time Machine. This chapter has shown you how to designate a hard drive for backing up your files and folders using Time Machine, as well as how to retrieve your backed-up files. There are no excuses for losing any data now, are there?
Part VII

Appendixes

IN THIS PART

Appendix A
Popular Third-Party Applications and Utilities
Appendix B
Gaming on the Mac
Appendix C
Resources
Appendix D
Apple Certification and Training
Appendix E
Glossary
Whether you've just unboxed your shiny new Mac or have just installed the latest and greatest version of Mac OS X, when you first boot up the computer and begin browsing its contents, you may be impressed—and possibly overwhelmed—by the quantity of applications and utilities Apple has seen fit to bestow on their finest customers. Certainly by this point in the book you've learned how to put most of those programs to good use, and some of you may even be asking, "Is this all there is?"

Well, the emphatic answer to that question is a resounding, "No way, my friend!" There are more programs and utilities floating around in the Mac universe than you can imagine. Indeed, most people who have been shackled to their Windows-based PC for most of their life are burdened under the false assumption that there just isn't much software out there for the Mac. The fact is, there is a ton of software for your Mac. Is there as much software written for the Mac as there is for PCs? No. But having said that, how many different applications and utilities do you need to choose from to perform a given job? Two? Ten? One hundred? For example, if you want to find a good third-party FTP client, how many choices do you really need? While there may be only 10 to 20 to select from on the Mac, and many more times that number for the PC, you will find that the quality of third-party applications on the Mac is generally on par or superior to that of their PC counterparts in many respects.

---

**IN THIS APPENDIX**

<table>
<thead>
<tr>
<th>To pay or not to pay?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Where to find great third-party software for your Mac</td>
</tr>
<tr>
<td>Recommended titles</td>
</tr>
</tbody>
</table>
It's incredibly rare to find a task that you need to perform on your Mac that can only be performed on a PC; there is almost always an equivalent Mac software title that can do the same job as a program on Windows. You'll even note that the makers of many applications you've been using on your PC probably have Mac versions available for purchase or download.

In this appendix I'll tell you where to get the best third-party software, and even give you a few of my personal recommendations.

To Pay or Not to Pay?

There are two types of software out there: the kind you pay for and (my personal favorite) the kind you don't. However, this isn't a treatise on what's good or bad about either kind, and I won't get into the "What do you mean by free?" debate.

There are lots of great apps out there, both paid—you purchase it—and free. You may think that paid software is inherently better than free, but you would be mistaken, at least on some accounts. Granted, with paid applications you typically get better support and more frequent updates, and I am certainly not against paying to use a program that is obviously worth the money to pay the developers for their time and effort put forth to make my life easier. Having said that, there are free applications that are maintained frequently and are designed extremely well that are available for many tasks. My advice is to search all the options available to you before deciding on a particular piece of software, and to take advantage of free trials, which most software vendors afford their potential customers.

Where to Find Great Third-Party Software for Your Mac

You can use the trusty Internet to find tons of software for your Mac; there are several good sites for finding what you need. These sites tend to focus primarily on freeware and shareware solutions provided by smaller (but no less talented) developers. In the following sections I'll discuss some of the best software sites for the Mac that you'll find on the Web.

Download.com

CNET's Download.com (Figure A.1) provides a list of the most popular downloads for the Mac, offers advice from the site's editors, and lets other users weigh in with their opinions. To access the Mac software, go to www.download.com/mac-software/.
VersionTracker

VersionTracker (www.versiontracker.com) is a Mac software stalwart that has been one of the most popular Mac sites for years. VersionTracker does exactly what its name implies: It keeps up-to-date with the latest versions and updates of thousands of applications, making it a must-bookmark site.

MacUpdate

MacUpdate is also a bastion of Mac software links and recommendations; it remains one of the most popular and fastest-growing Mac software sites. Unlike most sites of its type, MacUpdate (www.macupdate.com) focuses exclusively on the Mac and iPhone. It even offers software that you can download and install on your Mac to keep track of updates available for software you may already have installed, such as MacUpdate Desktop ($39.95 a year for the service/free trial is offered), shown in Figure A.2.
MacUpdate Desktop automatically keeps you informed of any updates available for your installed software without having to consult a Web site or search for the updates.

**Macintosh Products Guide**

Apple itself has a fantastic site called the Macintosh Products Guide that lists software of every kind with links to the developers’ sites. You can access the Guide by going to http://guide.apple.com/. You can even purchase many of the paid items you find directly from Apple (don’t worry; there’s lots of free stuff there, too). Check it out; this site doesn’t disappoint!

**Other sites**

Here are several other links to sites that cater to and give advice about Mac freeware and shareware:

- Open Source Mac: [www.opensourcemac.org](http://www.opensourcemac.org)
- FreeMacWare: [www.freemacware.com](http://www.freemacware.com)
- Mac Specialist: [http://macspecialist.org/content/articles/essential_apps/](http://macspecialist.org/content/articles/essential_apps/)
- Bestuff: [http://bestuff.com/category/mac-software](http://bestuff.com/category/mac-software)
Popular Third-Party Applications and Utilities

These sites offer reviews and of some of the wonderful and not-so-wonderful software in the Mac universe:

- Macworld: www.macworld.com/reviews.html
- MacReview: www.macreview.com
- Softpedia: www.softpedia.com/reviews/mac/

What about the "big dogs" of software, such as Microsoft and Adobe? Here are the links to those essential developers that most of us run across at some point in our Mac experience:

- Apple: www.apple.com
- Microsoft: www.microsoft.com/mac/default.mspx
- Adobe: www.adobe.com
- Quark: www.quark.com
- FileMaker: http://filemaker.com

Recommended Titles

In this section I'm recommending some of the most popular titles in the major software groups. This is by no means an exhaustive list as there may be some killer apps out there that either I'm not familiar with or I just simply forgot to mention.

Productivity

- **WriteRoom** is an application aimed at the writer in all of us. If you are a writer and you long for the days of the simplicity of a typewriter but like the convenience of digital, you'll love WriteRoom (download it at http://hogbaysoftware.com/products/writeroom). WriteRoom gives you an all-black screen with bright green text, which gives a very simplistic environment conducive to distraction-free writing (Figure A.3).

- **Bento** is a personal database tool created by FileMaker. Download a free trial from http://filemaker.com/products/bento/overview.html.

- **FileMaker Pro** is another database tool from FileMaker, but it is designed for heavy-duty databases. Check it out at http://filemaker.com/products/fmp/.

- **NeoOffice** is an application suite that rivals Microsoft Office and contains word-processing, spreadsheet, and presentation applications. NeoOffice can be accessed at www.neooffice.org.
xPad is a nifty little text editor that integrates features from TextEdit and Stickies into one easy-to-use application. I've begun using it extensively, and I downloaded it from http://getxpad.com/.

**Figure A.3**
WriteRoom harkens back to the days of yesteryear with its barren interface; nothing but the writer and his or her words.

---

**Internet**

- **Firefox** is one of the most popular Web browsers in the world on any platform. I use it extensively and highly recommend it as an alternative to Safari. Get Firefox at www.mozilla.com/en-US/firefox/.

- **Camino** is a Mac-only Web browser that is built for speed and good looks. Camino is a tabs-based browser, like Firefox and Safari, and strives to be the best Web experience for Mac OS X users. Download Camino at http://caminobrowser.org/.

- **NetNewsWire** is a very popular RSS reader, developed by NewsGator (www.newsgator.com/Individuals/NetNewsWire/). NetNewsWire, shown in Figure A.4, gives you the familiar three-pane look that, in my opinion, makes reading RSS an easy and intuitive experience.
Popular Third-Party Applications and Utilities

FIGURE A.4
Get the news double-quick with NetNewsWire.

- **RSSOwl** is another excellent RSS newsfeed aggregator that is platform independent, which gives it the bonus of working and looking the exact same way on all your computers regardless of their operating system. Go to www.rssowl.org to give it a try; it's a real hoot!

- **Mail.appetizer** is a plug-in for Apple's Mail application that displays a notification window showing you a preview of each incoming e-mail. It can be addictive to use. To start your habit, download Mail.appetizer from www.bronsonbeta.com/mailappetizer/.

- **SeaMonkey** is more than just a Web browser; it's a full-featured suite of Internet applications, including a browser, e-mail, chat client, newsgroup client, and an HTML editor all rolled into one. Look into SeaMonkey by visiting www.seamonkey-project.org.

- **DeepVacuum** is a neat utility that helps you download entire Web sites for offline viewing. Grab it at www.hexcat.com/deepvacuum/.

**Multimedia**

- **Miro** is a really cool app that lets you literally turn your Mac into an Internet TV! There are thousands of Internet channels that you can view, making this a near-replacement for your television (there's no ESPN, so I'm not quite ready to toss out my regular set). You can download Miro, shown in Figure A.5, at www.getmiro.com.
VideoLAN is a media player that can play more audio and video formats than you can shake a stick at. It's also a multiplatform app, so you can use it on any computer, regardless of operating system. Acquire VLC (VideoLAN Client) from www.videolan.org.

MPlayer is another great media player that is also cross-platform and boasts the ability to play back a plethora of multimedia files. MPlayer has been a stalwart on other UNIX-based operating systems for quite some time and has recently begun its invasion of Mac OS X. MPlayer can be obtained from www.mplayerhq.hu.

Seashore is a new open source application for basic viewing and editing of images. It is a very good program for the average user who doesn’t need all the bells and whistles of a more professionally oriented package. Seashore, available at http://seashore.sourceforge.net, is still in its early stages, but seems very promising.

Design and page layout

Adobe InDesign is a page-layout application that is very popular with the graphic arts crowd. The only downside is its hefty price tag, but it’s worth every penny if you’re in the desktop publishing business. For more information, go to www.adobe.com/products/indesign/family/.

QuarkXPress is the equivalent of the Hatfields compared to Adobe InDesign’s McCoys. QuarkXPress is a fine page-layout application that is the mortal enemy of said InDesign, but has the advantage of having been around for much longer. Learn more about QuarkXPress at http://8.quark.com/.
- **Scribus**, shown in Figure A.6, is another page-layout application, but it has the distinction of being free to use. Scribus is an open-source project and isn't quite as polished as its paid competitors, but its development is coming along quite nicely and may well be worth checking into, especially for the budget-conscious designer. Get Scribus by visiting [www.scribus.net](http://www.scribus.net).

**FIGURE A.6**
Scribus is an up-and-comer in the desktop publishing field.

- **Adobe Photoshop** is the de facto standard, the Godzilla, the king of all photo-editing software. Photoshop has been around a long time and its capabilities are unsurpassed. Give it a look at [www.adobe.com/products/photoshop/family/](http://www.adobe.com/products/photoshop/family/).

- **GIMP**, or GNU Image Manipulation Program, is an open-source alternative to Photoshop that has been around awhile and gained quite a following. The fact that it’s free doesn’t hurt, either. Take GIMP for a spin by visiting [www.gimp.org/macintosh/](http://www.gimp.org/macintosh/).
Who doesn’t love blasting aliens, throwing touchdowns, saving princesses, and creating their own species of life? How about using a fleet of wraiths to bring down a Protoss base station or winning the World Cup, all from the comfort of your own home or office? If any of these things makes the hair on the back of your neck stand on end with anticipation, you are a gamer. But now that you have a Mac you have to give up gaming on your computer, right? Absolutely, positively not! If you are a former Windows user lamenting the loss of all those great games you amassed over the years, you’ll be happy to know you don’t have to toss them out after all. Use this appendix to take a brief look into the world of gaming on the Mac.

Yes, Virginia, You Can Play Games on Your Mac

Contrary to popular belief in some circles, gaming is alive and well on the Mac. As a matter of fact, the state of Mac gaming is beginning to take on a much rosier outlook than in previous years. True enough, there was a time when Mac gaming was a dying art and only the staunchest of Mac fans even bothered with playing them. There was a dearth of games compatible with the Mac operating system; only a handful of developers actually went to the trouble of writing games specifically for the Mac, and there were just a couple of companies that ported PC games to the Mac. When you went into your local game store, it was a rare thing to actually find a Mac-compatible game on the shelves.
Those days are slowly but surely changing, and no small amount of thanks is owed to Apple's decision to switch from PowerPC to Intel processors in Macs. This move made many developers take a second look at the Mac, and even allows consumers to install Windows on their Macs, which enables them to use their old PC games. Today, a great many of the most popular games are being released for the Mac, usually at the same time as their PC counterparts, and there are tons of games available online for you to download, many of which are free. Games are back on the Mac!

Discovering Mac Games

Now that I've hopefully convinced you that your Mac can indeed do games, where can you find these entertaining titles? Glad you asked! In this section of the appendix I list the best Web sites for finding Mac games, updates to games you already own, demos for games you want to try out before you plunk down some of your hard-earned coin, and game reviews, and I list some of the more popular games out there and where to get them.

Learn more about Mac gaming

These sites are the places to go to find out about the latest and greatest games to hit the Mac platform, as well as tips and tricks to make your games even better.

- As a Mac user, you might be inclined to see what Apple has to say first, and your inclination would be a correct one. Go to www.apple.com/games/ (shown in Figure B.1) to see tons of information about the newest releases, as well as links to other gaming sites and downloads.

- Apple has several other sites that link from their main Games page and that include much more helpful information about gaming on their computers:
  - To gain a general knowledge of Mac gaming, check out www.apple.com/games/gettingstarted/. This page is a great way to learn more about gaming.
  - For discussions on gaming hardware and accessories, visit www.apple.com/games/hardware/.
  - Apple's articles page has a list of featured games, and you can search for games of particular interest to you. The articles page is located at www.apple.com/games/articles/.
  - Visit www.apple.com/games/trailers/ to see trailers of the latest and greatest games on the scene. Yes, games have trailers, just like movies, similar to the one shown in Figure B.2!
Gaming on the Mac

Apple's main gaming page is a relatively new but information-packed resource.

**FIGURE B.1**

Watching the trailer for Call of Duty 4: Modern Warfare

Courtesy of Activision Publishing, Inc.
Appendixes

- Inside Mac Games (www.insidemacgames.com) offers reviews, a store to purchase games, a forum to discuss tips and tricks with other gamers, and breaking gaming news.

- *Mac Life* is a great magazine with a great Web site that contains reviews of the newest games to hit Mac OS X: www.maclife.com/articles/reviews/software/games.

- IGN's Web site, http://mac.ign.com, is chock-full of Mac gaming goodness, including game profiles, reader reviews, message boards, cheat guides, and much more.

- Yet another good site for reviews is Mac Games, oddly enough found at www.macgames.biz.

Where to get your game on

It's time to find out where to download and test drive, or simply purchase, games to fill up your hard drive space, take up your valuable time, and generally have a blast with!

- Our first stop would be the good folks at Apple. Not only can you get your Mac and Mac OS X from them, they've also got the goods on most games. Go to http://store.apple.com/us/browse/home/shop_mac/software/games and you'll find more games than UPS, FedEx, or DHL can pack into a single truck!

- The Mac Game Store is another great site for finding the newest releases and some of the old standbys. Drop by their site at www.macgamestore.com.

- Mac Games and More has, well, Mac games and more. To be more specific, besides just having games, you can see game reviews and learn more about basic Mac usage. Check out their wares at www.macgamesandmore.com.

- Macgamefiles (www.macgamefiles.com) is a site that I've frequented for many years. It's a great place to find demos of games you want to test, as well as get updates for games you may already own.

- MacSoft is a Mac game company that has been around for a quite a while, and you can find such stalwarts as Age of Empires III, Unreal Tournament III, Zoo Tycoon 2, and more at www.macsoftgames.com.

- Blizzard is one of the most popular game developers in the country, with giant titles such as StarCraft (shown in Figure B.3) and WarCraft in their arsenal. Blizzard's site is at www.blizzard.com.
Electronic Arts is another great developer that has bestowed the likes of Madden NFL in all its incarnations, as well as Command & Conquer and others. See their Mac games by visiting www.ea.com. Their newest, and one of the coolest, is Spore (Figure B.4), with which you can create your own species and guide them through the evolutionary process, from the cell phase to the space phase! Learn more about Spore at www.spore.com.

Big Fish Games has tons of games available for download, as well as online games and forums. They proudly proclaim to provide a new game every day on their site, which is www.bigfishgames.com.
FIGURE B.4

Spore is one of the most popular games to come around in a while.

Courtesy of Electronic Arts Inc.
The Mac Bible is the end-all be-all of Mac books, so why would you need any other resource, right? Well, as much as I would love to say "right," I have to say "not quite." While this book is chock-full of information, there just isn’t enough space to print everything there is to know about the Mac.

The world of Mac is replete with other resources that can help you understand topics in more depth than I can provide here, and there are wonderful sites on the Web that can teach you many topics that most books don’t touch upon.

Other Helpful Mac Books

If you purchased this book from your local bookstore, you undoubtedly noticed the plethora of other volumes on the Mac that surrounded it on the shelves (thank you for choosing this one, by the way). The next time you’re browsing the shelves, take a look at those books again and see if any of the titles I’m about to mention are there. These are all great books designed to teach you any number of topics related to your Mac, and some are even interchangeable with PCs. Knowledge is power!
Photoshop CS4 Bible
By Simon Abrams, Stacy Cates, and Dan Moughamian
Wiley, 2009
A comprehensive manual for using Photoshop CS4, this book shows you how to use even the most advanced techniques for dealing with your digital photos.

Illustrator CS4 Bible
By Ted Alspach
Wiley, 2008
This book delivers all the goods on the latest version of Adobe Illustrator. The professional graphic artist will benefit tremendously from the author's in-depth knowledge of the subject.

QuarkXPress 8: Essential Skills for Page Layout and Web Design
By Kelly Kordes Anton and John Cruise
Peachpit Press, 2009
QuarkXPress has been one of the giants of digital publishing for years, and this is a great vehicle for everything from learning the basics of page layout to the intricacies of designing a Web page using version 8.

Photoshop CS4 For Dummies
By Peter Bauer
Wiley, 2008
Here's the perfect beginner's guide to Adobe's premier digital photo-editing software, Photoshop CS4. You will learn how to use one of the most popular applications on the market through simple language and instruction.

Apple Training Series: AppleScript 1-2-3
By Bill Cheeseman and Sal Soghoian
Peachpit Press, 2009
AppleScript is something most Mac users hear about, but are afraid to utilize. AppleScript will make your Mac handle the most tedious of tasks automatically, but you will have to learn how to use it first, and this book is the best one currently available on the subject.
The Bento Book: Beauty and Simplicity in Digital Organization
By Jesse Feiler
Que, 2008
Bento is a wonderful database for your Mac, and this is a great introduction to its multitude of features. You will have your life organized in no time!

Apple Pro Training Series: Color
By David Gross and Michael Wohl
Peachpit Press, 2007
Everything you ever wanted to know about color and how to manage it digitally can be found in this tome. If you have a question about color or color matching, you'll find it in here.

InDesign CS4 Bible
By Galen Gruman
Wiley, 2009
InDesign is another stalwart in the page layout field, and this huge volume provides all the technical ins and outs the professional graphic designer needs to learn at an in-depth level.

InDesign CS4 For Dummies
By Galen Gruman
Wiley, 2008
This is a great beginner's guide to InDesign, and gives even the most graphically challenged a working knowledge of page layout using Adobe's latest offering of its venerable software.

Microsoft Office 2008 for Mac Bible
By Sherry Kinkoph Gunter, Jennifer Ackerman Kettell, and Greg Kettell
Wiley, 2009
This is the definitive guide to Microsoft's Office suite of productivity applications for the Mac, including coverage of Word, Excel, PowerPoint, and Entourage. If you use Office, you must have this book.
iLife '09 Portable Genius
By Guy Hart-Davis
Wiley, 2009
Get intimate with the iLife suite of applications, such as iPhoto, iWeb, GarageBand, and iDVD. Make movies, organize and edit your photos, create Web pages, and more!

iWork '09 Portable Genius
By Guy Hart-Davis
Wiley, 2009
Apple offers an awesome set of productivity applications, such as Pages for document creation and layout, Numbers for spreadsheets, and Keynote for presentations. This book is the perfect companion for learning how to use them to their fullest.

Office 2008 for Mac For Dummies
By Bob LeVitus
Wiley, 2008
This book provides a really nice introduction to Office 2008, Microsoft's latest offering of productivity applications for the Mac. The sound instruction and light-hearted style make it a joy to read.

Dreamweaver CS4 Bible
By Joseph W. Lowery
Wiley, 2009
If you need to design Web pages, and you like to do so the WYSIWYG (What You See Is What You Get) way, Dreamweaver is your application. This is the must-have companion for learning all about its intricacies.

Adobe Creative Suite 4 Bible
By Kelly L. Murdock and Ted Padova
Wiley, 2008
This book is a great tool for wrapping your head around all the major applications in the newest version of Adobe's Creative Suite. You will get a hands-on knowledge of InDesign, Illustrator, Photoshop, and Acrobat.
Mac OS X UNIX Toolbox: 1000+ Commands for Mac OS X
By Christopher Negus
Wiley, 2009
Every UNIX geek who works with Mac OS X has to get a copy of this book. I didn’t even know there were 1,000 commands for UNIX!

Apple Training Series: Mac OS X Server Essentials (2nd Edition)
By David Pugh and Schoun Regan
Peachpit Press, 2008
Any system administrator who works with Apple’s Mac OS X Server will appreciate the level of training and understanding offered in this book.

Flash CS4 Professional Bible
By Robert Reinhardt and Snow Dowd
Wiley, 2009
Web designers who use Adobe Flash for their sites will love this book, which covers Flash CS4 at a level not seen in most books of its type.

Mac OS X Internals: A Systems Approach
By Amit Singh
Addison-Wesley Professional, 2006
Although this book is getting a little dated, I still know of no better source for understanding the inner workings of Mac OS X and its components. It’s definitely not for the technically faint of heart, though.

Mac OS X Leopard Portable Genius
By Dwight Spivey
Wiley, 2008
I’m patting myself on the back a bit with this one. This book concentrates on the basics of using Mac OS X Leopard and its accompanying software.
Dreamweaver CS4 For Dummies

By Janine C. Warner

Wiley, 2008

This is a good basic primer for learning how to design your own Web sites using Adobe's powerful Dreamweaver.

Great Mac Web Sites

The Internet is loaded with information about any topic you can think of, and there is certainly no dearth of Mac goodness. You'll find sites for almost any subject you can imagine with your Mac.

http://db.tidbits.com/

Since 1990 this site has been a great place to find Mac news, tips, and reviews. It includes sections on several topics, from business applications to editorial opinions and networking.

http://guide.apple.com/

This is a great resource for finding software and hardware that is compatible with your Mac. Apple provides this site so you can find lots of information in a single spot.

http://macosrumors.com

Another of the great rumor sites, this one has been in my bookmarks folder since the days of Mac OS 8.

http://macscripter.net/

Find all you wanted to know about scripting for your Mac, and more! AppleScript and Automator are favorite topics on this site.

http://mactimeline.com/

A great history of Apple's updates and when they were offered to users, this site probably best benefits the nerdiest of us Mac users (obviously including myself), but I've included it for all the Mac nerds-to-be as well.
http://support.apple.com/specs/
This is the best site for finding the specifications for almost any Apple product. It's an invaluable resource, especially for the techies in the crowd.

www.apple.com
This one's a no-brainer for this book. You'll discover everything there is to know about all of Apple's latest offerings, including software and hardware. There's a wealth of support information, too.

www.apple.com/usergroups/
Would you like to join up with other local Mac users to shoot the breeze about all things Mac? If so, then a Mac user group is for you. Go here to find the Mac user group in your area, and then get involved with the community.

www.appleinsider.com
Rumors are part of life when it comes to being a Mac fan, and this site gets the scoop on most of Apple's future offerings (sometimes seemingly before Apple even knows it!).

www.macfixit.com
Check out this great site for learning about your Mac's hardware, solving hardware issues when they crop up, and finding hardware tutorials to learn how things work on your Mac.

www.macintouch.com
This is a great source for Mac news and reader reviews. This has been one of my favorite sites for years.

www.macnn.com
News, podcasts, reviews, blogs, and forums abound on this premier Mac news site.

www.macosxhints.com
You can't beat this site for great Mac OS X tips and tricks. The friendly folks in the forums are willing and able to help you solve almost any issue you may run into, and some of their tips are priceless.
Macworld is a mecca for Mac folks all over the globe. You can find all sorts of Mac stuff here, from how-to articles to reviews of the newest products. There’s even a bit of iPod and iPhone stuff for you there, too.

Find all the latest updates for your Microsoft applications, and learn how to better use those you currently work with.

The Unofficial Apple Weblog (TUAW) is another good source for the latest Apple news, as well as for helpful tips and tutorials for the Mac OS, iPod, and iPhone.

Find the newest versions of your favorite third-party software, and discover the newest offerings from the best Mac developers around.
Apple provides a top-notch certification and training program for most of its products, covering both software and hardware. It offers a wide range of certification possibilities, each one suited to a particular product or level of service. And let's face it: You can never know too much about your Mac. The main portal to find out more about these programs is http://training.apple.com/certification/. Here's a brief look at the training offered by our friends at Apple.

Pro Applications Certification

(http://training.apple.com/certification/proapps)
Learn Apple's applications inside and out and pass certification exams to become an Apple Certified Pro for that specific application. Then you can work your way up the certification path to become a Master Pro, and eventually an Apple Certified Trainer or Master Trainer.

Apple Certified Pro
There are two certification levels for the Apple Certified Pro. Level One certification confirms that you have a basic knowledge of the particular application, while Level Two certification tells the world you command a deeper understanding of the application.

Apple Certified Master Pro and Master Trainer
Apple offers two versions of the Final Cut Studio and Logic Studio Master certifications: end user and trainer Master certification confirms that you have a superior knowledge of a chosen set of applications.
Appendixes

Apple Certified Trainer
You can learn how to administer Apple’s Pro certification courses by becoming an Apple Certified Trainer. You must submit an application to begin the process of becoming an Apple Certified Trainer.

Apple Certified Media Administrator
Apple Certified Media Administrators command an in-depth knowledge of Apple’s Xsan server architecture and can install and configure systems and networks.

Apple Certified Support Professional 10.5
(http://training.apple.com/certification/acsp)
This certification attests to the fact that you understand the basics of using Mac OS X, and have demonstrated the ability to assist other users with standard troubleshooting and usage of applications.

Apple Certified Technical Coordinator 10.5
(http://training.apple.com/certification/actc)
If you need to manage a small network of Mac systems, including Mac OS X and Mac OS X Server, this is the certification you need. You must have a core understanding of both the standard OS and the server version to complete certification.

Apple Certified System Administrator 10.5
(http://training.apple.com/certification/acsa)
An Apple Certified System Administrator has a vast working knowledge of Mac hardware and software, and the ability to maintain and troubleshoot multiplatform networks, integrate Macs into the network, troubleshoot at the deepest levels, and manage the network at an administrator’s level.

Xsan and Media Administration Certifications
(http://training.apple.com/certification/xsan)
Apple’s Xsan products offer data sharing at a high level, and anyone attaining certifications for Xsan and Media Administration will be able to handle multiple Mac Desktop and Xsan systems; be able to understand, set up, and administer RAIDs; and have knowledge of installation and usage for Apple’s line of Pro applications.
iLife and iWork Associate Certification
(http://training.apple.com/certification/associate)
Show the world (and current or prospective employers) that you have an insider's knowledge of using the applications included with Apple's iLife and iWork suites.

Apple Certified Macintosh Technician Certification
(http://training.apple.com/certification/acmt)
An Apple Certified Macintosh Technician (ACMT) certification affirms that you are capable of troubleshooting and resolving issues with Apple hardware. An ACMT will demonstrate a technical proficiency with all Apple products, including desktops and portables.
Address Book Application for maintaining lists of personal contacts and their pertinent information, such as their phone number, e-mail address, street address, and relevant Web pages.

administrator A powerful user account that has the ability to make permanent changes to your Mac's operating system. An administrator can perform many functions, including (but not limited to) creating and deleting other user accounts or other administrator accounts, installing software for system-wide use, installing device drivers, and the like.

AFP Apple Filing Protocol. A network protocol used to share files and network services among Mac computers.

AirPort Apple’s range of wireless networking products. AirPort uses the industry standard 802.11 protocol.

AppleTalk A networking protocol developed by Apple for communications among computers, servers, printers, and any other devices running the protocol. A hallmark of AppleTalk is its ease of use.

application Software that you can install on your Mac. Applications are designed with specific purposes in mind, such as word processors, Web browsers, e-mail clients, page layout, and so on.

Aqua The user interface theme designed by Apple used as the default for Mac OS X.

backup The process of creating copies of your data. Having recent backups prevents losing all of your information should your Mac experience serious hardware problems.

Bonjour A service discovery protocol implemented in Mac OS X. Formerly known as Rendezvous, Bonjour allows for the automatic discovery of other devices running the protocol. There is no setup needed; devices running Bonjour simply discover one another and can then share services. For example, a Mac running Bonjour can discover and print to a printer that’s also running Bonjour, without having to know the printer’s IP address.
BSD Berkeley Software Distribution. UNIX-based operating system that was developed by the University of California, Berkeley. Mac OS X runs on a derivative of BSD called Darwin. See Darwin.

Carbon A set of APIs (Application Programming Interfaces) that allows a developer to write applications that can run on Mac OS X as well as earlier versions of the Mac OS.

CD Compact disc. CDs are one of the most common media formats today, and are great for storing information portably. We most commonly associate CDs with music, but you can also store computing information on them.

Cocoa A set of APIs (Application Programming Interfaces) that helps developers write programs specifically for Mac OS X. Cocoa applications can be created with a great set of tools provided by Apple, and can implement services that allow them to integrate with other applications that are installed.

ColorSync Apple’s color management technology that uses other industry-standard technologies, such as ICC profiles, to keep color consistent among applications, your Mac, and input (scanners and cameras) and output (displays and printers) devices.

Command key The Command key is located next to the spacebar on the keyboard. This key can be used in conjunction with other keys to perform certain tasks. For example, pressing $\text{⌘}+P$ causes an application to open its print dialog box.

Command-line interface A text-only interface used to display information for the user and to send commands to the computer.

compression The process of making a file, or a folder containing many files, smaller in data size.

CPU Central Processing Unit. Every computer contains a CPU, which is the microprocessor that executes the commands given to it by the user or the operating system. Today's Macs use Intel processors for their CPUs, whereas older models used the PowerPC processor developed by Apple, Motorola, and IBM.

CUPS Common UNIX Printing System. The printing system used by most UNIX-based operating systems, including Mac OS X. Apple purchased CUPS in 2007.

cursor The arrow that moves when you reposition your mouse. The cursor is essential for knowing where you are on the screen and what objects you will interact with if you click your mouse button.

Darwin The name of the flavor of BSD UNIX that Mac OS X is based on. Darwin is developed by Apple and is the core of your Mac's operating system services, such as networking and file systems.

Dashboard An application that runs other mini-applications, called widgets. Dashboard can be accessed by pressing the F12 key on your keyboard or clicking its icon in the Dock.
Device Driver 
Software developed by a hardware device’s manufacturer that allows the operating system to interact with that hardware.

DHCP 
Dynamic Host Configuration Protocol. A protocol used to automatically assign IP addresses to client computers in a network environment.

directory 
Most commonly used as another name for a folder.

disk image 
A file that acts exactly like a physical disc would on your Mac. Disk images are created by Disk Utility, and you can place items into it just as you would any other directory. Many application installers that you download from the Internet use disk images to transport their data. Disk Utility will mount disk images just as it would an actual CD, DVD, or hard drive.

Dock 
Located at the bottom of your screen, the Dock is a great place to store links to items or applications you use more frequently than others.

Drop Box 
A directory in your home folder that can be used by others on your network to share files with you. They can drag-and-drop files into your Drop Box, but cannot view its contents.

DVD 
Digital Versatile Disc. Discs used for data storage. Their capacities are much greater than that of CDs.

e-mail 
Electronic mail is one of the most popular forms of communication today. It's used for sending messages and data to other computer users in lieu of traditional mail.

Ethernet 
The most common network standard in use today, Ethernet links computers together via a system of cables and hubs, or routers. Data transmission speed can range from 10 to as fast as 1,000 megabits per second, depending on the cabling and hardware used.

Exposé 
Allows the user to press the F9 key to see all open windows at once, F10 to see only the windows associated with the currently active application, or F11 to hide all open windows.

file 
Simply a container for information. Think of it as a modern digital equivalent to a paper document.

file system 
Method of storing and organizing files on a storage device, such as a hard disk or CD. Mac OS X supports many different file systems, but its default is HFS+.

Finder 
The one application that you can interact with that is running all the time on your Mac. The Finder is what you use to navigate your Mac’s disks for files, folders, applications, other volumes, and so on.

Firewall 
Software that protects your computer or network from outside intrusion.

FireWire 
A high-speed serial bus standard developed by Apple for the speedy transmission of large amounts of data. Also known as IEEE 1394, FireWire is cross-platform and can transmit between 400 and 800 megabits per second, depending on which version your Mac's hardware supports.
Appendixes

**font** A complete set of characters for a particular typeface that defines how the typeface appears on the Mac's display and on printed documents.

**FTP** File Transfer Protocol. An IP protocol used for transferring, creating, and deleting files and folders located on an FTP server.

**HFS+** Hierarchical File System. The default file system for Mac OS X, which uses a hierarchical system for storing and organizing files and folders.

**home directory** This is the directory that contains all of a user's personal documents and files. Every user account created on your Mac is assigned a home directory. These directories are located in the Users folder at the root of your hard drive.

**HTML** HyperText Markup Language. The programming language used to render the graphics and text of a simple Web page.

**HTTP** HyperText Transfer Protocol. A protocol responsible for linking and exchanging files on the Internet.

**IP** Internet Protocol. A protocol that delivers packets of information from one host computer to another based on each host's unique address.

**IP address** Internet Protocol Address. Uniquely identifies a device on a network so that it can exchange information with other devices on that network.

**Java** Cross-platform software development environment used on most computer operating systems and many handheld devices. Java is also frequently used to display dynamic information on Web pages.

**JPEG** Joint Photographic Experts Group. Perhaps the most common format for pictures on computers and the Internet. JPEG can compress the data size of the image while still retaining reasonable image quality.

**kernel** The central component of Mac OS X's UNIX underpinnings. Its main responsibility is the management of the system's resources. The kernel makes sure that each process running is allocated the proper amount of computing resources, such as memory, needed to complete its task.

**LAN** Local Area Network. Network that is confined to one particular area, such as in a small office or home business.

**LPD** Line Printer Daemon. An industry-standard protocol for printing via TCP/IP over a network.

**Mac OS X** Pronounced Mac Oh-Ess Ten, this is the default operating system developed by Apple for use on their Mac computers. Mac OS X 10.5, also known as Leopard, is the latest iteration of the operating system as of this writing.

**Mail** Mac OS X's default e-mail application. Mail can handle multiple e-mail accounts of varying protocols, such as IMAP, POP, and even Exchange.
mouse An input device for your Mac. The mouse controls movement of the cursor on the screen, and also facilitates the launch of applications, the opening of documents, and the placement of files using its buttons.

MP3 The most popular format for music files.

network A collection of computers and other devices (such as printers) that communicate with one another through a central location, or hub.

open source The software development method that allows for free access to source code, and the modification and redistribution of the code.

OpenGL Developed by Silicon Graphics, OpenGL is a cross-platform application programming interface (API) used for producing two- and three-dimensional graphics.

partition A portion of a hard drive’s space that has been separated from the rest of the disk. Your Mac will view each partition as a separate hard disk, and you can use the partition for anything you want, such as installing Windows or storing particular types of files.

PDF Portable Document Format. Created by Adobe Systems, PDF is a cross-platform file format mainly used for the distribution of documents.

permissions Every file and folder on your Mac is owned by a user account. Permissions are access rights given to the owner and other users of the Mac. Without the right permissions, another user may not view or access the file or folder owned by another user.

Preview An application that ships with Mac OS X that is used for viewing PDF files and images. Preview is capable of opening more than 25+ file formats, including almost all of the popular image formats.

printer queue Stores print jobs for your printers. Whenever you print a document, the print data goes to the printer queue that was created when you originally installed the printer on your Mac. The printer queue passes the data from Mac OS X to your printer. If there is a problem, the print data will be stored in the printer queue and wait until such time that it can resume printing.

protocol A set of standards or rules that govern the communication of information between two computers.

Quartz A graphics service in Mac OS X responsible for rendering two-dimensional graphics.

QuickTime Apple’s default multimedia framework designed for the creation and handling of various digital media formats in the areas of video, sound, and animation.

RAM Random Access Memory. Chips with integrated circuits that are used to store information on your computer. Whenever you use information on your Mac, it is stored in RAM for lightning-fast access. Your computer can never have too much RAM, so it’s not a bad idea to install the maximum amount your particular Mac can support.
Safari Mac OS X's default Web browser. Safari, which has recently ventured onto Microsoft's Windows operating system, is fast becoming a popular alternative to Microsoft's Internet Explorer.

Server A computer whose function is to provide a variety of services to other computers, such as file and printer sharing. There are many types of servers providing their own unique services; for example, mail servers provide storage and retrieval of e-mail for clients.

SMB Server Message Block. Protocol used primarily by Windows computers for accessing shared files, printers, and other network services. Mac OS X has the built-in ability to communicate with Windows-based PCs through SMB.

SMTP Simple Mail Transfer Protocol. Protocol that is used mainly for sending e-mail, but rarely for receiving e-mail.

Spaces An application that allows you to work with multiple desktops on which you can run applications and view documents. You can use each space for a different task, which is a good way to keep yourself organized.

SuperDrive Apple's term for an optical disc drive that is capable of reading and burning both CDs and DVDs.

System folder Located at the root of the hard drive, this folder contains the core components needed to boot your Mac system and run it efficiently after the boot process occurs. Your Mac will not be able to boot correctly if this folder is tampered with (such as by changing its name), so it's best to steer totally clear of this folder.

TCP/IP Transfer Control Protocol/Internet Protocol. Set of industry-standard protocols used for communications via the Internet. TCP's job is to keep up with the packets of data being sent, while IP is the actual vehicle for delivering the packets.

Terminal A program used for accessing the command-line interface of Mac OS X.

URL Uniform Resource Locator. Used to point to a specific file on a computer that either resides on a network or on the Internet. URLs are the addresses you type into the address field of your favorite Web browser. The beginning of the URL states the protocol needed to access the file (such as HTTP or FTP), the next part is the IP address, computer name, or Web site name where the file is located (such as www.apple.com, 127.0.0.1, or dwightsmac), and the last part is a hierarchical location for the file (such as /support.html or /hard_drive/users/Dwight).

User accounts Every person who uses your Mac needs an account to access personal files and folders, and these are called user accounts. Each user account contains folders dedicated to that user alone, and no other users, even administrators, can access them without permission.
utility Utilities are software applications dedicated to managing and tuning your Mac's software and, to some degree, hardware. Each utility has its own specialty; for example, Grab's function is to capture screen shots, and that's all it does. Some utilities may perform a variety of tasks, but the tasks are designed around a specific theme, such as Disk Utility, whose functions pertain to disks (formatting, mounting, and so on).

virtual machines Software files that virtualization applications, such as Parallels Desktop for Mac or VMware Fusion, recognize and utilize as if they were separate computers. You can install virtually any Intel-based operating system on your Mac using virtual machines. The virtual machine runs within Mac OS X, allowing you to use Mac OS X and the OS on the virtual machine at the same time.

VPN Virtual Private Network. A private network that utilizes software and IP protocols to remotely communicate via the Internet. A good example of how a VPN can be useful is when it allows a user to access his or her company's network while traveling.

WAN Wide Area Network. WANs are networks that span facilities in separate geographic locations.

widgets Mini-applications that are launched with Dashboard. Widgets typically concentrate on one particular task, such as local weather, movie show times, sports scores, recent news, and the like.

World Wide Web System of interlinked documents and servers that can be accessed via the Internet. World Wide Web is what the “www” stands for in the address of a Web page.

XML Extensible Markup Language. An open standard specification for creating documents that contain structured information. XML is used quite extensively on the Web and is becoming increasingly used for electronic publishing.
NUMERICS
7xz compression utility, 428
802.1x protocol, 131
802.1x tab, AirPort, 137

A
About application name option, 481
Academy Engraved LET Plain: 1.0 font family, 75
Accelerate Your Mac Web site, 487
Accept cookies option, Safari, 414
Account Information tab, Mail, 384
Account Setup window, iChat, 431
Account Summary window, Mail, 376
Account Type popup menu, iChat, 431
accounts. See also user accounts
Entourage, 402-404
iChat, 431
iTunes Store, 363-364
Mail, 374-378
Thunderbird, 397-401
troubleshooting, 475
Accounts preferences pane, System Preferences, 111-115
Accounts section, Mail, 382-384
Acrobat, 524
Action button, Mail, 379
Action menu, Time Machine, 499
Actions button, TextEdit, 192
activating widgets, 55-56
Active Screen Corners option, Exposé, 62-63
Add a new calendar feature, iCal, 249
Add a sheet option, Numbers, 217
Add bookmark option, Safari, 411
Add Events window, iCal, 252
Add invitations to iCal option, Mail, 381
Add Printer window, Mac OS X, 270, 273
Add Rule button, Mail, 389
Add Selection to Project button, iMovie, 332
Add source, iPhoto, 295
Add To Sidebar option, Mac OS X, 30, 45
Address Book application
contacts, 254-257, 395-396
defined, 533
groups, 254-256
setting preferences, 257-258
Address Book Archive format, 257
Address field option, Safari, 411
Adium chat client, 440
Adjust icon, iPhoto, 311, 316
Adjust This Slide window, iPhoto, 307
Adjustment window, iPhoto, 312
administrator (admin) accounts, 110, 533
Adobe Acrobat, 524
Adobe Creative Suite 4 Bible, 524
Adobe Flash, 525
Adobe Illustrator application, 522, 524
Adobe InDesign page-layout application, 512, 523-524
Adobe Photoshop application, 284, 513, 522, 524
Adobe Web site, 509
Advanced button, Bluetooth preferences pane, 94
Advanced section, iTunes
Burning tab, 358
General tab, 355-356
Importing tab, 356-357
Advanced tab
Finder, 41-42
Mail, 384
QuickTime preferences pane, 101
Safari, 415
Terminal, 450
AFP (Apple Filing Protocol), 157-158, 533
AIM (AOL Instant Messenger), 430, 440
AirPort, 137, 533
AirPort Card, 133
AirPort Extreme, 10
AirPort Extreme Card, 133
AirPort status menu, AirPort, 136
AirPort tab, AirPort, 134–135, 137
alarm option, iCal, 254
Album artwork/Video viewer item, iTunes Jukebox, 345
Album icon, iPhoto, 303
Album view, iTunes Jukebox, 345
albums, iPhoto, 304–305
Alert me if system fonts change option, Font Book, 74
aliases, file and folder, 36–38
aligning text, TextEdit, 188–190
Alignment buttons, Pages, 195
All Events button, iPhoto, 30
All Fonts collection, Font Book, 71
All Pages from option, advanced print dialog box, 280
all-day option, iCal, 253
AllMac Web site, 487
Alsoft DiskWarrior disk utility, 484
Always open folders in a new window function, Finder, 40
Animate opening applications option, Dock, 54
AOL Instant Messenger (AIM), 430, 440
Appearance option, Appearance preferences pane, 86
Appearance preferences pane, System Preferences, 85–87
Appearance tab, Safari, 411–412
Apple
certification and training, 529–531
history, 4
Web sites, 487, 509
Apple Certified Macintosh Technician Certification, 531
Apple Certified Master Pro, 529
Apple Certified Media Administrator, 530
Apple Certified Pro, 529
Apple Certified Support Professional 10.5, 530
Apple Certified System Administrator 10.5, 530
Apple Certified Technical Coordinator 10.5, 530
Apple Certified Trainer, 529–530
Apple Filing Protocol (AFP), 157–158, 533
Apple GarageBand, 367, 524
Apple Master Trainer, 529
Apple menu, 45, 474
Apple Mighty Mouse, 13–14
Apple Pro Training Series: Color, 523
Apple Training Series: AppleScript 1-2-3, 522
Apple Training Series: Mac OS X Server Essentials (2nd Edition), 525
Apple TV, sharing movie projects with, 337–338
Apple TV tab, iTunes, 359
AppleTalk protocol, 150, 276, 533
AppleTalk tab, AirPort, 137
AppleTalk Zone, AirPort, 137
AppleWorks suite, 210, 223
Application Assignments window, Spaces, 65
applications, See also names of specific applications; third-party applications and utilities
defined, 533
troubleshooting, 481–482
Applications folder, 69, 149, 173
Applications tab, iTunes, 366
Aqua user interface theme, 19, 533
Archive Utility, Mac OS X, 427
archived files, 427–428
aspect ratio, 331–332
Assist me button, Network preferences pane, 145
Attach button, Mail, 392
attachments, e-mail
saving, 394–395
sending, 392
attachments option, iCal, 254
attendees option, iCal, 254
Audacity application, 368
audio chat, 434–436
Aurora Desktop picture, 76
Authentication method field, Sharing preferences pane, 164
Authentication option, AirPort, 137
AutoFill tab, Safari, 414
Automatic font activation option, Font Book, 74
Automatic login option, Login Options, 116
Automatic Task popup menu, Image Capture, 286, 321
Automatically hide and show the Dock option, Dock, 54
AutoSum button, Excel, 225

B

B&W effect, iPhoto, 311
backing up
defined, 533
reasons for, 489–490
selecting files for, 490
third-party applications, 500–502
Time Machine
deleting files, 499
manual backups, 496
pausing backups, 496–497
restoring entire disks, 498–499
restoring single files, 497–498
resuming backups, 496–497
specifying what to back up, 494–495
storing backups on disk, 491–494
Balance slider, Sound preferences pane, 99
Battery settings, Energy Saver preferences pane, 96
Bento Book, The: Beauty and Simplicity in Digital Organization, 523
Bento personal database tool, 262–263, 509, 523
Berkeley Software Distribution (BSD) operating system, 443, 534
Bestuff Web site, 508
Bezipped utility, 428
Big Fish Games, 519
Bento Book, The: Beauty and Simplicity in Digital Organization, 523
Browse slider, iTunes jukebox, 345
Burn icon, Dock, 179
Burn Speed option, burn confirmation window, 180
burning data to discs, 178–180
Burning tab, iTunes, 358
Buy Book button, iPhoto, 318
Buy Calendar button, iPhoto, 318
Buy QuickTime Pro button, QuickTime preferences pane, 100
Calculations pane option, Numbers, 217
Calendar icon, iPhoto, 318
Calendar list feature, iCal, 249
calendar option, iCal, 253
calendars
creating, 249–251, 317–319
even, 250
events, 252–254
importing and exporting, 251–252
publishing, 250–251
subscribing to, 252
Calendars option, iSync, 261
Calibrate button, Displays preferences pane, 94
cameras
adding images to, 323–324
deleting images from, 322–323
importing digital images from, 297–299
overview, 16
shared, 173
video, 328–329
Camino browser, 510
CandyBar utility, 81–82
CaptainFTP FTP client, 177
Carbon APIs, 534
Carbon Copy Cloner, 500
carbonChrome theme, LeopardDocks, 81
cd (change directory) command, 445, 454
CDs (compact discs)
burning data to, 178–179
defined, 534
importing music into iTunes from, 349–350
installing applications from, 68–69
CDs & DVDs preferences pane, System Preferences, 94
cells, spreadsheet
entering data, 218–219
formulas, 219–220
naming tables, 220–221
overview, 217–218
Central Processing Unit (CPU), 458, 534
certification, Apple, 529–531
Change All button, Finder, 37
Change button, iTunes, 355
Change Desktop Background, Desktop & Screen Saver preferences pane, 76
change directory (cd) command, 445, 454
Change Password button, Accounts preferences pane, 114
Change Root Password option, Directory Utility, 447
Change view feature, Keynote, 236
Characters palette, International preferences pane, 89
Change directory (cd) command, 445, 454
Change Password button, Accounts preferences pane, 114
Change Root Password option, Directory Utility, 447
Change view feature, Keynote, 236
Characters palette, International preferences pane, 89
Chart button, Pages, 198
Chart Data Editor window, Pages, 198
Chart option, Pages, 195
charts
Excel, 225
Numbers, 221–222
Pages, 197–199
Word, 204
Charts button, Numbers, 221–222
Charts tab, Excel, 228
chat
iChat
accounts, setting up, 431
adding contacts to Buddy List, 432–433
audio chats, 434–436
making presentations with iChat Theater, 439
overview, 429–431
receiving files in, 438
sending files via, 437
text chats, 434
video chats, 436–437
third-party utilities, 439–440
Check for new mail option, Mail, 381
Check for updates box, Software Update preferences pane, 104
Check Now button, Software Update preferences pane, 105
Cheetah operating system, 49
Choose button, Pages, 193
Choose File button, Mail, 392
Choose master slides feature, Keynote, 236
CLI (command line interface), 444–446, 534
Click in the scroll bar to option, Appearance preferences pane, 86
clips, video, 330, 332–333
Clock tab, Date & Time preferences pane, 103–104
Cocktail utility, 485
Cocoa APIs, 534
collections, 71
Color Matching category, advanced print dialog box, 280
Color tab, Displays preferences pane, 94
Colors option, Pages, 195
Colors palette, Mail, 392
ColorSync option, advanced print dialog box, 280
ColorSync technology, 20, 534
Comma Separated Values (.csv) file format, 223, 231–232
Command key, 12, 534
command line interface (CLI), 444–446, 534
commands, UNIX
change directory (cd), 445, 454
cp, 455
ls, 452–453
ls -a, 453
man, 452
mkdir, 455
mv, 454–455
pwd, 455
rm, 455
rm -r, 455–456
su, 454
sudo, 454
Comment option, Pages, 195
Common UNIX Printing System (CUPS), 267, 534
compact discs. See CDs
Compatibility Report feature, 207, 227, 233
Components site, QuickTime preferences pane, 101
Compose button, iPhoto, 314, 316
Composing section, Mail, 387–388
compressed files, 427–428, 534
Computer Name field, Sharing preferences pane, 154
Computer Settings button, Sharing preferences pane, 160, 163
Conclusion window, iChat, 431
Configure button, Sharing preferences pane, 164
Configure IPv4 option, AirPort, 137
Configure IPv6 option, AirPort, 137
Configure option
AirPort, 137, 139
Speech preferences pane, 106
Configure Proxies option, AirPort, 137
connecting
printers, 268–269
scanners, 283–284
contacts
Address Book, 254–257, 395–396
iChat Buddy List, 432–433
Contacts option, iSync, 261
Delete All Backups of filename option, Time Machine, 499
Delete button, printer queue, 274
Delete mail option, Mail, 378
deleting
  backup files, 499
  files, 38–39
  folders, 38–39
Description window, Format popup menu, 232
Desktop
  changing picture, 76–78
  finding pictures for, 79
Desktop & Screen Saver preferences pane, System Preferences, 76–78
desktop computers
  iMac, 8–9
  Mac mini, 10–11
  Mac Pro, 11–12
Desktop folder, 29
Desktop tab, Desktop & Screen Saver preferences pane, 76
Detect Displays button, Displays preferences pane, 94
determining installable options window, Mac OS X, 272
Develop menu, Safari, 418–419
device browsers, 173
Device Browser window, Mac OS X, 173
device drivers. See drivers
DHCP (Dynamic Host Configuration Protocol), 535
DHCP/BOOTP (Dynamic Host Control Protocol/Bootstrap Protocol), 131
diagnostics button, Network preferences pane, 145
dif (Data Interchange Format) file format, 232
digital cameras. See cameras
digital images
  editing
    advanced, 309–312
    red-eye removal, 309
  exporting
    as files, 312–313
    via e-mail, 313–314
Image Capture
  acquiring images, 320–322
  adding images to cameras, 323–324
  deleting images from cameras, 322–323
importing
  from cameras, 297–299
  from files, 299–301
organizing
  albums, 304
  keywords, assigning, 303
digital images, organizing (continued)
    overview, 301–302
    slide shows, 305–308
    Smart Albums, 304–305
    overview, 294–296
    placing in Pages, 195–196
 printing
    books, calendars, and greeting cards, 317–319
    overview, 315–317
Digital Versatile Discs. See DVDs
digital video cameras, 328–329
directory, 535
Directory Utility, 111, 447
Disable automatic login option, Security preferences pane, 91
  disabling
    fonts, 71
    widgets, 57
Discoverable box, Bluetooth preferences pane, 94
disk image, 69, 91, 423, 426–427, 535
disk space, 491
disk utilities, 484
Disk Utility, 427, 482–483, 492
DiskWarrior disk utility, 484
Display Calibrator Assistant button, Displays preferences pane, 94
Display login window as option, Login Options, 116
Display notifications feature, iCal, 249
Display unread messages with bold font option, Mail, 386
Displays preferences pane, System Preferences, 94–95
Divide Equally button, Boot Camp, 461
DNS (Domain Name Services) protocol, 131
DNS Servers option, AirPort, 137, 140
DNS tab, AirPort, 137
.doc file format, 206
Dock
  adding items to, 51–53
  changing behavior of, 53–54
  customizing, 56
  defined, 535
  organizing icons, 53
  overview, 49–50
  removing items from, 50
  taking out Trash, 53
Dock preferences pane, System Preferences, 53–54
Dock unread count option, Mail, 381
Document Elements, Word, 201, 203–204
Document Inspector, Keynote, 239
Document option, scanner dialog box, 286
Documents folder, 29–30, 38
.docx file format, 206
Domain Name Services (DNS) protocol, 131
.dot file format, 207
.dotx file format, 207
Download All button, Image Capture, 321
Download Some button, Image Capture, 322–323
Download To popup menu, Image Capture, 321
Download.com Web site, 506–507
downloading
  applications, 69
  files, 426–428
Downloads folder, 29, 381, 426
Drafts mailbox, Mail, 390
Dreamweaver CS4 Bible, 524
Dreamweaver CS4 For Dummies, 526
Drive Genius disk utility, 484
Driver tab, Print & Fax preferences pane, 277
drivers
  defined, 535
  printer, 269–270
  scanner, 283
Drop Box directory, 166–167, 535
DropDMG utility, 428
Duplicate Photo window, iPhoto, 298
DVD or CD Sharing option, Sharing preferences pane, 159
DVDs (Digital Versatile Discs)
  burning data to, 178–179
  defined, 535
  installing applications from, 68–69
Dynamic Host Configuration Protocol (DHCP), 535
Dynamic Host Control Protocol/Bootstrap Protocol (DHCP/BOOTP), 131
E
Edit Keywords window, iPhoto, 303
Edit List button, International preferences pane, 87
Edit Mask button, Keynote, 238
Edit Picture window, Accounts preferences pane, 114–115
Edit window, Keynote, 238–239
Effects icon, iPhoto, 311
802.1x protocol, 131
802.1x tab, AirPort, 137
Eject button, 69
Electronic Arts, 519
Events Gallery, 201, 225, 228–230, 242
Email
alternative clients
Entourage, 402–405
Thunderbird, 396–401
defined, 535
exporting digital images via, 313–314
Mail
accounts, creating, 374–378
interface, 378–379
overview, 373–374
receiving, 394–396
replying, 394
sending, 390–393
setting preferences, 380–390
toolbar, modifying, 380
Email icon, iPhoto, 313
Empty Download Cache button, QuickTime preferences pane, 100
Empty Trash option, Trash icon, 39, 53
Empty Trash securely option, Finder, 42
Enable fast user switching option, Login Options, 117
Enable Firewall Logging option, Security preferences pane, 93
Enable Instant-On box, QuickTime preferences pane, 101
Enable kiosk mode option, QuickTime preferences pane, 101
Enable Parental Controls box, Parental Controls, 118
Enable Root User option, Directory Utility, 111, 447
Enable Spaces option, Exposé & Spaces preferences pane, 64
Enable Stealth Mode option, Security preferences pane, 93
enabling
Expose with function keys, 60–62
file sharing, 154–155
Macs for Spaces, 64
widgets, 57
Encodings tab, Terminal, 451
Energy Saver preferences pane, System Preferences, 95–96
Enter Time Machine option, Time Machine, 497
Entourage application, 402–405
Erase and Install button, Mac OS X, 486
Erase tab, Time Machine, 492
Ethernet
connecting printers via, 269
defined, 535
ports, 138, 145
Ethernet icon, Network preferences pane, 139
Ethernet tab, AirPort, 137
Event Library, iMovie, 326, 330, 332
Excel
2004 XML Spreadsheet (.xml) file format, 232
Excel 97–2004 Add-In (.xla) file format, 232
Excel 97–2004 Template (.xlt) file format, 231
Excel Add-In (.xlam) file format, 232
Excel application
creating spreadsheets
Elements Gallery, 228–230
overview, 225–226
Toolbox, 226–228
overview, 224–225
sharing spreadsheets, 230–233
Excel Binary Workbook (.xlsb) file format, 231
Excel Macro-Enabled Template (.xltm) file format, 231
Excel Macro-Enabled Workbook (.xlsm) file format, 231
Excel Template (.xltx) file format, 231
Excel Workbook (.xls) file format, 223, 231–232
Excel Workbook (.xlsx) file format, 231
Exchange server, 402
Exclude button, Time Machine, 494
Export Group vCard option, Address Book, 257
Export Using QuickTime option, iMovie, 338
Export vCard, Address Book, 257
exporting
bookmarks from Safari, 420
calendars from iCal, 251–252
contacts from Address Book, 257
digital images from iPhoto, 312–314
files from Pages, 200–201
files from Word, 206–207
groups from Address Book, 257
movie projects from iMovie, 339
presentations from PowerPoint, 244
spreadsheets from Numbers, 222–224
Exposé & Spaces preferences pane, System Preferences, 62–64
Exposé application
defined, 535
enabling with function keys, 60–62
setting preferences, 62–63
Extensible Markup Language (XML), 539
Extensible Markup Language-Remote Procedure Call (XML-RPC) protocol, 131
Extensis Suitcase Fusion utility, 74
Index

external devices
  FireWire, 16–17
  hard drives, 16, 84
  overview, 15–16
  troubleshooting, 479
  USB, 17

F
  F8 key, 64
  F9 key, 60
  F10 key, 60
  F11 key, 60
  fan pattern, Dock, 51
  fast user switching menu, 117
  FAT32 file format, 462
  Fetch FTP client, 174
  File Export tab, iPhoto, 312
  File Sharing box, Sharing preferences pane, 154–155, 282
  file system, 25, 491, 535
  File Transfer Protocol. See FTP
  File Transfer Protocol/Secure File Transfer Protocol
    (FTP/SFTP), 131
  FileMaker Bento personal database tool, 262–263, 509, 523
  files. See also sharing
    aliases, creating, 36–38
    creating, 32–33
    defined, 535
    deleting, 38–39, 499
    downloaded, 426–428
  exporting
    digital images from iPhoto as, 312–313
    from Pages, 200–201
    from Word, 206–207
  importing
    digital images into iPhoto from, 299–301
    music into iTunes from, 349
    into Pages, 200–201
    videos into iMovie from, 329–330
    into Word, 206–207
  opening in applications, 33–34
  previewing, 34–35
  receiving in iChat, 438
  renaming, 38
  restoring, 497–498
  selecting for backup, 490
  sending via iChat, 437
  viewing information about, 35–36
  file-sharing protocol. See sharing
  FileVault, 91–92, 113
  FileVault tab, Security preferences pane, 91–92
  FileZilla FTP client, 176–177
  Final Cut Studio certification, 529

Finder
  defined, 535
  Dock
    adding items to, 51–53
    changing behavior of, 53–54
    organizing icons, 53
    overview, 49–50
    removing items from, 50
    taking out Trash, 53
  Exposé, 60–63, 535
  finding items
    from within window, 44–45
    overview, 42
    with Spotlight, 43–47
  functions of, 21–22
  setting preferences, 39–42
  Spaces, 63–66
  utilizing
    files, 32–39
    folders, 29–31, 35–39
    icons, 23–25
    menus, 23–25
    overview, 22–23
    windows, 25–28
  widgets, 55–59
  Firefox browser
    add-ons, 424
    installing, 423–424
    overview, 422–423
    Web site, 510
  firewall, 92–93, 535
  Firewall tab, Security preferences pane, 92–93
  FireWire, 16–17, 283, 328, 535
  First Page from option, advanced print dialog box, 280
  Flash, 525
  Flash CS4 Professional Bible, 525
  flash drive, 180
  Flow FTP client, 177
  fn (Function) key, 13
folders. See also sharing
aliases, creating, 36–38
Burn Folders, 30–31
creating, 30
deleting, 38–39
icons, adding to, 79–81
renaming, 38
Smart Folders, 30–31
uses for, 29
viewing information about, 35–36
Font Book
adding fonts, 72–73
deleting fonts, 72–73
managing fonts, 70–72
setting preferences, 73–74
Font buttons, Pages, 195
Font menu, TextEdit, 190
Font smoothing style option, Appearance preferences pane, 87
FontAgent Pro application, 74
FontExplorer X application, 74–75
fonts
adding, 72–73
defined, 536
deleting, 72–73
finding, 70, 75
managing
overview, 70–72
third-party utilities for, 74–75
TextEdit, 190–192
Fonts & Colors section, Mail, 386
Fonts option, Pages, 195
Fonts window, TextEdit, 191–192
For first sync option, iSync, 260
Force Quit Applications window, Mac OS X, 480
Force Quit button, Mac OS X, 480
Format bar option, Numbers, 217
Format menu, TextEdit, 191
Format option, scanner dialog box, 286
Format popup menu, Excel, 232–233
Formats tab, International preferences pane, 87–88
Formatting buttons, Pages, 195
formatting hard disks, 491–492
Formatting Palette
PowerPoint, 242, 244
Toolbox, 226–227
Formula bar option, Numbers, 217
Formula Builder, Excel, 225, 227
FreeMacWare Web site, 508
Frenzic game, 69
from and to option, iCal, 253
frozen Macs, 480
FTP (File Transfer Protocol)
clients, 173–177
defined, 536
FTP/SFTP (File Transfer Protocol/Secure File Transfer Protocol), 131
Full Screen button, iMovie, 331
Full screen item
iPhoto, 295
iTunes Jukebox, 345
Function (fn) key, 13
Function button, Numbers, 220
function keys, 60–62
Function option, Numbers, 217
Funnel graphic, SmartArt Graphics, 204

G

games
finding, 518–520
overview, 515–516
Web site, 516–518
GarageBand, 367, 524
General section
iTunes, 350–351
Mail, 380–382
General tab
Address Book, 258
Finder, 39–40
iTunes, 355–356
Print & Fax preferences pane, 277
Safari, 411–412
Security preferences page, 90–91
Get Extensions link, Thunderbird, 401
Get Mail button, Thunderbird, 400
GIMP (GNU Image Manipulation Program), 513
Global Hot Key text field, Today, 264
Go to Podcast Directory button, iTunes, 352
Godzilla, 513
Google search item, Safari, 411
Google Talk instant messaging, 431
graphic designers, 523
graphics tablet, 15
greyscale, iPhoto, 310
greeting cards, creating, 317–319
grid pattern, Dock, 52
group accounts, 111
Group column, Address Book, 255
groups, Address Book, 254–256

H

hard disks
  formatting, 491–492
  moving to root directory of, 445
  restoring with Boot Camp, 466
Hard Drive icon, Finder, 166
Hardware category, System Preferences
  Bluetooth preferences pane, 93–94
  CDs & DVDs preferences pane, 94
  Displays preferences pane, 94–95
  Energy Saver preferences pane, 95–96
  Keyboard & Mouse preferences pane, 96–98
  Print & Fax preferences pane, 98
  Sound preferences pane, 98–99
Harmony theme, Themes, 236–237
Hearing tab, Universal Access preferences pane, 107
Help file, OpenOffice, 209
help resources, 487
Helpful Tips option, Speech preferences pane, 106
HFS+ (Hierarchical File System), 536
Hide profanity in Dictionary box, Parental Controls, 121
Hide Toolbar button, Finder, 26
Hierarchical File System (HFS+), 536
Highlight Color option, Appearance preferences pane, 86
Highlight related messages using color option, Mail, 386
hits, 44
Hold button, printer queue, 274
home directory, 445–446, 455, 536
host-client topology, 17
Hot Corners button, Desktop & Screen Saver preferences pane, 79
.htm (Web Page) file format, 207, 231, 244
HTML (HyperText Markup Language), 187, 536
HTTP (HyperText Transfer Protocol), 536
HTTP/HTTPS (Hypertext Transfer Protocol/Hypertext Transport Protocol Secure), 131

I

iCal application
  calendars, 249–252
  events, 252–254
  overview, 247–249
iChat application
  accounts, setting up, 431
  audio chats, 434–436
  contacts, adding to Buddy List, 432–433
  overview, 429–431
  presentations, making with iChat Theater, 439
  receiving files in, 438
  sending files via, 437
  text chats, 434
  video chats, 436–437
iChat Theater application, 437, 439
icons
  adding to folders, 79–81
  Finder, 23–25
  organizing on Dock, 53
iDisk application, 502
iDVD application, 338, 524
IEEE 802.1x protocol, 131
If outgoing server is unavailable option, Mail, 382
iFixit Web site, 487
IGN Web site, 518
iLife '09 Portable Genius, 524
iLife and iWork Associate Certification, 531
iLife Media Browser, 211
Illustrator application, 522, 524
Illustrator CS4 Bible, 522
iMac desktop computer, 8–9
Image Capture
  acquiring images, 320–322
  adding images to cameras, 323–324
  deleting images from cameras, 322–323
  scanning items, 284–288
  sharing, 288–289
  troubleshooting, 482
Image Capture Device Browser window, Image Capture, 287–288
Image Correction option, Image Capture, 286
images. See digital images
iMovie application
  creating projects
    marking favorite clips, 332–333
    music and sound effects, adding, 333–334
overview, 331–332
selecting clips, 332
transitions, 334–335
importing videos into
from files, 329–330
overview, 327
from video cameras, 328–329
overview, 325–327
sharing projects, 335–339
viewing imported video, 330–331
Import All button, iPhoto, 298
Import button, iPhoto, 300
Import CD button, iTunes, 349
Import Checked button, iMovie, 328
Import Selected button, iPhoto, 298
Import Using popup menu, iPhoto, 357
importing
bookmarks into Safari, 420
calendars into iCal, 251–252
contacts into Address Book, 257
digital images into iPhoto, 296–301
digital images into iPhoto, 296–301
files into Pages, 200–201
files into Word, 206–207
groups into Address Book, 257
music into iTunes, 348–350
presentations into PowerPoint, 244
spreadsheets into Numbers, 222–223
videos into iMovie, 327–330
Importing tab, iTunes, 356–357
In Printer option, advanced print dialog box, 280
InDesign CS4 Bible, 523
InDesign CS4 For Dummies, 523
InDesign page-layout application, 512, 523–524
Info button, printer queue, 275
Info tab, iTunes, 366
Info window, iCal, 250
Information pane, iPhoto, 295
Information Technology department, 129
input devices, 12–15
Input Menu icon, International preferences pane, 89
Input Menu tab, International preferences pane, 89–90
Input tab, Sound preferences pane, 99
Inside Mac Games Web site, 518
Insider FontAgent Pro application, 74
Inspector option, Pages, 195
Install button, Software Update, 475
Install Mac OS X and Bundled Software icon, Mac OS X, 486
Installed Updates tab, Software Update preferences pane, 105
installing
applications, 67–69
printers
drivers, 269–270
on networks, 272–274
printer queues, 270–272, 274–277
scanners, 283
Thunderbird, 397
widgets, 57–58
Windows, 459–464
Intego VirusBarrier X4 software, 484
Intel processor, 458
International preferences pane, System Preferences
Formats tab, 87–88
Input Menu tab, 89–90
Language tab, 87–88
Internet. See Web browsers
Internet & Network category, System Preferences
MobileMe preferences pane, 99–100
Network preferences pane
wired networks, 138–140
wireless networks, 134–138
QuickTime preferences pane, 100–101
Sharing preferences pane
Bluetooth Sharing option, 165–166
dVD or CD Sharing option, 159
enabling file sharing, 154–155
Internet Sharing option, 165
overview, 153–154
Printer Sharing option, 160–161
protocols supported by Mac OS X, 156–159
Remote Apple Events option, 163–164
Remote Login option, 161–163
Remote Management option, 163
Screen Sharing option, 159–160
setting user permissions, 155–156
Web Sharing option, 161
Xgrid Sharing option, 164
Internet Protocol address (IP address), 131, 137, 536
Internet Protocol (IP), 137, 276, 536
Internet Service Provider (ISP), 129, 374
Internet Sharing option, Sharing preferences pane, 165
Introduction window, Network Setup Assistant, 141
IP (Internet Protocol), 137, 276, 536
IP address (Internet Protocol address), 131, 137, 536
iPhone
- sharing movie projects with, 337–338
- using with iTunes, 364–367

iPhoto application
- editing images, 309–312
- exporting images, 312–314
- importing images
  - from cameras, 297–299
  - from files, 299–301
- overview, 296
- organizing images
  - albums, 304
  - keywords, assigning, 303
  - overview, 301–302
  - slide shows, 305–308
  - Smart Albums, 304–305
- overview, 293–296
- printing images, 315–319

iPod
- sharing movie projects with, 337–338
- using with iTunes, 364–367

ISP (Internet Service Provider), 129, 374

iSync application, 259–262

iTunes application
- importing music into, 348–350
- initializing, 342–344
- Jukebox interface, 344–348
- overview, 341
- playlists
  - creating Smart Playlists, 361
  - creating standard, 360
- overview, 359
- setting preferences
  - Advanced section, 355–358
  - Apple TV section, 359
  - General section, 350–351
  - Parental section, 358–359
  - Playback section, 352–353
  - Podcasts section, 351–352
  - Sharing section, 354
  - Store section, 354–355
  - Syncing section, 359
- using iPod and iPhone with, 364–367

iTunes Jukebox interface, 344–348

iTunes Library, 343, 349, 359, 366

iTunes MiniPlayer, 355–356

iTunes Music folder, 355

iTunes Setup Assistant, 342

iTunes Store
- creating accounts, 363–364
- interface, 362
- overview, 361–362

iWeb application, 524

iWork '09 Portable Genius, 524

J

Jabber instant messaging, 431

Java, 19, 408, 536

Java Virtual Machine (JVM), 408

JPEG (Joint Photographic Experts Group) file format, 312, 536

Junk Mail section, Mail, 385–386

JVM (Java Virtual Machine), 408

K

Keep iTunes Music folder organized box, iTunes, 355

Ken Burns Effect, iPhoto, 306–307

kernel, 536

Key Repeat option, Keyboard & Mouse preferences pane, 96

keyboard, 12–13, 96–98

Keyboard & Mouse preferences pane, System Preferences
  - Bluetooth tab, 97
  - Keyboard Shortcuts tab, 97–98
  - Keyboard tab, 96
  - Mouse tab, 97
  - Trackpad tab, 97

Keyboard and Mouse Shortcuts setting, Exposé & Spaces preferences pane, 63

Keyboard Shortcuts tab, Keyboard & Mouse preferences pane, 97–98

Keyboard tab
- Keyboard & Mouse preferences pane, 96
- Terminal, 450
- Universal Access preferences pane, 108

Keynote application
- customizing slide shows, 237–239
- interface, 234–236
- sharing slide shows, 240
- Themes, 236–237

Keynote slide show, iChat Theater, 439

keywords, assigning to images, 303

Keywords window, iPhoto, 303
Labels tab, Finder, 40
LAN (Local Area Network), 131, 536
Language tab, International preferences pane, 87–88
laptop computers
   MacBook, 4–5
   MacBook Air, 7–8
   MacBook Pro, 6–7
laser printer, 317
Last Import section, iPhoto, 300
Layout category, advanced print dialog box, 280
layouts, PowerPoint, 242–244
LDAP (Lightweight Directory Access Protocol), 131
LDAP tab, Address Book, 258
Learn More button, MobileMe, 100
ledger sheet, Excel, 225
Leopard. See Mac OS X
LeopardDocks App utility, 81
Library folder, 29, 59, 446
Library item, iTunes Jukebox, 345
Lightweight Directory Access Protocol (LDAP), 131
Limit iChat option, Parental Controls, 122
Limit Mail option, Parental Controls, 122
limiting application usage and tasks, 119–120
Line Printer Daemon (LPD) protocol, 536
Line-spacing options, Pages, 195
linking applications to Spaces, 65–66
Linotype FontExplorer X application, 74–75
list pattern, Dock, 52
List styles menu, Pages, 195
List view, iTunes Jukebox, 345
Listening Key option, Speech preferences pane, 106
Listening Method option, Speech preferences pane, 106
Live updating box, iTunes, 361
Local Area Network (LAN), 131, 536
Log & History button, printer queue, 275
Log Collections list, Parental Controls, 124
Logic Studio Master certification, 529
Login Items, 115–116
Login Options, 116–117
login picture, changing, 113–114
Logitech Cordless Optical Trackman, 15
Logs tab, Parental Controls, 124–125
Logs window, Parental Controls, 124
LPD (Line Printer Daemon) protocol, 536

1s -a command, 453
1s command, 452–453

Mac
   .Mac account, 430
   Mac Game Store Web site, 518
   Mac Games and More Web site, 518
   Mac Life Web site, 518
   Mac mini desktop computer, 10–11
   Mac Observer Web site, 487
   Mac OS Extended (Journaled) option, Time Machine, 492
   Mac OS X
      defined, 536
      file-sharing protocols supported by, 156–159
      networking protocols supported by, 131–132
      overview, 17–18
      prevalent technologies in
         Aqua, 19
         ColorSync, 20
         Darwin, 19
         Java, 19
         OpenGL, 20
         overview, 18
         PDF, 19
         Quartz, 19
         QuickTime, 20
      reinstalling, 486–487
      selecting startup volume within, 465
      Mac OS X Hints Web site, 487
      Mac OS X Internals: A Systems Approach, 525
      Mac OS X Leopard Portable Genius, 525
      Mac OS X Server 10.5, 468
      Mac OS X UNIX Toolbox: 1000+ Commands for Mac OS X, 525
      Mac Pro desktop computer, 11–12
      Mac Specialist Web site, 508
      MacBook Air laptop computer, 7–8
      MacBook laptop computer, 4–5
      MacBook Pro laptop computer, 6–7
      MacCleanse application, 485
      MacFixIt Web site, 487
      Macgamefiles Web site, 518
      Macintosh Products Guide, 508
      MacInTouch Web site, 487
      MacJanitor application, 485
      MacNN Web site, 487
MacPilot utility, 81
MacReview Web site, 509
MacReviewZone Web site, 509
Macs
Desktop pictures, 76–79
desktops
iMac, 8–9
Mac mini, 10–11
Mac Pro, 11–12
external devices
FireWire, 16–17
overview, 15–16
USB, 17
folders, adding icons to, 79–81
fonts
Font Book, 70–74
storage of, 70
third-party utilities, 74–75
input devices
graphics tablet, 15
keyboard, 12–13
mouse, 13–14
trackball, 15
trackpad, 14
installing applications
from CDs/DVDs, 68–69
from downloads, 69
overview, 67–68
laptops
MacBook, 4–5
MacBook Air, 7–8
MacBook Pro, 6–7
screen savers
finding, 79
selecting, 78–79
third-party utilities, 81–82
troubleshooting
applications, 481–482
external devices, 479
freezing, 480
help resources, 487
overview, 473
permissions, 482–483
reinstalling Mac OS X, 486–487
restarting, 474
shut-down problems, 479
startup problems, 477–479
third-party utilities for, 483–486
troubleshooting accounts, 475
upgrading software, 475–477
MacSoft Web site, 518
MacUpdate Web site, 507–508
Macworld Web site, 487, 509
Magnification option, Dock, 54
MagSafe power port, 5
Mail & iChat tab, Parental Controls, 122–123
Mail activity button, Mail, 379
Mail application
accounts, creating, 374–378
contacts, adding to Address Book, 395–396
defined, 536
interface, 378–379
overview, 373–374
receiving e-mail, 394
replying to e-mail, 394
saving attachments, 394–395
sending e-mail
attachments, 392
customizing messages with Stationery, 392–393
formatting messages, 390–392
setting preferences
Accounts section, 382–384
Composing section, 387–388
Fonts & Colors section, 386
General section, 380–382
Junk Mail section, 385–386
RSS section, 385
Rules section, 389–390
Signatures section, 388–389
Viewing section, 386–387
toolbar, modifying, 380
Mail icon, Finder, 374
Mail list option, Mail, 379
Mail Photo window, iPhoto, 313
Mail.appetizer plug-in, 511
Mailbox Behaviors tab, Mail, 382, 384
Mailbox pane, Mail, 378
maintenance. See troubleshooting
Make a new message option, Mail, 379
Make Alias option, Finder, 36
Make AppleTalk Active option, AirPort, 137
Make Default button, printer queue, 275
man command, 452
Manage parental controls from another computer box, Parental Controls, 118
Manage Widgets button, Finder, 57
margins, TextEdit, 190
Mark Selection as Favorite button, iMovie, 332
Master Pro certification, 529
Master Trainer certification, 529
MasterJuggler application, 74
Masters button, Keynote, 237–238
Mbps (megabits per second), 132
McAfee VirusScan Plus software, 471
McAfee VirusScan software, 484
Media Administration Certification, 530
Media Browser, 237–238, 338
Media button
   Keynote, 237
   Pages, 195–196
   PowerPoint, 244
Media Keys option, QuickTime preferences pane, 101
megabits per second (Mbps), 132
menus, Finder, 23–25
Message Viewer window, Mail, 378
metadata, 42
.mht (Single File Web Page) file format, 232
mice, 13–14, 97, 537
Micromat TechTool Pro disk utility, 484
Microphone option, Speech preferences pane, 106
microprocessor, 458
Microsoft Entourage, 402–405
Microsoft Excel. See Excel application
Microsoft Messenger, 439
Microsoft Office 2008 for Mac, 68–69, 233
Microsoft Office 2008 for Mac Bible, 523
Microsoft Office Communications Server 2007, 439
Microsoft PowerPoint. See PowerPoint application
Microsoft Web site, 509
Microsoft Word. See Word application
Mighty Mouse, 13–14
MIME Settings option, QuickTime preferences pane, 101
Minimize using option, Dock, 54
Minimize when double-clicking a window title bar option, Appearance preferences pane, 86
Miro application, 511
mkdir command, 455
MobileMe application, 251, 336, 412, 430, 502
MobileMe button, Mail, 382
MobileMe preferences pane, System Preferences, 99–100
Modifier keys button, Keyboard & Mouse preferences pane, 96
More Options button, iSync, 262
More Widgets button, Finder, 58
mouse, 13–14, 97, 537
Mouse tab, Keyboard & Mouse preferences pane, 97
.mov (Movie) format, 244
movie projects. See also iMovie application
   creating
      marking favorite clips, 332–333
      music, adding, 333–334
      overview, 331–332
      selecting clips, 332
      sound effects, adding, 333–334
      using transitions, 334–335
   sharing
      exporting, 339
      with iPhone, iPod, or Apple TV, 337–338
      with other applications, 338
      publishing to Web, 335–337
Movies folder, 29
Movies widget, Finder, 56
moving
   between Spaces, 64–65
   windows, 26–28
Mozilla Firefox. See Firefox browser
Mozilla Thunderbird. See Thunderbird application
MP3 file format, 343, 358, 368, 537
MPlayer application, 512
MS-DOS Comma Separated (.csv) file format, 232
MS-DOS Formatted Text (.txt) file format, 232
MTU option, AirPort, 137
music
   adding to movie projects, 333–334
   alternative utilities
      Audacity, 368
      GarageBand, 367
      Songbird, 368–369
iTunes
   importing into, 348–350
   initializing, 342–344
   Jukebox interface, 344–348
   overview, 341
   playlists, 359–361
   setting preferences, 350–359
   using iPod and iPhone with, 364–367
music (continued)
  iTunes Store
  creating accounts, 363–364
  interface, 362
  overview, 361–362
  using iPod and iPhone with
  synchronizing libraries, 366
  viewing information about, 365–366
  viewing other items, 366–367

Music folder, 29
Music icon, iPhoto, 307
Music tab, iTunes, 366
mv command, 454–455
My Computer icon, Windows, 168
My Day utility, 404–405

N
  Name Binding Protocol (NBP), 131
  Name box, Excel, 225
  Name column, Address Book, 255
  Name field option, iCal, 253
  Name option, scanner dialog box, 286
  naming
    files, 38
    folders, 38
    tables, 220–221
  NBP (Name Binding Protocol), 131
  NeoOffice application, 208, 210–211, 509
  NetBIOS Name option, AirPort, 137
  NetNewsWire RSS reader, 422, 510–511
  Network Diagnostics, 141–148
  Network Name field, AirPort, 135
  Network preferences pane, System Preferences
    wired networks, 138–140
    wireless networks, 134–138
  Network Setup Assistant, 141–145
  Network Time Protocol (NTP), 131
  Network Utility, 149–151
  networks
    defined, 537
    installing printers on, 272–274
    Network Diagnostics, 141–148
    Network Setup Assistant, 141–145
    Network Utility, 149–151
    overview, 129–130
  protocols supported by Mac OS X, 131–132
  wired
    hardware, 138
    setting up Macs on, 138–140
    versus wireless, 132
  wireless
    hardware, 133–134
    overview, 132–133
    setting up Macs on, 134–138
    versus wired, 132
  New Account popup menu, Accounts preferences pane, 112
  New Burn Folder option, Finder, 30–31
  New Finder windows open function, Finder, 40
  New mail sound option, Mail, 381
  New Message button, Mail, 390
  New playlist item, iTunes Jukebox, 345
  New slide feature, Keynote, 236
  New Smart Folder option, Finder, 30
  New Smart Playlist option, iTunes, 361
  NewsFire RSS reader, 422
  NewsGator NetNewsWire RSS reader, 422, 510–511
  Norton Antivirus software, 484
  Note option, iCal, 254
  Notes pane, PowerPoint, 242
  NTFS file format, 462
  NTP (Network Time Protocol), 131
  Number of Recent Items option, Appearance preferences
    pane, 86
  Numbers application
    creating spreadsheets
      charts, 221–223
    formatting cells and rows, 217–221
    interface, 216–217
    overview, 214–215
    templates, 215–216
    versus Excel, 233
  exporting spreadsheets, 222–224
  importing spreadsheets, 222–223
  overview, 213–214

O
  Object Palette
    Excel, 227–228
    PowerPoint, 244
  .odt (OpenOffice) file format, 187
  Office 2008 for Mac, 68–69, 233
  Office 2008 for Mac For Dummies, 524
Office Communications Server 2007, 439
Office Theme (.thmx) file format, 232
On CD Insert popup menu, iTunes, 357
Only when this computer is idle for the Agent accepts tasks option, Sharing preferences pane, 164
On/Off switch, Time Machine, 494
Onyx utility, 485
Open an Existing File button, Numbers, 215
Open Financial Exchange (OPX) file format, 223
Open Graphics Library (OpenGL) specification, 20, 537
Open Other button, Word, 202
Open Parental Controls button, Parental Controls, 118
Open part of page in Dashboard, Safari, 411
Open Print Queue button, Print & Fax preferences pane, 274
open source, 537
Open Source Mac Web site, 508
Open Speakable Items Folder option, Speech preferences pane, 106
Open With category, Mac OS X, 37
OpenOffice (.odt) file format, 187
OpenOffice.org Writer application, 208-210
operating system (OS). See also Mac OS X
Boot Camp
installing Windows, 459-464
restoring hard disks, 466
selecting startup volume, 464-465
reasons for installing alternative, 457-458
virtual machines
defined, 467
overview, 466-467
software for, 467-472
Optimization popup menu, Energy Saver preferences pane, 96
Option key, 12
Options & Supplies button, Print & Fax preferences pane, 277
Options button, Time Machine, 494
Options tab, Energy Saver preferences pane, 96
Options/Information window, Image Capture, 321
OPX (Open Financial Exchange) file format, 223
organization, personal
Address Book
contacts, 254-257
groups, 254-257
setting preferences, 257-258
iCal
calendars, 249-252
events, 252-254
overview, 247-249
iSync
setting up devices, 259-260
synchronizing information between devices, 260-262
third-party organizational tools
Bento, 262-263
Today, 263-265
OS. See Mac OS X; operating system
Outlook Web Access, Exchange server, 402
Output tab, Sound preferences pane, 99
Output volume slider, Sound preferences pane, 98
P
Page Setup dialog box, 278-279
Page viewer, Safari, 411
Pages application
charts, 197-199
creating documents
interface, 193-195
overview, 192
templates, choosing, 193
images, adding, 195-196
importing and exporting files, 200-201
shapes, adding, 197
tables, 197-199
Pages per Sheet option, advanced print dialog box, 280
Pages To Print option, advanced print dialog box, 280
PAP (Printer Access Protocol), 131
Paper Feed category, advanced print dialog box, 280
Paper Handling category, advanced print dialog box, 280
Paper Size, iPhoto, 315
Parallels Desktop for Mac application, 467-470
parameter RAM (PRAM), 478
Parental Controls
preferences pane
Content tab, 121
Logs tab, 124-125
Mail & iChat tab, 122-123
overview, 117-118
System tab, 118-120
Time Limits tab, 123-124
user accounts managed with, 110-111
Parental tab, iTunes, 358–359
partition, 459–462, 537
Password Assistant window, Accounts preferences pane, 113
Password option, AirPort, 137
Password pane, Accounts preferences pane, 114
passwords
  changing, 114–115
  FileVault, 91
  overview, 113
Path bar, Finder, 26
Pause Printer/Resume Printer button, printer queue, 275
pausing backups, 496–497
PDF (Portable Document Format), 19, 207, 231, 409, 537
peer-to-peer topology, 17
permissions. See user permissions
Personal Backup utility, 501–502
Personal category, System Preferences
  Appearance preferences pane, 85–87
  Desktop & Screen Saver preferences pane, 76–78
  Dock preferences pane, 53–54
  Exposé & Spaces preferences pane, 62–64
  International preferences pane
    Formats tab, 87–88
    Input Menu tab, 89–90
    Language tab, 87–88
  Security preferences pane
    FileVault tab, 91–92
    Firewall tab, 92–93
    General tab, 90–91
    overview, 89
  Spotlight preferences pane, 45–47
Phone tab, Address Book, 258
photos. See digital images
Photos tab
  iTunes, 366
  Keynote, 237
Photoshop application, 284, 513, 522, 524
Photoshop CS4 Bible, 522
Photoshop CS4 For Dummies, 522
Picture button, PowerPoint, 244
Pictures folder, 29
pinging, 150
Place scroll arrows option, Appearance preferences pane, 86
placeholders, 216, 236
Placeholders element, PowerPoint, 242
plain text (.txt) file format, 207
Play Project from Beginning button, iMovie, 332
Play slide show feature, Keynote, 236
Play slide show, iPhoto, 295
Playback section, iTunes, 352–353
playlists
  creating Smart Playlists, 361
  creating standard, 360
  overview, 359
Playlists item, iTunes Jukebox, 345
PMU (Power Management Unit), 478
Podcasts section, iTunes, 351–352, 366
Point-to-Point Protocol (PPP), 131
POP accounts, 400
popup blocking, 416
Portable Document Format (PDF), 19, 207, 231, 409, 537
ports, 15–16
Position on screen option, Dock, 54
  .pot (PowerPoint 97–2004 Template) file format, 244
  .potx (PowerPoint Template) file format, 244
  Power Adapter setting, Energy Saver preferences pane, 96
  Power Management Unit (PMU), 478
  PowerPC processor, 458
PowerPoint 97–2004 Presentation (.ppt) file format, 244
PowerPoint 97–2004 Template (.pot) file format, 244
PowerPoint application
  importing and exporting presentations, 244
  interface, 241–242
  layouts, 242–244
  overview, 240–241
  themes, 242–244
PowerPoint Package file format, 244
PowerPoint Presentation (.pptx) file format, 244
PowerPoint Template (.potx) file format, 244
PPP (Point-to-Point Protocol), 131
  .ppt (PowerPoint 97–2004 Template) file format, 244
  .pptx (PowerPoint Presentation) file format, 244
PRAM (parameter RAM), 478
Preferences directory, 446
Preferred Networks list, AirPort, 136
Preferred Networks option, AirPort, 137
presentations
  iChat Theater, 439
  Keynote
    customizing slide shows, 237–239
    interface, 234–236
    sharing slide shows, 240
    Themes, 236–237
PowerPoint
importing and exporting presentations, 244
interface, 241–242
overview, 240–241
themes and layouts, 242–244
Press Tab to highlight each item on a webpage box, Safari, 415
Preview application, 37, 231, 286, 537
Preview button, iPhoto, 306
previewing files, 34–35
Print & Fax icon, Finder, 270, 272
Print & Fax preferences pane, System Preferences, 98, 160–161, 270–277
Print Cover Page option, advanced print dialog box, 280
Print Document option, advanced print dialog box, 280
Print Installation & Setup Guide button, Boot Camp, 460
Print Size setting, iPhoto, 315
Print Test Page button, printer queue, 275
Print Using popup menu, Print & Fax preferences pane, 171, 270, 273
Printer Access Protocol (PAP), 131
printer queue
creating, 270
defined, 537
USB, 270–272
utilizing, 274–277
Printer Sharing option, 160–161
printers
configuring, 277
connecting
overview, 268–269
via Ethernet, 269
via USB, 269
digital images, 315–319
installing
drivers, 269–270
on networks, 272–274
printer queues, 270–272, 274–277
overview, 267–268
printing jobs, 278–280
sharing
with other Macs, 281
overview, 171–172, 280
with Windows users, 281–282
Privacy tab, Spotlight, 45
Private Browsing feature, Safari, 416, 418
Private Server option, iCal, 251
.prn (Space Delimited Text) file format, 232
Pro Applications Certification, 529
Profile tab, iChat, 434
Project Center tab, Word, 202
Project Gallery, Word, 201–202
Project Library, iMovie, 326, 331, 336, 338
Project Palette, Excel, 227
Project window, iMovie, 327
Prosoft Data Rescue disk utility, 484
Prosoft Drive Genius disk utility, 484
protocol, 537
Proxies tab, AirPort, 137
Public folder, 29
Publish button
iCal, 250
iTunes, 337
publishing
calendars, 250–251
movie projects to Web, 335–337
Publishing layout view, Word, 201
pwd command, 455
Q
Quark Web site, 509
QuarkXPress 8: Essential Skills for Page Layout and Web Design, 522
QuarkXPress page-layout application, 512
Quartz graphics service, 19, 409, 537
Quick Look feature, 34–35, 471
Quick Tables, Word, 204
QuickTime application, 20, 100–101, 408–409, 537
QuickTime preferences pane, System Preferences
Advanced tab, 101
Browser tab, 100
Register tab, 100
Streaming tab, 101
Update tab, 101
R
RADs (Random Access Devices), 328–329
RAM (Random Access Memory), 5, 467, 537
RBrowser FTP client, 174–175
Really Simple Syndication (RSS), 420–422
receiving
e-mail in Mail, 394
files in iChat, 438
Recent Pictures popup menu, Accounts preferences pane, 114
Recent tab, Word, 202
red-eye removal, iPhoto, 309
Reference Tools, Excel, 227, 229
Refresh page, Safari, 411
Register tab, QuickTime preferences pane, 100
reinstalling Mac OS X, 486–487
Reject Selection button, iMovie, 332–333
Relationship category, Word, 204
Remember any network this computer has joined option, AirPort, 137
Remote Apple Events option, Sharing preferences pane, 163–164
Remote Desktop software, 163
Remote Image Capture Devices, Image Capture, 173
Remote Login option, Sharing preferences pane, 161–163
Remote Management option, Sharing preferences pane, 163
Remove download list items popup menu, Safari, 411
Remove unedited downloads option, Mail, 381
removing items from Dock, 50
red-eye, 309
renaming files and folders, 38
Renew DHCP Lease option, AirPort, 137
Repair Disk button, Disk Utility, 479
Repair Disk Permissions button, Disk Utility, 483
repeat option, iCal, 253
Repeat playlists item, iTunes Jukebox, 345
Reply All button, Mail, 394
Reply options, Mail, 378
replying to e-mail, 394
Require password check box, Security preferences page, 90
resizing windows, 26–28
Resolution option, scanner dialog box, 286
resources
books, 521–526
Web sites, 526–528
restarting Macs, 474
Restore button, Time Machine, 498
Restore System option, Time Machine, 499
restoring entire disks, 466, 498–499
single files, 497–498
Results window, Finder, 26
Resume button, printer queue, 274
resuming backups, 496–497
Retouch icon, iPhoto, 311
Retrieve new mail option, Mail, 378
Retrospect backup application, 502
Rich Text Format Directory (.rtfd) file format, 187
Rich Text Format (.rtf), 187, 207
ringtones, 366–367
Ringtones tab, iTunes, 366
rm command, 455
rm -r command, 455–456
root accounts, 111
root directory, 445
Rotate icon, iPhoto, 309
rows, spreadsheet
entering data, 218–219
formulas, 219–220
naming tables, 220–221
overview, 217–218
Rows and Columns option, Spaces, 65
RSS (Really Simple Syndication), 420–422
RSS section, Mail, 385
RSS tab, Safari, 413–414
RSS Visualizer screen saver, Desktop & Screen Saver preferences pane, 78
RSSOwl application, 511
.rtfd (Rich Text Format Directory) file format, 187
Rules section, Mail, 389–390
S
Safari browser
bookmarks
importing and exporting, 420
organizing, 419–420
defined, 538
Develop menu, 418–419
interface, 409–411
popup blocking, 416
Private Browsing feature, 416
RSS, 420–422
setting preferences
Advanced tab, 415
Appearance tab, 411–412
AutoFill tab, 414
Bookmarks tab, 412–413
General tab, 411–412
RSS tab, 413–414
Security tab, 414-415
Tabs tab, 413
tabbed browsing, 416-417
Safe Mode, 478
Save As Draft button, Mail, 390
saving
downloaded files, 426
e-mail attachments, 394-395
Scan button, scanner dialog box, 287
Scan Mode option, scanner dialog box, 286
Scan To Folder option, scanner dialog box, 286
scanners
connecting, 283-284
Image Capture
overview, 284-286
scanning items, 286-288
sharing, 288-289
installing drivers for, 283
overview, 282-283
sharing, 173
Scheduled Check tab, Software Update preferences pane, 104-105
Scheduler category, advanced print dialog box, 280
Scrapbook, Excel, 227
Screen Saver tab, Desktop & Screen Saver preferences pane, 78
screen savers
finding, 79
selecting, 78-79
Screen Sharing option, Sharing preferences pane, 159-160
Scribus page-layout application, 513
SeaMonkey application, 511
Search bar, Spotlight, 44
Search button, Finder, 26
Search Domains option, AirPort, 137, 140
Search feature, iCal, 249
Search field, iTunes Store, 362
Search item, iTunes Jukebox, 345
Search mailboxes option, Mail, 379
Search option, iPhoto, 295
Search Results tab, Spotlight, 45
Seashore application, 512
Second Gear Today application, 263-265
Sections option, Pages, 194
Secure File Transfer Protocol (SFTP), 173
Secure MIME (S/MIME) protocol, 131
Secure Shell (SSH) protocol, 131
Secure Sockets Layer (SSL), 374
Security popup menu, AirPort, 135
Security preferences pane, System Preferences
FileVault tab, 91-92
Firewall tab, 92-93
General tab, 90-91
overview, 89
Security tab, Safari, 414-415
See today's events feature, iCal, 249
Seeing tab, Universal Access preferences pane, 107
Select a command set option, Speech preferences pane, 106
Select themes feature, Keynote, 236
Send Windows-Friendly Attachments option, Mail, 392
sending
e-mail attachments, 392
customizing messages with Stationery, 392-393
formatting messages, 390-392
files via iChat, 437
server, 538
Server Message Block (SMB) protocol, 157-158, 538
Server Settings option, Thunderbird, 400
Service Location Protocol (SLP), 131
Set as junk mail option, Mail, 378
Setting of High Quality option, iTunes, 357
Settings tab
Terminal, 450
Word, 202
7z compression utility, 428
SFTP (Secure File Transfer Protocol), 173
shapes, placing in Pages, 197
Shapes button, PowerPoint, 197, 244
Shapes option, Pages, 194
Share files and folders using AFP box, Sharing preferences pane, 158
Share files and folders using FTP box, Sharing preferences pane, 158
Share files and folders using SMB box, Sharing preferences pane, 158
Share my devices box, Image Capture, 288
Shared Folders list, Sharing preferences pane, 155
sharing
movie projects
exporting, 339
with iPhone, iPod, or Apple TV, 337-338
with other applications, 338
publishing to Web, 335-337

sharing (continued)
on networks
cameras, 173
files and folders, 166–170
FTP clients, 173–177
printers, 171–172
 printers
 with other Macs, 281
 overview, 171, 280
 with Windows users, 281–282
 scanners, 240
 spreadsheets, 230–233
 without networks
 burning data to discs, 178–179
 overview, 177
 utilizing USB flash drives, 179–181

Sharing preferences pane, System Preferences
 Bluetooth Sharing option, 165–166
 DVD or CD Sharing option, 159
 enabling file sharing, 154–155
 Internet Sharing option, 165
 overview, 153–154
 Printer Sharing option, 160–161
 protocols supported by Mac OS X, 156–159
 Remote Apple Events option, 163–164
 Remote Login option, 161–163
 Remote Management option, 163
 Screen Sharing option, 159–160
 setting user permissions, 155–156
 Web Sharing option, 161
 Xgrid Sharing option, 164

Sharing section, iTunes, 354
 Sharing tab, Address Book, 258
 sharing-only accounts, 111
 Sheets pane, Numbers, 217, 220, 222
 Sheets tab, Excel, 228
 Shell tab, Terminal, 450
 Short Name field, Accounts preferences pane, 112
 Show AirPort status, AirPort, 136
 Show all file extensions option, Finder, 41
 Show All option, Finder, 44
 Show Completed Jobs button, printer queue, 275–276
 Show Develop menu, Safari, 418
 Show input menu box, International preferences pane, 89
 Show Input menu in login window, Login Options, 116
 Show legacy encoders option, QuickTime preferences pane, 101
 Show Networks button, AirPort, 135
 Show or Hide Music button, iMovie, 334
 Show password hints option, Login Options, 117
 Show popup menu, Finder, 28
 Show Presenter Notes option, Keynote, 239
 Show previous/next page, Safari, 410
 Show Printer List button, printer queue, 275
 Show Ruler option, TextEdit, 188
 Show Stationery button, Mail, 392
 Show the Restart buttons, Login Options, 116
 Show these items on the Desktop function, Finder, 40
 Show Time Machine status, Time Machine, 496
 Show warning before changing an extension option, Finder, 41
 Show warning before emptying the Trash option, Finder, 42
 Show/hide Format Bar feature, Keynote, 236
 Shrook RSS reader, 422
 Shuffle item, iTunes Jukebox, 345
 Shut Down buttons, Login Options, 116
 shut-down problems, 479
 Sidebar tab, Finder, 26, 41
 Signatures section, Mail, 388–389
 Simple Finder, 119–120
 Simple Mail Transfer Protocol (SMTP), 538
 Simple Object Access Protocol (SOAP), 131
 Single File Web Page (.mht) file format, 232
 Sites folder, 29
 Size option, Dock, 54
 Size popup menu, Font Book, 72
 Size slider, iPhoto, 295
 Sleep buttons, Login Options, 116
 Slide canvas feature, Keynote, 236
 Slide element, PowerPoint, 242
 Slide Inspector, Keynote, 239
 Slide Layout tab, PowerPoint, 242
 Slide navigator feature, Keynote, 236
 Slide Navigator pane, Keynote, 239
 Slide Show button, PowerPoint, 244
 slide shows. See also presentations
 iPhoto
 creating, 305
 playing, 306–308
 setting up, 306–308
 Keynote
 customizing, 236–239
 sharing, 240
 Slide Themes tab, PowerPoint, 242
 Slide thumbnails, PowerPoint, 242
Index

.sln (Symbolic Link) file format, 232
Slow Keys option, Universal Access preferences pane, 108
SLP (Service Location Protocol), 131
Smart Albums, iPhoto, 304–305
Smart Folders, 30–31
Smart Playlists, iTunes, 361
Smart Shuffle, iTunes, 352
SmartArt Graphics
   Excel, 225, 228
   PowerPoint, 242
   Word, 201, 204–205
SMB (Server Message Block), 157–158, 538
SMC (System Management Controller), 478
S/MIME (Secure MIME) protocol, 131
SMTP (Simple Mail Transfer Protocol), 538
SOAP (Simple Object Access Protocol), 131
Softpedia Web site, 509
Software Update feature, 475–476
Software Update preferences pane, 104–105
Song Text option, iTunes, 350
Songbird application, 368–369
Sound Check option, iTunes, 352–353
sound effects, adding to movie projects, 333–334
Sound Effects browser button, iMovie, 334
Sound Effects tab, Sound preferences pane, 98–99
Sound Enhancer option, iTunes, 352
Sound preferences pane, System Preferences
   Input tab, 99
   Output tab, 99
   Sound Effects tab, 98–99
Source list, iPhoto, 295
Source pane
   iMovie, 326
   iTunes, 365
Source Text option, iTunes, 350
Space assignment, Spaces, 66
Space Delimited Text (.prn) file format, 232
Spaces application
   defined, 538
   enabling Macs for, 64
   linking applications to, 65–66
   moving between, 64–65
   overview, 63
Spaces icon, Finder, 64
Spaces tab, 63–66
Speakable Items radio buttons, Speech preferences pane, 105
speakers, 16
Speech preferences pane, System Preferences
   Speech Recognition tab, 105–106
   Text to Speech tab, 106
Speech Recognition tab, Speech preferences pane, 105–106
Spotlight application
   menu, 43–44
   overview, 42
   setting preferences, 45–47
Spotlight preferences pane, System Preferences, 45–47
spreadsheets
   Excel
      creating, 225–230
      overview, 224–225
      sharing, 230–233
   Numbers
      creating, 214–222
      importing and exporting, 222–224
      overview, 213–214
Spring-loaded folders and windows function, Finder, 40
SSH (Secure Shell) protocol, 131
SSL (Secure Sockets Layer), 374
stacks, 51
standard accounts, 110
Standard toolbar, Excel, 225
Start menu, Windows, 469
Startup Disk preferences pane, System Preferences, 106
Startup Disk tab, Boot Camp, 464–465
startup problems, 477–479
Startup tab, Terminal, 448–449
startup volume, selecting
   within Mac OS X, 465
   within Windows, 464–465
Stationery feature, Mail, 392–393
Statistics bar, Finder, 26
Status bar, Safari, 411
Status item, iTunes Jukebox, 345
Sticky Keys option, Universal Access preferences pane, 108
Stop Backing Up option, Time Machine, 496
Store item, iTunes Jukebox, 345
Store section, iTunes, 354–355
Straighten icon, iPhoto, 311
Streaming Speed selection, QuickTime preferences pane, 101
Streaming tab, QuickTime preferences pane, 101
Stuffit Deluxe utility, 428
Stuffit Expander utility, 428
Style buttons, Pages, 195
Styles pane option, Numbers, 217
Index

stylizing text, TextEdit, 188
su command, 454
subdirectory, 446
subscribing
to calendars, 252
to podcasts, 352, 366
to RSS feeds, 385, 420–421
sudo command, 454
Suitcase Fusion utility, 74
Summary category, advanced print dialog box, 280
Summary tab, iTunes, 365
Sun Microsystems VirtualBox application, 471–472
SuperDrive, 8, 538
SuperDuper! backup utility, 500
superuser accounts, 447
Supply Levels button, printer queue, 275
Supply Levels tab, Print & Fax preferences pane, 277
Symbolic Link (.slk) file format, 232
Sync Devices button, iSync, 262
Synchronize bookmarks using MobileMe box, Safari, 412
synchronizing
devices, 259–262
music libraries, 366
Syncing tab, Parental Controls, 359
System category, System Preferences
Accounts preferences pane, 111-115
Date & Time preferences pane
Clock tab, 103–104
Date & Time tab, 102–103
Time Zone tab, 103
Parental Controls preferences pane
Content tab, 121
Logs tab, 124–125
Mail & iChat tab, 122–123
overview, 117–118
System tab, 118–120
Time Limits tab, 123–124
Software Update preferences pane
Installed Updates tab, 105
Scheduled Check tab, 104–105
Speech preferences pane
Speech Recognition tab, 105–106
Text to Speech tab, 106
Startup Disk preferences pane, 106
Time Machine preferences pane, 493–496
Universal Access preferences pane
Hearing tab, 107
Keyboard tab, 108
Seeing tab, 107
System folder, 29, 538
System Management Controller (SMC), 478
System Preferences
Hardware category
Bluetooth preferences pane, 93–94
CDs & DVDs preferences pane, 94
Displays preferences pane, 94–95
Energy Saver preferences pane, 95–96
Keyboard & Mouse preferences pane, 96–98
Print & Fax preferences pane, 98
Sound preferences pane, 98–99
Internet & Network category
MobileMe preferences pane, 99–100
Network preferences pane, 134–140
QuickTime preferences pane, 100–101
Sharing preferences pane, 153–166
overview, 83–85
Personal category
Appearance preferences pane, 85–87
Desktop & Screen Saver preferences pane, 76–78
Dock preferences pane, 53–54
Expose & Spaces preferences pane, 62–64
International preferences pane, 87–89
Security preferences pane, 89–93
Spotlight preferences pane, 45–47
System category
Accounts preferences pane, 111–115
Date & Time preferences pane, 102–104
Parental Controls preferences pane, 117–125
Software Update preferences pane, 104–105
Speech preferences pane, 105–106
Startup Disk preferences pane, 106
Time Machine preferences pane, 493–496
Universal Access preferences pane, 107–108
System Profiler application, 486
System tab, Parental Controls
limiting application usage and tasks, 119–120
overview, 118–119
Simple Finder, 119
Tab Delimited Text (.txt) file format, 232
tab stops, TextEdit, 190
tabbed browsing, 416–417
tabbed chatting, 436
tabbed windows, 446–448
Table option, Pages, 195, 198
tables
  adding in Pages, 197–199
  naming in Numbers, 220–221
Tables option, Numbers, 217
Tabs tab, Safari, 413
tape-based digital video cameras, 329
TCPIIP (Transfer Control Protocol/Internet Protocol), 131, 276, 538
TCPIIP tab, AirPort, 137
Template Chooser
  Keynote, 234
  Numbers, 214–215
  Pages, 193
Template tab, Address Book, 258
templates
  Numbers, 215–216
  Pages, 193
Terminal application
  command line interface, 444–446
  defined, 538
  setting preferences
    Encodings tab, 451
    overview, 448–449
    Settings tab, 450
    Startup tab, 449
    Window Groups tab, 451
tabbed windows, 446–448
Test button, Desktop & Screen Saver preferences pane, 79
Text Box option, Pages, 194
text chats, 434
text color button, TextEdit, 191
Text Document icon, OpenOffice, 208
Text tab, Terminal, 450
Text to Speech tab, Speech preferences pane, 106
TextEdit application
  aligning text, 188–190
  fonts, 190–192
  functions of, 186–187
  margins setting, 190
  stylizing text, 188
  tab stops, 190
Theme Chooser, Keynote, 234, 236
themes
  Keynote, 236–237
  PowerPoint, 242–244
  Word, 201
third-party applications and utilities
  archived and compressed files, 427–428
  backing up, 500–502
  chat, 439–440
  design and page layout, 512–513
  disk recovery, 490
e-mail
  Entourage, 402–405
  Thunderbird, 396–401
finding, 506–508
font management, 74–75
freeware, 506
Internet, 510–511
Mac customization, 81–82
multimedia, 511–512
music, 368–369
operating systems, 469–472
overview, 505–506
personal organization, 262–265
productivity, 509–510
troubleshooting, 483–486
updating, 476–477
Web browsers, 422–426
.thmx (Office Theme) file format, 232
thumbnails pane, PowerPoint, 242
Thunderbird application
  accounts, setting up, 397–401
  extensions, 401
  installing, 397
  overview, 396
  steps to set up an account, 397–398
TidBITS Web site, 487
Time Capsule router, 501
Time Limits tab, Parental Controls, 123–124
Time Machine application
  deleting files, 499
  manual backups, 496
  pausing backups, 496–497
Time Machine application (continued)
  restoring
  entire disks, 498–499
  single files, 497–498
  resuming backups, 496–497
  specifying what to back up, 494–495
  storing backups on disk
    formatting hard disk, 491–492
    hardware requirements, 491
    setting up disk, 491–492
    specifying disk, 492–494
Time Machine icon, Finder, 496
Time Machine preferences pane, System Preferences, 493–496
Time Zone tab, Date & Time preferences pane, 103
To Do list feature, iCal, 249
Today application, 263–265
Toolbar
  Finder, 26, 28
  iMovie, 326
  iPhoto, 295
  Keynote, 236
  Mail, 380
  Safari, 410
Toolbox, Excel, 226–228
Track Changes option, Pages, 195
Track list, iTunes Jukebox, 345
trackball, 15
trackpad, 14
Trackpad tab, Keyboard & Mouse preferences pane, 97
  training programs, Apple, 529–531
Transfer Control Protocol/Internet Protocol (TCP/IP), 131, 276, 538
transitions, adding to movie projects, 334–335
Transitions pane, iMovie, 334–335
Translucent Menu Bar box, Desktop & Screen Saver preferences pane, 78
Transmit FTP client, 174–175
Transport Setup option, QuickTime preferences pane, 101
Trash icon, 38, 50, 53, 179
troubleshooting
  applications, 481–482
  external devices, 479
  freezing, 480
  help resources, 487
  permissions, 482–483
  reinstalling Mac OS X, 486–487
  restarting, 474
  shut-down problems, 479
  startup problems, 477–479
  troubleshooting accounts, 475
  updating software, 475–477
  utilities for, 483–486
TUAW (The Unofficial Apple Weblog), 528
Turn AirPort On button, Network preferences pane, 134
Turn Bluetooth On button, iSync, 259
Turn off text smoothing for font sizes option, Appearance preferences pane, 87
Turn on device name synchronization option, iSync, 260
Turn on FileVault protection box, FileVault, 113
TWAIN driver, 287
Two-Sided option, advanced print dialog box, 280
.txt (text) file format, 207, 232

U
UDP/IP (User Datagram Protocol/Internet Protocol), 131
Uniform Resource Locator (URL), 538
uninstalling widgets, 58–59
Unity technology, 470–471
Universal Access preferences pane, System Preferences
  Hearing tab, 107
  Keyboard tab, 108
  Seeing tab, 107
Universal Serial Bus. See USB
UNIX
  commands, 445, 452–456
  Terminal
    command line interface, 444–446
    setting preferences, 448–451
    tabbed windows, 446–448
  Unmark Selection button, iMovie, 332–333
  The Unofficial Apple Weblog (TUAW), 528
  Update tab, QuickTime preferences pane, 101
  updating software
    via Software Update, 475–476
    via third-party utilities, 476–477
  Upload button, Image Capture, 324
  Upon Recognition option, Speech preferences pane, 106
  URL (Uniform Resource Locator), 538
  url option, iCal, 254
USB (Universal Serial Bus)
  connecting printers via, 269
  flash drives, 179–181
  hubs, 479
keyboards, 12
overview, 17
printer queues, 270–272
Use 32GB button, Boot Camp, 461
Use AirPort box, Network Diagnostics, 147
Use for Backup button, Time Machine, 494
Use Password Manager, Thunderbird, 400
Use Simple Finder box., Parental Controls, 119
Use Small Size box, Finder, 28
Use Smart Builds feature, Keynote, 236
Use smooth scrolling option, Appearance preferences pane, 86
Use TWAIN UI button, Image Capture, 287
Use VoiceOver at login window option, Login Options, 117
user accounts
creating, 111–113
customizing
Login Items, 115–116
Login Options, 116–117
login picture, changing, 113–114
password, changing, 114–115
user name, changing, 114–115
defined, 538
folders, 29
Parental Controls preferences pane
Content tab, 121
Logs tab, 124–125
Mail & iChat tab, 122–123
overview, 117–118
System tab, 118–120
Time Limits tab, 123–124
troubleshooting, 475
types of
administrator, 110
group, 111
managed with Parental Controls, 110–111
overview, 109–110
sharing only, 111
standard, 110
User Datagram Protocol/Internet Protocol (UDP/IP), 131
user name, changing, 114–115
User Name field, Accounts preferences pane, 114
User Name option, AirPort, 137
user permissions
defined, 537
setting, 155–156
troubleshooting, 482–483
Users & Groups section, Sharing preferences pane, 156
Users folder, 29
UTF-16 Unicode Text (.txt) file format, 232
utilities, 539. See also third-party applications and utilities
Utilities folder, 149, 427, 460
Utilities menu, Mac OS X, 479

V
Validate fonts before installing option, Font Book, 74
vCard format, 257
vCard tab, Address Book, 258
Verify My Settings button, Entourage, 403
VersionTracker application, 507
video cameras, importing videos into iMovie from, 328–329
video chats, 436–437
Video tab, iTunes, 366
VideoLAN application, 512
videos, importing into iMovie. See also iMovie application
from files, 329–330
overview, 327
from video cameras, 328–329
View button
Finder, 26
Keynote, 239
View item, iTunes Jukebox, 345
View mini-month feature, iCal, 249
View option
Numbers, 217
Pages, 194
Viewer, iMovie, 326
viewing
imported video in iMovie, 330–331
iPod and iPhone information, 365–366
items on iPod and iPhone, 365–366
widgets, 55–56
Viewing area, iPhoto, 295
Viewing section, Mail, 379, 386–387
views, choosing, 26
virtual machines
defined, 467, 539
overview, 466–467
software for
Parallels Desktop for Mac, 469–470
selecting, 467–469
VirtualBox, 471–472
VMware Fusion, 470–471
Virtual Network Computing (VNC), 159-160
Virtual Private Network (VPN), 539
VirtualBox application, 471-472
virus-protection software, 484
VirusScan Plus software, 471, 484
Visual Basic macros, 233
VMware Fusion application, 467-471
VNC (Virtual Network Computing), 159-160
Volume Format popup menu, Time Machine, 492
VPN (Virtual Private Network), 539

W
WAN (Wide Area Network), 129, 539
WAP (wireless access point), 133
Web browsers
downloaded files
archived, 427-428
compressed, 427-428
saving, 426
Safari
bookmarks, 419-420
Develop menu, 418-419
interface, 409-411
popup blocking, 416
private browsing, 416
RSS, 420-422
setting preferences, 411-415
tabbed browsing, 416-417
Technologies
Java, 408
overview, 407
PDF, 409
QuickTime, 408-409
third-party
Camino, 425-426
Firefox, 422-424
Opera, 425
Web Page (.htm) file format, 207, 231, 244
Web Sharing option, Sharing preferences pane, 161
Web sites, recommended, 526-528
Website Restrictions area, Parental Controls, 121
Welcome Center window, Windows, 168
Welcome screen, iTunes, 342
Welcome to the iTunes Store window, 363
What You See Is What You Get (WYSIWYG), 524
When searching all mailboxes, include results from option, Mail, 382
Where popup menu, TextEdit, 33
Wide Area Network (WAN), 129, 539
Widget Manager, 57-58
widgets
activating, 55-56
deactivating, 56
defined, 539
disabling, 57
enabling, 57
installing, 57-58
uninstalling, 58-59
viewing, 55-56
Widgets folder, 59
Window Groups tab, Terminal, 451
Window menu, Safari, 418
Window tab, Terminal, 450
Window view options feature, iCal, 249
windows
creating groups of, 451
moving, 26-28
overview, 25-26
resizing, 26-28
views, choosing, 26
Windows
installing, 459-464
selecting startup volume within, 464-465
sharing printers with users of, 281-282
Windows Comma Separated (.csv) file format, 232
Windows Formatted Text (.txt) file format, 232
Windows Live account, 439, 459
WINS Servers option, AirPort, 137
WINS tab, AirPort, 137
wireless access point (WAP), 133
wireless keyboard, 97
wireless mouse, 97
wireless network interface controller (WNIC), 133
Wireless Network option, AirPort, 137
wireless networks
hardware, 138
setting up Macs on, 138-140
versus wireless, 132
wireless network interface controller (WNIC), 133
Index

Word application
importing and exporting files, 206–207
new features of
  charts, 204
  Document Elements, 203
  overview, 202
  Quick Tables, 204
  SmartArt Graphics, 204–205
  WordArt, 206
Project Gallery, 201–202
word processing
alternative applications
  NeoOffice, 211
  OpenOffice.org Writer, 208–210
Pages
  charts, 197–199
  creating documents, 192–195
  images, placing, 195–196
  importing and exporting files, 200–201
  shapes, placing, 197
  tables, 197–199
TextEdit
  aligning text, 188–190
  fonts, 190–192
  functions of, 186–187
  margins, setting, 190
  stylizing text, 188
  tab stops, 190
Word
  importing and exporting files, 206–207
  new features, 202–206
  Project Gallery, 201–202

WordArt
  Excel, 225, 228
  PowerPoint, 242
  Word, 201, 206
Workgroup option, AirPort, 137
World Wide Web, 539
WriteRoom application, 509–510
WYSIWYG (What You See Is What You Get), 524

X
Xgrid Sharing option, Sharing preferences pane, 164
.xla (Excel 97–2004 Add-In) file format, 232
.xlam (Excel Add-In) file format, 232
.xls (Excel Workbook) file format, 223, 231–232
.xlsb (Excel Binary Workbook) file format, 231
.xlsm (Excel Macro-Enabled Workbook) file format, 231
.xlsx (Excel Workbook) file format, 231
.xlt (Excel 97–2004 Template) file format, 231
.xlsm (Excel Macro-Enabled Template) file format, 231
.xlsx (Excel Template) file format, 231
.xml (Excel 2004 XML Spreadsheet) file format, 232
XML (Extensible Markup Language), 539
XML-RPC (Extensible Markup Language-Remote Procedure Call) protocol, 131
xPad text editor, 510
Xsan Administration Certification, 530

Y
Yahoo Messenger chat utility, 439
YouTube Web site, 335–337
Yummy FTP client, 176
Learn Adobe CS4 with a good book.

Get the big picture on Adobe CS4 with a comprehensive Wiley Bible. Discover the books you need to succeed!

Available at www.wiley.com or wherever books are sold.
All your Mac questions answered!

Whether you're one of the thousands unwrapping your first Mac or you're already an experienced Mac user, *Mac Bible* is the perfect Mac primer, from the very basics up to all the cool stuff. First get up to speed on Safari® and business tools, set up user accounts, and add your Mac to a network. The fun continues as you see how to edit digital video with iMovie, organize your calendar with iCal®, get the most out of iTunes, and much more. It's 600 pages jam-packed with the information you need to succeed with your Mac.

- Go under the hood and find out what makes a Mac tick
- Master Mac OS® X, the Mac operating system
- Get down to business with spreadsheets and presentations
- Print and scan, download iTunes®, and organize contacts
- Make iMovie® magic, create podcasts, and edit photos
- Troubleshoot and back up your Mac

A full-color, 32-page insert offers vibrant, colorful screen shots and photo images showing you the cool things you can do with iPhoto, iMovie, and other Mac applications.

Dwight Spivey is a software and support engineer for Konica Minolta, where he specializes in working with Mac operating systems, applications and hardware, as well as color and monochrome laser printers. He also teaches classes on Mac OS X, which he has used and tested since its first public beta was released in 2000.